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Safety Instructions
Be sure to read these instructions in order to operate the product safely. Follow these instructions to prevent injury or 
harm to the operator of the product or others.

WARNING
Denotes the risk of serious injury or death.
• Stop using the product in any case of unusual circumstances such as the presence of smoke or a strange smell.
• Do not touch any exposed internal parts.
• Do not get the product wet. Do not insert foreign objects or liquids into the product.
• Do not touch the product connected to a power outlet during lightning storms. This may cause electric shock.
• Do not disassemble or modify the product.
• Do not expose the product to strong shocks or vibration.
• Do not use organic solvents such as alcohol, benzine or paint thinner to clean the product.
• Do not use the product where flammable gases may be present. This may cause electric shock, explosion or fire.
• Use only power sources specified in this instruction manual for use with the product.
• Observe the following instructions when using a battery charger or AC adapter.

- Do not touch the battery charger or AC adapter connected to a power outlet during lightning storms.
- Do not use the product if the power plug is not fully inserted into the power outlet.
- Do not unplug the product by pulling the power cord.
- Do not plug in or unplug the product with wet hands.
- Do not place heavy objects on the power cord. Do not damage, break or modify the power cord.
- Do not leave the product connected to a power source for long periods of time.
- Do not expose the power plug and terminals to dirt or let them come into contact with metallic pins or other metal 

objects.
- Do not charge batteries/battery packs at temperatures outside the range of 0 - 40 °C (32 - 104 °F).

• Observe the following instructions when using commercially available batteries or provided battery packs.
- Do not use leaking batteries/battery packs. 

If a battery/battery pack leaks and the material contacts your skin or clothing, flush the exposed area thoroughly 
with running water. In case of eye contact, flush thoroughly with copious amounts of clean running water and seek 
immediate medical assistance.

- Use batteries/battery packs only with their specified product.
- Do not heat batteries/battery packs or expose them to fire. 
- Do not charge batteries/battery packs using non-authorized battery chargers.
- Do not expose the terminals to dirt or let them come into contact with metallic pins or other metal objects.
- Keep batteries out of the reach of children.
- When disposing of batteries/battery packs, insulate the terminals with tape or other means.

• Do not shoot the sun directly or point a lens or a camera with a lens attached at the sun. Even when the sun does not 
appear on the screen or is behind the subject, the lens may concentrate the sunlight and cause a malfunction or fire.

• Do not leave a lens or a camera with a lens attached, exposed without the lens cap attached. The lens may concentrate 
the light and cause fire.

• Do not wrap the product in cloth or other materials when in use or shortly after use when the product is still warm in 
temperature.

• Do not allow the product to maintain contact with the same area of skin for extended periods of time during use. This 
may result in low-temperature contact burns, including skin redness and blistering, even if the product does not feel 
hot. The use of a tripod or similar equipment is recommended when using the product in hot places and for people 
with circulation problems or less sensitive skin.

• Keep the product out of the reach of young children.
- A strap wrapped around a person’s neck may result in strangulation.
- The parts or provided items of cameras or accessories are dangerous if swallowed. If swallowed, seek immediate 

medical assistance.
- The accessory shoe cover is dangerous if swallowed. If swallowed, seek immediate medical assistance.
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• This product uses a button/coin battery.
- Button/coin batteries are dangerous and should always be kept out of the reach of children, whether new or used.
- Swallowing or placing these batteries anywhere in the body can cause serious injury or death within 2 hours.
- If you suspect a button/coin battery has been swallowed or placed anywhere in your body, seek medical attention 

immediately.
• Periodically remove any dust buildup from the power plug and power outlet using a dry cloth.
• Follow any indications to turn off the product in places where its use is forbidden. Not doing so may cause other 

equipment to malfunction due to the effect of electromagnetic waves and even result in accidents.
• Before installing, be sure the surface is capable of supporting the total weight of the camera and connected devices, 

and sufficiently reinforce the surface if necessary.
• Do not place the battery near pets. When chewed, the battery may leak, overheat, or burst, causing damage or fire.

CAUTIONS
Follow the cautions below. Otherwise physical injury or property damage may result.
• Strap is intended for use on the body only. Hanging the strap with any product attached on a hook or other object may 

damage the product. Also, do not shake the product or expose the product to strong impacts.  This may cause injury or 
damage to the product.

• Do not leave the product in places exposed to extremely high or low temperatures. The product may become 
extremely hot/cold and cause burns or injury when touched.

• Only mount the product on a tripod that is sufficiently sturdy.
• Do not look at the screen for prolonged periods of time. This may induce symptoms similar to motion sickness. In such 

a case, stop using the product immediately and rest for a while before resuming use.
• Do not apply strong pressure on the lens or allow an object to hit it. This may cause injury or damage to the product.
• Do not carry the product when it is mounted on a tripod. This may cause injury or may result in an accident.
• Do not touch any parts inside the product. This may cause injury.
• If any abnormal skin reaction or irritation occurs during or following the use of this product, refrain from further use 

and get medical advice/attention.

Only for European Union and EEA (Norway, Iceland and Liechtenstein) and United Kingdom
These symbols indicate that this product is not to be disposed of with your household waste, 
according to the WEEE Directive (2012/19/EU), the Battery Regulation ((EU) 2023/1542) and/or 
national legislation implementing those Directive and Regulation and the UK Waste Electrical and 
Electronic Equipment Regulations and the UK Batteries and Accumulators Regulations.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Regulation and the 
UK Batteries and Accumulators Regulations, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = 
Lead) is present in this battery or accumulator at a concentration above an applicable threshold specified in the 
Battery Regulation and the UK Batteries and Accumulators Regulations.
This product should be handed over to a designated collection point, e.g., on an authorized one-for-one basis when 
you buy a new similar product or to an authorized collection site for recycling waste electrical and electronic 
equipment (EEE) and batteries and accumulators. Improper handling of this type of waste could have a possible 
impact on the environment and human health due to potentially hazardous substances that are generally 
associated with EEE. Your cooperation in the correct disposal of this product will contribute to the effective usage of 
natural resources. 
For more information about the recycling of this product, please contact your local city office, waste authority, 
approved scheme or your household waste disposal service or visit
www.canon-europe.com/sustainability/approach/.
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Introduction

About this Manual
Thank you for purchasing the Canon EOS C50. Please read this manual carefully before you use the camera and retain it 
for future reference. Should the camera fail to operate correctly, refer to Troubleshooting (A 221).

Conventions Used in this Manual
• IMPORTANT: Precautions related to the camera’s operation.
• NOTES: Additional topics that complement the basic operating procedures.
• A: Reference page number.
• The following terms are used in this manual.

- “Screen” refers to the LCD monitor's screen.
- “Handle unit” refers to the included handle unit.
- “Battery” refers to a supplied or optional battery pack.
- “SD card” refers to an SD, SDHC or SDXC memory card.
- “Memory card”  or “card”  refers to SD cards or CFexpress cards.
- “RAW” refers to the data recorded in Cinema RAW Light.
- “Multi-Camera Control” refers to Canon Multi-Camera Control.

Before Using the Camera

• Before making important recordings for the first time, make test recordings using the video configuration(s) you 
plan to use to check that the camera operates correctly. Should it fail to operate correctly, refer to Troubleshooting 
(A 221).

• Copyright notice: Unauthorized recording of copyrighted materials may infringe on the rights of copyright owners and 
be contrary to copyright laws.

• Notes on privacy and publicity rights regarding the use of video: When using the camera, exercise proper caution in order to 
protect privacy and avoid any violation of publicity rights.

• About the LCD screen: The screen is produced using extremely high-precision manufacturing techniques, with more 
than 99.99% of the pixels operating to specification. Very rarely, pixels may misfire or light up permanently. This has 
no effect on the recorded image and does not constitute a malfunction.

• About CFexpress cards: CFexpress cards can become hot due to the high operating temperature inside the camera. 
Removing a CFexpress card immediately after using it for recording may cause burns or cause you to drop the card, 
resulting in damage to the card.

• About the access indicator: Observe the following precautions while an access indicator (A 39) is illuminated or flashing 
in red. Failing to do so may result in permanent data loss.
- Do not turn off the camera and do not remove the battery or other power source.
- Do not open the card compartment cover.

• The camera has two operation modes: PHOTO mode and VIDEO mode.
Set the power switch to PHOTO to set the camera to PHOTO mode, or to VIDEO to set the camera to VIDEO mode. 
Software compatible with either PHOTO mode or VIDEO mode can only be used when the camera is set to the 
corresponding mode, so switching the camera's operation mode when using said software will end the connection 
to the camera.
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- “CAMERA mode”: operating mode for making recordings (shooting mode). 
“MEDIA mode”: operating mode for playing back and managing recordings (playback mode).

- “Access indicator”: when not specified, refers collectively to the CFexpress or SD CARD access indicators.
• Unless indicated otherwise, shooting functions are utilized in CAMERA mode.
• Unless indicated otherwise, illustrations in the manual show the Canon EOS C50 camera with a Canon RF24-105mm F4 

L IS USM lens attached.
• Photographs in the manual are for illustration purposes only.
• Some screenshots have been altered to make them easier to read. Furthermore, screenshots used are from a product in 

development and may differ slightly from the actual screens due to product enhancement.
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Supplied Accessories

Supplied Accessories
The following accessories are supplied with the camera. For accessories sold separately, please refer to List of Accessories 
(A 238). Unless indicated otherwise, accessories mentioned in this manual are the ones supplied with the camera.

About the Instruction Manual
The included Instruction Manual contains important information to read before using the camera, as well as safety 
precautions.

Complete instructions are provided in the Advanced User Guide. This document is the Advanced User Guide for VIDEO 
mode (VIDEO edition). For details on recording photos, please refer to the Advanced User Guide for PHOTO mode 
(PHOTO edition).

PHOTO edition: Provides detailed instructions for the camera in PHOTO mode. Set the power switch to PHOTO to set 
the camera to PHOTO mode.

VIDEO edition: Provides detailed instructions for the camera in VIDEO mode. Set the power switch to VIDEO to set the 
camera to VIDEO mode.

For the latest Advanced User Guide, refer to the following website:
https://cam.start.canon/

LC-E6/LC-E6E Battery Charger1 LP-E6P Battery Pack
(incl. terminal cover)

Handle Unit Microphone Holder
(incl. M4 fixation bolts, x2)

Multi-Function Shoe Cover2 Body Cap2 SS-1200 Shoulder Strap Instruction Manual

1 LC-E6 or LC-E6E Battery Charger is provided. (The LC-E6E comes with a power cord.)
2 Comes pre-attached to the camera.
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Names of Parts
Camera

Removing and attaching the terminal covers
You can remove the covers of the camera’s terminals to access them more easily. To remove a terminal’s cover, open 
the cover and gently pull it straight out. To attach back the terminal cover, insert the connecting strip into the opening. 
If the connecting strip is difficult to grasp, use a pair of tweezers or similar tool.

1 2

3

4

5

8

7

6

9

10

* Names and functions differ in PHOTO mode.

1 Screw hole for 1/4"-20 mounting screws (9.1 mm 
(0.36 in.) deep)

2 Strap mounts
Pass one end of the SS-1200 Shoulder Strap through 
the strap mount and adjust the length of the strap.

3 TIME CODE terminal (A 106)
4 MIC (microphone) terminal (A 110)
5 USB terminal (A 129)
6 × (headphone) terminal (A 116)
7 HDMI OUT terminal (A 157)
8 DC coupler cord hole
9 Exhaust ventilation outlet (A 48)
10 Remote control terminal (A 238)

For connection with a wired remote controller.
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Names of Parts

1 2 3

4

5 6 7

* Names and functions differ in PHOTO mode.

1 Strap mounts
Pass the end of the SS-1200 Shoulder Strap through 
the strap mount to secure it to the camera.

2 Screw hole for 1/4"-20 mounting screws (9.6 mm 
(0.38 in.) deep)

3 FUNC (main functions) button (A 61)/
Assignable button Camera 11 (A 131)

4 Card access indicator (A 39)
5 Card compartment cover (A 39)
6 Card slot 1 (CFexpress card) (A 39)
7 Card slot 2 (SD card) (A 39)
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3 5 64 7

1

2

8

9

1110 12 13
Lens mount

* Names and functions differ in PHOTO mode.

1 REC (start/stop recording) button (A 51)
2 Zoom lever (A 98)
3 Grip control dial (A 79, 82)
4 Self-timer lamp/AF-assist beam (exclusive to PHOTO 

mode)
5 RF lens mount index (A 32)
6 Lock plate mounts (x4)
7 Tally lamp/Charge lamp (A 51)

8 Lens lock pin
9 Lens release button (A 32)
10 Air intake vent (A 48)
11 AF LOCK button (A 93)/

Assignable button Camera 12 (A 131)
12 Lens contacts (A 32)
13 REC (start/stop recording) button (A 51)/

Assignable button Camera 13 (A 131)
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Names of Parts

1 2

3 4 5 6 7 8 9 10

1514131211

* Names and functions differ in PHOTO mode.

1 LCD monitor (A 25)
2 Speaker (A 150)
3 Assignable button Camera 14 (A 131)
4 MENU button (A 28)
5 Power indicator / Tally lamp (A 51)
6 DISP (display) button (A 53)/

Assignable button Camera 4 (A 131)
7 Joystick (A 28)

You can push the joystick in 8 directions (up/down, 
left/right, or diagonally) and press the joystick itself to 
confirm.

8 AF-ON (One-Shot AF) button (A 92)/
Assignable button Camera 1 (A 131)

9 MAGN. (magnification) button (A 91)/
INDEX button (A 146)/
Assignable button Camera 2 (A 131)

10 PUSH AUTO IRIS (momentary automatic aperture) 
button (A 83)/Assignable button Camera 5 (A 131)

11 Air intake vent (A 48)
12 MEDIA button (A 145)

When the camera is on, press to toggle the camera 
between CAMERA mode (shooting) and MEDIA mode 
(playback).

13 CANCEL button (A 28)
14 SELECT dial/SET button (A 28)
15 MENU button (A 28)/

Assignable button Camera 3 (A 131)
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IMPORTANT

• Do not use tripods and other accessories with mounting screws exceeding the depth of the screw holes on the 
camera as this may damage the camera.

1 2 3 4

5 6 7 8 9 10 11

12 13

14 15

* Names and functions differ in PHOTO mode.

1 focal plane mark
2 Screw holes for 1/4"-20 mounting screws (8.8 mm 

(0.35 in.) deep, x2)
3 LOCK (key lock) button (A 31) / Assignable button 

Camera 8 (A 131)
4 WFM (video scope) button (A 118)/

Assignable button Camera 10 (A 131)
5 Power switch

VIDEO: Turns on the camera in VIDEO mode.
PHOTO: Turns on the camera in PHOTO mode.
OFF: Turns off the camera.

6 Multi-function shoe (with shoe cover) (A 37)
7 Built-in microphone (A 108)

8 Top control dial (A 79, 82)
9 Assignable button Camera 6 (A 131)
10 PEAKING button (A 91)/

Assignable button Camera 9 (A 131)
11 REC (start/stop recording) button (A 51)/

Assignable button Camera 7 (A 131)
12 Screw hole for 1/4"-20 mounting screws (5.5 mm 

(0.22 in.) deep)
13 Socket for tripod's anti-rotation pin (4.5 mm (0.18 in.) 

deep)
14 Battery compartment cover lock (A 22)
15 Battery compartment cover (A 22)
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Names of Parts

Handle Unit

Microphone Holder

 (A 36)

1 2 3 4 5 6

7 8

13

9

10
11
12

1 Screw holes for 1/4"-20 mounting screws (5.5 mm 
(0.22 in.) deep, x2)

2 Lock lever
3 Handle zoom lever (A 98)
4 REC (start/stop recording) button (A 51)
5 Accessory shoe
6 Sockets for the microphone holder (A 37)
7 Fixation bolts

8 INPUT 1/INPUT 2 terminals (A 110)
9 Sensitivity selection switches for INPUT 1 and INPUT 2  

(A 111)
10 Audio level switches for CH1 and CH2 (A 112)
11 Handle INPUT 1/2 switch (A 110)
12 Audio level dials for CH1 and CH2 (A 113)
13 Tally lamp (A 51)

 (A 37)

1

3

2

1 Microphone lock screw
2 Microphone holder

3 Microphone cable clamp
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Workflow Overview: 4K and Higher
The following illustrates the typical workflow for 4K (or higher) recording with the camera.

1 Shoot in 4K (or higher) mode (A 63).

2 You can record primary clips (6.9K1/5K: RAW, 4K: XF-AVC / XF-AVC S, 6.9K/4K: XF-HEVC S) on a CFexpress or SD card in 
the camera or record 4K data using an external recorder connected to the camera’s HDMI OUT terminal (A 157).

3 While recording primary clips, you can simultaneously record 2K proxy clips on the SD card.
• Proxy data can only be recorded on the SD card. When recording proxy data, the main video is recorded on the 

CFexpress card.
• The file names of 2K proxy clips (XF-AVC / XF-HEVC S / XF-AVC S) and main clips are linked and identical for the most 

part (A 46).

4 You can use the 2K proxy clips recorded on the SD card or proxy files generated by Cinema RAW Development on NLE 
software to edit the video offline and create an EDL.

5 After recording RAW data, develop the clips using the Cinema RAW Development software (A 163) to generate full-
quality data.
• You can also generate proxy data.

6 Perform color grading based on the full-quality data.
1 Recording to the SD card is not possible.

Recording Post-production

HDMI OUT 
terminal 
output

SD card

XF-AVC
XF-HEVC S
XF-AVC S

data

EDL

NLE 
software

 2K recording (XF-AVC / 
XF-HEVC S / XF-AVC S)

Cinema 
RAW 

Development

Color 
grading

External 
recorder

Full-quality 
data

RAW data

 4K recording

 6.9K1/5K recording (RAW), 
4K recording (XF-AVC / XF-AVC S), 
6.9K/4K recording (XF-HEVC S)

CFexpress card
SD card

Full-quality 
data

 Shooting
Proxy data

Primary clips

Proxy
data
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Workflow Overview: 4K and Higher

Color Grading with the ACES Workflow
You can perform color grading using ACES, the color encoding system defined by the Academy of Motion Picture Arts 
and Sciences. 

Color spaces:
ST2065-1: AP0 primaries, linear floating-point encoding.
ACEScc: AP1 primaries, log floating-point encoding.
ACEScct: AP1 primaries, log floating-point encoding. Differs from 

ACEScc by adding a ‘toe’ to the encoding, with a 
behavior resembling that of the Cineon curve.

Input Transform: Refers to the table used for converting color information 
of the input device to ST2065-1 color space. It can be 
downloaded from Canon’s website.

Output Transform: Refers to the table used for mapping ST2065-1 color 
space information to the specific color information 
scheme used by the display device.

ASC-CDL: Refers to the list that contains color grading adjustment 
data. This step requires equipment compatible with 
ASC-CDL.

Cinema RAW 
Development Color grading

(ACEScc/ACEScct)

Post-production

Output 
Transform

RAW data

OpenEXR 
(ACES)

Input 
Transform

ASC-
CDL

CFexpress 
card

SD card

XF-AVC
XF-HEVC S

XF-AVC S 
data

Input 
Transform

Input 
Transform

RAW 
Development

Canon Log 2 / 3
Cinema Gamut

‐ 0.2

0

0.2

0.4

0.6

0.8

1

1.2

‐ 0.2 0 0.2 0.4 0.6 0.8 1

BT.709
BT.2020
Cinema Gamut 
AP0
AP1
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Preparations

Preparing the Power Supply
You can power the camera using a battery or a power outlet. You can check in advance for restrictions that may arise 
depending on the type of power source used (Power Source Navigation) (A 36).

Using a Battery
You can power the camera using the LP-E6P Battery Pack (or the LP-E6NH Battery Pack). When using a battery for the first 
time, charge it fully and then use the camera until the battery is completely depleted.

Charging the Battery

Charge battery packs using the LC-E6/LC-E6E Battery Charger. Before charging, remove the terminal cover of the battery 
pack.

1 Fully insert the battery into the charger.
• Do the opposite to remove the battery.

2 Recharge the battery.

For LC-E6
• As shown by the arrow, flip out the battery charger's prongs 

and insert the prongs into a power outlet.

For LC-E6E
• Connect the power cord to the charger and insert the plug into a 

power outlet.
• Recharging starts automatically and the charge lamp blinks in 

orange.

�
�

�

�

�

�
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IMPORTANT

• Do not connect to the battery charger any product that is not expressly recommended for use with this camera.
• To prevent equipment breakdowns and excessive heating, do not connect the battery charger, an optional DC coupler 

and a USB power adapter/AC adapter, or the USB power adapter to voltage converters for overseas travels or special 
power sources such as those on aircraft and ships, DC-AC inverters, etc.

• After removing the battery charger from the power outlet, avoid touching the charger's plug for approximately ten 
seconds.

• Battery packs other than the LP-E6P/LP-E6NH/LP-E6N/LP-E6 cannot be charged using the included battery charger. 
The LP-E6N/LP-E6 is not compatible with this camera.

NOTES
• The approximate charging time for a fully depleted battery pack is 3 hours at room temperature (23 °C) (73 °F). 

Charging times vary greatly depending on the ambient temperature and remaining charge.
• Charging times will be longer (up to approximately 4 hours) in low temperatures (5 °C to 10 °C) (41°F to 50 °F) in order 

to ensure a safe charge.
• Charge the battery pack before use. The battery pack is not fully charged at the time of purchase.
• For handling precautions regarding the battery, refer to Safety Instructions (A 2) and Handling Precautions (A 235).
• For approximate charging times / usage times, refer to the Reference Tables (A 250) and Approximate Continuous 

Recording Times (A 249).
• Charged batteries continue to discharge naturally. Therefore, charge them on the day of use, or the day before, to 

ensure a full charge.
• Once fully charged, remove the battery pack from the charger and unplug the power cord from the power outlet.
• Remove the battery pack from the camera when not in use. A small amount of electrical current flows when the 

battery pack is left attached to the camera for long periods of time, causing overdischarge and shortening its battery 
life. Be sure to attach the terminal cover when storing the battery pack. Storing a fully charged battery pack for long 
periods of time may shorten its lifespan.

• A fully charged battery pack that is depleted immediately after use has reached the end of its lifespan. Check if the 
battery pack has reached the end of its battery life. If so, buy a new battery pack.

• Repeatedly charging and completely depleting a battery will eventually shorten its battery life. You can check the 
battery life on the [B System Setup] status screen (A 204). Fully charging the battery and then depleting it 
completely will give you a more accurate reading.

Attaching the Battery

1 Turn off the camera.

Charge Level
Charge Lamp

Color Display

0–49%

Orange

Blinks once per second

50–74% Blinks twice per second

75% or higher Blinks three times per second

Fully charged Green Turned on
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2 Slide the battery compartment cover lock and open the cover.

3 Insert the battery.
• Insert the end with the electrical contacts.
• Insert the battery until it locks in place.

4 Close the cover.
• Press the cover until it snaps shut.

Removing the Battery

1 Turn off the camera.

2 Open the cover and remove the battery.
• Press the battery lock lever as shown by the arrow and remove the battery.
• To prevent short-circuits, always attach the included protective cover to 

the battery.

IMPORTANT

• Using a genuine Canon Battery Pack LP-E6P is recommended. If you use batteries that are not genuine Canon 
products, the camera's full performance may not be attained or malfunction may result.

NOTES
• The remaining recording/playback time (in minutes) may not match the remaining battery charge (in percentage).
• The remaining battery charge may differ in VIDEO and PHOTO mode. Additionally, it may not match the charge 

indicator on the supplied charger. 
• Depending on the camera and battery conditions, the remaining recording/playback time (in minutes) and battery 

charge (in percentage) may decrease suddenly.
• The remaining recording/playback time (in minutes) and battery charge are approximate.

Using a Power Outlet
You can also power the camera directly from a power outlet using the optional DR-E6P DC Coupler and PD-E2 USB Power 
Adapter, or DR-E6C DC Coupler and CA-946 AC Adapter. For details on how to connect said accessories, refer to their 
respective instruction manuals.
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Using a USB Power Adapter
Using the PD-E2/PD-E1 USB Power Adapter (sold separately), you can charge the LP-E6P/LP-E6NH Battery Pack without 
removing it from the camera. The camera can also be powered using the PD-E2 USB Power Adapter. For details such as 
how to attach the power adapter to the camera, refer to the Advanced User Guide (PHOTO Edition).
The USB power adapter is used when a battery pack is attached to the camera. When recording, using a fully charged 
battery is recommended.

• If the power switch is set to VIDEO, you will be able to 
power the camera but charging will not be possible. 

• Setting the power switch to OFF will switch from 
powering the camera to charging, and the charge lamp 
will illuminate in green.
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Using the LCD Screen

Using the LCD Screen
This section explains how to adjust the LCD monitor. You can adjust the direction of the screen as shown below, as well as 
image settings such as brightness or contrast. Additionally, you can use the touch screen to select the subject or perform 
a variety of settings using direct touch control (A 60).

1 Open the LCD monitor 180 degrees ( ) and adjust to the desired angle ( ).

2 When the screen is facing the subject ( ), you can also place it back in its original position with the screen 
facing out ( ).

NOTES
• You can adjust the brightness, contrast, color saturation, sharpness and luminance of the LCD screen with the 

respective settings in the  > [¢ Monitoring Setup] menu (A 196). These settings do not affect the recorded 
video.

• If the LCD screen display is difficult to see in bright outdoor conditions, you can adjust the display for better visibility by 
setting  > [¢ Monitoring Setup] > [LCD Luminance Boost] to [On].

• In CAMERA mode, you can use the  > [¢ Monitoring Setup] > [B&W Image: LCD] setting to change the 
image on the screen to black and white display. Even when the captured image is displayed in black and white, 
onscreen displays and icons will be shown in color.

• You can use the  > [B System Setup] > [Touch Screen Response] setting to adjust the LCD monitor’s response 
to touch input.

• When the LCD panel is rotated 180 degrees toward the subject, you can set  > [¢ Monitoring Setup] > 
[LCD Mirror Image] to [On] to flip the image horizontally so it shows a mirror image of the subject.

• For details about how to take care of the LCD monitor, refer to Handling Precautions (A 235), Cleaning (A 237).
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PIN Code, Date, Time and Language Settings
You will need to set the PIN code, date and time on the camera the first time you power it on, or after the camera's 
settings have been reset. The [Date/Time] screen will appear automatically when the camera’s clock is not set. Refer to 
Using the Menus (A 28) for instructions on how to operate the menus.

Setting the PIN Code

1 Enter a PIN code (6-digit number).
• The numeric keypad screen is displayed by touching the input area in the center of the screen.
• Touch a key on the screen to select a number, then touch [OK] to confirm the entry.
• You can also use the SELECT dial or the joystick to select a number and press the SET button to enter it.

2 Select [OK].

3 Enter the PIN code again following the on-screen instructions and select [OK].

4 When the confirmation message appears, select [OK].
• You will need to enter the PIN code when starting up the camera.
• By configuring the following settings, you can omit entering the PIN code from next time.

- Select [Don't require PIN code again.] on the PIN code entry screen.
- Set  > [B System Setup] > [PIN Code Management] > [PIN Code Request] to [Disable].

IMPORTANT

• If you forget your PIN code, you will need to reset the device. Please note that all camera settings will be initialized.
• Setting a PIN code does not protect the recorded data stored on the card.
• Canon shall not be liable for the theft of this product or any memory cards.
• If you configure the settings to omit entering the PIN code, please be careful to prevent third parties from accessing 

the camera's settings and other information.

NOTES

• Set the PIN code in VIDEO mode and the password in PHOTO mode, respectively.
• Until you enter the PIN code, these connections are not available while the PIN code screen is displayed.

- USB connection
- Network connection in VIDEO mode

• To change the PIN code, go to  > [B System Setup] > [PIN Code Management] > [PIN Code Change].
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Setting the Date and Time

1 Select the desired time zone* using the joystick or the SELECT dial, and confirm by pressing the SET button 
or the joystick itself.
• The cursor will move to the next field.
• You can also push the joystick left/right to move between the fields.

* The default time zone is [UTC-05:00] (New York) or [UTC+01:00] (Central Europe), depending on the country/region of purchase. Time 
zones are based on Coordinated Universal Time (UTC).

2 Change the rest of the fields in the same way.

3 Select [Set] and then press SET.

NOTES
• You can display the date/time with the  > [¢ Monitoring Setup] > [Custom Display 2] or [Custom Display] > 

[Date/Time] setting.
• With the following settings, you can make changes after the initial setup. You can also change the date format and 

clock format (12 or 24 hours).
-  > [B System Setup] > [Time Zone], [Date/Time] and [Date Format]

• When you do not use the camera for about 3 months, the built-in backup battery may be depleted completely and the 
date and time setting may be lost. In such case, recharge the built-in backup battery (A 236) and set the time zone, 
date and time again.

• Using the GP-E2 GPS Receiver, you can have the camera adjust settings automatically according to the UTC date/time 
information received from the GPS signal (A 203).

Changing the Language
The camera’s default language is English. You can change it to German, Spanish, French, Italian, Polish, Portuguese, 
Russian, Ukrainian, Simplified Chinese, Korean or Japanese. Please note that some settings and screens will be displayed 
in English, regardless of the language setting.
Refer to Selecting an Option from the Menu (A 28) for details on how to navigate the menu to complete this procedure.

1 Select  > [B System Setup] > [Language H].

2 Select the desired language and press the MENU button to close the menu.
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Using the Menus
Many of the camera’s functions can be adjusted using the menus. In CAMERA mode, you can also register frequently used 
menu settings in a customized menu (My Menu) for easy access. For details about the available menu options and 
settings, refer to Menu Options (A 191).

Selecting an Option from the Menu
The following is a step-by-step explanation of how to select a typical option from the setup menus. Some menu items 
may require additional steps. Such operations will be explained in the respective section of the manual.
For brevity's sake, references to menu settings throughout the manual will be abbreviated as follows:
  > [B System Setup] > [Language H] > Desired option

1 Press the MENU button.
• The menu opens. The icon displayed in orange is the menu item that was selected the last time the menu was 

closed (unless the camera was turned off ).
• When a menu icon is not selected, first push the joystick up or press the CANCEL button to move the orange 

selection frame to one of the icons.

2 Push the joystick left/right to select the icon of the desired setup menu.
• You can also use the top control dial. 
• You can also touch a menu icon to select it.

MENU button
Press the button to open the setup menus and then press 
again to close the menu after adjusting desired settings.

SET button
Press the SET button to confirm a selection.

SELECT dial
Turn the dial to move the orange selection frame in the menu.

CANCEL button
Press to return to the previous menu/submenu level or to stop 
some operations that are in progress.Joystick/SET button

When making a menu selection, push the joystick to 
move the orange selection frame in the menu. Then, 
press the joystick itself to select the menu item 
indicated by the orange selection frame.

Top control dial
When the menu is open, turn the 
dial to move to the next/previous 
setup menu.

Grip control dial
When the menu is open, turn the dial to move to the next/
previous menu page.
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3 Press the joystick or the SET button to confirm your selected setup menu.
• The cursor moves to the first item on the first page of the selected setup menu.
• You can also push the joystick down to move the cursor to the list of menu items.
• You can also move the cursor by touching the desired page or menu item.
• Going forward, this operation will be referred to as “press SET” in this manual.

4 Select the desired menu item ([Language H], in the example) and then press SET.
• Joystick operation: 

- Push the joystick left/right to scroll through the menu pages. Moving left/right from the first/last page will move 
to the previous/next setup. You can use the grip control dial.

- Push the joystick up/down to move the cursor over the menu items on the page.
• Dial operation: 

- Turning the SELECT dial will scroll through the menu items on the page. Scrolling beyond the first/last menu item 
in the list will move to the previous/next menu page.

- Scrolling beyond the first/last page will move to the previous/next setup menu.
• Touch screen operation:

- You can also drag the screen left/right to navigate pages, or drag the screen up/down to move the orange 
selection frame. You can also select a menu item by lifting your finger when you get to the desired item.

5 Push the joystick up/down or turn the SELECT dial to select the desired setting option and then press SET.
• During the selection, the currently selected option is indicated with a  mark. Press SET to confirm your selection 

and go back to the previous screen.
• When many options are available, a scroll bar will appear on the right. Scroll up or down to see other options.
• You can also touch the desired setting option on the screen to select it.
• Press the CANCEL button or select [L] and press SET to return to the previous menu level.

6 Press the MENU button to close the menu.
• Pressing the MENU button at any time closes the menu.

NOTES

• Unavailable items may appear grayed out.
• On some screens, the following icons may be displayed as a guide: , , . They refer, respectively, to 

pressing the joystick or SET button, the MENU button and the CANCEL button.
• You can check most of the current settings on the status screens (A 204).
• You can set  > [B System Setup] > [Ctrl Dial in Menus] to [Disable] to disable the use of the grip and top 

control dials while browsing the menus. In such case, use the SELECT dial to move between menus.

Using the Customized Menus (My Menu)
In CAMERA mode, you can register up to 6 frequently used menu settings under a My Menu page for easy access. You can 
save up to 5 separate sets of My Menu settings each with 6 options for different shooting situations. Furthermore, if you 
set an assignable button to [My Menu] (A 131), you can press the button to access your registered menu settings even 
faster and more easily.

Adding Menu Settings

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Register].
• A screen will appear where you can select the menu setting you want to add.
• Press the CANCEL button to cancel the operation and return to the regular menu.

2 Select the menu setting you want to add.

3 Select [OK].
• The menu setting you registered will now appear under the currently selected My Menu set.
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Rearranging Menu Settings

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Move].

2 Select the menu setting you want to move.
• The ] icon will appear next to the setting you selected to move.

3 Move the menu setting to the desired position and press SET.

Removing Menu Settings

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Delete].

2 Select the menu setting you want to remove and then select [OK].

Resetting All the My Menu Sets

Reset all the menu settings registered to the currently selected My Menu set.

Select  > [¥ My Menu] > Desired menu page > [Edit] > [Reset All] and then select [OK].

Renaming My Menu Sets

You can give each of the 5 My Menu sets a more descriptive name to make them easier to identify.

1 Select  > [¥ My Menu] > Desired menu page > [Edit] > [Rename].

2 Enter the desired name (8 characters long) using the keyboard screen (see the following sidebar).

Entering text and numbers
There are two types of screens used to enter text and numbers – the keyboard screen, and the data entry screen. 
Which screen is used, as well as the available characters will depend on the menu setting.

Keyboard screen

1 Touch the character you wish to enter.
• The characters you entered will appear in the input area at the top of the screen.

• You can also move the cursor with the SELECT dial or the joystick, and select the desired character by pressing 
SET.

2 After entering the desired text, touch [OK] to confirm.

Data entry screen
Use the SELECT dial or the joystick to select characters.

1 Select a character and then press SET to confirm.
• The cursor will move to the next field.
• You can also push the joystick left/right to move between the fields.
• Change the rest of the characters in the same way.

2 Select [Set] to confirm the text or value.
• Press CANCEL to stop entering text.

Key Function

 /  Moves the cursor in the input area.

Shift key

 / Switches between letters, numbers and special characters.

Space key

Backspace key
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Locking the camera's controls (key lock)
You can lock all the camera's buttons* and switches. This is useful in preventing settings from being changed due to 
inadvertently pressing one of the buttons. Turning off the camera will reactivate the controls, but it is possible to change 
this setting so that the controls remain locked.
* REC buttons are not locked by default but you can choose to lock them too.

Press the LOCK (key lock) button
• C is displayed on the screen.
• Press the LOCK button again to reactivate the controls.

Changing Key Lock Settings

Select  > [B System Setup] > [Key Lock] > [All Buttons] or [All Except REC Button].
• If you select [All Buttons], the REC button is also disabled.

Keeping Key Lock at Shutdown 

Select  > [B System Setup] > [Keep Key Lock at Shutdown] > [On].

NOTES
• In the following cases, key lock settings will not be saved by setting [Keep Key Lock at Shutdown] to [On].

- When no assignable button has been set to [Key Lock].
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Preparing the Camera
This section details how to prepare the camera for the first time, including how to mount and remove lenses and the 
handle unit. 

Examples of Camera Configurations
Your camera allows you to build the shooting configuration that best fits your needs and shooting conditions. For details 
on the optional accessories compatible with this camera, refer to List of Accessories (A 238) and the Cinema EOS System 
Expansion User Guide (PDF file).

IMPORTANT

• Be careful not to drop the camera or accessories when attaching, removing or adjusting the various accessories. Use a 
table or other stable surface to change the camera’s configuration.

Preparing the Lens
As much as possible, attach and remove the lens quickly and in a clean environment free of dust. You can also use an EF 
lens or PL lens by attaching a mount adapter to the RF lens mount. Refer also to the instruction manual of the lens/mount 
adapter used.

IMPORTANT

• When attaching/removing a lens, avoid direct sunlight or strong light sources. Also, be careful not to drop the camera 
or lens.

NOTES
• After removing a lens/When a lens is not attached to the camera:

- Do not touch the lens’s surfaces, the lens mount or any components inside the lens mount area.
- Place the body cap back on the lens mount and the dust caps on the lens. Clean any dust or dirt from the body cap 

and dust caps before using them.

Configuration with handleConfiguration with microphone
 holder and handle

Minimal configuration 
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Attaching a Lens

1 Turn off the camera.

2 Remove the body cap from the camera and the dust caps from 
the lens.

3 Attach the lens to the camera and turn the lens in the direction 
of the arrow until it clicks in place.
• Align the red mark on the lens with the red lens mount 

index mark on the camera.

Removing a Lens

1 Turn off the camera.

2 Hold down the lens release button and turn the lens all the way 
in the direction of the arrow until it stops.

3 Remove the lens.

4 Place the body cap back on the lens mount and the dust caps 
on the lens.

NOTES

• Turning on the image stabilization function of a lens may reduce the effective usage time of the battery pack. When 
image stabilization is not necessary, for example if the camera is fixed to a tripod, it is recommended to turn it off.

• Depending on the lens used, you may experience one or more of the following limitations.
- The lens model name may be shortened when displayed on the screen.
- You may not be able to focus manually when the focus mode switch of an EF lens is set to AF.
- You may not be able to use the focus preset function on an EF lens (super telephoto lenses).
- You may not be able to use the power zoom function on EF lenses with that function.

• This camera’s sensor is larger than the sensor size for which RF-S/EF-S lenses are designed (APS-C). When using RF-S/EF-
S lenses with this camera, you may notice peripheral illumination fall-off or vignetting (A 193).

• When using a compatible lens, you can use the  > [B System Setup] > [Retract Lens] setting to retract the lens 
automatically when the camera’s power is turned off with the lens's focus mode switch set to AF.

• When a VR lens is attached, the handle unit, accessories attached to the handle unit or the hand holding the grip may 
be reflected in the image. Check the image before recording.
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Using the EF-EOS R 0.71x Mount Adapter
• You can use the EF-EOS R 0.71x Mount Adapter to attach a compatible EF lens to the camera and shoot video with an 

angle of view equivalent to full frame (when the sensor mode is [Super 35mm (Cropped)]). Additionally, you can use 
autofocus, peripheral illumination correction and chromatic aberration correction. For details on compatible lenses, 
visit your local Canon website.

* Setting the camera's sensor mode to [Full Frame 3:2]/[Full Frame] causes vignetting.

• When using the EF-EOS R 0.71x Mount Adapter with some EF lenses, a frame that limits the AF range may be displayed.

Updating the Firmware of a Lens or Accessory

You can update the firmware of the lens/mount adapter/power zoom adapter/accessory (described as "lens/accessory" 
hereafter) attached to the camera (only in CAMERA mode). For details about firmware updates, visit your local Canon 
website.

1 Download the lens/accessory firmware update file from the Canon website and save it on the root directory of an SD 
card. Insert the SD card containing the firmware update into the camera's card slot 2 (A 39).

2 Attach the lens/accessory you want to update and turn on the camera in CAMERA mode.
• Attach a lens also when updating the firmware of the mount adapter*/power zoom adapter.

* The PL-RF Mount Adapter can be updated without attaching a lens.

3 Select  > [B System Setup] > [Firmware] > [Lens], [Mount Adapter], [Power Zoom Adapter] or [Accessory].
• The current lens/accessory firmware version will appear on the screen.
• If the menu option is grayed out, the attached lens/accessory may not support firmware updates or the SD card 

used may not contain a valid lens firmware file. Check the lens/accessory and SD card and repeat the procedure from 
the beginning.

4 Select [OK].

5 Select the lens firmware file (.LFU or .AFU file).

6 Select [OK].
• The firmware will be updated. Once in progress, the lens firmware update cannot be canceled.

7 When the confirmation message appears, press SET.

IMPORTANT
• Be sure to observe the following precautions while the lens firmware is being updated.

- Do not turn off the camera and do not remove the battery pack or other power source.
- Do not remove the lens/accessory.
- Do not operate any buttons or controls on the camera.
- Do not open the card compartment cover and do not remove the SD card.

NOTES

• The lens firmware cannot be updated while pre-recording is activated.
• Power the camera using a power outlet (with the DC coupler and a USB power adapter/AC adapter, or a USB power 

adapter) or a sufficiently charged battery pack.
• When using an EF extender, remove the extender before performing the procedure.
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In-Camera Lens Correction
Depending on the characteristics of the lens used, the corners of an image frame may be darker than the center due to 
light fall-off (peripheral illumination drop), color shift/color fringing may be visible along high-contrast edges in the 
image (chromatic aberration), the image produced may not be as sharp at certain apertures (lens diffraction), the image 
might appear distorted (distortion aberration), or the angle of view may change when focusing (focus breathing). In 
CAMERA mode, you can apply a correction to compensate as necessary. To apply correction for peripheral illumination, 
chromatic aberration, distortion aberration or focus breathing, correction data for the lens used is necessary. Since these 
corrections are made through image processing, they may not completely correct the issue, but rather reduce the 
phenomenon to some extent. Distortion aberration/focus breathing correction is only possible for compatible RF lenses. 

1 Attach the lens you want to use and set the power switch to VIDEO.

2 Select  > [v Camera Setup] > [Periph. Illum. Corr.], [Chromatic Aberr. Corr.], [Diffraction Correction], 
or [Distortion Aberr. Corr.].
• If correction data is not available, [Periph. Illum. Corr.] or [Chromatic Aberr. Corr.] will appear grayed out. Visit your 

local Canon website and check if there is correction data available for the lens you are using. If so, download the 
necessary update package, update the camera’s firmware version and repeat the procedure from the beginning.

3 Select [On].

4 When [Distortion Aberr. Corr.] is set to [On], set [Focus Breathing Correction] to [On].
• The camera will apply the correction for the attached lens to all future recordings.

NOTES
• About in-camera lens correction data: The camera contains a register of correction data for compatible lenses that were 

available at the time the camera went on sale. Correction data for future lenses will be made available as part of the 
regular updates released for the camera’s firmware. For more details, visit your local Canon website.

• When peripheral illumination/diffraction correction is activated:
- Depending on the recording conditions, noise may appear in parts of the image.
- The level of correction will be lower for lenses that cannot provide distance information.
- The level of correction will be lower the higher the ISO speed/gain setting used.
- When using RF-S/EF-S lenses, peripheral illumination fall-off may be more pronounced.

• Peripheral illumination/chromatic aberration correction cannot be applied in the following cases:
- When the appropriate correction data is not available for the lens attached.
- When using non-Canon lenses. Even if the corresponding menu setting is available (not grayed out), setting it to 

[Off ] is recommended.
• About Focus Breathing Correction:

- Focus breathing correction results in narrowing of the angle of view. The amount depends on shooting conditions.
- When focus breathing correction is used, certain types of image processing may cause digital noise and 

deterioration of the video resolution. Be sure to check the results before using this function.
- Optimum correction is applied according to the position of the focusing distance range selection switch on the lens 

(also applied for MF). If the shooting distance is outside the range set by the focus range selector switch, focus 
breathing correction will not be applied for that portion.

- While recording, changing the position of the focusing distance range selection switch will cause a sudden change 
in the angle of view in the recording.

• Diffraction correction cannot be applied when the camera cannot obtain the current aperture value of the lens.
• Chromatic aberration/diffraction/distortion/focus breathing correction is not applied to RAW clips. Correction is 

applied to proxy clips recorded simultaneously.
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Checking the Required Type of Power Source (Power Source Navigation)
You can check for restrictions that may arise depending on the type of power source used.

1 Select  > [B System Setup] > [Power Source Navigation] > [OK].

2 Select the power source used.
• The respective restrictions are displayed.

Functions/settings that stop power supply to the lens when the LP-E6NH Battery Pack/DR-E6C DC Coupler is used.

* Power supply to the lens does not stop when  > [B System Setup] > [HDMI Output] is set to [Off ].

NOTES

• When using an Ethernet adapter, only supply power using the DR-E6P DC Coupler and the PD-E2 USB Power Adapter 
in combination (A 169).

When using the LP-E6NH Battery Pack/DR-E6C DC Coupler:
- Power supply to the lens will stop when some EF lenses are attached.
- When both  > [B System Setup] > [HDMI Output] and  > [¢ Monitoring Setup] > [LCD Luminance 

Boost] are set to [On], the boost effect is limited compared to other power sources.

Attaching the Handle Unit
1 Slide the mounting base at the bottom of the handle unit into 

the camera’s top accessory shoe and gently push it all the way 
forward ( ).

2 Tighten the locking knob to firmly secure the handle in place.
• If necessary, use a hex wrench for 0.64 cm, 1/4" screws to tighten the 

locking knob.

Item (screen display) Unavailable function/setting

Network  > [  Network/USB Settings] > [Network] > [Enable]

LCD luminance above [Normal]*  > [¢ Monitoring Setup] > [LCD Luminance] set to [+1] or [+2]

HDR assistance*
 > [¢ Monitoring Setup] > [View Assist:] set to [On] and [Select View Assist: LCD] set to [HDR Assist. (1600%)] or 

[HDR Assist. (400%)]
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Attaching the Microphone Holder

To the Right Side of the Handle Unit

1 Attach the microphone holder to the handle unit.

2 Use a commercially available Phillips head (“crosshead”) screwdriver to 
secure it firmly with the 2 included M4 bolts.

Checking the Camera’s Inclination
You can display the level of the effective inclination compensation of the camera.

Select  > [¢ Monitoring Setup] > [Custom Display 1] > [Level] > Desired option.
• The following settings are possible.

- [Tilt+Roll]: Displays inclination for both tilt and roll.
- [Tilt]: Displays the vertical inclination of the optical axis.
- [Roll]: Displays the amount of rotation around the optical axis.
- [Off ]: Inclination is not displayed.

Attaching an Accessory Compatible with the Multi-Function Shoe
For details on how to attach and use accessories, refer to the instruction manual of the accessory in use.

Remove the multi-function shoe cover ( ) and slide the accessory's 
connecting terminal into the multi-function shoe ( ).
• When attaching accessories that communicate through contacts of the multi-

function shoe, insert the accessory's mounting foot until it clicks into place, 
then slide the mounting foot locking lever to secure it.

IMPORTANT
• Protecting the multi-function shoe:

- After removing accessories from the multi-function shoe, reattach the shoe cap to protect the contacts from dust 
and water.

- Blow off any foreign material on the multi-function shoe with a commercially available blower or similar tool.
- Allow the multi-function shoe to dry before use if it gets wet.

• Using accessories with screws may damage the multi-function shoe.
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Preparing Recording Media
The camera records clips, photos and other files on CFexpress cards or SD cards*. The camera has two card slots, and 
recording on two cards is possible (A 43).
Initialize cards (A 40) when you use them with this camera for the first time.
* The SD card is used also to save/read other files such as custom picture files.

Compatible Recording Media
The following types of memory card can be used with this camera. For the latest information about recording media 
tested for use with this camera, visit your local Canon website.

CFexpress cards
CFexpress cards compliant with CFexpress 2.0 Type B specifications.
However, it may not be possible to record on the card depending on the camera mode and bit rate used. For details 
about CFexpress cards tested for use with this camera, visit your local Canon website.

SD cards

If the video speed class is not appropriate for the bit rate, a warning is displayed.
* UHS and Video Speed Class are standards that indicate the minimum guaranteed data transfer rate of SD cards.

Recommended SD card speed class by video configuration

* Recording to the SD card is not possible when the bit rate is greater than 600 Mbps.

SD card type: . SD cards, /SDHC cards, 0 SDXC cards

UHS Speed Class*: U3

Video Speed Class*: V30, V60, V90

Video configuration
Recommended speed class*

Recording mode Recording format Resolution

Slow & fast motion recording – – V90

Other recording modes

RAW ST
RAW LT 5036x2656 V90

RAW HQ
RAW ST
RAW LT

2524x1332 V60

XF-AVC YCC422 10 bit
4096x2160, 3840x2160 V90

2048x1080, 1920x1080 V60

XF-HEVC S YCC422 10 bit

6912x4608 V90

4096x2160, 3840x2160 V60

2048x1080, 1920x1080 U3, V30

XF-HEVC S YCC420 10 bit
6912x4608 V60

4096x2160, 3840x2160, 
2048x1080, 1920x1080 U3, V30

XF-AVC S YCC422 10 bit
4096x2160, 3840x2160 V90

2048x1080, 1920x1080 V60

XF-AVC S YCC420 8 bit 4096x2160, 3840x2160 U3, V30
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IMPORTANT

• CFexpress cards can become hot due to the high operating temperature inside the camera. Removing a CFexpress 
card immediately after using it for recording may cause burns or cause you to drop the card, resulting in damage to the 
card.

• After repeatedly recording, deleting and editing clips (if the memory is fragmented), you may notice slower writing 
speeds to the card and recording may even stop. In such case, save your recordings and initialize the card with the 
camera. Be sure to initialize cards especially before shooting important scenes.

• If you repeatedly record for short periods of time at a low bit rate, you may not be able to record even if the card has 
free space.

• About CFexpress and SDXC cards: You can use SDXC cards with this camera but these cards are initialized by the camera 
using the exFAT file system.
- When using exFAT-formatted cards with other devices (digital recorders, card readers, etc.), make sure that the 

external device is compatible with exFAT. For more information on compatibility, contact the computer, operating 
system or card manufacturer.

- If you use exFAT-formatted cards with a computer OS that is not exFAT-compatible, you may be prompted to format 
the card. In such case, cancel the operation to prevent data loss.

NOTES
• Proper operation cannot be guaranteed for all cards.
• SDHC cards are formatted using the FAT32 file system so, when recording proxy clips, the video (stream) file in the clip 

will be split approximately every 4 GB. Playback with the camera will be seamless.
SDXC cards use the exFAT file system so the stream file in the clip will not be split.

Inserting a Memory Card

1 Wait until the card access indicator is off.

2 Slide the card compartment cover to open it ( , ).

3 Insert the card.
• The rear card slot is [ ] (CFexpress card), and 

the one in front of it is [ ] (SD card).
• CFexpress card: With the card label facing 

you, insert the open side of the card ( ) into 
the card slot. Inserting cards the wrong way may 
damage the camera. 

• The gray card-eject button pops out.
• SD card: With the card label facing you, insert 

the card into the card slot until it clicks into 
place.

Access indicator 

 CFexpress card  SD card
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4 Close the card compartment cover ( , ).
• Do not force the cover closed if the card is not correctly inserted.

IMPORTANT
• Cards have front and back sides that are not interchangeable. Inserting a card facing the wrong direction can cause a 

malfunction of the camera. Be sure to insert the card as shown in the illustration.
• If you set  > [B System Setup] > [Card Access LED] to [Off ], the card access indicator will not illuminate.

Removing a Memory Card

1 Set the power switch to OFF.

2 Make sure the card access indicator is off.

3 Slide the card compartment cover to open it ( , ).

4 Remove the card.
• CFexpress cards: Push the CFexpress card release button.
• SD cards: Push the card once to release it. When the card springs out, pull it 

all the way out.

Initializing Cards
Initialize cards when you use them with this camera for the first time. You can also initialize a card to permanently delete 
all the recordings it contains.

1 Select  > [Æ Recording/Media Setup] > [Initialize Media].

Access indicator 

Card release button
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2 Select the desired card.

3 Select [OK].
• The card is initialized and all the data it contains is erased.

IMPORTANT
• SD cards are initialized using the FAT file system, SDHC cards using the FAT32 file system, and CFexpress/SDXC cards 

using the exFAT file system.
• Initializing a card will permanently erase all data, including photos and protected custom picture files. Lost data cannot 

be recovered. Make sure you save important recordings in advance.
• Depending on the card, initialization may take up to a few minutes.

NOTES

• If you set an assignable button to [Initialize Media] (A 131), you can press the button to open the [Initialize Media] 
submenu.

Setting a Card’s Volume Label
You can set the volume label for CFexpress and SDXC cards used for recording, in order to make it easier to identify and 
organize them later.

1 Select  > [Æ Recording/Media Setup] > [Volume Label] > Desired option.

2 Initialize the card (A 40).

3 If necessary, set the clip file name’s metadata elements (A 46).

4 Record clips on the card.
• The card’s volume label changes when the first clip is recorded on a just initialized card. 

Options
[Canon]: The card’s volume label will be “CANON” regardless of the clip file name settings.

[Canon + Metadata]:
The card’s volume label will be “CANON”, plus the camera index number and the reel number (A 46).

Switching Between Card Slots
If both slots contain a card, you can switch the card used for recording/playback as necessary.

1 Assign the [Slot Selection] function to an assignable button (A 131).

2 Press the assigned button during record standby mode (STBY) or on the index screen.

NOTES
• You can also use the  > [ÆRecording/Media Setup] > [Main Recording Destination] setting.
• You cannot use the button assigned to [Slot Selection] to switch between card slots while recording or playing back.
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Checking the Remaining Recording Time on a Card
The display on the upper left of the screen shows the card icons and the remaining recording time* (in minutes) on each 
card (A 54).
On the [Æ Recording/Media Setup] status screen (A 204), you can check the total space, used space and approximate 
remaining recording time* of each card. The approximate remaining number of photos and speed class will be displayed 
as well.
* Remaining recording times are approximate and calculated based on the current video configuration used.

Recovering Recordings
Some actions, such as suddenly turning off the camera or removing the card while data is being recorded, can cause data 
errors in the recorded file. You may be able to recover recordings (clips, WAV audio, News Metadata) with corrupted data 
using the following procedure.

1 Switch to MEDIA mode and open the index screen with the recordings you wish to recover (A 145).

2 Select the desired recording (with the  icon).

3 Press SET to open the file menu and select [Recover] > [OK].
• The camera will attempt to recover the corrupted data.

NOTES

• The file may not be recorded if the power is cut or if the SD card is removed immediately after starting recording. In 
case of recordings with a duration of less than 0.5 seconds, such files may be deleted if file recovery is attempted.

• In some cases, it may not be possible to recover the data. This is more likely when the file system is corrupted or the 
card is physically damaged.

• Only clips, audio (WAV) and News Metadata files recorded with this camera can be recovered. Chunk recording clips 
(including News Metadata) and photos cannot be recovered.

• In the RAW/XF-HEVC S/XF-AVC S index screen, recovered clips appear with a Ð icon instead of the usual thumbnail.
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Selecting the Video Recording Method 
This camera features various recording modes, as well as video recording methods using two cards. You can also stream 
the audio/video while recording it on a card (A 183). Below is an overview. For details, refer to each function’s section.

Recording modes 

Second card recording Functions

1 Select the recording mode
• Use direct touch control (A 60) or in the menu, select  > [Æ Recording / Media Setup] > [Recording 

Mode] > Desired option.

2 Select the second card's recording function
• Use direct touch control (A 60) or in the menu, select  > [Æ Recording / Media Setup] > [2nd Card Rec 

Functions] > Desired option.

[Recording Mode] [Main Rec Format] Description A

[Normal Recording] All
Normal recording. Records a clip in the selected recording format. The most basic video recording 
method.

51

[Slow & Fast Motion] All
Slow & fast motion recording. Records using a frame rate that is different from the playback frame rate 
(overcrank/undercrank shooting). Audio is not recorded (muted).

124

[S&F Clip / Audio (WAV)] All
Records at a frame rate different from that used during playback (overcrank and undercrank shooting). 
Audio (WAV) is recorded to the card that is not the video recording destination.

124

[Pre-Recording]
XF-AVC / XF-AVC S /
XF-HEVC S

Pre-recording. Records onto a temporary memory (3 seconds) so the clip will contain a few seconds of 
video and audio recorded before you perform the recording operation.

125

[  Main / Continuous Rec] XF-AVC S / XF-HEVC S
Continuous recording. Card 1 is used for normal recording (following REC button record/stop 
operations), and card 2 is used for continuous recording (uninterrupted recording).

126

[Frame Recording] All
Frame recording. A preset number of frames are recorded each time the REC button is pressed, and 
saved as one clip when frame recording mode ends. Audio is not recorded (muted).

126

[Interval Recording] All
Interval recording. Automatically records a pre-defined number of frames at a pre-defined interval. 
Sound is not recorded in this mode.

127

[2nd Card Rec Functions] Description A

[  Main / Proxy Rec]
Proxy recording. Simultaneously records a proxy clip (to card 2, while the main clip is recorded to card 1) with a smaller file 
size for offline editing. The proxy clip is recorded with a file name associated with the main clip.

69

[  Main / Sub Rec]
Sub recording. Simultaneously records a clip to card 2 with a different video configuration from that of the main clip on 
card 1.

68

[  Main / Crop Rec]
Crop recording. The main clip is recorded on card 1, and simultaneously, the area of the set cropping frame is recorded on 
card 2.

71

[  Main / Audio Rec]
The main clip is recorded on card 1, and a WAV file* is recorded on card 2 simultaneously.
* Differs from WAV files recorded using slow & fast motion recording.

108

[  Main / Chunk Rec]
Chunk recording. Simultaneously records the main clip to card 1, and a clip divided in chunks (suitable for automatic 
transfer) to card 2.

73

[Double Slot Recording]
Double slot recording. Records the same clip simultaneously to both cards, which is a convenient way to make a backup copy 
of your recordings.

–

[Relay Recording]
Relay recording. Continues recording on the other card without interruption when the card you are using becomes full. It is 
available from card 1 to card 2 and vice versa.

–
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Available simultaneous recording configurations

• Simultaneous recording is available only with normal recording while connected to a network with IP streaming 
activated.

1 Only when the main recording format is RAW. 
2 Not available when recording in RAW format.
3 Not available when recording in XF-AVC format.
4 For details on recording formats that can be recorded to card 2, refer to the description of each function (A 43).

NOTES

• It is not possible to switch between card slots when proxy recording, sub recording, chunk recording, crop recording, 
continuous recording or audio recording is activated.

• If a card becomes full during double slot recording, recording on both cards will stop. On the other hand, if an error 
occurs with one of the cards, recording will continue on the other card.

Video Recording and Outputs (Diagram)

 Select the main recording format (A 66)

 Second card recording functions (A 43)
• Chunk recording, crop recording, audio recording, relay recording and double slot recording are also available. Some 

functions are not available depending on the main recording format and recording mode.

 Custom picture settings (A 135)
• You can control various aspects of the image produced using custom picture files.

Second card recording function

Off
Proxy 

Recording4
Sub 

Recording4
Crop 

Recording4
Audio 

Recording
Chunk 

Recording4
Double Slot 
Recording

Relay 
Recording2

Recording 
mode

Normal Recording Ü Ü Ü Ü2 Ü Ü Ü Ü

Slow & Fast Motion 
Recording

Ü Ü1 Ü1 – – – – –

Slow & Fast Motion 
Recording / Audio (WAV)

Ü – – – – – – –

Pre-recording2 Ü Ü Ü Ü – Ü Ü Ü

Continuous Recording2, 3 Ü – – – – – – –

Frame Recording Ü – – – – – Ü Ü

Interval Recording Ü – – – – – Ü Ü

XF-AVC
or

XF-HEVC S 
/ XF-AVC S

RAW

Sensor Image 
processing

 View assistance:
(HDMI)

 View assistance:
(LCD)

HDMI OUT 
terminal

LCD monitor

 Proxy 
recording color 
conversion

 Custom Picture

 Main recording 
(RAW)

 Main recording 
 (XF-AVC/XF HEVC S/
XF AVC S)

 Sub recording  Proxy recording

XF-AVC
or

XF-HEVC S 
/ XF-AVC S

XF-AVC
or

XF-HEVC S 
/ XF-AVC S
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 For proxy clips: select the proxy recording color conversion (A 69)
• Changes the gamma and color space settings.

 Apply the view assistance function to the image displayed (A 160)
• Changes the gamma and color space settings.
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Setting the File Name for Recordings
This section explains how to set the file names for RAW clips, XF-AVC clips, XF-HEVC S clips, XF-AVC S clips and photos. 

Clips File Names
The camera allows you to change several settings that determine the clip file name of recorded clips (only in CAMERA 
mode). For more details on how to enter characters, see Entering text and numbers (A 30).
The basic file name structure is as follows.

• Apart from component number 11, the file name of the primary clip and the proxy clip will be identical.
• Apart from components number 6, 10 and 11, the file name of the primary clip and the chunk recording clip will be 

identical.
• The file name of double slot recording clips will be the same on both cards.
• Apart from the .WAV extension, the file name of the audio recorded with slow & fast motion clips will be the same as 

that of the main clip, and will be saved on the "/PRIVATE/AUDIO" folder.

To set the camera index

Select  > [Æ Recording/Media Setup] > [Metadata] > [Camera Index] > Desired camera index (A 30).

To set the clip numbering method

Select  > [Æ Recording/Media Setup] > [Metadata] > [Clip Numbering] > [Reset] or [Continuous].

1 2 3 4 6 7 8 9 10 115

A_0 0 0 1 C 0 0 1 X yy mm dd _ hh mm ss X X _ C A N O N _ 0 0 1_ Proxy

1 Camera index: Two characters (A to Z, or “_” for the 
second character) that identify the camera used.

2 Reel number: 4 characters (0001 to 9999) that identify 
the card used. The number is assigned automatically 
but you can set the initial number.
After you insert a new card (just purchased or 
initialized), the number advances by one when the 
first recording is made.

3 Clip number: 4 characters (C001 to D999). The clip 
number advances automatically with each clip 
recorded (switching to D001 after C999), but you can 
set the initial clip number and select the clip 
numbering method.

4 Main codec identifier: One character that identifies the 
main codec (X: RAW, A: AVC/H.264, H: HEVC/H.265).

5 Recording date and time (set automatically by the 
camera).

6 Special recording mode identifier: Identifies the recording 
mode (“_” for normal, “C” for the continuous 
recording clip, "B"/"D"/"E" for files of a clip recorded 
with chunk recording: "B" for the first file, "D" for 
intermediate files, and "E" for the last file) used by the 
camera.

7 Recording time: Recording hour, minute, and second 
(set automatically by the camera).

8 Random component: 2 characters (numbers 0 to 9 and 
capital letters A to Z) that change randomly with each 
clip.

9 User defined field: 5 characters (numbers 0 to 9 and 
capital letters A to Z) for any other identification 
purposes.

10 Stream number: When an SD or SDHC card is used to 
record clips or during chunk recording, a stream 
number (001 to 999) will be added. The stream 
number will advance every time the video (stream) 
file within the clip is split.

11 Proxy clips only: The camera will automatically add the 
suffix “_Proxy” to the file name of proxy clips 
(including chunk recording).
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Options
[Reset]: The clip number will restart from 001 every time you insert a new card.

[Continuous]: Clip numbers will start from the initial number set with [Clip Number] (following procedure) and continue 
across multiple cards.

To set the reel number or initial clip number

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [Reel Number] or [Clip Number] > [Change].
• To return to initial settings, select [Reset] instead.

2 Enter the reel/clip number using the data entry screen (A 30).

To set the user-defined field

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [User Defined] > [Change].
• To return to initial settings, select [Reset] instead.

2 Enter the desired text string using the data entry screen (A 30).

Photo Numbering
Photos are automatically assigned consecutive numbers and stored on the SD card in folders. You can select the 
numbering method to be used.

Photo folder names and file names

Photo number 

Select  > [Æ Recording/Media Setup] > [Photo Numbering] > Desired option.

Options
[Reset]: Recording numbers will restart from 100-0001 every time you insert a new card. If a card already contains 

previous recordings, numbers will continue from the number following that of the last photo on the card.

[Continuous]: Recording numbers will continue from the number following that of the last photo recorded with the camera. 
This setting is the most convenient for managing files on a computer. We recommend using the [Continuous] 
setting.

NOTES

• Each folder can contain up to 500 files. When that number is exceeded, a new folder is created automatically.

x x x   n n n n

x x x __ m m d d

I M G __ n n n n . J P G

DCIM

: “xxx” indicates the folder number (from 100 to 999), and “nnnn” indicates the consecutive number 
assigned to the photo (from 0001 to 9999).

: Folder name. “mmdd” indicates the month and day of recording.

: Photo file name.
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Using the Fan
The camera uses a cooling fan to lower the camera’s internal temperature. In CAMERA mode, you can change the fan’s 
operation mode and speed. In MEDIA mode, the fan runs at all times but you can select its speed.

Setting the Fan’s Operation in CAMERA Mode

1 Select  > [B System Setup] > [Fan Mode] > Desired option.

If you selected [Automatic]

2 Select  > [B System Setup] > [Fan Speed (STBY)] > Desired fan speed in record standby mode.

3 Select  > [B System Setup] > [Fan Speed (REC)] > Desired fan speed while recording.
• The [Maximum] option offers the maximum cooling effect but is available only for [Fan Speed (STBY)], as it is noisier.

If you selected [Always On]

2 Select  > [B System Setup] > [Fan Speed (Always)] > Desired fan speed.

Options for [Fan Mode]
[Automatic]: The fan runs while the camera is not recording and is automatically turned off while the camera is recording. 

However, if the internal temperature of the camera is too high (b appears in yellow), the fan will be activated 
automatically (in that case, ` will appear next to the b icon). When the camera’s temperature has 
decreased sufficiently, the fan will be turned off. Use this setting when you do not want the camera to pick up 
the fan’s operating sound.

[Always On]: The fan runs at all times.

Setting the Fan Speed in MEDIA Mode

1 Select  > [B System Setup] > [Fan Speed].

2 Select the desired option.

IMPORTANT
• While the fan is running, the exhaust vent will emit warm air.
• Be careful not to obstruct in any way the fan’s air vents (A 13, 14, 16).

NOTES

• Depending on the ambient temperature and other shooting conditions, the fan may not turn off even if you set its 
operating mode to [Automatic].
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Adjusting the Black Balance
In CAMERA mode, you can have the camera adjust the black balance automatically when ambient temperature changes 
considerably or if there is a noticeable change in a true black video signal.

1 Attach the body cap to the lens mount and set the camera to CAMERA mode.
• If a lens was attached, turn off the camera and remove the lens. Place the body cap back on the lens mount and turn 

on the camera.

2 Select  > [v Camera Setup] > [ABB] > [OK].
• The automatic black balance procedure will start. It may take about 1 minute depending on the frame rate.
• If the sensor is not completely shielded from light, [Error] will appear on the screen. Repeat the procedure from the 

beginning.

NOTES

Adjusting the black balance is necessary in the following cases:
- When using the camera for the very first time or after a long period of not using it.
- After sudden or extreme changes in ambient temperature.
- When red, green, blue, white, or black dots appear on the screen.
- After changing the sensor mode.
- After activating or deactivating slow & fast motion recording (including switching to another special recording 

mode).
- After changing the shooting frame rate, when slow & fast motion recording is activated.
- After resetting the camera’s settings.

• During the adjustment of the black balance, you may notice some irregular displays appear on the screen. This is not a 
malfunction.

• If the battery's recording/playback time reaches the power warning level, black balance cannot be adjusted.
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Recording

Recording Video and Photos
This section explains the basics of recording clips* and photos. For details on recording audio, refer to Recording Audio 
(A 108). 
* “Clip” refers to a single movie unit recorded with a single recording operation. This may also include metadata or News Metadata.

Recording

* By default assigned to function as a REC button (A 131).

1 Set the power switch to VIDEO.
• The camera turns on in CAMERA mode and enters record standby mode ([STBY]). The power indicator (tally lamp) 

illuminates in green.
• The access indicators of card slots with a card inserted will illuminate momentarily in red. Then, the access indicators 

of cards selected for recording will change to green.

2 Press the REC button to begin recording.
• Recording starts. The tally lamp changes from green (power indicator) to red and the recording indicator at the top 

of the screen changes from [STBY] to [ÜREC].
• The access indicator of cards used for recording will illuminate in red.
• You can also perform this function remotely using an XC protocol-compatible device connected to a network.

*

*

Access indicator

Tally lamp

REC button

REC button

Power indicator/
Tally lamp

Tally lamp/
Charge lamp
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3 Press the REC button to stop recording.
• The clip is recorded and the camera enters record standby mode. The tally lamp changes from red to green (power 

indicator).
• The access indicator of cards selected for recording will change back to green.

IMPORTANT

• Be sure to save your recordings regularly, especially after making important recordings. Canon shall not be liable for 
any loss or corruption of data.

NOTESNOTES

• If you record using metadata settings (such as News Metadata), those settings will be added to the clip. For more 
details, refer to Using Metadata (A 121) and Using News Metadata (A 122).

• If the camera switches to the other card while recording video due to the relay recording function (A 43), the two 
parts (before/after the switch) will be recorded as separate clips.

• A single clip can be recorded continuously for up to 6 hours. At that point, a new clip will be created automatically and 
recording will continue on a separate clip. For RAW/slow & fast motion/chunk recording, recording stops once the 
recording time reaches 6 hours.

• You can use the review function (A 58) to play back part or all of the last clip recorded without having to switch to 
MEDIA mode.

• When recording clips on SDHC cards, the video (stream) file in the clip will be split approximately every 4 GB. Playback 
with the camera will be seamless.

• You can assign the [REC] function to an assignable button and use it to start/stop recording.
• You can set  > [B System Setup] > [Onscreen REC/STBY Button] to [On] to use the onscreen [ÜREC]/[STBY] 

touch buttons to stop and start recording respectively.
• When  > [B System Setup] > [Tally Lamp Settings] is set to an option other than [REC], the tally lamp 

illuminates when PGM tally information is input.
• The REC button on the handle unit has a lock lever to prevent accidental operation. Set the lock lever to C in cases 

such as when you do not want a recording inadvertently paused or do not plan to use this REC button. Return the lever 
to its previous position to enable use of the REC button again.

To take photos

While the camera is in record standby mode, you can record photos on card 2.

1 Set an assignable button to [Photo] (A 131).

2 When the camera is in record standby mode, press the assignable button.
•  appears on the screen and the photo is recorded on card 2.
• The access indicator will illuminate in red.
• The size of the recorded photos depends on the video configuration currently in use. For details, refer to 

Specifications (A 244).

NOTESNOTES

• Photos cannot be recorded in the following cases
- While recording a clip, or when slow & fast motion recording is activated.
- When pre-recording is activated.
- While color bars are displayed.
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Onscreen Displays
Refer to this section for an explanation of the various screen displays that appear in CAMERA mode. You can use the 
custom display function (A 197) to turn off individual onscreen displays if they are not required. The menu item that 
controls each display is given in the following tables (1: indicates a menu item under [Custom Display 1] and 2: indicates a 
menu item under [Custom Display 2]).
The position of some icons and onscreen displays may change depending on the display level settings, which can be set 
to level 1, level 2 or level 3. The following screenshot and tables describe the onscreen displays at display level 1 with the 
[All Displays] setting (A 56).

AF frames
You can turn AF frames on/off with the  > [¢ Monitoring Setup] > [Custom Display 1] > [Focus Frame] setting.

Left side of the screen

Icon/Display Description Custom Display

, , , ,
, , 

,  00,  00, 

Network connection status, functions and upload status (A 182). 2: [Network Functions]

Flicker detection (A 76). 1: [Flicker Detection]

Zoom (A 98). 1: [Zoom Position]

Continuous AF frame – 
in white/gray/red/yellow (A 92)
One-shot frame – 
in white/green/red (A 92)

Subject detection frame (main 
subject): white/gray/green/red/
yellow (A 94)

Subject detection frame (subjects 
other than the main subject): gray

Tracking: Subject selection 
(A 95)

Tracking: During tracking Focus frame with focus guide (A 90) 

Focus adjustment frame: In red 
when it is not possible to stop at or 
locate the focus position during 
one-shot AF, or when the subject is 
out of focus (outside the close/far 
range of the lens) during 
continuous AF.

Eye detection: Main subject’s eyes (A 94)

Frame for trackable subjects (A 96)
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Top of the screen

0.0x Digital zoom magnification (A 99). 1: [Digital Zoom Magn.]

, , , Digital tele-converter (A 98). 1: [Tele-converter]

Object distance (bar).
• Only when an RF lens/RF Cinema lens is attached to the camera.

1: [Object Distance (Bar)]

0000 mm Approximate focal length of the lens. 1: [Focal Length]

000.0 m Object distance (numeric).
• Only when an RF lens or certain EF Cinema lenses are attached.

1: [Object Distance (Numeric)]

A, @ Focus mode (A 89). 1: [Focus Mode]

(in yellow),  ±0.0 
(Lens information)

Lens information. 
• Depending on the lens, the information displayed may differ.

1: [Lens]

, Subject to be detected (A 94). 1: [Subj. Detect. AF]

, Detection priority, detection only.

, , Eye detection (A 94).

Touch tracking priority (A 95). 1: [Tracking by Touch Priority]

, , Image stabilization enabled/disabled (A 97). 1: [Digital IS]

Lens optical IS (A 97)

/00 Custom picture file selected (A 135). 1: [Custom Picture]

, , , , 
, , , , 
, 

[Gamma/Color Space] setting in the custom picture file (A 139).

Look Files (A 137).

View assistance (A 160). 1: [View Assist]

Status of the accessory attached to the multi-function shoe (A 37).
• Appears in red in case of a communication error or if the attached accessory is turned off.

2: [Multi-Function Shoe]

GPS signal: continuously on - satellite signal acquired; flashing - satellite signal not acquired.
• Displayed only when a GP-E2 GPS Receiver is connected to the camera.

2: [GPS]

, 
, 

, 

Tracking guide, warning. –

Icon/Display Description Custom Display

Recording media status, estimated remaining recording time and recording format 2: [Remaining Rec Time]

,  (in green)
000 min

: CFexpress card / : SD card  
The card’s status is indicated by the icon’s color: in green – can record; in yellow – card almost full 
(less than 6 minutes); in red – card almost full (less than 1 minute); in white – reading the card.
• The card selected for recording is indicated with a  mark.

,  (in red) END Card is full.

,  (in red) No card or cannot record on the card.

r, , , 
, 

Video format (A 66) and audio format (A 124).

Icon/Display Description Custom Display
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Right side of the screen

Recording operation 2: [Recording Mode]

STBY, ÜREC Normal recording: record standby, recording.

S&F STBY, 
S&F ÜREC

Slow & fast motion recording (A 124): record standby, recording.

PRE STBY, 
PRE ÜREC

Pre-recording (A 125): record standby, recording.

CONT, ÜCONT Continuous recording (A 126).

FRM STBY, 
FRM ÜREC, 
FRM ÜSTBY

Frame recording (A 126): record standby, recording.

INT STBY, 
INT ÜREC, 
INT ÜWAIT

Interval recording (A 127): record standby, recording.

0s / 00m00s Interval counter (A 127). 2: [Interval Counter]

REC`, STBY`
EXT REC`, EXT STBY`

Recording command (A 157).
"EXT" is displayed when there is no recording media.

2: [Rec Command(EXT REC)]

, Double slot recording (A 43). 2: [Recording Mode]

00.00P, 00.00i Frame rate (A 66).
When slow & fast motion recording is activated, the shooting frame rate is also displayed (000/
00.00P).

2: [Frame Rate]

C Key lock (A 31). 1: [Key Lock]

00:00:00.00 / 00:00:00:00 
R, P, F, E

Time code (A 104).
Time code status (A 105).

2: [Time Code]

Power supply level indicator 2: [Remaining Battery]

è  é  
ê  ë  

 (in red)
000 min

Remaining battery charge of a LP-E6P/LP-E6NH Battery Pack and estimated remaining usage time 
(in minutes).
• When  is displayed, replace the battery pack with a fully charged one.
• Depending on the conditions of use, the actual battery charge level may not be indicated 

accurately or may not match the levels shown on the [B System Setup] status screen or the 
indicators on the battery pack.

USB Power Adapter (A 24).

Icon/Display Description Custom Display

60(24)fps,
60(30)fps

Video output (A 131). 2: [Output Terminals Status]

, , Sensor mode (A 66). 2: [Sensor Mode]

0000x0000 Resolution (A 66). 2: [Resolution/Color Sampling]

YCC000 00 bit
HQ / ST / LT 12 bit

Color sampling, bit depth, RAW mode (A 66).

 (in green) Photos can be recorded on the SD card (A 52). 2: [Photo]

 (in red) No SD card or cannot record photos on the SD card.

T (in yellow) Output onscreen displays (A 159). 2: [OSD Output]

^ (in yellow) Magnification (A 91). 1: [Magnification]

J, K (in yellow) Peaking (A 91). 1: [Peaking]

 (in yellow) LCD luminance boost (A 25). 2: [LCD Luminance Boost]

×00, Headphone volume (A 150). –

Icon/Display Description Custom Display
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Bottom and center of the screen

Selecting the Onscreen Display Level

You can press the DISP button to control de amount of information shown over 
the image. Repeatedly pressing the DISP button will change the display level: 
Display level 1  Display level 2  Display level 3  Display level 1. In CAMERA 
mode, you can change the information displayed at each display level in the 
menu (A 196). 

Audio level meter (A 112). 2: [Audio Level Indicator]

Date/time 2: [Date/Time]

CH0/CH0, 
CH0+CH0/CH0+CH0

Audio output channels (A 162). 2: [Monitor Channels]

1/0000.00, 000.00°*, 000.00Hz, Shutter speed (A 75).
* When [Shutter Mode] is set to [Angle], and 60 (24) fps or 60 (30) fps is selected with an assignable button 

(set to [Output: 60⇔60(24)fps] or [Output: 60⇔60(30)fps]), 60P and 24P or 30P angles are displayed.

1: [Shutter]

Icon/Display Description Custom Display

 (horizontal/vertical)
Level (bar) (A 37). 1: [Level (bar)]

Base 0000 Base ISO (A 78). 1: [Base ISO]

` Fan operation: in white – normal (A 48); in red – fan warning (A 223). 2: [Temperature/Fan]

b (in green)
b (in yellow)
b (in red)

Temperature warning (A 48).
• When the camera internal temperature rises above a certain level, b will appear in yellow. If the 

temperature rises further, b will appear in red.

i (in red)
i (in yellow)

Lens error warning (A 223). 1: [Lens]

 Direct touch control (A 60). –

A_0001C001 to ZZ9999D999 Clip identification. Includes the camera index, reel number and clip number components of the clip 
file name (A 46).

2: [Reel/Clip Number]

00 00 00 00 User bit (A 105). 2: [User Bit]

Exposure bar (A 84). 1: [Exposure Bar]

, Light metering mode (A 85). 1: [Light Metering]

AE ±0.00 AE shift (A 84). 1: [AE Shift]

ÅA / ÅB, ¼, É, È, 
 

00000K ±00

White balance (A 86). 1: [White Balance]

E, F00.0 / T00.0, closed Aperture value (A 82). 1: [Iris]

EISO 000000, 00.0dB ISO speed/Gain value (A 78). 1: [ISO/Gain]

Icon/Display Description Custom Display

Example of the 
[Main Recording Displays] option
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CAMERA mode

MEDIA mode

1  > [¢ Monitoring Setup] > [DISP Level 1], [DISP Level 2] or [DISP Level 3].
2 Smaller onscreen displays (same size as when set to [All Displays (Periph. Border)]).

NOTESNOTES

• You can change the transparency level of onscreen displays (A 159).

Peripheral Border Display

You can apply the peripheral border display to all display levels. With the peripheral border display, the camera’s image is 
reduced slightly so the onscreen displays are shown mostly around it and not on top of it, partially hiding it. The 
peripheral border is linked with the display level. You can select the levels that use the peripheral border with the 

> [¢ Monitoring Setup] > [Apply Peripheral Border] setting.

NOTESNOTES

• When using a display level with the peripheral border display, if you set  > [¢ Monitoring Setup] > [OSD 
Output: HDMI] to [Off ], the video output from each video terminal will be displayed in full screen.

Displaying the Tally OSD

While recording (REC) or when receiving an external tally signal input, the tally OSD (frame or bar) can be displayed on 
the screen. Displaying the tally OSD allows you to easily check whether recording is in progress even when viewing the 
screen from a distance.

1 Select  > [¢ Monitoring Setup] > one of the [Tally OSD:] settings > [On].
• Confirm and/or change the screen for tally OSD display and the output destination.

Display level1 Options Description

[DISP Level 1] [All Displays] All onscreen displays at a larger size.

[All Displays (Periph. Border)] All onscreen displays at a smaller size, more appropriate for use with the peripheral border.

[DISP Level 2]2 [Main Recording Displays] Only the onscreen displays most relevant for shooting.

[Only FUNC/MENU] Only markers, focus frames/tracking frame, and video scopes are displayed. When the FUNC button, MENU button 
or an assignable button is pressed, the necessary information will be displayed.

[DISP Level 3]2 [Only REC/STBY] No onscreen displays except for the recording operation (REC/STBY).

[No Displays] No onscreen displays at all.

Display level1 During clip/photo playback Index screen/During audio playback

[DISP Level 1] All onscreen displays.

All onscreen displays.[DISP Level 2] No onscreen displays.

[DISP Level 3] –

Full-screen display Peripheral border display
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2 Select  > [¢ Monitoring Setup] > [Tally OSD Settings] > Desired option.

Tally OSD Settings List

3 Select  > [¢ Monitoring Setup] > [Tally OSD Position] > Desired option.

NOTESNOTES
• Recorded video/still images are not affected.

Onscreen Displays in Portrait Mode

When shooting in portrait mode, you can change the orientation of the onscreen 
displays.

Select  > [¢ Monitoring Setup] > Desired [OSD Orientation:] setting > 
[ 90 Degrees Left] or [ 90 Degrees Right].

NOTESNOTES
• The menu and status screens cannot be rotated.
• Direct touch control (other than recording settings) and the peripheral border display 

cannot be used when the CAMERA mode screen is rotated. 

Reviewing a Recording
If you set an assignable button to [Review Recording] in advance, you can review the last clip recorded on the main 
recording destination even with the camera set to CAMERA mode.

1 Set an assignable button to [Review Recording] (A 131).

2 Select  > [B System Setup] > [Review Recording] > Desired option.

[Tally OSD Settings] Tally Input State Recording Status (REC) Tally OSD Lamp Color

[Tally In (PGM/PVW)]

PGM

—

Red

PVW Green

PGM + PVW Amber

[REC] —
Recording Red

[REC/Tally In (PGM/PVW)]

—

PGM

Record Standby Mode

Red

PVW Green

PGM + PVW Amber

Frame Top Bottom
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3 After you finish recording a clip, press the assignable button.
• The last clip that was recorded is played back for the selected duration. [Ð REVIEW] appears on the screen.
• There will be no sound from the built-in speaker but the audio will be output from the × (headphone), HDMI OUT  

terminal.
• You can use the joystick to jump back/forward within the clip. You can also touch or slide the onscreen progress bar 

to move to a different position in the video (A 149).
• Press CANCEL or flick down on the screen to stop reviewing the clip.
• After the clip finishes playing back, or if you stop reviewing the clip, the camera returns to record standby mode.

Options
[Entire Clip]: Allows you to review the entire clip.

[Last 4 sec]: Allows you to review just the last 4 seconds of the clip.

NOTESNOTES
• If the camera switched cards during a recording, the camera will play back the clip on the card most recently recorded 

on.
• You cannot review clips when continuous recording is activated.
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Adjusting Camera and Recording Settings
Using direct touch control, you can perform a variety of settings (camera, recording, assistance functions, etc.) in CAMERA 
mode. White balance and exposure related settings can also be modified with the direct setting mode, using the FUNC 
button.

Performing Basic Settings with Direct Touch Control
With direct touch control you can change commonly used settings such as camera and recording settings and assistance 
functions. For details about each function, refer to the respective section on the manual.

Available Direct Touch Control Settings

1 Only when the main recording format is XF-HEVC S / XF-AVC S.
2 Only when the [Continuous Recording] setting (A 126) is changed from [STBY] to [REC].

Turn on/off the Direct Touch Control Interface

Even when the direct touch control interface is displayed, you can still use other functions such as recording, menu 
settings, direct setting mode or status screens.

1 Touch  to open the direct touch control interface.

2 Touch X to close the direct touch control interface.

Touch button Available settings

White balance White balance mode (custom, preset, color temperature, automatic (AWB)), color correction value.

Aperture Adjustment of the F value/T value.

ISO/Gain Adjustment of ISO or gain value/adjustment value preset.

Shutter speed Adjustment of the value in the current shutter speed mode.

A (assistance functions) Focus guide (on/off), peaking (type), WFM, zebra (type), false color (on/off), markers (on/off), view assistance (on/off).

Æ(recording settings) Sensor mode, recording mode, second card recording functions, main recording destination, continuous recording1, 2, slow & fast 
shooting frame rate, frame recording frame rate, interval recording frame rate, interval recording time interval, chunk recording time 
setting, main recording format, / file selection, main resolution, frame rate, bit rate, LCD luminance,  recording format, proxy 
recording color conversion,  resolution,  bit rate,  frame rate.

Recording settings

Assistance functionsOpening ( )/ Closing (X) the
direct touch control interface

Camera settings



61

Adjusting Camera and Recording Settings

Changing Camera Settings

1 Touch the setting you want to adjust, then select the desired value/
setting.
• Once the settings menu is displayed, touch to select the desired value/

setting as needed.
• When the slider appears, drag the slider left/right or touch the / 

buttons to adjust the desired value.
• You can also use the SELECT dial or the control dial.

2 Touch K. 

Using Assistance Functions

1 Touch A (assistance functions) and then turn assistance functions on/off, 
or select the desired assistance function.

2 Touch K. 

Changing Recording Settings

1 Touch Æ (Recording Settings) 
• The recording settings menu will be displayed. There are three pages 

that can be switched by swiping left and right.

2 Select the desired menu setting and then select the desired option.

3 Touch X. 

Direct Setting Mode (FUNC Button)
You can adjust main camera functions—white balance, aperture, ISO speed/
gain and shutter speed—using the FUNC button (direct setting mode). This 
section will explain the basic operation of the direct setting mode. For details 
about each function, refer to the respective section on the manual.

1 Press the FUNC button.
• The onscreen display of the selected function will be highlighted in 

orange.
• Press the FUNC button repeatedly or push the joystick left/right to select a 

different function (the top control dial can also be used).

2 Push the joystick up/down or turn the SELECT dial to select the 
desired value or white balance mode.
• You can also use the grip control dial.

3 Press SET.
• The selected value/mode will be set and direct setting mode will end.
• The onscreen display of the selected function will return to normal.

Drag the slider to select the desired value
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NOTESNOTES

• The camera will automatically end the direct setting mode in the following cases.
- If no operation was performed for more than 6 seconds.
- If the FUNC button is pressed while selecting the shutter speed.
- If the menu or a status screen was opened.

• If you set an assignable button to [White Balance], [Iris], [ISO/Gain] or [Shutter], you can press the button to enter direct 
setting mode with the respective function highlighted.
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Video Recording Configuration: Video Format, Sensor Mode, System 
Frequency, Resolution and Frame Rate
When recording media, you can set the video configuration used for primary clips with the following procedures. Select 
the sensor mode, main recording format (video format, color sampling, bit depth), primary resolution, frame rate and bit 
rate settings that best match your creative needs. The camera uses a variable bit rate (VBR). Intra-frame options compress 
the image after analyzing each frame separately and are more appropriate for editing. Long GOP options compress the 
image after analyzing also changes across a group of pictures and offer better compression (smaller data size). Available 
options for some settings may change depending on previous selections for other settings. See the following tables for a 
summary.
For details about sub recording clips and audio, refer to Sub Recording Clips (A 68) and Recording Audio (A 108) 
respectively.

RAW
Target recording media: CFexpress and SD cards (cells in color show bit rates only available for CFexpress cards).

Sensor mode
Main recording 

format
Main 

resolution
Bit depth

System frequency/Frame rate/Bit rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

Full frame 3:2
RAW ST

6960x4640

12 bit

– Ü
1800 Mbps

Ü
1440 Mbps – Ü

1510 Mbps
Ü

1450 Mbps

RAW LT – Ü
1170 Mbps

Ü
936 Mbps – Ü

976 Mbps
Ü

937 Mbps

Full frame

RAW HQ

6960x3672

– Ü
2900 Mbps

Ü
2320 Mbps – Ü

2420 Mbps
Ü

2320 Mbps

RAW ST Ü
2860 Mbps

Ü
1430 Mbps

Ü
1150 Mbps

Ü
2380 Mbps

Ü
1190 Mbps

Ü
1150 Mbps

RAW LT Ü
1860 Mbps

Ü
927 Mbps

Ü
742 Mbps

Ü
1550 Mbps

Ü
773 Mbps

Ü
742 Mbps

Super 35mm (Cropped)

RAW HQ

5036x2656

– Ü
1520 Mbps

Ü
1220 Mbps – Ü

1270 Mbps
Ü

1220 Mbps

RAW ST Ü
1500 Mbps

Ü
748 Mbps

Ü
599 Mbps

Ü
1250 Mbps

Ü
624 Mbps

Ü
599 Mbps

RAW LT Ü
972 Mbps

Ü
486 Mbps

Ü
389 Mbps

Ü
811 Mbps

Ü
406 Mbps

Ü
390 Mbps

Super 16mm (Cropped)

RAW HQ

2524x1332

Ü
769 Mbps

Ü
385 Mbps

Ü
308 Mbps

Ü
642 Mbps

Ü
321 Mbps

Ü
308 Mbps

RAW ST Ü
379 Mbps

Ü
190 Mbps

Ü
152 Mbps

Ü
316 Mbps

Ü
158 Mbps

Ü
152 Mbps

RAW LT Ü
246 Mbps

Ü
123 Mbps

Ü
99 Mbps

Ü
206 Mbps

Ü
103 Mbps

Ü
99 Mbps
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XF-AVC
Target recording media: CFexpress and SD cards (cells in color show bit rates only available for CFexpress cards).

* Only 1920x1080.

XF-HEVC S
Target recording media: CFexpress and SD cards (cells in color show bit rates only available for CFexpress cards).

Main recording 
format

Main 
resolution 

Bit rate

System frequency/Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 59.94i 29.97P 23.98P 50.00P 50.00i 25.00P 24.00P

XF-AVC YCC422 10 bit

4096x2160
3840x2160

1200 Mbps Intra-frame Ü – – – – – – –

1000 Mbps Intra-frame – – – – Ü – – –

900 Mbps Intra-frame Ü – – – – – – –

750 Mbps Intra-frame – – – – Ü – – –

600 Mbps Intra-frame Ü – Ü – – – – –

500 Mbps Intra-frame – – – – Ü – Ü –

480 Mbps Intra-frame – – – Ü – – – Ü

450 Mbps Intra-frame – – Ü – – – – –

375 Mbps Intra-frame – – – – – – Ü –

360 Mbps Intra-frame – – – Ü – – – Ü

300 Mbps Intra-frame – – Ü – – – – –

250 Mbps Intra-frame – – – – – – Ü –

240 Mbps Intra-frame – – – Ü – – – Ü

250 Mbps Long GOP Ü – – – Ü – – –

150 Mbps Long GOP – – Ü Ü – – Ü Ü

2048x1080
1920x1080

300 Mbps Intra-frame Ü – – – – – – –

250 Mbps Intra-frame – – – – Ü – – –

150 Mbps Intra-frame – Ü* Ü – – – – –

125 Mbps Intra-frame – – – – – Ü* Ü –

120 Mbps Intra-frame – – – Ü – – – Ü

50 Mbps Long GOP Ü Ü* Ü Ü Ü Ü* Ü Ü

25 Mbps Long GOP – Ü* – – – Ü* – –

Main recording format Main resolution Bit rate

System frequency/Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

XF-HEVC S YCC422 10 bit

6912x4608

1730 Mbps Intra-frame – – Ü – – Ü

1620 Mbps Intra-frame – Ü – – – –

1350 Mbps Intra-frame – – – – Ü –

1300 Mbps Intra-frame – – Ü – – Ü

1080 Mbps Intra-frame – Ü – – – –

900 Mbps Intra-frame – – – – Ü –

864 Mbps Intra-frame – – Ü – – Ü

486 Mbps Long GOP – Ü Ü – Ü Ü

4096x2160
3840x2160

225 Mbps Long GOP Ü – – Ü – –

135 Mbps Long GOP – Ü Ü – Ü Ü

2048x1080
1920x1080 50 Mbps Long GOP Ü Ü Ü Ü Ü Ü
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XF-AVC S
Target recording media: CFexpress and SD cards (cells in color show bit rates only available for CFexpress cards).

NOTESNOTES
• For details on the signal output from each terminal, refer to Video Output Configuration (A 155).

XF-HEVC S YCC420 10 bit

6912x4608 360 Mbps Long GOP – Ü Ü – Ü Ü

4096x2160
3840x2160

150 Mbps Long GOP Ü – – Ü – –

100 Mbps Long GOP – Ü Ü – Ü Ü

2048x1080
1920x1080 35 Mbps Long GOP Ü Ü Ü Ü Ü Ü

Main recording format Main resolution Bit rate

System frequency/Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

XF-AVC S YCC422 10 bit

4096x2160
3840x2160

1200 Mbps Intra-frame Ü – – – – –

1000 Mbps Intra-frame – – – Ü – –

900 Mbps Intra-frame Ü – – – – –

750 Mbps Intra-frame – – – Ü – –

600 Mbps Intra-frame Ü Ü – – – –

500 Mbps Intra-frame – – – Ü Ü –

480 Mbps Intra-frame – – Ü – – Ü

450 Mbps Intra-frame – Ü – – – –

375 Mbps Intra-frame – – – – Ü –

360 Mbps Intra-frame – – Ü – – Ü

300 Mbps Intra-frame – Ü – – – –

250 Mbps Intra-frame – – – – Ü –

240 Mbps Intra-frame – – Ü – – Ü

250 Mbps Long GOP Ü – – Ü – –

150 Mbps Long GOP – Ü Ü – Ü Ü

2048x1080
1920x1080

300 Mbps Intra-frame Ü – – – – –

250 Mbps Intra-frame – – – Ü – –

150 Mbps Intra-frame – Ü – – – –

125 Mbps Intra-frame – – – – Ü –

120 Mbps Intra-frame – – Ü – – Ü

50 Mbps Long GOP Ü Ü Ü Ü Ü Ü

XF-AVC S YCC420 8 bit

4096x2160
3840x2160

150 Mbps Long GOP Ü – – Ü – –

100 Mbps Long GOP – Ü Ü – Ü Ü

2048x1080
1920x1080 35 Mbps Long GOP Ü Ü Ü Ü Ü Ü

Main recording format Main resolution Bit rate

System frequency/Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P
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Selecting the System Frequency
You can change the system frequency also in MEDIA mode if you want to play back clips from a card recorded with a 
different system frequency setting.

1 Select  > [Æ Recording/Media Setup] > [System Frequency].

2 Select the desired option.
• The camera will reset and restart in the selected mode.

Selecting the Main Recording Destination
1 Select  > [Æ Recording/Media Setup] > [Main Recording Destination].

2 Select [CFexpress] or [SD Card].
•  If you set an assignable button to [Slot Selection], you can press it to switch between cards (A 131).

Selecting the Sensor Mode
You can change the area of the imaging circle covered by the CMOS sensor to produce the recorded image. 

1 Select  > [Æ Recording/Media Setup] > [Sensor Mode].
• You can also adjust this setting using direct touch control (A 60).

2 Select the desired option.

Selecting the Main Recording Format
Select the combination of video format, color sampling and bit depth for primary clips. 

1 Select  > [Æ Recording/Media Setup] > [Main Rec Format].
• You can also adjust this setting using direct touch control (A 60).

2 Select the desired option.

Selecting the Resolution of Primary Clips
1 Select  > [Æ Recording/Media Setup] > [Main Resolution].

• You can also adjust this setting using direct touch control (A 60).

2 Select the desired option.

Selecting the Frame Rate
Select the frame rate for the primary clips. This procedure is not necessary when the system frequency is set to 24.00 Hz.

1 Select  > [Æ Recording/Media Setup] > [Frame Rate].
• You can also adjust this setting using direct touch control (A 60).

2 Select the desired option.
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Selecting the Bit Rate for Primary Clips
Select the bit rate when the primary clip has the following recording format, resolution and frame rates.

* Recording is only possible with CFexpress cards.

1 Select  > [Æ Recording/Media Setup] > [Bit Rate].
• Operation by direct touch control is also possible (A 60).

2 Select the desired option.

Main recording format Main resolution Frame rate Bit rate

XF-AVC YCC422 10 bit
XF-AVC S YCC422 10 bit

4096x2160 Intra-frame
3840x2160 Intra-frame

59.94P 1200 Mbps*, 900 Mbps*, 600 Mbps

50.00P 1000 Mbps*, 750 Mbps*, 500 Mbps

29.97P 600 Mbps, 450 Mbps, 300 Mbps

25.00P 500 Mbps, 375 Mbps, 250 Mbps

24.00P 480 Mbps, 360 Mbps, 240 Mbps

23.98P 480 Mbps, 360 Mbps, 240 Mbps

XF-AVC YCC422 10 bit 1920x1080 Long GOP 59.94i, 50.00i 50 Mbps, 25 Mbps

XF-HEVC S YCC422 10 bit 6912x4608 Intra-frame

29.97P 1620 Mbps*, 1080 Mbps*

25.00P 1350 Mbps*, 900 Mbps*

24.00P, 23.98P 1730 Mbps*, 1300 Mbps*, 864 Mbps*
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Sub Recording Clips
While recording a primary clip on the card in slot 1, you can simultaneously record the same scene on the card in slot 2. 
Recording formats that can be used in conjunction are shown below. Refer to Recording / Output Signal and Detailed 
Settings (A 206) for more details. For more details on audio, see Recording Audio (A 108). 

* Sub recording clips cannot be recorded when [Sensor Mode] is set to [Full Frame 3:2].

1 Insert a card into each card slot (slot 1 for the main clip, slot 2 for the sub recording clip).

2 Select  > [Æ Recording/Media Setup] > [2nd Card Rec Functions] > [  Main /  Sub Rec].

3 Select  > [Æ Recording/Media Setup] > [  Rec Format] > Desired option.

4 Select  > [Æ Recording/Media Setup] > [  Resolution] > Desired option.

5 Select  > [Æ Recording/Media Setup] > [  Frame Rate] > Desired option.

6 Select  > [Æ Recording/Media Setup] > [  Bit Rate] > Desired option.
• Steps 3 to 6 can only be selected with some main recording formats.

7 Press the REC button to start recording.
• Proxy clips will be recorded simultaneously with the primary clips.

NOTESNOTES
• If there is no card inserted in the slot used for the primary clip, only the sub recording clip will be recorded.

Primary clip Sub recording clip

Main recording format*

Recording format / color sampling

XF-AVC XF-HEVC S XF-AVC S 

YCC422 10 bit YCC422 10 bit YCC420 10 bit  YCC422 10 bit YCC420 8 bit

RAW HQ
RAW ST
RAW LT

Ü Ü Ü Ü Ü

XF-AVC YCC422 10 bit Ü – – Ü Ü

XF-HEVC S YCC422 10 bit – Ü Ü – –

XF-HEVC S YCC420 10 bit – – Ü – –

XF-AVC S YCC422 10 bit – – – Ü Ü

XF-AVC S YCC420 8 bit – – – – Ü
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Proxy Clips
While recording a primary clip on the card in slot 1, you can simultaneously record the same scene as a proxy clip on the 
card in slot 2. Because proxy clips have smaller files, they are suitable for offline editing. 

Available configurations

1 Cannot be selected if the proxy clip has a larger bit rate than that of the main clip.

1 Insert a card into each card slot (slot 1 for the main clip, slot 2 for the proxy clip).

2 Select the main recording format (A 66).

3 Select  > [Æ Recording/Media Setup] > [2nd Card Rec Functions] > [  Main /  Proxy Rec].

4 Select  > [Æ Recording/Media Setup] > [  Rec Format] > Desired option.

5 Select  > [Æ Recording/Media Setup] > [  Resolution] > Desired option.

6 Select  > [Æ Recording/Media Setup] > [  Frame rate] > Desired option.

7 Select  > [Æ Recording/Media Setup] > [  Bit rate] > Desired option.
• Steps 4 to 7 can only be selected for some primary clip recording formats.

Primary clip

Proxy clips

Recording format / Resolution / Scanning method / Color sampling /  bit rate

XF-AVC XF-HEVC S XF-AVC S

2048x1080 1920x1080 2048x1080 1920x1280 1920x1080 1280x720 2048x1080 1920x1280 1920x1080 1280x720

P i P P

Recording 
format

Resolution
Scanning 
method

YCC420 8 bit YCC420 10 bit
YCC420 

8 bit
YCC420 8 bit

35 Mbps 16 Mbps, 9 Mbps 6 Mbps 16 Mbps, 9 Mbps 6 Mbps

RAW
6960x4640 – – – – – Ü – – – Ü – –

Other than 
the above – Ü – – Ü – – – Ü – – –

XF-AVC

4096x2160
2048x1080 P Ü – – – – – – Ü – – –

3840x1920
1920x1080 P – Ü – – – – – – – Ü Ü

1920x1080 i – Ü1 Ü1 – – – – – – Ü Ü

XF-HEVC S

4096x2160
2048x1080 P – – – Ü – – – – – – –

3840x1920
1920x1080 P – – – – – Ü Ü – – – –

XF-AVC S

4096x2160
2048x1080 P – – – – – – – Ü – – –

3840x1920
1920x1080 P – – – – – – – – – Ü Ü
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8 Select  > [Æ Recording/Media Setup] > [Proxy Rec Color Conversion] > Desired option.
• If you select [Conform to Custom Picture], the gamma curve and color space are determined to conform to the 

gamma curve of Custom Picture. Furthermore, if you select [BT.709 (Canon 709)] or [BT.709 (CMT 709)], they are 
converted as follows.

• If the gamma curve/color space in the custom picture is [PQ: BT.2020] / [HLG: BT.2020], or if the gamma curve/color 
space after enabling and applying a Look File is one of the [HDR] settings, the value set for  > 
[¢ Monitoring Setup] > [Gain for HDR  SDR Conv.] (A 161) is applied to the proxy clips as well.

9 Press the REC button to start recording.
• Proxy clips will be recorded simultaneously with the primary clips.

NOTESNOTES

• If the recording of the primary clip stops during simultaneous recording, recording of the proxy clip will stop as well. 
• If there is no card inserted in the slot used for the primary clip, only the proxy clip will be recorded.

Gamma curve of Custom Picture
Gamma curve after conversion Color space after conversion

BT.709 (Canon 709) BT.709 (CMT 709) BT.709 (Canon 709) BT.709 (CMT 709)

BT.709 Standard BT.709 Standard BT.709 Standard

BT.709

BT.709 Wide DR BT.709 Wide DR BT.709 Wide DR

Canon 709 Canon 709 Canon 709

The gamma curve and color space after applying the 
Look File and after conversion is [SDR BT.709] or 
[SDR BT.2020].

SDR SDR

Other Canon 709 CMT 709
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Simultaneous Crop Recording
You can record the main clip to the card in slot 1 while recording a cropped clip to the card in slot 2. A cropped clip is 
recorded by capturing the area of the set cropping frame. You can also adjust the cropping position.

Available configurations

Available values

Primary clip

Crop recording

Recording format / Color sampling / Resolution / Scanning method

XF-HEVC S XF-AVC S

YCC422 
10 bit

YCC420 
10 bit

YCC422 
10 bit

YCC420 
10 bit

YCC422 
10 bit

YCC420 
10 bit

YCC422 
10 bit

YCC420 
8 bit

YCC422 
10 bit

YCC420 
8 bit

YCC422 
10 bit

YCC420 
8 bit

Recording 
format

Resolution
Scanning 
method

1080x2048 1080x1920 1080x1080 1080x2048 1080x1920 1080x1080

P P

RAW All – – – – – – – – – – – – –

XF-AVC 
YCC422 10 bit

4096x2160 P – – – – – – Ü Ü – – Ü Ü

3840x1920 P – – – – – – – – Ü Ü Ü Ü

All except the above – – – – – – – – – – – –

XF-HEVC S 
YCC422 10 bit

4096x2160 P Ü Ü – – Ü Ü – – – – – –

3840x1920 P – – Ü Ü Ü Ü – – – – – –

All except the above – – – – – – – – – – – –

XF-HEVC S 
YCC420 10 bit

4096x2160 P – Ü – – – Ü – – – – – –

3840x1920 P – – – Ü – Ü – – – – – –

All except the above – – – – – – – – – – – –

XF-AVC S 
YCC422 10 bit

4096x2160 P – – – – – – Ü Ü – – Ü Ü

3840x1920 P – – – – – – – – Ü Ü Ü Ü

All except the above – – – – – – – – – – – –

XF-AVC S 
YCC420 8 bit

4096x2160 P – – – – – – – Ü – – – Ü

3840x1920 P – – – – – – – – – Ü – Ü

All except the above – – – – – – – – – – – –

Recording format Resolution Bit rate

System frequency / Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

XF-HEVC S YCC422 10 bit
1080x2048
1080x1920 50 Mbps Long GOP Ü Ü Ü Ü Ü Ü

1080x1080 27 Mbps Long GOP Ü Ü Ü Ü Ü Ü

XF-HEVC S YCC420 10 bit
1080x2048
1080x1920 35 Mbps Long GOP Ü Ü Ü Ü Ü Ü

1080x1080 19 Mbps Long GOP Ü Ü Ü Ü Ü Ü
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1 Insert a card into each card slot (slot 1 for the main clip, slot 2 for the crop recording clip).

2 Select  > [Æ Recording/Media Setup] > [Sensor Mode] > [Full Frame] or [Super 35mm (Cropped)].

3 Select the main clip recording format (A 66).

4 Select  > [Æ Recording/Media Setup] > [  Main /  Crop Rec].

5 Select  > [Æ Recording/Media Setup] > [  Rec Format] > Desired option.

6 Select  > [Æ Recording/Media Setup] > [  Resolution] > Desired option.

7 Adjust the cropping position from  > [Æ Recording/Media Setup] > [Crop Setting] > [Position].
• Press the joystick left or right, or turn the SELECT dial to move the frame left or right, then press SET.

8 Press the REC button to start recording.
• The recording of the main clip and the crop recording clip starts simultaneously.

NOTESNOTES

• This function cannot be used with slow & fast motion recording, frame recording, or interval recording.
• The cropping position cannot be changed while recording is in progress.
• Anamorphic desqueeze is not applied during playback of a cropped clip.

Displaying the Cropping Frame

You can display the cropping frame to check the cropping position.

Select  > [Æ Recording/Media Setup] > [Crop Setting] > one of the [Frame Display:] options > [On].

XF-AVC S YCC422 10 bit

1080x2048
1080x1920

300 Mbps Intra-frame Ü – – – – –

250 Mbps Intra-frame – – – Ü – –

150 Mbps Intra-frame – Ü – – – –

125 Mbps Intra-frame – – – – Ü –

120 Mbps Intra-frame – – Ü – – Ü

50 Mbps Long GOP Ü Ü Ü Ü Ü Ü

1080x1080

159 Mbps Intra-frame Ü – – – – –

133 Mbps Intra-frame – – – Ü – –

80 Mbps Intra-frame – Ü – – – –

67 Mbps Intra-frame – – – – Ü –

64 Mbps Intra-frame – – Ü – – Ü

27 Mbps Long GOP Ü Ü Ü Ü Ü Ü

XF-AVC S YCC420 8 bit
1080x2048
1080x1920 35 Mbps Long GOP Ü Ü Ü Ü Ü Ü

1080x1080 19 Mbps Long GOP Ü Ü Ü Ü Ü Ü

Recording format Resolution Bit rate

System frequency / Frame rate

59.94 Hz 50.00 Hz 24.00 Hz

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P



73

Chunk Recording Clips for Automatic Transfer

Chunk Recording Clips for Automatic Transfer
While recording a primary clip on the card in slot 1, you can simultaneously record clips divided in chunks (according to 
the specified time setting) on the card in slot 1. Enable the automatic transfer function from Content Transfer Professional 
to transfer the recorded clips sequentially (A 164). Chunk recording clips can be transferred even while the main clip is 
being recorded, reducing the wait time of the receiver.

Available configurations

1 Insert a card into each card slot (slot 1 for the main clip, slot 2 for chunk clip recording).

2 Set the video configuration for the main clip (A 66).

3 Select  > [Æ Recording/Media Setup] > [2nd Card Rec Functions] > [  Main /  Chunk Rec].

4 Select  > [Æ Recording/Media Setup] > [  Rec Format] > Desired option.

5 Select  > [Æ Recording/Media Setup] > [  Resolution] > Desired option.

6 Select  > [Æ Recording/Media Setup] > [  Frame rate] > Desired option.

7 Select  > [Æ Recording/Media Setup] > [  Bit rate] > Desired option.
• Steps 4 to 7 can only be selected for some primary clip recording formats.

8 Select  > [Æ Recording/Media Setup] > [Chunk Rec: Time Setting] > the desired option.

9 Select  > [Æ Recording/Media Setup] > [Proxy Rec Color Conversion] > Desired option (A 69).

10 Press the REC button to start recording.
• Recording of the main clip and chunk recording start simultaneously.

NOTESNOTES
• If the recording of the primary clip stops during simultaneous recording, chunk recording will stop as well.

Primary clip

Chunk Recording

Recording format / Resolution / Scanning method / Color sampling / Bit rate

XF-HEVC S XF-AVC S

2048x1080 1920x1280 1920x1080 1280x720 2048x1080 1920x1280 1920x1080 1280x720

P P

Recording 
format

Resolution
Scanning 
method

YCC420 10 bit YCC420 8 bit YCC420 8 bit

16 Mbps, 9 Mbps 6 Mbps 16 Mbps, 9 Mbps 6 Mbps

RAW
6960x4640 – – Ü – – – Ü – –

All except the 
above – Ü – – – Ü – – –

XF-AVC

4096x2160
2048x1080 P – – – – Ü – – –

3840x1920
1920x1080 P – – – – – – Ü Ü

1920x1080 i – – – – – – Ü Ü

XF-HEVC S

4096x2160
2048x1080 P Ü – – – – – – –

3840x1920
1920x1080 P – – Ü Ü – – – –

XF-AVC S

4096x2160
2048x1080 P – – – – Ü – – –

3840x1920
1920x1080 P – – – – – – Ü Ü
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• If there is no card inserted in the slot used for the primary clip, only chunk recording is performed.
• The chunk recording time interval may differ slightly from the selected time setting by up to 1.5 seconds.
• Recording to SD/SDHC cards is not possible.
• Recording stops if the recording time exceeds 6 hours.
• Playback and recovery of chunk recording clips is not possible on the camera.
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Shutter Speed
You can set the shutter speed according to the shooting conditions. For example, you may want to set slower shutter 
speeds in darker environments. You can choose between an automatic or manual mode. The camera offers the following 
manual modes.

[Speed]: Allows you to set the shutter speed (in fractions of a second). You can select the increment to use when 
adjusting the shutter speed between 1/3-stop and 1/4-stop increments.

[Angle]: You can set the shutter angle to determine the shutter speed.

[Clear Scan]: Set the frequency in order to record CRT computer monitors without displaying black bands or flicker on the 
screen.

[Slow]: You can set slower shutter speeds to obtain brighter recordings in places with insufficient lighting.

[Off ]: The camera uses a standard shutter speed based on the frame rate.

Available shutter speeds
The individual setting options that can be selected will change depending on the frame rate used.

1 When slow & fast motion recording is activated, available setting options will vary depending on the selected shooting frame rate.
2 Not available when slow & fast motion recording is activated.

1 Select  > [v Camera Setup] > [Shutter Mode] > Desired shutter speed mode.

2 If set to [Manual], select  > [v Camera Setup] > [Shutter Manual] > Desired option.

3 For [Speed] only: Select  > [v Camera Setup] > [Shutter Increment] > [1/3 stop] or [1/4 stop].

4 Adjust the shutter speed, angle value or clear scan frequency using the direct setting mode (A 61).
• You can also use direct touch control (A 60).

NOTESNOTES

• When [Shutter Manual] is set to [Slow], bright red, green, blue, white or black dots may appear on the screen. In such 
case, use a faster shutter speed or select a lower ISO speed or gain value (A 78).

• Automatic adjustment is not possible during slow & fast motion recording when the shooting frame rate exceeds 
150 (fps).

Shutter manual
System frequency/Frame rate

59.94 Hz 24.00 Hz 50.00 Hz
59.94P / 59.94i 29.97P 23.98P 24.00P 50.00P / 50.00i 25.00P

[Speed]1

1/3-stop 
increments

1/1 to 1/2000 (34 setting options in total)

1/4-stop 
increments

1/1 to 1/2000 (47 setting options in total) 1/1 to 1/2000 (45 setting options in total)

[Angle]1 360.00°, 240.00°, 180.00°, 120.00°, 90.00°, 60.00°, 45.00°, 30.00°, 22.50°, 15.00°, 11.25°
Also angle values equivalent to the following shutter speeds: 1/120, 1/100, 1/60, 1/50, 1/40, 3/100, 1/30, 1/25.

[Clear Scan]1 Approx. 24 Hz to 2000 Hz
Within the above range, the frequency can be set with the minimum available resolution depending on the sensor mode and frame rate.

[Slow]2 1/4, 1/8, 1/15, 
1/30 1/4, 1/8, 1/15 1/3, 1/6, 1/12 1/3, 1/6, 1/12, 

1/25 1/3, 1/6, 1/12

[Off]1 1/60 1/30 1/24 1/50 1/25

Using slow shutter mode
When recording in dark surroundings, you can obtain a brighter picture by using slow shutter mode. You can also use 
this mode when you wish to add certain effects to your recordings, such as blurring the background during panning 
shots or recording a moving subject with an afterimage trail.
• Image quality may not be as good as when using faster shutter speeds in brighter surroundings.
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Recording Under High-Frequency Light Sources
Flickering may occur when recording video under a rapidly blinking light source. When you execute [Auto Clear Scan 
Setting], the camera detects the frequency of the light source (in a range of 50.0 Hz to 2011.2 Hz) and shoots at a shutter 
speed that matches the blinking cycle, reducing flickering.

1 Select  > [v Camera Setup] > [Shutter Mode] > [Manual].

2 Select  > [v Camera Setup] > [Shutter Manual] > [Clear Scan].

3 Select  > [v Camera Setup] > [Auto Clear Scan Setting] > [OK].

4 Change the shutter speed to the displayed speed.
• When you select [OK], the shutter speed changes to the displayed speed.

NOTESNOTES
When [No flicker detected.] is displayed, or when the flickering does not disappear even after changing to the displayed shutter speed, perform the 
following operations:
• Execute [Auto Clear Scan Setting] again.
• Execute [Auto Clear Scan Setting] after changing the camera’s orientation by about 90 degrees.
• Adjust manually.

- Set a control dial / control ring to [Clear Scan (Steps)] or [Shutter] (A 202).
- With [Clear Scan (Steps)], you can change the shutter speed to 2, 3, or 4 times, or to 1/2, 1/3, or 1/4 times the 

frequency set using [Auto Clear Scan Setting].
- With [Shutter] you can make fine adjustments.

• The accuracy of high-frequency flickering detection may be reduced under the following conditions.
- When there are repetitive patterns (such as grid or stripe patterns).
- When the subject is in constant movement.
- In extreme brightness or darkness.
- When there are multiple light sources in the screen.
- When the blinking light source is too small.
- When the subject illumination is low.

Flicker Reduction 
You can perform the following procedure to have the camera automatically detect and reduce flicker.

Select  > [v Camera Setup] > [Flicker Reduction] > [Automatic].

NOTESNOTES
• When recording under artificial light sources such as fluorescent, mercury or halogen lamps, the screen may flicker 

depending on the shutter speed. You may be able to avoid flicker by setting the shutter speed mode to [Speed] and 
the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 for 50 Hz systems, 1/
60 or 1/120 for 60 Hz systems.

* May not be available depending on the frame rate.

• When  > [¢ Monitoring Setup] > [Custom Display 1] > [Flicker Detection] is set to [On] and [Flicker Reduction] is 
set to [Off ], when flicker is detected, the  icon flashes.

Flicker reduction cannot be used in the following cases.
• During slow & fast motion recording when the following shooting frame rates are not used:

- 59.94 Hz: 24P*/30P/60P/120P
- 50.00 Hz: 25P/50P/100P
- 24.00 Hz: 24P*
* When [Shutter Mode] and [ISO/Gain Mode] are set to an option other than [Automatic].
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• When using a recording mode other than slow & fast motion recording, the frame rate is 24.00P or 23.98P and [Shutter 
Mode] and [ISO/Gain Mode] are set to an option other than [Automatic].



ISO Speed/Gain

78

ISO Speed/Gain
You may want to adjust the brightness of the image according to the shooting conditions. You can choose between 
manual and automatic settings. By choosing manual settings you can change the ISO speed or gain value to adjust the 
sensitivity of the sensor. You can also set the camera’s base ISO speed by choosing from three modes.

Available setting values

Available range

1  > [v Camera Setup] > [ISO/Gain] setting.
2  > [v Camera Setup] > [ISO/Gain Increment] setting.
3 Available only when  > [v Camera Setup] > [ISO/Gain Extended Range] is set to [Off ].
4 Available only when [ISO/Gain Extended Range] is set to [On].

Base ISO Speed 
Set the base ISO speed for the recommended dynamic range. You can achieve low noise even at high ISO/gain levels by 
switching to one of two settings that suit different lighting conditions (normal lighting, low light, and dark places). 
Additionally, the [Auto Selection] setting automatically switches between two levels of base ISO according to the ISO/
gain value, ensuring an optimal dynamic range and S/N ratio.

Select  > [v Camera Setup] > [Base ISO] > Desired option.
• Available values will depend on the [Gamma/Color Space] setting in the custom picture file and the recording format.

ISO/Gain1 Increment2 Available setting values

[ISO]
[1 stop] 1004, 1603, 200, 400, 800, 12503, 1600, 3200, 6400, 12800, 25600, 512004, 1024004

[1/3 stop] 1004, 1254, 160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250, 1600, 2000, 2500, 3200, 4000, 5000, 6400, 8000, 
10000, 12800, 16000, 20000, 25600, 320004, 400004, 512004, 640004, 800004, 1024004

[Gain]

[Normal]
(3 dB) –6dB4, –3dB4, –2dB3, 0dB to 42dB, 45dB4 to 54dB4

[Fine]
(0.5 dB) –2dB to 42dB, 42.5dB4 to 54dB4

Base ISO ISO/Gain1 Increment2
Available range

Extended range4

[Auto Selection]

[ISO] Any setting 160 to 25600 100 to 102400

[Gain]
[Normal] (3 dB) –2dB to 42dB –6dB to 54dB

[Fine] (0.5 dB) –2dB to 42dB –2dB to 54dB

[Base ISO 160] / [Base ISO 160 (–2dB)]
[Base ISO 400] / [Base ISO 400 (6dB)]

[Base ISO 800] / [Base ISO 800 (12dB)]

[ISO] Any setting 160 to 12800 100 to 25600

[Gain]
[Normal] (3 dB) –2dB to 36dB –6dB to 42dB

[Fine] (0.5 dB) –2dB to 36dB –2dB to 42dB

[Base ISO 1250] / [Base ISO 1250 (–2dB)]
[Base ISO 3200] / [Base ISO 3200 (6dB)]

[Base ISO 6400] / [Base ISO 6400 (12dB)]

[ISO] Any setting 1250 to 25600 800 to 102400

[Gain]
[Normal] (3 dB) –2dB to 24dB –6dB to 36dB

[Fine] (0.5 dB) –2dB to 24dB –2dB to 36dB
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Base ISO settings

* When the main recording format is RAW, the available base ISO settings are the same as when the gamma curve component of the 
[Gamma/Color Space] setting in the custom picture file is set to [Canon Log 2] / [Canon Log 3].

NOTESNOTES

• If you select an ISO/gain value below the base ISO speed, white clipping in the highlights is more likely to occur.
• There is a difference in the amount of noise between each base ISO speed setting. Example: when comparing base ISO 

800/ISO 800 and base ISO 6400/ISO 6400, there is a difference in the amount of noise generated in the dark areas.

Manual ISO Speed/Gain Value
1 Select  > [v Camera Setup] > [ISO/Gain] > [ISO] or [Gain].

2 Select  > [v Camera Setup] > [ISO/Gain Mode] > [Manual].

3 Depending on your previous selection, select  > [v Camera Setup] > [ISO/Gain Increment] > 
Desired option.

4 Adjust the ISO speed or gain value using the direct setting mode (A 61).
• You can also use direct touch control (A 60).

Using the Control Dial/Control Ring/SELECT Dial

You can adjust the ISO speed or gain value using the control dial, the control 
ring of an RF lens or mount adapter, or the SELECT dial.

1 Perform steps 1 to 3 in the Manual ISO Speed/Gain Value procedure. 
(A 79)

2 Select  > [B System Setup] > [Grip Control Dial], [Top Control 
Dial], [Control Ring] or [SELECT Dial] > [ISO/Gain].

3 Turn the control dial, control ring or SELECT dial to set the desired ISO 
speed or gain value.

ISO Speed/Gain Preset

Using direct touch control (A 60), you can adjust and use up to 3 preset ISO speed/gain values.

Gamma curve
 > [v Camera Setup] > [ISO/Gain]

[ISO] [Gain]

[Canon Log 2] / [Canon Log 3]
[Auto Selection], [Base ISO 800], [Base ISO 6400] [Auto Selection], [Base ISO 800 (12 dB)], 

[Base ISO 6400 (12 dB)]

[PQ] / [HLG] / [Canon 709] / 
[BT.709 Wide DR]

[Auto Selection], [Base ISO 400], [Base ISO 3200] [Auto Selection], [Base ISO 400 (6 dB)], 
[Base ISO 3200 (6 dB)]

[BT.709 Standard]
[Auto Selection], [Base ISO 160], [Base ISO 1250] [Auto Selection], [Base ISO 160 (–2 dB)], 

[Base ISO 1250 (–2 dB)]

Control dial

SELECT dial
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Saving a preset value

1 Touch  > Current ISO speed/gain value.

2 Adjust the value selected and touch [Register].

3 Touch the desired position to save the preset value. 
• The current value is saved. 

Using a saved preset value

1 Touch  > Current ISO speed/gain value.

2 Touch the desired preset value (above the slider).
• The selected preset value is applied.

NOTESNOTES

• When high ISO speeds or gain levels are set, the picture may flicker slightly.
• When high ISO speeds or gain levels are set, bright red, green, blue, black or white dots may appear on the screen. In 

such case, use a faster shutter speed (A 75) or select a lower ISO speed or gain value.
• When the ISO speed or gain level is changed, some noise may appear momentarily on the screen. Do not adjust the 

ISO speed/gain level while recording.
• You can use the  > [B System Setup] > [Grip Ctrl Dial Dir.], [Top Ctrl Dial Dir.], [Control Ring Dir.] or [SELECT Dial 

Dir.] setting to change the direction of the adjustment when you turn the control dial, control ring or SELECT dial.
• If you set an assignable button to [ISO/Gain Mode] (A 131), you can press the button to switch between automatic 

and manual adjustment.

Automatic ISO Speed/Gain
Sensitivity is automatically adjusted according to the subject. You can also set an upper limit for the sensitivity. Automatic 
adjustment is not possible during slow & fast motion recording when the shooting frame rate exceeds 150 (fps).

Automatic setting values
The sensitivity lower limit will be set automatically according to the [Gamma/Color Space] setting in the custom picture 
file.

* When the main recording format is RAW, the available base ISO settings are the same as when the gamma curve component of the 
[Gamma/Color Space] setting in the custom picture file is set to [Canon Log 2] / [Canon Log 3].

Select  > [v Camera Setup] > [ISO/Gain Mode] > [Automatic].

Gamma curve Base ISO Lower sensitivity limit

[Canon Log 3]
[Canon Log 2]

[Auto Selection]
ISO 800 (Gain 12 dB)

[Base ISO 800]

[Base ISO 6400] ISO 6400 (Gain 12 dB)

[BT.709 Wide DR]
[PQ]

[HLG]
[Canon 709]

[Auto Selection]
ISO 400 (Gain 6 dB)

[Base ISO 400]

[Base ISO 3200] ISO 3200 (Gain 6 dB)

[BT.709 Standard]

[Auto Selection]
ISO 160 (Gain –2 dB)

[Base ISO 160]

[Base ISO 1250] ISO 1250 (Gain –2 dB)

Stored preset values

Drag the slider to select the desired value

Touch to register a preset value
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NOTESNOTES

• You can set the responsiveness of the automatic exposure function with the  > [v Camera Setup] > 
[AE Response] setting*.

* Except when using an incompatible lens (A 246). 

Setting an automatic ISO limit

By setting an ISO limit in automatic mode, you can curb the amount of noise and keep a dark ambient.

Select  > [v Camera Setup] > [Limit for Auto Mode] > Desired option.
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Aperture
You can affect the brightness of your recordings or change the depth of field by adjusting the aperture. Depending on 
the lens used, the aperture value displayed may differ (F value or T value) and available aperture values will vary as well 
(A 246). You can select the adjustment increment and even use the smallest iris increment allowed by the lens.

Manual aperture: Adjust the aperture value manually.

Automatic aperture: The camera adjusts the aperture automatically.

Push Auto Iris: Momentary automatic aperture. During manual aperture, press the AUTO IRIS button to temporarily adjust 
the aperture automatically (only while the button is held pressed down).

Aperture Settings of the Lens
To adjust the aperture from the camera, you will need to enable automatic adjustment using the controls on the 
compatible EF Cinema/RF (with iris ring) lens. Required settings vary depending on the lens. Refer to the instruction 
manual of the lens used.

Set the lens or iris ring to automatic aperture.

Manual Aperture: Changing the Aperture Value
1 Select  > [v Camera Setup] > [Iris Mode] > [Manual].

• This setting is available only when a lens compatible with automatic aperture is attached to the camera. For non-
compatible lenses, the aperture mode is automatically set to [Manual] and cannot be changed.

2 When using a lens equipped with aperture settings, set the lens to automatic aperture mode.

3 Select  > [v Camera Setup] > [Iris Increment] > [1/2 Stop] or [1/3 Stop].
• You can also set  > [v Camera Setup] > [Fine Increment] to [On] to use the smallest iris increment allowed 

by the lens attached. Nevertheless, the aperture value displayed on the screen will be the closest value in the 
selected increment scale.

4 Adjust the aperture value using direct setting mode (A 61).
• You can also use direct touch control (A 60).

Using the Control Dial/Control Ring/SELECT Dial

You can also adjust the aperture settings using the control dial, the control ring of an RF lens or mount adapter, or the 
SELECT dial.

1 Select  > [B System Setup] > [Grip Control Dial], [Top Control 
Dial], [Control Ring] or [SELECT Dial] > [Iris].

2 Turn the control dial, control ring or SELECT dial to adjust the aperture. Control dial

SELECT dial



83

Aperture

NOTESNOTES

• You can use the  > [B System Setup] > [Grip Ctrl Dial Dir.], [Top Ctrl Dial Dir.], [Control Ring Dir.] or [SELECT Dial 
Dir.] setting to change the direction of the adjustment when you turn the control dial, control ring or SELECT dial.

• Closing down the aperture when recording under bright conditions may cause the picture to appear soft or out of 
focus. The following measures may be effective in avoiding the loss of sharpness due to diffraction.
- Using a faster shutter speed (A 75).
- Applying diffraction correction (A 35). Results may vary depending on the lens used.

• If you set an assignable button to [Iris +] or [Iris –] (A 131), you can press the button to respectively open up or close 
down the aperture.

• When using a lens equipped with aperture settings, you can also adjust the aperture with the iris ring on the lens 
(A 82).

• When using a lens with no lens contacts or an incompatible lens (A 246), you cannot adjust the aperture using the 
camera. Adjust it using the lens.

• When using a lens that can correct the aperture value according to the position of the zoom, you can use the 
> [v Camera Setup] > [Zoom-Iris Correction] setting to activate this correction.

• Using an RF/EF Cinema lens
- The aperture value displayed on the screen will be a T value*. The aperture value (T value) displayed on the screen 

may differ from the indication on the lens’s aperture scale. 
* Updating the firmware is necessary for RF Cinema lenses (A 34).

- When the iris is almost fully closed, the aperture value (T value) will appear in gray on the screen.
- When you change the aperture value from a position of fully open or fully closed iris, multiple adjustment operations 

may be required until the aperture changes.
• If you use the EF-EOS R 0.71x Mount Adapter to attach an EF lens, the aperture will be approximately one level brighter 

than the value indicated by the lens. 

Momentary Automatic Aperture - Push Auto Iris
During manual aperture, you can press the AUTO IRIS button to have the camera temporarily take control and adjust the 
aperture automatically for an optimal exposure.
Push Auto Iris is not possible during slow & fast motion recording when the shooting frame rate exceeds 150 (fps).

1 Select  > [v Camera Setup] > [Iris Mode] > [Manual].

2 When using a lens equipped with aperture settings, set the lens to 
automatic aperture mode (A 82).

3 Press and hold the AUTO IRIS button.
• The camera will automatically adjust the aperture to obtain optimal 

exposure as long as you hold the button pressed down, and E will appear 
on the screen next to the aperture value.

• When you release the button the aperture value will be set, automatic 
aperture mode will end and the E icon will disappear.

NOTESNOTES
• You can use the  > [v Camera Setup] > [AE Response] setting to change how quickly the aperture changes 

during automatic aperture mode. This setting has no effect when using an incompatible lens (A 246).
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Automatic Aperture
When a compatible lens is attached to the camera, you can have the camera automatically adjust the aperture. 
Automatic aperture is not possible during slow & fast motion recording when the shooting frame rate exceeds 150 (fps).

1 Select  > [v Camera Setup] > [Iris Mode] > [Automatic].
• The camera will automatically adjust the aperture to obtain optimal exposure. The selected aperture value will 

appear at the bottom of the screen with an E icon next to it.

2 When using a lens equipped with aperture settings, set the lens to automatic aperture mode (A 82).

NOTESNOTES

• If you set an assignable button to [Iris Mode] (A 131), you can press the button to toggle between the [Automatic] 
and [Manual] settings.

• The aperture value may change in the following cases.
- While using the built-in extender or iris compensation function of an EF Cinema lens, when you switch from 

automatic aperture to manual aperture.
- When the aperture controls on the lens are switched between automatic/manual mode.

• When using EF Cinema lenses that let you adjust the aperture gain, if the aperture gain is set too high, the aperture 
adjustment may not be stable (“aperture hunting”), depending on the shooting conditions. In such case, reset the lens’s 
aperture gain to its initial value.

Exposure Compensation - AE Shift
Use AE shift to compensate the exposure that was set using automatic aperture, in order to darken or lighten the image.

1 Select  > [v Camera Setup] > [AE Shift].

2 Select the desired option.
• The camera will attempt to adjust the exposure accordingly.
• You can select one of 17 AE shift levels from –2.0 to +2.0.

NOTESNOTES

• If you set an assignable button to [AE Shift +] or [AE Shift –] (A 131), you can press the button to adjust the AE shift 
level.

The exposure bar
The Î on top of the exposure bar indicates optimal exposure without any shift 
(AE±0); the scale markings indicate the deviation from optimal exposure in 
1/2 EV increments. The indicator inside the exposure bar represents the current 
exposure. When the difference between current and optimal exposure is larger than 
±2 EV, the indicator will flash at the edge of the exposure bar. Optimal exposure will 
change depending on the light metering mode used.

Optimal exposure AE±0

Current exposure
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Light Metering Mode
Select the light metering mode to match the recording conditions. Using the appropriate setting will help achieve a 
more appropriate exposure level.

1 Select  > [v Camera Setup] > [Light Metering].

2 Select the desired option.
• The icon of the selected mode (  or ) appears on the screen.

Options
[Backlight]: Suitable when recording backlit scenes.

[Standard]: Averages the light metered from the entire screen, giving more weight to the subject in the center.

[Spotlight]*: Use this option when recording a scene in which only a certain part of the picture is lit, for example, when the 
subject is lit by a spotlight.

* Cannot be selected when a VR lens is attached.

NOTESNOTES

• If [EOS Standard] or [EOS Neutral] is selected for [Select / File], the light metering mode cannot be selected. 
However, it can be selected if the custom picture file is edited (gamma adjustment, registering a different LUT as a Look 
File).

• If you set an assignable button to [Backlight] or [Spotlight] (A 131), you can press the button to toggle between the 
respective light metering mode and [Standard].

• Adjust the exposure again if you change the metering mode after adjusting the aperture manually.
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White Balance
The camera uses an electronic white balance process to calibrate the picture and produce accurate colors under different 
lighting conditions. The camera offers the following ways to set the white balance.

Custom white balance: You can use a gray card or white object with no pattern to establish the white balance and set it 
to one of two custom white balance positions, ÅA or ÅB. When recording under fluorescent lights, we recommend 
setting the custom white balance.

Preset white balance: Set the white balance to ¼ (daylight) or É (tungsten lamp). You can further adjust the color 
temperature (K) value and the color compensation (CC) value, which adjusts the color along the green/magenta 
gradation.

Color temperature: Allows you to set the color temperature between 2,000 K and 15,000 K, and further adjust the color 
compensation (CC) value.

Auto white balance (AWB): The camera automatically adjusts the white balance to the optimal level.

NOTESNOTES
• The [White Balance] setting in the custom picture file (A 141) takes precedence over the white balance set with these 

procedures.
• You can use the  > [v Camera Setup] > [Shockless WB] setting to make the transition look smoother when 

you change the white balance settings.
• The color temperatures displayed on the screen are approximate. Use them only as a reference.

White Balance Mode
Select a white balance mode using the direct setting mode (A 61).
• You can also use direct touch control (A 60).
• If you set  > [B System Setup] > [Grip Control Dial], [Top Control Dial], [Control Ring] or [SELECT Dial] to [White 

Balance Mode], you can change the white balance mode using the control dials, control ring or SELECT dial.

NOTESNOTES

• If you set an assignable button to [  AWB]. [Å Set A], [Å Set B], [¼ Daylight], [É Tungsten] or [È Kelvin] 
(A 131), you can press the button to change the white balance mode temporarily. Press the button again to return to 
the previous white balance mode.

Custom White Balance

1 Select the ÅA or ÅB icon (A 86).
• To apply the stored custom white balance setting as is, the rest of 

the procedure is not necessary. To set a new custom white 
balance, continue the procedure.

2 Point the camera at a gray card or white object so that it fills 
the center of screen.
• Use the same lighting conditions you plan to use when recording.
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3 Press the Å button.
• The Å A or Å B icon will flash quickly.
• Make sure the gray card or white object fills the center of the screen until the procedure is completed.
• Once the icon stops flashing, the procedure is completed. The setting is retained even if you turn off the camera.
• The color temperature and CC value registered by the camera will appear at the bottom of the screen next to the 

ÅA or ÅB icon.

NOTESNOTES
• Readjust the custom white balance if the light source changes.
• Very rarely and depending on the light source, Å may keep flashing (it will change to a slow flashing). In that case, 

change the subject brightness and adjust the custom white balance again.
• After the camera registers a custom white balance, the color temperature or CC value may appear in gray. This 

indicates that the value registered exceeds the range of values that can be displayed but the white balance is correctly 
calibrated and you can continue shooting.

Color Temperature/Preset White Balance
1 Select the ¼ or É icon (preset white balance), or the È icon 

(color temperature setting) (A 86).
• To apply the stored preset setting or color temperature as is, the rest 

of the procedure is not necessary. To adjust the color temperature or 
CC value, continue the procedure.

2 Press the Å button.
• The camera will enter the direct setting mode with the color 

temperature highlighted in orange. To adjust the CC value, push the 
joystick right.

• You can also adjust the color temperature or CC value using direct 
touch control (A 60).

3 Select the desired value.
• The selected color temperature and CC value will be set and will appear on the screen next to the white balance 

icon.

NOTESNOTES

• You can use the  > [v Camera Setup] > [C. Temp. Increment] setting to change the units for the color 
temperature increment to [Mired] (5-mired increments) or [Kelvin] (100-kelvin increments). Even when [Mired] is 
selected, the color temperature is converted to and displayed in kelvins. Changing this setting may change the white 
balance setting.

• If you set  > [B System Setup] > [Grip Control Dial], [Top Control Dial], [Control Ring] or [SELECT Dial] to [White 
Balance (K)] or [White Balance (CC)], you can adjust the color temperature (K) value and the color compensation (CC) 
value using the control dials, control ring or SELECT dial.

White balance mode/setting
Adjustment range

Color temperature (K) Color compensation (CC) value

¼ (daylight) 4,300 K to 8,000 K
–5 to +5

É (tungsten lamp) 2,700 K to 3,700 K

È (color temperature) 2,000 K to 15,000 K –20 to +20
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Auto White Balance (AWB)
The camera constantly adjusts the white balance automatically to achieve an appropriate level. The camera will adjust 
the white balance if the light source changes.

Select the  icon (A 86).
• The color temperature and CC value set automatically by the camera will appear at the bottom of the screen next to 

the  icon.

NOTESNOTES
• Custom white balance may provide better results in the following cases:

- Changing lighting conditions
- Close-ups
- Subjects in a single color (sky, sea or forest)
- Under mercury lamps and certain types of fluorescent and LED lights

• You can use the  > [v Camera Setup] > [AWB Response] setting to change how quickly the white balance 
changes in auto white balance (AWB) mode.

• If you set an assignable button to [AWB Lock] (A 131), you can press the button to lock the current white balance 
settings set automatically by the camera. To cancel the lock, press the button again (resume auto white balance mode) 
or select a different white balance setting.
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The camera offers the following ways to focus, depending on the lens used. The camera incorporates Dual Pixel CMOS AF 
technology for advanced autofocus performance with compatible lenses. Refer to the list of compatible lenses and 
functions that can be used (A 246). 
Note that some methods allow you to operate aspects of the focus by touching the LCD screen.

Manual focus (MF): Turn the focus ring on the lens to adjust the focus. The camera offers several focus assistance 
functions (A 90) to help you focus more accurately when using the manual focus.

Automatic focus (AF): The focus is adjusted automatically.

- One-shot AF*: You will be able to focus manually but still have the option to press the AF-ON button to let the 
camera focus automatically once on the subject inside the AF area.

- Continuous AF*: The camera automatically keeps the subject inside the AF frame in focus at all times. You can use 
the AF lock function (A 93) to change the composition of the picture while keeping the focus on the selected spot.

Functions related to focus adjustment:

- Subject detection: Set a subject to be detected in advance to automatically detect the face/head, eyes or body of a 
person or an animal.

- Subject tracking: After you select a subject, the camera keeps focusing it and tracks the subject if it moves.

* Not available when a manual focus lens is attached to the camera.

Focus Mode on the Lens
Use the switch on the lens to select the lens’s focus mode (automatic, manual). The name of the controls may differ 
depending on the lens. Refer to the instruction manual of the lens used.
 

Set the lens’s focus mode to either automatic or manual.
• Either @ (automatic) or A (manual) will appear on the screen.
• When using a lens without a focus mode switch, select  > [v Camera Setup] > [Focus Mode] > [AF] 

(automatic) or [MF] (manual).

Manual Focus
Focus manually using the focus ring on the lens.

Turn the focus ring to adjust the focus.

NOTESNOTES
• With some lenses, you may be able to operate the focus ring even when the focus mode is set to automatic.
• If you operate the zoom after focusing, the focus on the subject may be lost.
• If you focus manually and then leave the camera with the power turned on, the focus on the subject may be lost after 

a while. This possible slight shift in focus is a result of the internal temperature rising in the camera and lens. Check the 
focus before resuming shooting.

• When adjusting the focus, be careful not to touch the front of the lens or moving parts on the lens except for the focus 
ring.
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Using the RF lens's focus ring
- You can change the direction of the adjustment when operating the focus ring with the  > [B System 

Setup] > [Focus Ring Dir.] setting.
- You can link the amount of focus adjustment when using the focus ring to either the rotation angle or the rotation 

speed  with the  > [B System Setup] > [Focus Ring Response] setting. 
- When the lens is set to autofocus, you can enable/disable manual adjustments with the  > [B System Setup] 

> [Focus Ring Operation] setting.

Using the Focus Assistance Functions

In order to focus more accurately, you can use the following focus assistance functions: Dual Pixel Focus Guide, an 
onscreen guide that shows you if the selected subject is in focus; peaking, which creates a clearer contrast by 
emphasizing the outlines of the subject; and magnification, which enlarges the image on the screen. You can use 
peaking and the focus guide or peaking and magnification simultaneously for greater effect.

Focus guide
The focus guide gives you an intuitive visual indication of the current focus distance and the direction and amount of 
adjustment necessary to bring the selected subject into full focus. When used in combination with subject detection 
(A 94), the guide will focus as follows: if set to [People] / [Animals], on the face (or body, if a face cannot be detected) of 
the subject. If [Eye Detection] is set to [On], the guide will focus on the vicinity of the eyes of the detected person or 
animal.

1 Set the focus mode on the lens to manual (A 89).

2 Using direct touch control (A 60), you can touch the [Focus Guide] switch to turn on/off the focus guide.
• Alternatively, you can use the  > [A Assistance Functions] > [Focus Guide] setting or an assignable button 

set to [Focus Guide], to display/hide the focus guide. 

3 Touch the point where you want to focus on the LCD screen to move the focus guide.
• You can also use the joystick to move the focus guide’s frame. Press SET or the CANCEL button to return the focus 

guide’s frame to the center of the screen.

4 Adjust the focus manually as necessary.
• When the focus guide turns green, the subject is correctly focused.

NOTESNOTES

• With subjects or in situations where autofocus may not work well (A 96), the focus guide may not work correctly.
• The focus guide cannot be used in the following cases:

- While the focus is being adjusted automatically using one-shot AF or continuous AF. 
- When a manual focus lens is attached to the camera, except for compatible RF/EF Cinema lenses (A 246).

In focus 
(in green)

Focus farther 
(large adjustment)

Focus farther 
(small adjustment)

Focus closer 
(small adjustment)

Focus closer 
(large adjustment)

Cannot determine 
adjustment
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Peaking
The camera offers two peaking levels.

1 Press the PEAKING button.
• The peaking icon (J or K) appears on the left of the screen and 

outlines (contour lines) in the image that are in focus will be shown 
highlighted.

• Press the button again to turn off peaking.
• You can use direct touch control (A 60) to turn the 

[Peaking 1]/[Peaking 2] setting on/off.
• Alternatively, you can use one of the  > [A Assistance 

Functions] > [Peaking:] settings to turn the peaking function on/off 
separately on the respective terminal/output destination.

2 To change the peaking level, select  > [A Assistance Functions] > 
[Peaking] > [Peaking 1] or [Peaking 2].

Magnification

1 Press the MAGN. button.
• ^ appears on the left of the screen and the center of the screen* is 

magnified 2 times.
• The orange frame displayed on the top right of the screen (magnification 

frame) shows the approximate part of the image shown magnified.
• Press SET to change the magnification setting in the following order: 

2x 5x 10x.

2 If necessary, use the joystick to move around the magnification frame and 
check other parts of the image.
• You can also drag your finger across the LCD screen to move the frame.
• Press the CANCEL button to return the magnification frame to the center position.
• Press the MAGN. button again to cancel the magnification.

* If one of the AF frames or a subject detection frame is displayed on the screen, the area around the active frame will be magnified instead.

NOTESNOTES
• About Peaking/Magnification:

- You can use the  > [A Assistance Functions] > [Peaking 1] and [Peaking 2] settings to set the color, gain and 
frequency of the two peaking levels independently of each other.

- You can use the  > [A Assistance Functions] > [Magn. Output] setting to select where to show the 
magnified image.

- The assistance functions will not affect your recordings.
- Magnification will be turned off if you change the video configuration (A 63) or turn  > [v Camera Setup] 

> [Digital IS] or [Digital Magnification Func.] on/off while the magnified image is displayed.
• Peaking/magnification are not available while the color bars are displayed.
• When  > [A Assistance Functions] > [B&W during Magn.] is set to [On], the screen is set to black and white 

during magnification. The assistance functions will not affect your recordings.
• When [Sensor Mode] is set to [Full Frame 3:2] and the recording format is set to XF-HEVC S YCC, the magnification 

factor is only 2x. During 4K HDMI output, magnification for HDMI output cannot be displayed.
• Magnification cannot be displayed under the following conditions.

- When [Sensor Mode] is set to [Full Frame] or [Super 35mm (Cropped)] and the slow & fast motion recording frame 
rate exceeds 60P.

• Peaking cannot be displayed under the following conditions.
- When [OSD Output: HDMI] is set to [Off ].
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One-Shot AF
In this focus mode, you will focus manually in most situations but still have the option to have the camera focus 
automatically only once on the subject inside the AF area. You can change the type and position of the AF area.

1 Set the focus mode on the lens to automatic (A 89).

2 If necessary, change the type and position of the AF area (A 93).

3 Press and hold the AF-ON button.
• As long as the assigned button is held down the camera will focus 

automatically.
• When correct focus has been achieved, a green frame is displayed.
• If [Continuous AF] is disabled and [Subject to Detect] is set to [None], the 

AF frame will disappear when you release the assigned button (after a 
certain time has passed).

Continuous AF
The camera will focus automatically on a subject inside the area of the selected AF area position/type (A 93).
For details on compatible lenses, refer to Compatible Lenses and Functions (A 246).

1 Set the focus mode on the lens to automatic (A 89).

2 Select  > [v Camera Setup] > [Continuous AF] > [Enable].
• A white AF frame will appear on the screen (if the AF area is set to an option other than [Whole Area]).
• When focusing nearer is not possible, the AF frame will turn red.
• If [Lens action if cannot AF] was set to [Stop], when distance measurement is not possible, the AF operation is 

stopped, the focus position is fixed and the AF frame becomes yellow. 

3 If necessary, change the type and position of the AF area (A 93).

NOTESNOTES
About the autofocus (AF) functions: 
• The point where the camera focuses may change slightly depending on shooting conditions, such as subject, 

brightness and zoom position. Check the focus before resuming shooting.
• Ensure in advance that the AF speed and subject switching sensitivity are suitable for the subject you wish to focus on.
• Autofocus may take longer in the following cases.

- With some lenses, the camera may take longer to focus automatically or may not be able to focus correctly. Visit your 
local Canon website for the latest information.

• You can change the adjustment speed and responsiveness of the autofocus function with the following settings. Visit 
your local Canon website for the latest information.
-  > [v Camera Setup] > [AF Speed] to set the AF speed (the speed at which the focus is adjusted) to one of 

10 levels.
-  > [v Camera Setup] > [Subj. Switching Sensitivity] to adjust the subject tracking sensitivity and how easily 

the focus changes. The higher the value, the easier it is to keep focusing on fast-moving subjects (with large changes 
in shooting distance) and to change focus.

- While using continuous AF, you can hold the AF-ON button pressed down to temporarily adjust the focus using the 
maximum AF speed. Used when you want to quickly achieve focus after a significant loss of focus.

• Continuous AF and one-shot AF will not work in the following cases. 
- When the shooting frame rate in slow & fast motion recording exceeds 150 (fps). 
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• Autofocus may not work well on the following subjects or in the following cases. In such case, focus manually.

- When using small apertures.
- When subjects at different distances appear in the picture.
- When an ISO speed or gain value in the extended range is selected (A 78).
- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture file (A 139) is set 

to an option other than [BT.709 Standard].
- When the main recording format is set to RAW.

AF Lock

While using continuous AF, you can lock the focus on a certain subject 
and then move the camera to change the composition. 

1 While the autofocus is active, press the AF LOCK button.
• The focus will be locked and @ and the AF frame will turn gray. 

When you are using subject detection, the frame around the 
main subject will turn gray.

• The frame displayed on the screen will be the focus guide frame if 
[Focus Guide] is set to [On].

• When you use a button assigned to [AF Lock (While Pressed)], the 
focus will only be locked while the button is held pressed down.

2 Press the AF LOCK button again to cancel the AF lock.

NOTESNOTES
AF lock will be canceled automatically in the following cases:

- If the camera is turned off or the camera’s system frequency is changed.
- If the lens is removed or replaced.
- If  > [v Camera Setup] > [Continuous AF] is changed to [Disable].
- When the shooting frame rate in slow & fast motion recording exceeds 150 (fps). 

Changing the AF Area Type and Position
You can change the type and position of the AF area that appears on the screen while using one of the autofocus 
functions. You can change the position and thickness of the AF area when the AF area is set to an option other than 
[Whole Area].

1 Select  > [v Camera Setup] > [AF Area] > Desired option.

• When one of the [Flexible Zone] options is selected, press the MENU button to adjust the position and size of the 
frame.

• When set to an option other than [Whole Area], the position of the AF area can be moved. Touch the LCD screen to 
move the AF area.

- Reflective surfaces
- Subjects with low contrast or without vertical lines
- Fast moving subjects

- Through dirty or wet windows
- Night scenes
- Subjects with a repetitive pattern

[Small Zone] [Flexible Zone 1] [Flexible Zone 2] [Flexible Zone 3] [Whole Area]



Focus

94

2 If you select an option other than [Whole Area], select  > [v Camera Setup] > [AF Frame Thickness] 
> Desired option.

NOTESNOTES

• When [Digital Magnification Func.] is enabled, the [Small Zone] frame will be displayed and the position will be [Center 
Frame]. The size of the AF area will change depending on the set magnification.

 Subject Detection Function
The subject detection function automatically detects the face/head, eyes or body* of a person or animal, according to 
the menu settings.
You can use subject detection with one of the autofocus functions to let the camera focus on the main subject 
automatically. You can use the focus guide (A 90) in combination to help you focus on the main subject manually. You 
can use the focus guide to adjust the focus on the main subject manually. You can also change the main subject.
* When tracking people or when detecting people in the AF area (whole area), the body of a person is detected when the face/head is 

hidden from view.

1 Select  > [v Camera Setup] > [Subject to Detect] > [People] or [Animals].
•  (People) or  (Animals) appears on the left side of the screen.

2 Select  > [v Camera Setup] > [Subj. Detect. AF] > [Detect. Priority] or [Detect. Only].
•  (detection priority) or  (detection only) will appear on the left of the screen.

3 Select  > [v Camera Setup] > [Eye Detection] > Desired option.
[Disable]: No eye detection.

[Auto]: Automatically selects the eye to be detected. Priority is given to eyes closer to the camera or closer to the 
center of the AF area.

[Right Eye Priority]: 
The subject's right eye is prioritized and detected.

[Left Eye Priority]: 
The subject's left eye is prioritized and detected.

4 Select  > [v  Camera Setup] > [Face Detection AE] > [On].

5 Point the camera at the subject.
• When [Subject to Detect] is set to [People], a frame is displayed on all detected people. When set to [Animals], a 

frame is displayed only the main subject (animals or people). The main subject is determined automatically and is 
displayed in white when using autofocus, and in gray or yellow* when using manual focus.
* When [Continuous AF] is enabled and [Lens action if cannot AF] was set to [Stop].

• When multiple subjects are detected, Ï and Ð are shown on the main subject frame. If [Subject to Detect] is set to 
[People], a gray frame is displayed on subjects other than the main subject. When Ï and Ð are shown, pressing 
the joystick to the left/right switches the main subject to another subject and tracking starts.

Options for [Subj. Detect. AF]
[Detect. Priority]: When a subject is not being detected, the camera determines the main subject and focuses on it.

[Detect. Only]: When a subject is not being detected, the camera locks the focus.

AF operation according to the [Subject to Detect] settings is as follows:

- Continuous AF: The camera continuously focuses on the subject it determines to be the main subject.
- One-shot AF: When you press a button assigned to [One-Shot AF], the camera focuses on the subject it determines 

to be the main subject.
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Operation by AF mode

NOTESNOTES

• Typical examples of subjects not correctly detected
- Faces extremely small, large, dark or bright in relation to the overall picture.
- Faces that are turned to the side, at a diagonal, partially hidden or upside-down.
- When the subject is blurred due to weather, the background, etc.

• The subject detection function cannot be used in the following cases.
- When the shutter speed used is slower than 1/30 (59.94 Hz recordings), 1/25 (50.00 Hz recordings) or 1/24 (24.00 Hz 

recordings or 59.94 Hz recordings with a 23.98P frame rate), except when slow & fast motion recording mode is 
activated.

- When the shooting frame rate for slow & fast motion recording is lower than 24P.
- When a manual focus lens is attached to the camera.
- When [Digital Magnification Func.] is set to an option other than [Off ].

• Subject Detection AF cannot be used in the following cases.
- When the shooting frame rate for slow & fast motion recording is lower than 24P or higher than 150P.

• Face detection AE cannot be used in the following cases.
- When shutter speed, ISO speed/gain and aperture are set to manual.

• The camera may mistakenly detect a subject other than the desired subject. In such case, set [Subject to Detect] to 
[None].

• If you set an assignable button to [Subject to Detect], [Subj. Detect. AF], [Eye Detection] or [Face Detection AE] 
(A 131), you can press the button to adjust those settings.

Tracking a Specific Subject

You can have the camera track other moving subjects that are not faces and also combine the tracking function with one 
of the autofocus functions to let the camera focus on the desired subject automatically.
To use the tracking function, you will need to set an assignable button to [Tracking] in advance.

1 Set an assignable button to [Tracking] (A 131).

2 Press the assignable button.
• The subject selection mark I will appear on the screen.
• Press the assignable button again or the CANCEL button to end the subject selection mode.

3 Select the subject you want to track.
• Touch the desired subject on the LCD screen. 
• You can press the joystick up, down, left, or right to move to the subject you want to track, and then press SET (or 

press the joystick itself ) to start tracking.

4 The I mark changes to a double frame £ (tracking frame) and the camera will start tracking the selected subject.
• To stop tracking the selected subject, press CANCEL.

AF mode Focus operation

Subj. Detect. AF

[Detect. Priority] [Detect. Only]

Subject detected No subject detected Subject detected No subject detected

Continuous AF: disabled
Manual focus Manual focus

One-shot AF in operation

Focus on the detected 
subject

Focus on the subject 
inside the AF area

Focus on the detected 
subject

Focus on the subject 
inside the AF area

Continuous AF: enabled
Automatic Manual focus

One-shot AF in operation Focus on the subject 
inside the AF area
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Subject Tracking Adjustment After Focus

After focusing manually on the desired subject, you can automatically track the subject using the [Track after Focusing] 
function. When there is no subject in focus, subject tracking is not performed and the AF operation is performed on the 
automatically detected subject. Available when Continuous AF is enabled.

1 Select  > [v Camera Setup] > [Track after Focusing] > Desired option.

2 Turn the focus ring to adjust as needed.

Options for [Track after Focusing]:
[On (tracking frame)]:

An orange frame for trackable subjects is displayed on the screen during focus operation. After the focus 
operation, the frame changes to a white double frame £ (tracking frame) to perform subject tracking.

[On (no tracking frame)]:
No frame for trackable subjects is displayed during focus operation. After the focus operation, a white double 
frame £ (tracking frame) is displayed to perform subject tracking.

[Disable]: The subject is not tracked. 

NOTESNOTES

• When the AF area is set to [Whole Area] or when [Tracking by Touch Priority] is enabled and the AF area is set to an 
option other than [Whole Area], during subject tracking, you can track a subject by touching the subject to be tracked 
on the LCD monitor. If [Subject to Detect] is set to [People] or [Animals] and  /  are added to the frame of the main 
subject, you can switch the main subject by pressing the joystick left or right and start tracking. 

• Even if [Subject to Detect] is set to [People] during tracking, frames are not displayed for subjects other than the main 
subject.

• The camera may start tracking the incorrect subject if there is another subject in the picture with similar color/pattern 
characteristics. In that case, select the desired subject again.

• Tracking cannot be used in the same cases in which the subject detection function cannot be used.
• Subject tracking after focus operation will not work in the following cases:

- When the shooting frame rate in slow & fast motion recording is lower than 24P or higher than 150P. 
- When [Digital Magnification Func.] is set to an option other than [Off ].
- When  > [B System Setup] > [Focus Ring Operation] is set to [Disable During AF].
- AF lock is enabled or the focus mode is set to MF.
- When there is no subject in focus on the screen.
- When operating the focus ring with a VR lens or a lens other than an RF lens attached to the camera.
- When operating the focus from a controller connected to the Remote control terminal with an attached lens that 

does not support tracking (A 246).
• In the following cases, you may not be able to select a subject or track the selected subject after focusing.

- When switching between multiple subjects at the same depth.
- In case of landscapes/distant subjects with a near identical depth.
- When the subject on the screen appears small.
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Image Stabilization
You can use the image stabilizer to compensate for camera shake and achieve steadier shots. The image stabilizer is more 
effective at wider angles and the effect is reduced the more you approach the telephoto end.

1 Select  > [v Camera Setup] > [Digital IS] > [On].
• When using lenses not compatible with camera-lens communication, perform step 4 to enter the lens’s focal length 

manually. 
• Image stabilization is activated and  appears on the left of the screen.
• You can also turn image stabilization on/off using an assignable button set to [Digital IS].

2 Select  > [v Camera Setup] > [Digital IS Mode] > Desired option.
•  (standard) or  (high) will appear on the screen.

3 Select  > [v Camera Setup] > [Motion Vector For Digital IS] > Desired option.

4 For lenses for which the focal length cannot be obtained, select  > [v Camera Setup] > [Lens Focal 
Length] and enter the lens’s focal length using the data entry screen.
• The image stabilization is adjusted according to the focal length entered.

5 When using an anamorphic lens, select  > [v Camera Setup] > [Anamorphic Corr.] > Squeeze factor 
to use to correct the image stabilization.
• If you selected [Lens Squeeze Factor], the anamorphic correction will be applied according to the squeeze factor 

specified with the  > [Æ Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.

Options for [Digital IS Mode]
[Standard]: Compensates for camera shake. The viewing angle is slightly reduced. 

[High]: Achieves stronger compensation for camera shake. The viewing angle is further reduced.

Options for [Motion Vector For Digital IS]
[Enable]: Image stabilization using camera shake information and motion vectors. This setting allows for very effective 

image stabilization.

[Disable]: Image stabilization using only camera shake information.

• When recording a subject (such as a person or an animal) with a large amount movement, enabling this setting may 
cause the image to shake along with the subject.

NOTESNOTES
• If the IS function is turned off on a lens, the camera’s image stabilization function is deactivated too and the  icon 

will flash on the left of the screen. When an RF-S lens is attached, select  > [v Camera Setup] > [Lens Optical 
IS] > [On] to turn on the image stabilization function of the lens.

• The camera’s image stabilization will stop if an assignable button set to [Pause Digital IS] is pressed (  or  are 
displayed in gray). The reduced viewing angle caused by the digital image stabilization function is maintained even if 
the function is paused. Pressing the assignable button again will start the camera's image stabilization. Lens image 
stabilization is not affected. You can pause or resume image stabilization while shooting.

• Depending on the subject and shooting conditions, subject blur may be more prominent (the subject may be 
momentarily blurred) due to the use of image stabilization. Selecting a fast shutter speed may produce better results.

• Turning off the camera’s image stabilization is recommended in the following cases:
- When using TS-E lenses and fisheye lenses
- When the camera is expected to be stable, for example when it is mounted on a tripod

• If the degree of camera shake is too high, the image stabilizer may not be able to compensate fully.
• The camera's image stabilizer will not function in the following cases: 

- When recording in RAW format
- When the sensor mode is [Full Frame 3:2]
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Zoom
When an EF/RF Cinema lens or EF1/RF2 lens that supports zoom adjustment is attached (A 246), you can control the 
zoom from the camera.
Additionally, you can select the digital tele-converter from the menu and move the focal length to the telephoto range 
(except when recording in RAW format).
1 Only lenses with the PZ-E1 Power Zoom Adapter attached.
2 Only lenses with the PZ-E2/PZ-E2B Power Zoom Adapter attached.

Zoom Modes of the Lens
Use the switch on the lens to select the lens’s zoom mode (for example, MANU. or SERVO). The name of the controls may 
differ depending on the lens. Refer to the instruction manual of the lens/accessory used.

Set the lens’s zoom mode to SERVO.
• Operating the zoom from the camera is enabled.

Adjusting the Optical Zoom
1 Enable SERVO zoom mode on the lens.

2 Select  > [v Camera Setup] > [Optical Zoom Speed] > [Zoom Speed] > Desired option.
• The [Zoom Speed] setting is applied to the camera's zoom lever, the lens's zoom ring and the handle's zoom lever.

Using the Camera's Zoom Lever

You can set two levels of zoom speed based on the zoom lever's movement.

1 Select  > [v Camera Setup] > [Optical Zoom Speed] > [Speed Level (Camera) ] > Desired option.
• Set the zoom speed level for the zoom lever when operated slightly (level 1). [1] is the slowest setting and [16] is the 

fastest.

2 Select  > [v Camera Setup] > [Optical Zoom Speed] > [Speed Level (Camera) ] > Desired option.
• Set the zoom speed level for the zoom lever when operated significantly (level 2).
• Adjusting towards T will zoom in (telephoto), while adjusting towards W will zoom out (wide-angle).

Using the Lens's Zoom Ring

When a lens that supports zoom ring speed adjustment from the camera is attached, you can set two levels of zoom 
speed for the zoom ring operation.

1 Select  > [v Camera Setup] > [Optical Zoom Speed] > [Speed Level (Lens) ] > Desired option.
• Set the zoom speed level for the zoom ring when operated slightly (level 1). [1] is the slowest setting and [15] is the 

fastest.

2 Select  > [v Camera Setup] > [Optical Zoom Speed] > [Speed Level (Lens) ] > Desired option.
• Set the zoom speed level for the zoom ring when operated significantly (level 2).
• Adjusting towards T will zoom in (telephoto), while adjusting towards W will zoom out (wide-angle).

Using the Handle's Zoom Lever

1 Select  > [v Camera Setup] > [Optical Zoom Speed] > [Speed Level (Handle)] > Desired option.
• Sets the zoom speed level when the zoom lever is operated. [1] is the slowest setting and [16] is the fastest setting.
• Adjusting towards T will zoom in (telephoto), while adjusting towards W will zoom out (wide-angle).
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NOTESNOTES
• When using slow zoom speeds, it may take longer for the lens to start moving.
• Depending on the lens, the zoom speed may not change even if the speed level is changed.

Using the digital magnification function
1 Select  > [v Camera Setup] > [Digital Magnification Func.] > Desired option.

[Tele-converter 3.0x]: The focal length is moved approximately 3.0 times to the telephoto side.

[Tele-converter 2.5x]: The focal length is moved approximately 2.5 times to the telephoto side.

[Tele-converter 2.0x]: The focal length is moved approximately 2.0 times to the telephoto side.

[Tele-converter 1.5x]: The focal length is moved approximately 1.5 times to the telephoto side.

[Digital Zoom]: Enables the digital zoom function.

[Off ]: Only optical zoom is used.

NOTESNOTES

• The digital magnification function is not available in the following cases:
- During RAW format recording.
- When a VR lens is attached.

Adjusting the Digital Zoom

Using the camera's zoom lever

You can set two levels of zoom speed based on the zoom lever's movement.

1 Select  > [v Camera Setup] > [Digital Zoom Speed] > [Speed Level (Camera) ] > Desired option.
• Set the amount of operation for the zoom lever when operated slightly (level 1). [1] is the slowest setting and [16] is 

the fastest.

2 Select  > [v Camera Setup] > [Digital Zoom Speed] > [Speed Level (Camera) ] > Desired option.
• Set the amount of operation for the zoom lever when operated significantly (level 2).
• Adjusting towards T will zoom in (telephoto), while adjusting towards W will zoom out (wide-angle).

Using the Handle's Zoom Lever

1 Select  > [v Camera Setup] > [Digital Zoom Speed] > [Speed Level (Handle)] > Desired option.
• Adjusting towards T will zoom in (telephoto), while adjusting towards W will zoom out (wide-angle).
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Onscreen Markers, Zebra Patterns and False Color
Using onscreen markers allows you to make sure your subject is correctly framed and is within the appropriate safe area. 
Zebra patterns help you identify areas that are overexposed. The false color overlay allows you to check if the exposure is 
correct. You can display the assistance overlays independently on the LCD monitor and HDMI OUT terminal. The 
assistance overlays will not affect your recordings.

Displaying Onscreen Markers
The camera offers several onscreen markers. You can display multiple onscreen markers simultaneously and select their 
color individually.

[Center Marker]: Displays a small marker that indicates the center of the screen. You can select the shape of the center 
marker.

[Horizontal Marker], [Vertical Marker]: Displays a horizontal or vertical line to help you compose level shots.

[Grid Marker]: Displays a grid that allows you to frame your shots correctly (horizontally and vertically).

[Aspect Marker]: Indicates various aspect ratios by displaying border lines or by masking the image outside the selected 
aspect ratio. The aspect ratio can be set freely by the user.

[Safe Area Marker]: Displays a margin from the edges of the image (using border lines or by masking the image) to 
indicate the action safe area, text safe area, etc. You can select the core area used as the basis for calculating the safe area 
and a percentage, relative to the side length.

[User Marker 1], [User Marker 2], [User Marker 3]: Displays up to three rectangular frames whose size and position you can 
set freely and independently of each other.

1 Select  > [A Assistance Functions] > Desired [Markers:] setting > [On].
• Onscreen markers will be displayed on the corresponding video output.
• You can also use direct touch control (A 60) to turn the [Markers: LCD] setting on/off.
• If the respective setting is set to [Off ], onscreen markers will not be displayed on the corresponding video outputs 

even if individual markers are configured.

2 Select the marker(s) you wish to display and configure them with the following procedures.
• You can display multiple markers simultaneously.

Center Marker / Horizontal Marker / Vertical Marker / Grid Marker

1 Select  > [A Assistance Functions] > [Center Marker], [Horizontal Marker], [Vertical Marker] or [Grid Marker] > 
Desired marker color.
• Select [Off ] to turn off the marker.

2 For [Center Marker] only: Select  > [A Assistance Functions] > [Center Marker Type] > Desired marker shape.

Aspect guide 4:3Center marker 
([Cross 1] type)

Grid marker

Horizontal marker

Safe area 88% by 
side length

User marker 
(100, 250)

Vertical marker
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Aspect Marker

1 Select  > [A Assistance Functions] > [Aspect Marker] > Desired marker color or transparency of the masked 
area.
• Select [Off ] to turn off the marker.

2 Select  > [A Assistance Functions] > [Marker Aspect Ratio] > Desired option.

3 For [Custom] only: Select  > [A Assistance Functions] > [Marker Custom Asp. Ratio] and enter the aspect ratio 
using the data entry screen (A 30).

NOTESNOTES

Aspect markers will not be displayed in the following cases. 
- When the resolution is set to 3840x2160 or 1920x1080 and the marker aspect ratio is set to [16:9].
- When the resolution is set to 4096x2160 or 2048x1080 and the marker aspect ratio is set to [1.90:1].
- The same applies when the same aspect ratio is set manually using [Custom].

Safe Area Marker

The safe area is displayed using a border line or by masking the image outside the safe area. It can be calculated as a 
percentage of the width/height.

1 Select  > [A Assistance Functions] > [Safe Area Marker] > Desired marker color/mask opacity level.
• Select [Off ] to turn off the marker.

2 Only when an aspect marker is already activated: Select  > [A Assistance Functions] > [Basis for Marker Safe 
Area] > [Whole Picture] or [Selected Aspect Marker].

3 Select  > [A Assistance Functions] > [Marker Safe Area %] > Desired percentage.
• You can select the margin as a percentage of the width/height [(Side Length)].

User Markers

You can set 3 individual user markers ([User Marker 1] to [User Marker 3]) and adjust their color, size and position 
separately.

1 Select  > [A Assistance Functions] > [User Marker 1], [User Marker 2] or [User Marker 3] > Desired marker color.
• Select [Off ] to turn off the marker.

2 Select  > [A Assistance Functions] > [User Marker 1 Settings], [User Marker 2 Settings] or [User Marker 3 
Settings] > [Size] > [Specification Method] > Desired option.

Options:
[Pixel]: Specify the number of pixels (width and height).

[Ref. Area & Aspect Ratio]:
Specify an aspect ratio for the reference area.

[Ref. Area & Magn. Ratio]:
Specify a magnification ratio for the selected reference area.

• Select the input value or setting value according to the selected specification method.

3 Select  > [A Assistance Functions] > [User Marker 1 Settings], [User Marker 2 Settings] or [User Marker 3 Settings] > [Position] > 
[Specification Method] > Desired option.
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Options:
[Center Coordinates], [Upper-left Coordinates]:

Sets the user marker reference coordinates to the center or the upper-left.

[Centering (User Marker 1)], [Centering (User Marker 2)]: 
Aligns the center with that of a user marker. Available options differ depending on the set user marker.

[Centering (Crop)]:
Sets the user marker reference coordinates to the center of the crop position.

• Select the input value or setting value according to the selected specification method.

When setting a method relative to other markers, such as [Reference Area] > [User Marker 1] to [User Marker 3] or 
[Centering (User Marker 1)] to [Centering (User Marker 2)], you can select the following markers for the reference:

- When [User Marker 1] is set: No reference marker can be selected
- When [User Marker 2] is set: [User Marker 1]
- When [User Marker 3] is set: Either [User Marker 1] or [User Marker 2] can be selected

NOTESNOTES
• You can choose the onscreen display level to turn off all other onscreen displays, leaving only the markers (A 56).
• If you set an assignable button to one of the [Markers:] settings (A 131), you can press the button to turn the markers 

on and off on the corresponding video output.
• In MEDIA mode, you can display the same markers as in CAMERA mode by selecting  > [A Assistance 

Functions] > [Playback Marker Display] > [Enable].

Displaying Zebra Patterns
The camera has a zebra pattern function that shows black and white diagonal stripes over areas that 
are overexposed. There are two types of zebra patterns and you can display both simultaneously. 
Zebra 1 lets you identify areas within a certain range (±5% of a specified level from 5% to 95%) while 
zebra 2 lets you identify areas that exceed a specified level (from 0% to 100%).

1 Select  > [A Assistance Functions] > [Zebra:] > Desired option
• You can also use direct touch control (A 60) to turn the [Zebra: LCD] setting on/off.
• Alternatively, you can press an assignable button set to one of the [Zebra:] settings (A 131), to turn the zebra 

pattern overlay on and off on the corresponding video output.

2 Select  > [A Assistance Functions] > [Zebra] > Desired option.

3 Select  > [A  Assistance Functions] > [Zebra 1 Level] or [Zebra 2 Level] > Desired option.
• [Zebra: HDMI] cannot be displayed under the following conditions.
- When [OSD Output: HDMI] is set to [Off ].

Displaying False Color
In CAMERA mode, you can display the false color overlay to check the brightness levels as different colors.

Select  > [A Assistance Functions] > Desired [False Color:] setting > [On].
• You can also use direct touch control (A 60) to turn the [False Color: LCD] setting on/off.
• Alternatively, you can press an assignable button (A 131) set to one of the [False Color:] settings to turn the false color 

overlay on and off on the corresponding output destination.

Zebra 1 Zebra 2
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NOTESNOTES

• You can use the  > [A Assistance Functions] > [False Color Index] setting to check an index (in English only) of 
the colors used in the false color overlay.

• Depending on the custom picture file settings, the color displayed might not be that of the correct brightness level.
• [False Color: HDMI] cannot be displayed under the following conditions.

- When [OSD Output: HDMI] is set to [Off ].

Color Meaning

Red White clipping

Yellow Just below white clipping

Pink One stop over 18% gray

Green 18% gray (medium gray)

Blue Just above black clipping

Purple Black clipping
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Setting the Time Code
The camera generates a time code signal and records it with the recorded clips. The time code signal can be output from 
the TIME CODE terminal or HDMI OUT terminal.
Depending on the frame rate used, you may be able to select between a drop frame an non-drop frame time code signal 
(A 105). The default mode varies depending on the country/region of purchase and, though the time code display style 
is different for DF and NDF, in this section the NDF display style is used for simplicity’s sake.

Selecting the Time Code Mode
You can select the camera’s time code mode.

Select  > [B System Setup] > [Time Code Mode] > Desired option.

Options

[Preset]: The time code starts from an initial value you can select in advance. The default initial time code is 00:00:00.00 
(00:00:00:00 for NDF).
See the following procedures to select the time code running mode and set the initial time code.

[Regen.]: The camera will read the selected card and the time code will continue from the last time code recorded on 
the card. The time code runs only while recording so clips recorded consecutively on the same card will have 
continuous time codes.

Setting the Time Code Running Mode

If you set the time code mode to [Preset], you can select the time code running mode.

Select  > [B System Setup] > [Time Code Run] > Desired option.

Options

[Rec Run]: The time code runs only while recording so clips recorded consecutively on the same card will have 
continuous time codes.

[Free Run]: The time code starts running the moment you confirm the selection and keeps running regardless of the 
camera’s operation.

Setting the Time Code’s Initial Value

If you set the time code mode to [Preset], you can set the initial value of the time code.

1 Select  > [B System Setup] > [Set Time Code] > [Change].
• The time code setting screen appears with an orange selection frame indicating the hours.
• To reset the time code to [00:00:00:00], select [Reset] instead. If the running mode is set to [Free Run], the time code 

will be reset the moment you confirm the selection and keep running continuously from 00:00:00:00.

2 Enter the initial time code using the data entry screen (A 30).
• If the running mode is set to [Free Run], the time code will start running from the selected time code the moment 

you confirm the selection.
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Selecting Drop or Non-Drop Frame
When the frame rate is set to 59.94P, 59.94i or 29.97P, you can select between a drop frame (DF) or non-drop frame (NDF) 
time code, depending on how you plan to use your recordings.
With all other frame rates, the time code is set to non-drop frame (NDF) and cannot be changed.

Select  > [B System Setup] > [Time Code DF/NDF] > Desired option.
• The time code display will change depending on the setting. When you select [DF], the time code will appear as 

[00:00:00.00]; when you select [NDF], it will appear as [00:00:00:00].

About the time code display
A letter may appear next to the time code depending on the setting/status. Refer to the following table.

Setting the User Bit
You can set a user bit composed of the date or the time of recording or an identification code consisting of 8 characters 
in the hexadecimal system. There are sixteen possible characters: the numbers 0 to 9 and the letters A to F.
The user bit is recorded with clips and can be output from the TIME CODE terminal/HDMI OUT terminal. It can be used 
freely to categorize and manage recordings or to keep additional information about them.

1 Select  > [B System Setup] > [User Bit Type] > [Setting], [Date] or [Time].
• If you select [Time] or [Date] the rest of the procedure is not necessary.

2 Select [Change].
• To reset the user bit to [00 00 00 00], select [Reset] instead.

3 Enter the user bit using the data entry screen (A 30).

NOTESNOTES
• The frames value of the time code runs from 0 to 23 (frame rate set to 23.98P or 24.00P), from 0 to 24 (frame rate set to 

25.00P, 50.00i or 50.00P), or from 0 to 29 (all other frame rates). However, if the frame rate is 23.98P/24.00P and 
> [B System Setup] > [HDMI Output Signal] is set to [1920x1080i] or [1280x720P], the frame count of the time 

code output to the HDMI OUT terminal runs from 0 to 29.
• When slow & fast motion recording / frame recording / interval recording is activated, you cannot select the [Free Run] 

running mode. Conversely, when pre-recording is activated, [Free Run] is set automatically and cannot be changed.
• When slow & fast motion recording / frame recording / interval recording is activated, the time code signal and user bit 

will not be output from any of the terminals.
• When you mix drop frame and non-drop frame time codes, there might be a discontinuity in the time code at the 

point where the recording starts.
• When you are using the [Free Run] running mode, the time code will continue running as long as the built-in backup 

battery has some charge left, even if you disconnect all other power sources.
• If you set an assignable button to [Time Code] (A 131), you can press the button to open the 

[B System Setup] menu page with the time code settings.
• With the  > [Æ Recording/Media Setup] > [HDMI Time Code] set to [On] you can output the time code signal 

and user bit from the HDMI OUT terminal (A 157).

Letter Description

R The time code mode is set to [Regen.].

P The time code mode is set to [Preset] and the running mode is set to [Rec Run].

F The time code mode is set to [Preset] and the running mode is set to [Free Run].

E The time code signal is coming from an external source.

No letter Time code during clip playback.
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Synchronizing with an External Device
You can use the camera’s TIME CODE terminal to synchronize this camera’s time code to an external signal. Using the 
same external time code signal with multiple cameras allows you to set up a multi-camera recording. You can output the 
time code signal from this camera to other cameras.

Connecting an External Device
When synchronizing a time code signal, connect the external device to the TIME CODE terminal on the camera.  Be sure 
to set the TIME CODE terminal to input or output in advance.

Connection diagram

Time Code Signal Input
An external SMPTE-standard LTC timing signal received from the TIME CODE terminal can be recorded as the time code. 
The user bit of the external timing signal can also be recorded with clips. Before connecting the device, set the TIME 
CODE terminal to input with the procedure below and make sure the time code running mode is set to [Free Run] 
(A 104).

1 Select  > [B System Setup] > [TC In/Out] > [In].

2 To record the external signal’s user bit, select also  > [B System Setup] > [User Bit Recording Mode] > 
[External].

NOTESNOTES

• Synchronize the camera’s time code with an external time code signal that matches the camera’s system frequency. 
Use a 24-frame time code signal when the frame rate is set to 23.98P or 24.00P, a 25-frame time code signal when it is 
set to 25.00P, 50.00i or 50.00P and a 30-frame time code signal for other frame rates.

• When a suitable external time code signal is received, the camera’s own time code will be synchronized to it and the 
synchronization will be maintained even if you disconnect the cable from the TIME CODE terminal.

• If the external time code signal is incorrect or there is no input signal, the internal time code set in the camera will be 
recorded instead.

• When an external time code signal is received, the DF/NDF selection will follow the external time code signal’s settings.
• If an external time code signal is input while pre-recording is activated, there might be a discontinuity in the time code 

of the pre-recorded clip.

Standard TC signal

TIME CODE terminal

DIN-BNC cable (commercially available)
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• Performing any of the following actions while the cable is not connected will cause the synchronization to be 
disrupted; the correct time code will be restored once you reconnect the cable.
- Turning the camera on/off
- Switching to MEDIA mode
- Changing the video configuration

Time Code Signal Output
The time code signal output from the TIME CODE terminal will be a SMPTE-standard LTC timing signal. The user bit will 
also be output.

Select  > [B System Setup] > [TC In/Out] > [Out].

NOTESNOTES

• About the user bit output: The user bit set by the user (A 105) will be output. In MEDIA mode, the user bit is not output 
from the TIME CODE terminal.

• The time code and user bit will not be output when slow & fast motion recording / frame recording / interval recording 
is activated.
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Recording Audio
The camera features the following options for audio recording and playback. You can record audio using an external 
microphone/line-in device (INPUT terminals* or MIC terminal), the built-in microphone, or an accessory compatible with 
the multi-function shoe.
The audio signal will be output with the video signal from the HDMI OUT terminal. You can record the audio signal on an 
external recorder.
* Only when the handle unit is attached.

Available audio recording formats

1 Audio for proxy clips is recorded in AAC format.
2 CH1 and CH2 audio is recorded.

Audio Settings and Recorded Audio Channels

When the handle unit is attached

Video format / audio recording function
Audio format

Codec
Sampling 
frequency

Bit depth
Number of audio 

channels
Bit rate

Video recording

RAW Linear PCM

48 kHz

24 bit 4 channels 4.5 Mbps

XF-AVC Linear PCM 24 bit 4 channels 4.5 Mbps

XF-HEVC S1

XF-AVC S1
Linear PCM 24 bit 4 channels 4.5 Mbps

AAC 16 bit 2 channels2 256 Kbps

Audio recording
For slow & fast motion recording Linear PCM 48 kHz 24 bit 4 channels 4.5 Mbps

For second card recording functions Linear PCM 8 kHz 16 bit 1 channel 128 Kbps

MIC terminal 
(external mic)

Required settings Recorded audio

Handle INPUT 
1/2 switch

INPUT 1/2 terminal sensitivity 
switch CH2 Input CH1 CH2 CH3 CH4

INPUT 1 INPUT 2

Connected ON MIC / 48V MIC / 48V INPUT 2 INPUT 1 MIC INPUT 2 MIC MIC terminal (L) MIC terminal (R)

Connected ON MIC / 48V LINE INPUT 2 INPUT 1 MIC INPUT 2 LINE MIC terminal (L) MIC terminal (R)

Connected ON LINE MIC / 48V INPUT 2 INPUT 1 LINE INPUT 2 MIC MIC terminal (L) MIC terminal (R)

Connected ON LINE LINE INPUT 2 INPUT 1 LINE INPUT 2 LINE MIC terminal (L) MIC terminal (R)

Connected ON MIC / 48V – INPUT 1 INPUT 1 MIC INPUT 1 MIC MIC terminal (L) MIC terminal (R)

Connected ON LINE – INPUT 1 INPUT 1 LINE INPUT 1 LINE MIC terminal (L) MIC terminal (R)

Connected ON MIC / 48V – MIC terminal INPUT 1 MIC MIC terminal (L+R) MIC terminal (L) MIC terminal (R)

Connected ON LINE – MIC terminal INPUT 1 LINE MIC terminal (L+R) MIC terminal (L) MIC terminal (R)

Not connected ON MIC / 48V MIC / 48V INPUT 2 INPUT 1 MIC INPUT 2 MIC Built-in Mic

Not connected ON MIC / 48V LINE INPUT 2 INPUT 1 MIC INPUT 2 LINE Built-in Mic

Not connected ON LINE MIC / 48V INPUT 2 INPUT 1 LINE INPUT 2 MIC Built-in Mic

Not connected ON LINE LINE INPUT 2 INPUT 1 LINE INPUT 2 LINE Built-in Mic

Not connected ON MIC / 48V – INPUT 1 INPUT 1 MIC INPUT 1 MIC Built-in Mic

Not connected ON LINE – INPUT 1 INPUT 1 LINE INPUT 1 LINE Built-in Mic

Not connected ON MIC / 48V – Built-in Mic INPUT 1 MIC Built-in Mic Built-in Mic

Not connected ON LINE – Built-in Mic INPUT 1 LINE Built-in Mic Built-in Mic

Connected OFF – – – MIC terminal (L) MIC terminal (R) Built-in Mic

Not connected OFF – – – Built-in Mic Built-in Mic
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When the handle unit is not attached

NOTESNOTES
• You can press an assignable button set to [Audio Status] to display only the [¡ Audio Setup] status screens. On these 

status screens you can check the input source selected for each audio channel and other audio-related settings. You 
can also check  > [¡ Audio Setup] > [Audio Status].

Audio Format for XF-HEVC S / XF-AVC S Clips
Select the audio recording format for XF-HEVC S / XF-AVC S clips (primary clips or sub recording clips).

Select  > [ÆRecording/Media Setup] > [  /  Main Audio] or [   /  Audio] > 
Desired option.

MIC terminal 
(external mic)

Accessory compatible 
with the multi-function shoe

Recorded audio

CH1 CH2 CH3 CH4

Connected Connected Multi-function shoe MIC terminal (L) MIC terminal (R)

Not connected Connected Multi-function shoe Built-in Mic

Connected Not connected MIC terminal (L) MIC terminal (R) Built-in Mic

Not connected Not connected Built-in Mic Built-in Mic
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Connecting an External Microphone or External Audio Input Source to the Camera
To each of the INPUT terminals you can attach commercially available microphones or analog line in sources with an XLR 
connector. To the MIC terminal you can attach commercially available condenser microphones/line-in devices (analog) 
with a ∅ 3.5 mm stereo mini plug.
Using the supplied microphone holder, you can fix external microphones with a diameter of 19 mm to 20 mm. Before 
using the INPUT terminals or the microphone holder, attach the handle unit and microphone holder (A 36, 37).

1 To use a microphone, loosen the microphone lock 
screw ( ), open the microphone holder and insert the 
microphone ( ).

2 Tighten the lock screw ( ) and put the microphone 
cable through the cable clamp.

3 When using any INPUT terminal, set the handle INPUT 
1/2 switch to ON ( ), the corresponding INPUT 1/
INPUT 2 sensitivity switch to a position other than 
MIC+48V ( ).

4 Plug the microphone/external line-in device cable into 
the desired INPUT terminal or the MIC terminal ( ).

IMPORTANT
• Do not connect or disconnect microphones and other audio devices from any INPUT terminal when the 

corresponding INPUT sensitivity switch is set to the MIC+48V position. This may damage the camera and/or device.

Microphone lock screw

MIC terminal

Cable clamp

INPUT 2 terminal

INPUT 1 terminal

INPUT 1 / INPUT 2 switches 
(sensitivity switch)

Handle INPUT 1/2 switch



111

Recording Audio

Selecting the Input Type for the INPUT 1/INPUT 2 Terminals

Change the position of the corresponding INPUT sensitivity switch according to the audio device connected to the 
INPUT 1/INPUT 2 terminals.

Set the INPUT 1 or INPUT 2 sensitivity switch to LINE, MIC, or MIC+48V.
• When using the INPUT terminals to record to only one channel, use the INPUT 1 terminal.

IMPORTANT
• When using a microphone that requires phantom power, turn off the camera and set the respective INPUT sensitivity 

switch to MIC. After connecting a +48V compatible microphone, switch the INPUT switch to MIC+48V.
• To connect a microphone or other audio device that is not compatible with phantom power to an INPUT terminal, 

make sure the respective INPUT sensitivity switch is set to LINE or MIC. Setting the switch to MIC+48V may damage the 
audio device.

Selecting the Input Type for the MIC Terminal

Change the setting according to the audio device connected to the MIC terminal.

1 Select  > [¡ Audio Setup] > [MIC Terminal] > [MIC Input]

2 Select [MIC (with Power Supply)] or [LINE]
• Select [MIC (with Power Supply)] to supply plug-in power to the external microphone.

Selecting the Audio Input Source for Audio Channels
For details on recorded audio,  refer to the Audio Settings and Recorded Audio Channels table (A 108).

Recording the Same Analog Audio Input to Two Channels

By default, each audio input is recorded to a separate audio channel (INPUT 1 to CH1 and INPUT 2 to CH2).
If necessary audio from the INPUT 1 terminal can be recorded on both CH1 and CH2 (CH2 as backup). In that case, you 
can adjust the audio recording levels of each channel independently of each other.

Select  > [¡ Audio Setup] > [CH2 Input] > Desired option.

Options
[INPUT 2]: Records audio to each channel separately. Audio input into INPUT 1 is recorded to CH1, while audio input into 

INPUT 2 is recorded to CH2.

[INPUT 1]: Audio input into INPUT 1 is recorded to both channels. Audio input into INPUT 2 will not be recorded.

[Built-in Mic] / [MIC Terminal]:
Audio input into INPUT 1 is recorded to CH1, while audio input to the built-in microphone and the MIC 
terminal is recorded to CH2.

Selecting the Input Audio Mode for the Built-in Microphone

Switch the built-in microphone settings according to the intended use.

1 Select  > [¡ Audio Setup] > [Built-in Mic] > [Mic Mode] > Desired option.
[Normal]: Audio suitable for recording clips (stereo).

[Voice Memo]: Audio suitable for recording voice memos (monaural).

[Off ]: Sound is not recorded from the built-in microphone (muted).
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2 If set to [Normal], select [Mic Sensitivity] > Desired option.
[Normal]: Records sound at normal level.

[High]: Records at a higher volume (+6dB).

NOTESNOTES

• The operating noise of the camera's cooling fan and lens may be recorded by the built-in microphone. Before using the 
built-in microphone, it is recommended to take a test shot to check the sound quality.

Adjusting the Audio Recording Level
You can adjust the audio recording level of the INPUT terminals/MIC terminal/built-in microphone. You can select 
automatic or manual audio level adjustment, and adjust each audio channel separately or adjust CH1/CH2 or CH3/CH4 
together (when the audio level adjustment of the audio channels is linked, A 113).

Using the Menu to Adjust the Audio Level for Each Channel

If the handle unit is not attached, you can adjust audio levels from the menu.

1 Select  > [¡ Audio Setup] > [Audio Rec Level] > Desired option.
• Use Ï/Ð to choose the desired option.
- Select [A] (automatic) to adjust the audio level automatically.
- Select [M] (manual) to manually adjust the audio level using Ï/Ð.

Automatic Audio Level Adjustment for CH1, CH2 or CH1/CH2

Set the audio level switch of the desired channel to A 
(automatic) to let the camera automatically adjust that 
channel’s audio level.

CH1/CH2 audio level switches
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Manual Audio Level Adjustment for CH1, CH2 or CH1/CH2

You can set the audio level manually from –  to +18 dB.

1 Set the audio level switch of the desired channel to M 
(manual).

2 Turn the corresponding audio level dial to adjust the 
audio level.
• For reference, the 0 corresponds to – , 5 

corresponds to 0 dB, and 10 corresponds to +18 dB.
• As a guideline, adjust the audio recording level so that 

the audio level meter on the screen will go to the right 
of the –18 dB mark (one mark right of the –20 dB 
mark) only occasionally.

NOTESNOTES
• We recommend using headphones when adjusting the audio level. If the input level is too high, audio may become 

distorted even if the audio level indicator shows an appropriate level.
• If you set an assignable button to [Audio Level Indicator] (A 131), you can press the button to turn the onscreen 

audio level indicator on and off.
• When the optional the Canon DM-E1D Multi-Function Shoe Directional Stereo Microphone is attached, adjustment 

with the audio level switch is also possible. In this case, CH1 settings are also applied to CH2.

Automatic Level Control (ALC): Linking the audio level adjustment of CH1/CH2 or CH3/CH4
• When both CH1 and CH2, or CH3 and CH4, are set to the MIC terminal or INPUT terminals and to the same type of 

analog audio source (external line input or external microphone), you can use the  > [¡ Audio Setup] > 
[CH1/CH2 ALC Link] or [CH3/CH4 ALC Link] setting to link the audio level adjustment of both channels.

• When CH1 and CH2 are linked, you can use the CH1 audio level switch and dial to affect both CH1 and CH2. When 
CH3 and CH4 are linked, you can use the [Audio Rec Level] settings to affect both CH3 and CH4. 

Audio peak limiter
• You can set  > [¡ Audio Setup] > [Audio Limiter] to [On] to activate the audio limiter to limit the amplitude 

of audio input signals when they start to distort.

Audio compressor
• With the following settings, when the input signal level exceeds the reference sound, the audio signal will be 

attenuated and the dynamic range will be compressed and recorded.

Select  > [¡ Audio Setup] > [Audio Compressor] > Desired option.
[High]: Increases the compression amount by setting the reference sound to a level lower than the standard.

[Low]: Decreases the compression amount by setting the reference sound to a level higher than the standard.

[Off ]: Turns compression off.

Changing the level adjustment target for CH2
• With the following setting, you can change the adjustment target of the CH2 recording level switch and audio level 

dial.

Select  > [¡ Audio Setup] > [Assign CH2 Switch & Dial] > [On].

CH1/CH2 audio level dials

CH1/CH2 audio level switches
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Advanced Audio Input Settings
You can adjust the audio input settings for the INPUT terminals/MIC terminal/built-in microphone. The corresponding 
menu settings become available only when the respective audio input is active and the following conditions are met:
INPUT terminals: INPUT 1 or INPUT 2 sensitivity switch is set to MIC or MIC+48V
MIC terminal: [MIC Input] is set to [MIC (with Power Supply)]
Built-in microphone: input is set to [Normal].

Microphone Sensitivity (INPUT Terminals)

You can select the external microphone’s sensitivity.

Select  > [¡ Audio Setup] > [INPUT Terminals (Handle)] > [INPUT 1 Mic Trimming] or [INPUT 2 Mic 
Trimming] > Desired sensitivity level.
• You can select one of 5 sensitivity levels from –12 dB to +12 dB.

Microphone Attenuator (INPUT Terminals/MIC Terminal/Built-in Microphone)

You can activate the microphone’s attenuator (20 dB).

INPUT Terminals: Select  > [¡ Audio Setup] > [INPUT Terminals (Handle)] > [INPUT 1 Mic Att.] or 
[INPUT 2 Mic Att.] > [On].

MIC Terminal: Select  > [¡ Audio Setup] > [MIC Terminal] > [Attenuator] > [On].

Built-in Microphone: Select  > [¡ Audio Setup] > [Built-in Mic] > [Attenuator] > [On].

Low-Cut Filter (INPUT Terminals/MIC Terminal)

You can select the characteristics of the microphone according to the sound to be recorded.

INPUT Terminals: Select  > [¡ Audio Setup] > [INPUT Terminals (Handle)] > [INPUT 1 Mic Low Cut] or 
[INPUT 2 Mic Low Cut] > Desired option.

MIC Terminal: Select  > [¡ Audio Setup] > [MIC Terminal] > [Low Cut] > Desired option.

Options
[Off ]: For recording audio under usual conditions.

[LC1]: For recording mainly people’s voices.

[LC2]: For reducing the background sound of wind when recording outdoors in windy surroundings (for example, 
on a beach or close to buildings). Note that when you use this setting some low-frequency sounds may be 
suppressed along with the sound of wind.

Changing the Reference Level of the External Microphone (INPUT Terminals) 

You can select the reference level of each INPUT terminal (–18 dB or –20 dB).

Select  > [¡ Audio Setup] > [INPUT Terminals (Handle)] > [Reference Level] > Desired option.

Selecting the Frequency Characteristic of the Built-in Microphone

You can select the frequency characteristic of audio input from the built-in microphone.

Select  > [¡ Audio Setup] > [Built-in Mic] > [Frequency Characteristic] > Desired option.

Options
[Normal]: Produces a balanced recording.

[Low-Freq. Enhancement]: 
Emphasizes the low frequencies for powerful recordings.

[Low-Freq. Cut]: Reduced low-frequency environmental sounds such as wind, noise, and vehicle sounds.
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[Mid-Freq. Enhancement]: 
Records focusing on human voices.

[Low-High-Freq. Enhanc.]: 
Improves the clarity of the sound when recording music (concerts, etc.).

Selecting the Directionality of the Built-in Microphone

You can select the directionality of audio input from the built-in microphone.

Select  > [¡ Audio Setup] > [Built-in Mic] > [Directivity] > Desired option.

Options
[Monaural]: Monaural recording focusing on the sound in front of the microphone.

[Normal]: Standard 2-channel recording settings, between [Wide] and [Monaural].

[Wide]: 2-channel recording that emphasizes the spread of sound. Use this setting to enhance the sense of realism.

Multi-Function Shoe Audio Input Settings
You can adjust the audio settings for the DM-E1D Directional Stereo Microphone attached to the multi-function shoe. 
The corresponding adjustment function become available only when the audio input is active. Refer to the DM-E1D 
instruction manual for more information and details on connections.

Microphone Attenuator (DM-E1D Directional Stereo Microphone)

You can activate the microphone attenuator for a shoe microphone attached to the multi-function shoe (20 dB). 

Select  > [¡ Audio Setup] > [Shoe Mic] > [Attenuator] > [On].

Low Cut (DM-E1D Directional Stereo Microphone)

You can choose the characteristics of the shoe microphone according to the recorded audio.

Select  > [¡ Audio Setup] > [Shoe Mic] > [Low Cut] > Desired option.

Options
[Off ]: For recording audio under usual conditions.

[On]: For reducing the background sound of wind when recording outdoors in windy surroundings (for example, 
on a beach or close to buildings). Note that when you use this setting some low-frequency sounds may be 
suppressed along with the sound of wind.

Microphone Directionality (DM-E1D Directional Stereo Microphone)

Select  > [¡ Audio Setup] > [Shoe Mic] > [Directionality] > Desired option.

Options
[Shotgun (Monoaural)]: 

Captures clear audio from the front of the microphone.

[90°(Stereo)]: Captures suitable audio from both the front and the sides of the microphone.

[120°(Stereo)]: Captures audio from a wider angle. 
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Monitoring the Audio with Headphones
Connect headphones with a ∅ 3.5 mm stereo mini-plug to the × (headphone) 
terminal to monitor the recorded audio.

NOTESNOTES
• You can adjust the headphone volume with the  > [¡ Audio Setup] > 

[Headphone Volume] setting. If you set an assignable button to [Headphones +] 
or [Headphones –] (A 131), you can press the button to adjust the headphone 
volume without using the menu.

× (headphone) terminal
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Colors Bars/Audio Reference Signal
You can have the camera generate color bars and a 1 kHz audio reference signal and output them from the following 
terminals.

Color Bars
The camera offers SMPTE, EBU and ARIB color bars.

1 Select  > [v Camera Setup] > [Color Bars] > [On].
• The selected color bars appear on the screen.

2 Select  > [v Camera Setup] > [Color Bar Type] > Desired option.
• The selected color bars will be recorded when you press the REC button.
• Turning off the camera or changing the operating mode to MEDIA mode will deactivate the color bars.

NOTESNOTES

• If you set an assignable button to [Color Bars] (A 131), you can press the button to turn the color bars on/off.
Color bars cannot be displayed in the following cases: 

- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to an option 
other than [BT.709 Wide DR], [BT.709 Standard] or [Canon 709].

- When recording in RAW format.
- When [Sensor Mode] is set to [Full Frame 3:2].
- When [2nd Card Rec Functions] is set to [  Main /  Crop Rec].

Audio Reference Signal
The camera can record a 1 kHz audio reference signal with the color bars.

Select  > [¡ Audio Setup] > [1 kHz Tone] > Desired option.
• You can select one of three audio levels (–12 dB, –18 dB, –20 dB), or [Off ] to turn off the signal.
• The reference signal will be output at the selected level when you display the color bars, and will be recorded when 

you press the REC button.

LCD monitor HDMI OUT terminal × (headphone) terminal

Color bars Ü Ü –

Audio reference signal – Ü Ü
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Video Scopes
The camera can display a simplified waveform monitor or a vectorscope to check your recordings. The selected video 
scope is displayed on the LCD monitor and can be output to other monitoring devices as well.

Displaying a Video Scope
Choose between a waveform monitor or a vectorscope. You can also 
change opacity, position and waveform monitor size settings.

1 Select  > [A Assistance Functions] > 
[WFM Function] > [Waveform Monitor] or [Vectorscope].

2 Press the WFM button.
• Alternatively, you can use one of the  > [A Assistance 

Functions] > [WFM:] settings to turn the video scope on/off 
separately on the desired video output.

• By default, the video scope will appear on the right of the screen. 
Using the  > [A Assistance Functions] > [Waveform 
Settings] or [Vectorscope Settings] > [Position] settings, you can select where to display it (left or right side).

• You can also use direct touch control (A 60) to turn on/off the display of video scopes, or to change their position.

3 If needed, select  > [A Assistance Functions] > [WFM Opacity Level] > Desired option.
• The smaller the percentage the more transparent the onscreen displays.

NOTESNOTES

• The waveform monitor will not be affected even if a view assistance function is applied to the image, the range is 
changed or anamorphic desqueeze is used on the selected video output or screen.

• The video scopes will also be displayed while adjusting a custom picture file's image settings (A 136).

Changing the Waveform Monitor Settings
1 Select  > [A Assistance Functions] > [Waveform Settings] > [Type] > Desired option.

• If you selected an option other than [Select Line], skip to step 4.

2 Select  > [A Assistance Functions] > [Waveform Settings] > [Select Line].

3 Enter the Y coordinate of the red horizontal line to display using the data entry screen (A 30).
• The available range of lines that can be selected depends on the vertical component of the resolution used.

For 2160 and over: 0 to maximum value, minus 2 lines (in 2-line increments)
Example: 0 to 2158 (for 2160)

Below 2160: 0 to maximum value, minus 1 line (in 1-line increments)
Example: 0 to 1079 (for 1080)

4 Select  > [A Assistance Functions] > [Waveform Settings] > [Vertical Scale for HDR] > Desired 
option.
• Select the Y axis (luminance) scale used when displaying the waveform monitor of an HDR image.

5 If needed, touch the waveform monitor on the screen to change its display size (only for LCD).
• You can also select  > [A Assistance Functions] > [Waveform Settings] > [Size: LCD] > Desired option.



119

Video Scopes

Options for [Type]
[Line]: Sets the waveform monitor to line display mode.

[Line+Spot]: The waveform of the area in the red frame is displayed in red on top of the [Line] mode waveform.

[Select Line]: The selected horizontal line (in red) will be displayed along with its waveform.

[RGB]: Shows 3 side-by-side waveforms in an RGB parade.

[YPbPr]: Shows 3 side-by-side waveforms in a YPbPr parade.

Options for [Vertical Scale for HDR]
[IRE]: Displays the video scope in IRE units.

[PQ/HLG]: For HDR-PQ images, the video scope can be displayed in nits (cd/m2) (including when the gamma curve after 
applying the Look File is set to [PQ]).
For HDR-HLG images, the Y axis can display relative-index value between 0 and 1000 nits (including when the 
gamma curve after applying the Look File is set to [HLG]). 

NOTESNOTES

• If the waveform monitor is activated and the  > [/ Custom Picture] > [Edit / File] > [Knee] > [Point] setting 
is changed, when you display the waveform monitor, a horizontal line will appear indicating the luminance (Y) level* 
corresponding to the knee point.
 * When a Look File registered to the custom picture file is active, the displayed luminance may not be at the correct level.

• When the waveform monitor’s Y axis is set to display in IRE units, a level of 10 bit 64 maps to 0 IRE and 10 bit 940 maps 
to 100 IRE, regardless of the custom picture settings.

• During crop recording, the waveform is displayed for the entire image in CAMERA mode, and displayed for the crop 
area in MEDIA mode.

Changing the Vectorscope Settings
1 Select  > [A Assistance Functions] > [Vectorscope Settings] > [Type] > Desired option.

2 Touch the onscreen vectorscope to switch its magnification rate between [1x] and [2x].
• You can also select  > [A Assistance Functions] > [Vectorscope Settings] > [Gain] > Desired option.

Options for [Type]
[Normal]: Displays the usual vectorscope.

[Spot]: The color signal of the area in the red frame is displayed in red on top of the [Normal] mode waveform.

NOTESNOTES
• During crop recording, the waveform is displayed for the entire image in CAMERA mode, and displayed for the crop 

area in MEDIA mode.
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Adding Marks to Clips in CAMERA Mode
When the recording format is set to XF-AVC, while recording, you can add shot marks (!) to flag an important shot or 
frame. After recording a clip, you can add an OK mark ($) or check mark (%) to help you identify particular clips. 
You can add and delete marks also in MEDIA mode (A 152, 153). 
Marks cannot be added to proxy clips.

Adding a Shot Mark while Recording
To add a shot mark to a clip while recording, you must set an assignable button to [Add Shot Mark] in advance.
 

1 Set an assignable button to [Add Shot Mark] (A 131).

2 While you are recording, press the assignable button at the beginning of the shot you wish to mark.
• [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.

NOTESNOTES

• Up to 100 shot marks can be added to a single clip.
• There may be up to a 0.5 second delay from when you press the button to when the camera adds the shot mark.
• When a clip contains a shot mark, ! will appear next to the clip’s thumbnail in the playback index screen.
• You cannot add a shot mark before pressing the REC button (start/stop recording) when pre-recording is activated, or 

during interval recording/frame recording.

Adding an $ Mark or % Mark to the Last Clip Recorded
$ marks can be used to protect important clips, as clips with an $ mark cannot be deleted with the camera.
To add a mark in CAMERA mode, you must set an assignable button to [Add $ Mark] or [Add % Mark] in advance.

1 Set an assignable button to [Add $ Mark] or [Add % Mark] (A 131).

2 After recording a clip, press the assignable button.
• [$Mark] or [%Mark] will appear briefly and the selected clip mark will be added to the clip.

NOTESNOTES
• A clip cannot have both an $ mark and a % mark at the same time.
• When a clip has an $ mark or % mark, the respective icon will appear next to the clip's thumbnail in the playback 

index screen.
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Using Metadata
In CAMERA mode, when the recording format is set to XF-AVC / XF-AVC S / XF-HEVC S, the camera automatically adds 
metadata to the recorded clips. You can use Canon XF Utility to check and search for specific metadata. 

Metadata components

1 User memo files need to be created using the software and saved on an SD card in advance.
2 Only when a GP-E2 GPS Receiver is connected to the camera. While recording, GPS information is recorded automatically by the camera.
3 GPS information can only be added to clips already recorded.
4 Only in CAMERA mode.
5 Recording data is logged automatically by the camera.

Setting a User Memo Created with Canon XF Utility
Before you can add a user memo, you must first install Canon XF Utility (A 163). Next, create the user memo and then 
save it to an SD card. Once you insert the SD card in the camera and select the user memo, it will be added to clips you 
record. User memos cannot be added to clips when the main recording format is RAW.

1 Use Canon XF Utility to save a user memo to an SD card.
• User memo files are saved to the “/XMLCMF” folder in the SD card. For details, refer to Managing User Memo Profiles in 

the Canon XF Utility Instruction Manual.

2 Insert the SD card into the camera’s card slot 2.

3 Select  > [Æ Recording/Media Setup] > [Metadata] > [Add XML File] > [On].

4 Select  > [Æ Recording/Media Setup] > [Metadata] > [XML File Format] > [User Memo]. 

5 Select  > [Æ Recording/Media Setup] > [Metadata] > [User Memo] > Desired user memo file.
• Select [Off ] to record clips without a user memo.

NOTESNOTES
• After you set a user memo, do not remove the card while you are recording. If the SD card is removed, the user memo 

will not be added to the clip.
• You must set the user memo before you start recording for it to be added to the clips. You cannot change the user 

memo already added to a clip using the camera but you can do so with Canon XF Utility.

Metadata

Entering content Checking content

Camera
Canon XF 

utility

Content 
Transfer 

Professional
Camera

Canon XF 
utility

Content 
Transfer 

Professional

User Memo: clip title, creator, location and description. – Ü1 – Ü Ü –

GPS information: altitude, latitude and longitude. Ü2 Ü3 – Ü Ü –

Information about the recording: scene and take. Ü – – Ü4 Ü –

Information about camera settings: shutter speed, ISO speed/gain 
value, etc.

–5 – – Ü Ü –

Unique Material Identifiers (UMID): country, organization and user 
codes based on the SMPTE standard.

Ü
(A 195) – – Ü4 – –

News Metadata (A 122) – – Ü Ü – Ü
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Using News Metadata
When recording, you can add News Metadata* to the recorded clips. Using Content Transfer Professional, you can check 
and edit News Metadata files. The most recently set News Metadata will be prioritized and added. News Metadata cannot 
be added to clips when the main recording format is RAW. See the following table for details on News Metadata settings.
* Refers to a metadata file compliant with the DPP002 Metadata Exchange for News recommendation ver. 1.1.1.

NOTESNOTES
• News Metadata files with file names that exceed 64 characters (extension included) cannot be used.

Setting News Metadata saved on an SD card

Before setting News Metadata, create a News Metadata file and save it to an SD card. Once you insert the SD card into the 
camera, select the News Metadata file and start recording. The News Metadata will be added to the recorded clips.

1 Save the News Metadata file to an SD card.
• News Metadata files should be saved in the “/XMLTAG” folder of the SD card.

2 Insert the SD card into the camera’s card slot 2.

3 Select  > [Æ Recording/Media Setup] > [Metadata] > [Add XML File] > [On].

4 Select  > [Æ Recording/Media Setup] > [Metadata] > [XML File Format] > [News Metadata].

5 Select  > [Æ Recording/Media Setup] > [Metadata] > [News Metadata] > Desired News Metadata 
file saved to the SD card.
• The selected News Metadata file will be saved to the camera.

NOTESNOTES

• You cannot change the News Metadata already added to a clip using the camera but you can do so using Content 
Transfer Professional.

Setting News Metadata edited with Content Transfer Professional

Before setting News Metadata, edit the News Metadata file using Content Transfer Professional. Connect the camera to a 
smartphone using the smartphone application (A 164, 187) to transfer and save News Metadata files from a 
smartphone to the camera. News Metadata will be added to the recorded clips.

1 Smartphone: edit and save the News Metadata file with Content Transfer Professional.

2 Connect the camera to a smartphone.

3 Operate Content Transfer Professional to load the News Metadata file and transfer it to the camera.

News Metadata
Entering content Checking content

Camera
Content Transfer 

Professional
Camera

Content Transfer 
Professional

Story Title, Description, Keyword (Tags), Category, Contributor, Source/Originator, 
Copyright Holder, Restrictions.

– Ü Ü Ü

Genre – Ü – Ü

Language – – – Ü
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4 Save the News Metadata to the camera.
• News Metadata files transferred from a smartphone will be saved automatically to the camera. 
• Automatically,  > [Æ Recording/Media Setup] > [Metadata] > [Add XML File] will be set to [On], and [XML 

File Format] will be set to [News Metadata].
• Only the most recently transferred file can be saved.

Resetting News Metadata

You can reset the News Metadata added to clips.

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [News Metadata Reset All].

2 Select [OK].

IMPORTANT

• When the camera is turned off normally, the News Metadata file is saved or a previously saved News Metadata is reset. 
In the case of a power outage or if the power is not terminated normally the file will not be saved or reset.

• News Metadata saved to the camera will be reset if you select  > [B System Setup] > [Reset] > [All Settings], or 
if the camera’s firmware is updated.

Entering Slate Information About the Recording
You can enter scene and take information to help identify the recording later on.

1 Select  > [Æ Recording/Media Setup] > [Metadata] > [Scene] or [Take] > [Change]. 

2 Enter the desired text using the keyboard screen (A 30).
• To clear the scene/take information, select [Reset] instead.
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Special Recording Modes
The camera features the following special recording modes.

Slow & Fast Motion Recording
The camera can record using a frame rate* (shooting frame rate) that is different from the playback frame rate. Recording 
a clip with a shooting frame rate higher than the [Frame Rate] setting will result in a slow motion effect during playback. 
Conversely, a lower shooting frame rate will result in a fast motion effect.
Sound is not recorded with the clip, but it can be recorded separately as a WAV file.  For details on the frame rates that can 
be set for slow & fast motion recording, refer to Recording / Output Signal and Detailed Settings (A 206).
* Progressive format.

1 To record audio, insert an SD card into the card slot where video is not being recorded.

2 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Slow & Fast Motion] or [S&F Clip/Audio 
(WAV)].
• Slow & fast motion recording is activated. [S&F STBY] appears on the screen and the shooting frame rate appears 

next to the frame rate setting (the playback frame rate).

3 Select  > [Æ Recording/Media Setup] > [Slow & Fast Frame Rate] > Desired frame rate.

4 Press the REC button to begin recording.
• The tally lamp changes from green (power indicator) to red.
• [S&F STBY] changes to [S&F ÜREC] while recording. 

5 Press the REC button again to stop recording.
• The clip is recorded on the selected SD card.
• When [S&F Clip/Audio (WAV)] is selected, audio in WAV format will be recorded on the SD card where video is not 

being recorded.
• The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [S&F STBY].

6 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off slow & 
fast motion recording.

NOTESNOTES
• When [Sensor Mode] is set to [Full Frame] and the shooting frame rate exceeds 120P, the viewing angle becomes 

slightly narrow (approximately by 12%) regardless of the [Main Rec Format] and [Main Resolution] settings.
• When the slow & fast motion shooting frame rate exceeds 60P, the following functions cannot be used.

- CV protocol.
- Second card recording functions (proxy recording, sub recording).

• When [S&F Clip / Audio (WAV)] is selected, slow & fast motion recording frame rates exceeding 60P cannot be set.
• When [Sensor Mode] is set to [Full Frame] and the shooting frame rate exceeds 60P, the number of pixels read from the 

sensor decreases, which can make moiré, false color and jaggies more noticeable. To minimize these artifacts, it is 
recommended to set the shooting frame rate to 60P or below.

• The maximum recording time of a single clip is the equivalent of approximately 6 hours of playback time.
• The shooting frame rate cannot be changed while recording.
• If you change the system frequency, slow & fast motion recording will be canceled and the shooting frame rate will be 

reset to its default value.

- Slow & fast motion recording (A 124).
- Pre-recording (A 125).
- Continuous recording (A 126).

- Frame recording (A 126).
- Interval recording (A 127).
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• About the time code when slow & fast motion recording is activated:
- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. 
- If the time code running mode was set to [Free Run], the time code running mode will be changed automatically to 

[Rec Run] when slow & fast motion recording is activated. 
- When the special recording mode is turned off, the time code running mode will return to its previous setting.
- The time code signal will not be output from any terminal.

• Recording Audio (WAV)
- Audio is recorded with the following settings: 48 kHz, 24 bit, 4 channels.
- If video cannot be recorded due to a card problem, audio will also not be recorded.
- However, video will be recorded even if audio cannot be recorded due to a card problem.
- Audio will not be recorded if there is an existing WAV file with the same file name.
- Audio recording will stop automatically after reaching 60 minutes (video recording will continue).
- A maximum of 999 WAV files can be recorded.

Pre-recording
When pre-recording is activated, the camera starts recording continuously onto a temporary memory (approx. 
3 seconds) so when you press the REC button, the clip will contain also a few seconds of video and audio recorded before 
you pressed the button. Pre-recording is not available when the main recording format is set to RAW.

1 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Pre-Recording].
• [PRE STBY] appears on the screen.

2 Press the REC button to begin recording.
• The tally lamp changes from green (power indicator) to red.
• [PRE STBY] changes to [PRE ÜREC] while recording.

3 Press the REC button again to stop recording.
• The clip is recorded. The recorded clip will include a few seconds of video and audio recorded before the REC button 

was pressed.
• The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [PRE STBY].

4 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop pre-
recording.

NOTESNOTES
• Pre-recording will be canceled if the recording mode is changed.
• About the time code when pre-recording is activated:

- The time code of the clip will start a few seconds before the REC button was pressed.
- The time code will be recorded with the running mode set to [Free Run].
- If the time code mode was set to [Regen.], or to [Preset] with [Rec Run] running mode, the time code running mode 

will be changed automatically to [Free Run] when pre-recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous setting.
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Continuous Recording
Audio and video are recorded on both cards in this mode, normal recording on card 1 (according to REC button record/
stop operations, etc.), and continuous recording on card 2 (recording continues regardless of REC button operations). 
This function can be used when the main recording format is set to XF-HEVC S / XF-AVC S. Audio will be recorded in linear 
PCM format.

1 Insert an SD card into each card slot (slot 1 for normal recording, slot 2 for continuous recording).

2 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [ Main / Continuous Rec].
• The continuous recording mode is activated and [CONT] appears on the screen next to the card 2 indicator. 

3 Select  > [Æ Recording/Media Setup] > [Continuous Recording] > [REC].
• The tally lamp changes from green (power indicator) to red and continuous recording starts on card 2. The onscreen 

display changes to [ÜCONT].

4 Press the REC button to start recording.
• Normal recording on card 1 starts.
• If you press the button before step 3, recording will start on both cards.

5 Select  > [Æ Recording/Media Setup] > [Continuous Recording] > [STBY].
• The tally lamp changes from red to green (power indicator) and recording stops on both cards. The onscreen display 

changes to [CONT].

6 Select  > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off 
continuous recording.

NOTESNOTES
• When continuous recording is activated, if recording on card 2 (continuous recording) is not available, normal 

recording on card 1 will not be possible either.
• Continuous recording will continue even if card 1 becomes full.
• If [Continuous Recording] is set to [STBY] and the main recording format is changed to an option other than XF-HEVC S 

/ XF-AVC S, continuous recording will be canceled.

Frame Recording Mode
Each time the REC button is pressed, a preset number of frames (set in advance) is recorded, and all the recorded footage 
is combined into a single clip when the frame recording mode finishes. We recommend operating the camera remotely 
or stabilizing the camera, for example, on a tripod. Sound is not recorded in this mode. 

1 Select > [Æ Recording/Media Setup] > [Recording Mode] > [Frame Recording].
• [FRM STBY] appears on the screen (with [FRM] flashing).

2 Select > [Æ Recording/Media Setup] > [Frame Rec: Frame Rate] (A 194) > Desired option.

3 Press the REC button to begin recording.
• The tally lamp changes from green (power indicator) to red.
• [FRM STBY] changes to [FRM ÜREC] while recording.
• The camera automatically records the specified number of frames.

4 Repeat until you finish recording.

5 Select > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop frame recording.
• Frame recording mode ends and all of the recorded frames are joined together into one clip.
• The tally lamp changes from red to green (power indicator) and [STBY] appears on the screen.
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NOTESNOTES

• Frame recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, frame recording will end if 
the frame rate is set to 59.94i or 50.00i.

• The number of frames recorded cannot be changed while recording.
• The same image as the last frame when frame recording was stopped may be recorded and added to the end of the 

clip.
• About the time code when frame recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code advances by 
the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time code signal, 
the time code running mode will be changed automatically to [Rec Run] when frame recording is activated.

- When the special recording mode is deactivated, the time code will return to its previous setting.
- The time code will not be output from any terminal.

Interval Recording Mode
Set the interval and number of frames in advance. Sound is not recorded in this mode.

1 Select > [Æ Recording/Media Setup] > [Recording Mode] > [Interval Recording].
• [INT STBY] appears at the top of the screen (with [INT] flashing).

2 Select > [Æ Recording/Media Setup] > [Interval Rec: Time Interval] (A 194) > Desired option.

3 Select > [Æ Recording/Media Setup] > [Interval Rec: Frame Rate] (A 194) > Desired option.

4 Press the REC button to begin recording.
• The tally lamp changes from green (power indicator) to red.
• [INT STBY] changes to [INT ÜREC] while recording.
• The camera automatically records the set number of frames at the specified interval.

5 Press the REC button again to stop recording.
• The tally lamp changes from red to green (power indicator) and [INT STBY] appears at the top of the screen (with 

[INT] flashing).

6 Select > [Æ Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop interval recording.

NOTESNOTES

• Interval recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, interval recording will end 
if the frame rate is set to 59.94i or 50.00i. 

• The interval and the number of frames recorded cannot be changed while recording.
• The same image as the last frame when interval recording was stopped may be recorded and added to the end of the 

clip.
• About the time code when interval recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code advances by 
the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time code signal, 
the time code running mode will be changed automatically to [Rec Run] when interval recording is activated.

- When the special recording mode is deactivated, the time code will return to its previous setting.
- The time code will not be output from any terminal.
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Using Anamorphic Lenses
You can attach an anamorphic lens to the camera and set the anamorphic desqueeze ratio used to display the image 
from the camera on monitoring devices while shooting or during playback.

1 Select  > [¢ Monitoring Setup] > Desired [Anamorphic:] setting > [On].

2 Select  > [¢ Monitoring Setup] > [Anamorphic Desqueeze] > Desired option.

Options
[Lens Squeeze Factor]:

The desqueeze factor is linked to the  > [Æ Recording/Media Setup] > [Metadata] > [Lens Squeeze] 
setting.

[x2.0]: Stretches the video horizontally by a factor of 2.

[x1.8]: Stretches the video horizontally by a factor of 1.8.

[x1.5]: Stretches the video horizontally by a factor of 1.5.

[x1.33]: Stretches the video horizontally by a factor of 1.33.

NOTESNOTES

• You can record the lens’s squeeze factor in the clip’s metadata with the  > [Æ Recording/Media Setup] > 
[Metadata] > [Lens Squeeze] setting.

• The image displayed during photo playback will not be desqueezed.
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Web Camera Function
You can connect the camera to a computer using an interface cable, and use the camera as a web camera (with 
compatible software). For more details about supported operative systems or software tested for use with the camera, 
visit your local Canon website. For more details, refer to the computer’s instruction manual.
When connecting the camera to a computer, use a Canon cable. 

Video output configuration

Audio output configuration

1 Select  > [ Network/USB Settings] > [USB Mode] > [Video Output (UVC)].

2 Select  > [ Network/USB Settings] > [UVC Setting] > [Frame Rate] > Desired option.

3 To output audio (UAC), select  > [ Network/USB Settings] > [UVC Setting] > [Audio (UAC)] > 
[Enable].

4 Connect the camera to a computer.

5 Open the desired compatible software on the computer.

6 When the connection ends, disconnect the interface cable from the camera.

NOTESNOTES

When using video output (UVC):
- This function cannot be used simultaneously with IP streaming, XC protocol (A 185), while shooting photos or 

when using the [Auto Clear Scan Setting] function.
When using audio output (UAC):

- This function cannot be used at the same time as video/audio recording functions.
-  This function cannot be used at the same time as network functions.

• During USB 2.0 communication, data is output at 30P/25P even if [UVC Setting] > [Frame Rate] is set to 60P/50P. You 
can check the status of the output frame rate on the status screens (A 204).

Main resolution Video format Resolution Frame rate

3840x2160, 1920x1080

Motion JPEG

1920x1080

60P, 50P, 30P, 25P6960x3672, 5036x2656, 4096x2160, 2524x1332, 2048x1080 2048x1080

6960x4640, 6912x4608 1620x1080

Codec Sampling frequency Bit depth Number of audio channels

Linear PCM 48 kHz 16 bit 2 channels

USB terminal
Computer

Interface cable
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• When connecting to a computer, using a USB terminal that does not support USB Power Delivery is recommended.
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Assignable Buttons
The camera offers a number of assignable buttons to which you can assign various function. Assign often-used functions 
to the buttons you find most convenient to personalize the camera to your needs and preferences. 
You can find 14 assignable buttons on the camera’s body, and 4 assignable buttons on the RC-IP100/RC-IP1000 Remote 
Camera Controller, Remote Camera Control Application, and Multi-Camera Control. In most cases, the names of the 
buttons printed on the camera and accessories also indicate their default settings.

Changing the Assigned Function
Functions can be set separately in CAMERA mode and MEDIA mode.

1 Press the MENU button and, while holding it pressed down, press the assignable button whose function you 
wish to change.
• A list of available functions appears.
• You can also select the appropriate menu setting from the various pages of the  > [ Assignable Buttons] 

menu.

2 Select the desired function.
• The selected function will be assigned to the selected button.

3 If you selected [User Setting], select the menu setting you want to register.
• The selected menu setting will be assigned to the selected button. User-selected settings will be indicated with a 

 icon in the [ Assignable Buttons] menu.

4 Press the assignable button to use the assigned function as described in the following table.
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NOTES

• You can check the [ Assignable Buttons] status screens (A 204) to see what functions are currently assigned to 
each button.

• You can reset only the functions assigned to the assignable buttons, without affecting other camera settings, with the 
 > [B System Setup] > [Reset] > [Assignable Buttons] function. All the assignable buttons will return to their 

default function.
• When you select  > [ Assignable Buttons] > [Link to Camera] > [Enable], the functions assigned to assignable 

buttons 1–4 on the camera can also be assigned to assignable buttons 1–4 of the RC-IP100/RC-IP1000, Remote Camera 
Control Application, and Multi-Camera Control.

Assignable functions
Functions whose names include a video output destination (LCD, terminal name) affect only the specified video output, 
while [All] indicates the function affects all video outputs.

Function name Description
CAMERA 

mode
MEDIA 
mode

A

[One-Shot AF]1 The camera focuses automatically one time only (one-shot AF function). Ü – 92

[AF Lock] Turns the AF lock function on/off.
Ü – 93

[AF Lock (While Pressed)]1, 3 Activates the AF lock function while the button is held pressed down.

[AF Area] Toggles the type of the AF area. Ü – 93

[Focus Mode] Toggles the focus mode between AF (autofocus) and MF (manual focus). Ü – 89

[Face Detection AE] Turns face detection AE on/off Ü – 94

[Subj. Detect. AF] Toggles the [Subj. Detect. AF] setting between [Detect. Priority] and [Detect. Only]. Ü – 94

[Subject to Detect] Switches the subject to be detected. Ü – 94

[Eye Detection] Toggles the [Eye Detection] setting between [Disable], [Auto], [Right Eye Priority] and [Left Eye 
Priority].

Ü – –

[Tracking] Enters/cancels tracking standby mode. Ü – 95

[Tracking by Touch Priority] Turns the [Tracking by Touch Priority] function on/off. Ü – 95

[Focus Guide] Turns the focus guide on/off. Ü – 90

[Peaking: All], 
[Peaking: LCD], 
[Peaking: HDMI]

Turns peaking on/off.
Ü – 91

[Magnification], 
[Magn.: LCD], 
[Magn.: HDMI]

Turns magnification on/off.
Ü – 91

[Tele-converter] Cycles through the digital tele-converter options in the following order: 
x1.5  x2.0  x2.5  x3.0 Off.

Ü – 98

[Digital Zoom] Turns digital zoom on/off. Ü – 99

[Push Auto Iris]1 The camera automatically adjusts the aperture only while the button is held pressed down. Ü – 83

[Iris Mode] Switches the aperture adjustment mode between automatic and manual. Ü –
82

[Iris +], [Iris –] Opens up/closes the aperture, respectively. Ü –

[Shutter Mode] Switches the shutter mode between automatic and manual. Ü – 75

[Auto Clear Scan Setting] Displays the [Auto Clear Scan Setting] screen Ü – 76

[Base ISO] Switches between base ISO speed settings. Ü – 78

[ISO/Gain Mode] Changes the ISO speed/Gain adjustment mode. Ü – 78

[AE Shift +], [AE Shift –] Compensates the exposure making the image brighter/darker, respectively. Ü – 84

[Backlight], [Spotlight] Toggles the light metering mode between [Standard] and [Backlight]/[Spotlight], respectively. Ü – 85

[Zebra: All], [Zebra: LCD], 
[Zebra: HDMI]

Turns zebra patterns on/off.
Ü – 102
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[WFM: All], [WFM: LCD], 
[WFM: HDMI]

Turns the selected video scope on/off.
Ü Ü 118

[View Assist: All], 
[View Assist: LCD], 
[View Assist: HDMI]

Turns view assistance on/off.
Ü – 161

[False Color: All], 
[False Color: LCD], 
[False Color: HDMI]

Turns the false color overlay on/off.

Ü – 102

[False Color Index] Displays/hides the false color index screen.

[White Balance] Enters the direct setting mode with the white balance mode highlighted and ready to be 
adjusted.

Ü – 86

[Set White Balance] Starts the white balance calibration for a custom white balance setting. Ü – 86

[AWB Lock]1 While using auto white balance (AWB), locks the current white balance settings. Ü – 88

[  AWB], 
[Å Set A], [Å Set B], 
[¼ Daylight], 
[É Tungsten], 
[È Kelvin]

Changes the white balance mode/setting to the respective option.

Ü – 86

[Lens Optical IS] Turn lens optical IS on/off. Ü – –

[Digital IS] Stops/starts digital IS
Ü – 97[Pause Digital IS]1 Turns the digital image stabilizer (digital IS) on/off. Can be switched during shooting. The 

viewing angle is maintained even when the digital image stabilizer is paused.

[LCD Setup] Opens the [¢ Monitoring Setup] menu page with the settings for adjusting the LCD screen. Ü Ü 196

[LCD Luminance Boost] Turns LCD luminance boost on/off. Ü Ü 25

[OSD Output: HDMI] Turns the camera’s onscreen displays on/off. Ü Ü 159

[OSD Opacity: All], 
[OSD Opacity: LCD], 
[OSD Opacity: HDMI]

Changes the transparency level of onscreen displays.
Ü Ü 159

[DISP] Changes the onscreen display level. Ü Ü 56

[OSD Orientation: LCD] Changes the onscreen display direction in the following order: standard, 90 degrees rotation, 
270 degrees rotation.

Ü – 58

[Markers: All], 
[Markers: LCD], 
[Markers: HDMI]

Turns onscreen markers on/off.
Ü Ü 100

[Color Bars] Turns color bars on/off. Ü – 117

[IP Streaming] Turns the IP streaming function on/off. Ü – 183

[Photo]1 Records a photo. Ü – 52

[Review Recording]1 Plays back the last clip recorded in CAMERA mode. Ü – 58

[Time Code] Opens the [B System Setup] menu page with the time code settings. Ü – 104

[Add Shot Mark]1 Adds a shot mark to the clip. Ü Ü 120, 
152, 
153

[Add $ Mark], 
[Add % Mark]

Adds an $ or % mark to the clip.
Ü Ü

[Headphones +], 
[Headphones –]

Increases/reduces the headphone volume, respectively.
Ü Ü 150

[Monitor Channels] Switches the audio channels output from the × (headphone) terminal and the built-in speaker. Ü Ü 162

[Audio Level Indicator] Turns the audio level meter on/off. Ü Ü 112

[FUNC] Enters the direct setting mode. Ü – 61

Function name Description
CAMERA 

mode
MEDIA 
mode

A
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1 Function can be used only by assigning it to a button.
2 Not available when slow & fast motion recording is activated.
3 Cannot be used with XC Protocol.
4 Cannot be set with XC Protocol. Even when [Link to Camera] is set to [Enable], operation from XC protocol is not possible.

[Slow & Fast Motion] Turns slow & fast motion recording on/off.
Ü – 124[Slow & Fast Frame Rate] When slow & fast motion recording is activated, highlights the shooting frame rate in order to 

adjust it.

[Output: 60  60 (24) fps]1, 2, 
[Output: 60  60 (30) fps]1, 2

When the frame rate is 59.94P or 59.94i, toggles the frame rate of video output terminals and the 
LCD screen between said frame rates and 24 fps or 30 fps, respectively.

Ü – –

[Iris] Enters the direct setting mode with the aperture value highlighted and ready to be adjusted. Ü – 82

[Shutter] Enters the direct setting mode with the shutter speed highlighted and ready to be adjusted. Ü – 75

[ISO/Gain] Enters the direct setting mode with the ISO speed or gain value highlighted and ready to be 
adjusted.

Ü – 79

[Status]1 Displays the status screens. Ü Ü 204

[Audio Status] Displays the [¡ Audio Setup] status screens. You can press SET to open the [¡ Audio 
Setup] menu. 

Ü Ü 204

[MENU] Displays the menu. Ü Ü –

[Custom Picture] Opens the [/ Custom Picture] menu. Ü – 135

[Assignable Button Setting] Displays the assignable button settings. Ü Ü –

[My Menu] Opens the [¥ My Menu] customized menu. Ü – 29

[Initialize Media] Opens the [Initialize Media] submenu. Ü Ü 40

[Play/Pause] Pauses and resumes the playback. – Ü 146

[INDEX/Cancel Resume] Returns to the index screen. The next time the clip is selected, playback will start from the 
beginning.

– Ü 146
[INDEX] Returns to the index screen. The next time the clip is selected, playback will start from the frame 

where it stopped.

[Slot Selection] Switches between card slots. Ü Ü 41

[Select File] File selection. – Ü –

[Refine] Switches [Refine] (refining clip selection) on/off. – Ü –

[Frame.io Upload] Adds clip to the Frame.io upload queue. – Ü 188

[Key Lock]3 Turns key lock on/off. Can only be assigned to assignable button Camera 8. Ü Ü 31

[REC] Functions as the REC button. Ü – 51

[CAMERA⇔MEDIA]3, 4 Switches between CAMERA mode and MEDIA mode. Ü Ü –

[  User Setting]1 Customizable slot. Assign to the button any menu setting you would like to register. Ü Ü –

Function name Description
CAMERA 

mode
MEDIA 
mode

A
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Custom Picture Settings
The camera lets you change many settings (A 139) that control various aspects of the image produced. As a set, all 
these settings are treated as a single custom picture file. After adjusting the desired settings to your preference, you can 
save up to 20 custom picture files (in the camera or on an SD card), and load them later to apply exactly the same settings 
(A 138). You can also save the custom picture file as part of the metadata recorded with clips (A 138). Custom picture 
settings do not affect the recording or output of RAW clips.

Selecting Custom Picture Files
In CAMERA mode, select a custom picture file to apply its settings to your recordings or to edit, rename, protect, or 
transfer it.

1 Select  > [/ Custom Picture] > [Select / File].
• The custom picture file selection screen is displayed.
• Select one of the custom picture files saved in the camera (C1 to C20). To use the settings of a custom picture file 

saved on an SD card, copy the file to the camera in advance (A 138).
• You can also use direct touch control's Æ recording settings (A 60).

2 Select the desired file.
• When you close the menu, the selected custom picture file’s settings will be applied.

Preset Picture Settings
The following settings are saved to custom picture files C1 to C20 as preset custom picture settings. Custom picture files 
C1 to C9 are protected by default and need to be unprotected before they can be edited.

Preset custom picture file [Gamma/Color Space]* [Color Matrix] [Look File] Characteristics

C1: [Canon 709] [Canon 709 / BT.709]

[Neutral]

–
These settings produce a look appropriate also for use without post processing, 
featuring high contrast while ensuring a wide dynamic range optimized for 
playback on BT.709 compliant monitors.

C2: [Canon Log 2] [Canon Log 2 / C.Gamut] –
These settings use Canon Log 2 gamma and require post-production 
processing. They achieve superior gradation in the shadows (dark areas of the 
image).

C3: [Canon Log 3] [Canon Log 3 / C.Gamut] –
These settings use Canon Log 3 gamma and require post-production 
processing. They keep the [Canon Log] gamma characteristics while expanding 
its dynamic range.

C4: [BT.709 Wide DR] [BT.709 Wide DR / BT.709] –
These settings produce a wide dynamic range and are appropriate for playback 
on BT.709 compliant monitors.

C5: [BT.709 Standard] [BT.709 Standard / BT.709] [Video] –
These settings are appropriate for playback on BT.709 compliant monitors, and 
use a gamma curve that meets ITU-R BT.709 standards.

C6: [PQ] [PQ / BT.2020]

[Neutral]

–
These settings use a high dynamic range gamma curve compliant with the PQ 
standard defined by ITU-R BT.2100**.

C7: [HLG] [HLG / BT.2020] –
These settings use a high dynamic range gamma curve compliant with the HLG 
standard defined by ITU-R BT.2100**.

C8: [EOS Standard] [BT.709 Wide DR / BT.709] On
Reproduces the image quality and look of an EOS interchangeable lens DSLR 
camera with its picture style set to [Standard].

C9: [EOS Neutral] [BT.709 Wide DR / BT.709] On
Reproduces the image quality and look of an EOS interchangeable lens DSLR 
camera with its picture style set to [Neutral].

C10: [User10] to 
C20: [User20] [Canon 709 / BT.709] –

These settings produce a look appropriate also for use without post processing, 
featuring high contrast while ensuring a wide dynamic range optimized for 
playback on BT.709 compliant monitors.
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* This setting is found under  > [/ Custom Picture] > [Edit / File].
**ITU-R BT.2100 is a standard for a bit depth of 10 or 12 bits. When the video configuration is set to one of the 8 bit options, the gamma curve 

is approximately equivalent to this standard.

NOTES
About the logarithmic gamma curves (Canon Log settings)

- These gamma curves require post-production processing. They were designed to make the most of the imaging 
sensor characteristics in order to obtain impressive levels of dynamic range.

- In CAMERA mode, you can apply a view assistance function to the LCD screen's image to use gamma curve settings 
more suitable for viewing on a monitor screen.

- There are also other LUTs available that can be applied for processing in post-production. For the latest information 
on available LUTs, please visit your local Canon website.

Editing a Custom Picture File’s Settings
In CAMERA mode, adjust the image quality to your preference and save the settings as part of a custom picture file.

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Edit / File].
• Select an unprotected custom picture file.

3 Select a setting you wish to change and select the desired option.
• Refer to Available Custom Picture Settings (A 139) for details on the various settings.
• Repeat step 3 for other settings as necessary.
• When you close the menu, the new custom picture settings will be applied.

Renaming Custom Picture Files

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Edit / File] > [Rename] > [Input].
• Enter the desired file name (16 characters long) (A 30).

Protecting Custom Picture Files

Protecting a custom picture file prevents its settings from being accidentally changed.

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Edit / File] > [Protect] > [Protect].
• i will appear next to the file name.
• To remove the protection, select [Unprotect] instead.

Resetting Custom Picture Files

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Edit / File] > [Reset].

3 Select a preset custom picture setting and then select [OK].
• The custom picture file will be reset to the selected values.
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Look Files
You can register LUT files created with Blackmagic Design’s DaVinci Resolve as Look Files in the custom picture file. Using 
a Look File allows you to adjust the video quality of the recorded video. These adjustments apply also to proxy clips, 
photos, and screen/output terminals.

1 Insert the SD card with the desired Look File (.cube format, located in the root directory of the SD card) into 
the camera’s card slot 2.

2 Select a custom picture file. (A 135)

3 Select  > [/ Custom Picture] > [Edit / File] > [Gamma/Color Space] > Desired option.

4 Select  > [/ Custom Picture] > [Edit / File] > [Look File Setup] > [Register].
• The Look Files in the SD card will be displayed.

5 Select the desired Look File.

6 Select the [Gamma/Color Space] setting to use after the Look File is applied.

7 Select [OK] twice.
• The selected Look File will be loaded and registered to the custom picture file.
• The image quality adjustments set in the Look File will be applied, and  will appear on the screen.
• When disabling the image quality adjustments set in the Look File, select  > [/ Custom Picture] > [Edit / 

File] > [Look File] > [Off ].

NOTES
About Look files

- The camera supports LUT files (3D LUT/.cube format) in 17 grid or 33 grid format created with Blackmagic Design’s 
DaVinci Resolve.

- LUT files with input ranges outside the 0 to 1 range in the header (“LUT_3D_INPUT_RANGE”) are not supported.
- LUT files which include values outside of the 0 to 1 range in the data area are not supported.
- LUT files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name: 

Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte space.
• Save a Look File to the root directory of the SD card.
• If the correct input/output gamma curve and color space conversion are not selected, video will not be output 

correctly.
• A Look File cannot be used if the [Gamma/Color Space], [HLG Color], [White Level 100%], or [Over 100%] settings are 

changed after registering it.
• When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to either [BT.709 

Standard] or [BT.709 Wide DR], super-white (video signal above 100%) and super-black (video signal below 0%) levels of 
brightness will be clipped. When the video signal contains super-white brightness levels, select  > [/ Custom 
Picture] > [Edit / File] > [Other Functions] > [Over 100%] > [Press] and then activate the Look File to apply it to a 
signal compressed to 100%.

• When playing RAW clips, the Look File registered when the clip was recorded will only be applied to the thumbnail and 
not the clip itself.

Adjusting the Look File's intensity

Adjust the intensity of the Look File registered to a custom picture file.

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Edit / File] > [Look File Setup] > [Intensity].

3 Select the intensity while checking the preview.
• The intensity can be changed from 10% to 100% in increments of 10%.
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4 Select [OK] twice.

NOTES

• If the intensity is reduced from 100%, it will be adjusted in relation to the look that corresponds to the [Gamma/Color 
Space] setting to use after the Look File is applied.
- For [Comform to Custom Picture]: The look with no Look File applied.
- Other than [Comform to Custom Picture]:  The look set according to the [Gamma/Color Space] setting to use after 

the Look File is applied.

Deleting a Look File

You can delete Look Files registered in custom picture files.

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Edit / File] > [Look File Setup] > [Delete] > [OK].
• The Look File will be deleted and the image quality adjustments will be reversed to the original settings of the 

selected custom picture file.

Saving a Custom Picture File

Copying Custom Picture Files

You can copy custom picture files between the camera and SD card. Insert in advance into the camera the card where 
you want to save your custom picture files or the card that contains the custom picture file you want to load.

Copying a File from the Camera to an SD Card

1 Select a custom picture file (A 135).

2 Select  > [/ Custom Picture] > [Save / File] > [Save to SD Card].

3 Select the destination file on the card and then select [OK].
• Select an existing custom picture file to overwrite it or [New File] to save the settings as a new custom picture file on 

the card.

4 When the confirmation message appears, press SET.

NOTES

• Custom picture files are exclusively compatible for use only with the same camera model.

Replacing a File in the Camera with a File on an SD Card

1 Select the custom picture file that you wish to replace (A 135).

2 Select  > [/ Custom Picture] > [Save / File] > [Load from SD Card].

3 Select the file with the settings that you want to replicate and then select [OK].
• The file in the camera will be overwritten by the one on the card. 

4 When the confirmation message appears, press SET.

Embedding the Custom Picture File in Clips (CAMERA Mode)

When you record after having set custom picture settings, you can have the custom picture file embedded in the 
metadata and saved along with the clips. When displaying the information screen in MEDIA mode, you can check the 
custom picture settings used at the time of recording.

Select  > [Æ Recording/Media Setup] > [Metadata] > [Add / File] > [On].
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Available Custom Picture Settings

Menu items Options / Additional information

[Gamma/Color Space] [Canon Log 2 / C.Gamut], [Canon Log 3 / C.Gamut], [Canon Log 3 / BT.2020], 
[Canon Log 3 / BT.709], [Canon 709 / BT.709], [BT.709 Wide DR / BT.709], 
[BT.709 Standard / BT.709], [PQ / BT.2020], [HLG / BT.2020]

Combination of gamma curve and color space settings that affects the overall look and color space of the image.

Gamma curve
[Canon Log 2]: Logarithmic gamma curve that obtains a richer color gradation in the dark areas of the image. Requires 

image processing in post-production.
[Canon Log 3]: Logarithmic gamma curve that keeps the characteristics of the [Canon Log] setting while expanding its 

dynamic range. Requires image processing in post-production.
[PQ]: HDR (high dynamic range) gamma curve compliant with the PQ standard defined by ITU-R BT.2100.*
[HLG]: HDR (high dynamic range) gamma curve compliant with the HLG standard defined by ITU-R BT.2100.*
[BT.709 Wide DR]: Gamma curve with a very wide dynamic range. Optimized for playback on BT.709 compliant monitors. 

Equivalent to the [Wide DR] setting in previous camera models.
[BT.709 Standard]: Gamma curve that meets ITU-R BT.709 standards, for playback on BT.709 compliant monitors. 

Equivalent to the [Normal 3] setting in previous camera models.
[Canon 709]: Gamma curve appropriate also for use without post processing, featuring high contrast while ensuring a wide 

dynamic range. Use this when outputting to a BT.709 compliant monitor.
* ITU-R BT.2100 is a standard for a bit depth of 10 or 12 bits. When the video configuration is set 

to one of the 8 bit options, the gamma curve is approximately equivalent to this standard.

Color space
[C.Gamut]: Color space developed by Canon based on the specific characteristics of the camera’s imaging sensor. It covers a 

wider color gamut than that of BT.2020. Use this setting with workflows that require ACES2065-1 color space.
[BT.2020]: Color space that meets ITU-R BT.2020 standards, which defines parameters for ultra-high-definition television 

(4K/8K).
[BT.709]: Standard color space that is compatible with sRGB specifications.

[Color Matrix] [Neutral], [Production Camera], [Video]

The color matrix affects the overall color tonality of the image.
[Neutral]: Reproduces neutral colors.
[Production Camera]: Reproduces colors more suitable for motion picture production.
[Video]: Reproduces colors with a contrast suitable for TV broadcasting.

[Look File] [On], [Off]

Image quality adjustments set in the Look File will be applied.

[Look File Setup]

[Register] Registers a Look File to a custom picture file.

[Intensity] 10% to 100% (---)

Sets the intensity of the applied Look File.

[Delete] Deletes a Look File registered to a custom picture file.

[HLG Color] [BT.2100], [Vivid]

Changes the quality of color reproduction when using the hybrid log gamma (HLG). This setting is only available when 
[Gamma/Color Space] is set to [HLG / BT.2020].
[BT.2100]: Color reproduction according to ITU-R BT.2100 specifications.
[Vivid]: More saturated color reproduction according to the 'Traditional Colour' approach in ITU-R BT.2390.
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[Black]

[Master Pedestal] –50 to +50 (±0)

Increases or decreases the black level. Higher settings will make dark areas brighter but decrease contrast. This setting is 
not available when the gamma curve component of the [Gamma/Color Space] setting is set to one of the [Canon Log 2] or 
[Canon Log 3] options.

[Master Black Red], 
[Master Black Green], 
[Master Black Blue]

–50 to +50 (±0)

These settings correct the color cast in blacks. These settings are not available when the gamma curve component of the 
[Gamma/Color Space] setting is set to one of the [Canon Log 2] or [Canon Log 3] options.

[Black Gamma]

[Level] –50 to +50 (±0)

[Range], [Point] –20 to +50 (±0)

These settings control the lower part of the gamma curve (dark areas of the image). These settings are only available when 
the gamma curve component of the [Gamma/Color Space] setting is set to one of the [BT.709 Standard] options.
[Level]: Raises or lowers the lower part of the gamma curve. 
[Range]: Selects the adjustment range from the selected [Point].
[Point]: Determines the shape of the lower part of the gamma curve. 

[Low Key Saturation]

[Activate] [On], [Off]

Set this setting to [On] to enable the adjustment of color saturation in dark areas with the [Level] setting.

[Level] –50 to +50 (±0)

Specifies how saturated colors are in dark areas.

[Knee]

[Activate] [On], [Off]

Set this setting to [On] to enable the adjustment of the knee point with the following settings. These settings are only 
available when the gamma curve component of the [Gamma/Color Space] setting is set to one of the [BT.709 Standard] 
options.

[White Level 100%] [On], [Off]

[Slope] –35 to +50 (---)

[Point] 50% to 100% (85%)

[Saturation] –10 to +10 (±0)

These settings control the upper part of the gamma curve (highlights of the image). By compressing the highlights, you 
can prevent parts of the image from being overexposed.
[White Level 100%]: Adjusts automatically to keep output at 100% even if [Point] is changed.
[Slope]: Determines the slope of the gamma curve above the knee point (can only be adjusted if [White Level 100%] is set 

to [Off]).
[Point]: Sets the knee point of the gamma curve. When [White Level 100%] is set to [Off], it is adjusted within a range of 

50% to 109%.
[Saturation]: Adjusts the color saturation in the highlights.

Menu items Options / Additional information
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[Sharpness]

[Level] –10 to +50 (±0)

Sets the sharpness level of the video output signal and the recorded signal.

[Detail Frequency] –8 to +8 (±0)

Sets the center frequency of horizontal sharpness. Setting higher values increases the frequency, which, in turn, increases 
the sharpness.

[Coring Level] –30 to +50 (±0)

Sets the level of correction of artifacts caused by high sharpness levels (coring). Higher values prevent sharpness from 
being applied to minute details, resulting in less noise.

[Limit] –50 to +50 (±0)

Restricts how much sharpness is applied.

[Noise Reduction]

[Automatic] [On], [Off]

Adaptively changes the noise reduction effect.

[Spatial Filter] [Off], 1 to 12

Reduces noise by applying a soft focus-like effect on the entire picture. When set to a value other than [Off], afterimages 
are not produced but the whole image will have a softer look.

[Frame Correlation] [Off], 1 to 3

Reduces noise elements by comparing the current image to the previous one (field). When set to a value other than [Off], 
the perceived resolution will not be affected but an afterimage may appear for moving subjects.

[Skin Detail]

[Effect Level] [Off], [Low], [Middle], [High]

[Hue] –16 to +16 (±0)

[Chroma], [Area], [Y Level] 0 to 31 (16)

The camera applies a softening filter to areas in the picture with skin tones to give a more pleasant appearance. By 
changing these settings, you can determine what areas will be detected as skin tones. A zebra pattern will appear on the 
screen or video output terminal over areas of the image that are detected as having skin tones.
[Effect Level]: Adjusts the level of the filter. 
[Hue]: Adjusts the hue for detection of skin tones. 
[Chroma]: Adjusts the color saturation for detection of skin tones. 
[Area]: Adjusts the color range for detection of skin tones.
[Y Level]: Adjusts the brightness for detection of skin tones.

[Color Matrix Tuning]

[Gain] –50 to +50 (±0)

[Phase] –18 to +18 (±0)

These settings adjust the color intensity ([Gain]) and color phase ([Phase]) of the color matrix, affecting the color tones of 
the whole image.

[R-G], [R-B], [G-R], [G-B], 
[B-R], [B-G]

–50 to +50 (±0)

Each matrix changes the tint of the picture along the color gradations detailed below, affecting the color tones of the 
whole image.
[R-G]: cyan/green and red/magenta; [R-B]: cyan/blue and red/yellow; 
[G-R]: magenta/red and green/cyan; [G-B]: magenta/blue and green/yellow;
[B-R]: yellow/red and blue/cyan; [B-G]: yellow/green and blue/magenta.

Menu items Options / Additional information
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NOTES

• Depending on other menu settings, you may not be able to obtain the desired image effect even after changing the 
custom picture settings.

[White Balance]

[R Gain], [G Gain], [B Gain] –50 to +50 (±0)

These settings adjust the amount of white balance throughout the whole image by changing the intensity of red tones ([R 
Gain]), green tones ([G Gain]), and blue tones ([B Gain]).

[Color Correction]

[Select Area] [Off], [Area A], [Area B], [Area A&B]

The camera detects areas with certain color characteristics (color phase, chroma, area and Y level) and corrects them when 
recording. You can set the color correction for up to two different areas 
(A and B) and apply the color correction to either one ([Area A] or [Area B]) or both of them ([Area A&B]). 
While color correction is activated, parts of the image that are not detected as having the characteristics specified for area 
A or B will appear colorless on the screen or the image output from the output terminals (except when adjusting the 
[Revision Level]/[Revision Phase] settings).

[Area A Setting Phase],
[Area B Setting Phase]

0 to 31 (0)

These settings determine the color phase of the area to be corrected (A or B, respectively).

[Area A Setting Chroma],
[Area B Setting Chroma],
[Area A Setting Area],
[Area B Setting Area],
[Area A Setting Y Level],
[Area B Setting Y Level]

0 to 31 (16)

These settings determine the following color characteristics of the area to be corrected (A or B, respectively).
[Area A Setting Chroma], [Area B Setting Chroma]: Color saturation. 
[Area A Setting Area], [Area B Setting Area]: Color range. 
[Area A Setting Y Level], [Area B Setting Y Level]: Brightness.

[Area A Revision Level],
[Area B Revision Level]

–50 to +50 (±0)

These settings adjust the amount of correction applied to the color saturation in the corrected area 
(A or B, respectively).

[Area A Revision Phase],
[Area B Revision Phase]

–18 to +18 (±0)

These settings adjust the amount of correction applied to the color phase in the corrected area 
(A or B, respectively).

[Other Functions]

[Over 100%] [Through], [Press], [Clip]

Determines how the camera handles video signals exceeding 100%. This setting is not available when the gamma curve 
component of the [Gamma/Color Space] setting is set to one of the [Canon Log 2], [Canon Log 3], [PQ], [HLG] or [Canon 
709] options, or when [White Level 100%] is set to [On].
[Through]: Leave the signal unchanged.
[Press]: Compress a signal of up to 108% down to 100% levels.
[Clip]: Clip the signal at 100%.

Menu items Options / Additional information
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Saving and Loading Menu Settings
After you adjust settings in the various menus, you can save those settings in the camera or on the SD card (slot 2). You 
can load those settings at a later date or on another camera of the same model so that you can use that camera in the 
same way.

Saving Menu Settings
1 Select  > [B System Setup] > [Transfer Menu//] > [Save].

2 Select [To Camera] or [To SD Card] and then select [OK].
• The camera’s menu settings will be saved to the selected destination. If menu settings were previously saved, the old 

file will be overwritten by the current menu settings.

Loading Menu Settings
1 Select  > [B System Setup] > [Transfer Menu//] > [Load].

2 Select [From Camera] or [From SD Card] and then select [OK].
• The camera’s menu settings will be replaced by the settings in the previously saved file. Then, the screen will turn 

black momentarily and the camera will restart.

NOTES
• The following menu settings are not saved with this operation.

-  > [v Camera Setup] > [ABB], [Color Bars]
-  > [Æ Recording/Media Setup] > [Metadata] > [News Metadata], [User Memo]
-  > [A Assistance Functions] > [Magnification], [Magn. Output], [False Color Index]
-  > [A Assistance Functions] > [Waveform Settings] > [Size: LCD]

• When menu settings are loaded with this operation, even protected custom picture files in the camera will be 
replaced.
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Playback
This section explains how to play back clips, photos and WAV audio with the camera. For details on playing back 
recordings using an external monitor, refer to Connecting to an External Monitor or Recorder (A 157).

Displaying the Index Screen
Press the MEDIA button (A 15)
• The camera is set to MEDIA mode and the clip thumbnails will appear in the index screen.
• Use the joystick or the SELECT dial to move the orange selection frame.
• Flick up/down on the screen or turn the grip control dial to move to the next/previous page. 

NOTES

• If the card contains XF-AVC clips recorded at a system frequency other than the one currently used by the camera, you 
will not be able to play back the clips and the clip thumbnails will not appear in the index screen. To play back such 
clips, change the camera’s system frequency (A 66) to match the recordings on the card.
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1 Key lock (A 31)
2 Shot mark (A 153)
3 $ mark/% mark (A 152)
4 Orange selection frame 
5 Proxy clip (A 69) 
6 Chunk recording (A 73)
7 Clip identification (camera index, reel number, clip 

number and clip/audio file name) (A 46)
8 Recording date and time
9 Network status / functions (A 182)
10 Recording media

• The toggle button is displayed on the side of the 
currently selected card.

11 File selection (A 147)
12 Index screen currently displayed (A 146)

13 Clip thumbnail
14 Power supply level (A 55)
15 Clip number / Total number of clips
16 Recording date (month and day only) and time
17 Clip’s start time code
18 Clip duration
19 Custom picture file embedded (A 138) 
20 Special recording mode (A 124) 
21 Color sampling and resolution, audio recording 

format
• For RAW clips, RAW mode (HQ/ST/LT) and resolution 

are displayed.
22 Frame rate (A 66)

• For slow & fast motion recording clips, the recording/
playback frame rate is displayed.
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Switching Card Slots

If both card slots contain a card, you can switch card slots by touching the orange dot next to the card currently selected.

Switching Index Screens

The clip index screen that appears when you switch to MEDIA mode depends on the current recording settings. 

1 Touch the recording format on the index screen.
• The index screen selection menu appears.
• You can also press an assignable button set to [INDEX] in MEDIA mode.

2 Select the desired index screen.
• The selected index screen appears.
• Select [Cancel] to return to the previous index screen.

Options
[RAW Index]: Clips in RAW format.

[XF-AVC Index]: Clips in XF-AVC format.

[XF-HEVC S / XF-AVC S Index]:
Clips in XF-HEVC S / XF-AVC S format.

[Photo index]: Photos recorded on the card.

[WAV Index]: Audio files (WAV format).

Playing Back Recordings

After selecting the desired index screen, play back the desired clips, photos or audio files. You can use the touch screen or 
assignable buttons to play back the recordings.

Touch the thumbnail of the recording you want to play back.
• Playback will start.
• You can also move the orange selection frame using the joystick or the SELECT dial, and then press and hold the SET 

button (for approximately 1 second) to start playback. 
• Touch the screen or press the joystick to pause/resume playback.
• Press an assignable button set to [INDEX] or flick the screen down to stop the playback and return to the index screen.
• While browsing photos, press the joystick left/right to move to the previous/next photo.

Custom picture settings of RAW clips during playback
RAW clips are played back using the following custom picture settings.
• [Gamma/Color Space]: Same setting used for recording
• [Color Matrix]: [Neutral]
• Contour lines are de-emphasized in a way similar to setting [Sharpness] > [Level] to –10.
• Other settings are set to [Off ].

In-camera lens correction during playback of RAW clips
• In-camera lens correction (peripheral illumination/chromatic aberration/diffraction/focus breathing correction) set 

during recording will be reflected when playing back RAW clips.
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NOTES

• The following image files may not be displayed correctly.
- Images not recorded with this camera.
- Images edited on a computer.
- Images whose file names have been changed.

• Chunk recording clips are not played back.

Refining Clip Selection for Playback

Play back only the selected clips in succession.

1 Touch  on the index screen.
• The file selection screen is displayed.
• Touch X to return to the index screen.

2 Touch a thumbnail to select a clip, then touch .
• The Refine screen is displayed.
• Touch K to return to the file selection screen, or X to return to the 

index screen.

3 Touch the desired thumbnail on the Refine screen.
• Subsequent operations are the same as for Playing Back Recordings.
• Once playback ends, the screen returns to the Refine screen.

File selection screen example

Refine screen example
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Onscreen Displays During Clip Playback

1 Only when [¢ Monitoring Setup] > [Custom Display] > [Date/Time] is set to [On].
2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
3 XF-AVC clips only. 
4 Only when [¢ Monitoring Setup] > [Custom Display] > [Audio Level Indicator] is set to [On].
5 Only when [¢ Monitoring Setup] > [Custom Display] > [Camera Data] is set to [On].

NOTES
• You can press the DISP button repeatedly to change the level of onscreen displays (A 56).
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1 Fan operation (A 48) and temperature warning 
(A 223)

2 Output onscreen displays (A 159)
3 Playback button 

Advance 10 seconds 
Go back 10 seconds 

4 Recording date and time1

5 Frame reverse button 
Frame advance button 

6 Base ISO
7 Playback operation

8 Frame rate2 (A 66)
9 Custom picture file embedded3 (A 138) 
10 $ mark3/% mark3 / Proxy clip (A 152, 69)
11 Time code (A 104)
12 Video format (A 66) 
13 Color sampling and bit depth (A 66)
14 Resolution (A 66)
15 Headphone volume (A 150) 
16 Audio level meter4

17 Aperture value5 (A 82)
18 ISO speed/Gain5 (A 78)
19 Progress bar
20 Shutter speed5 (A 75)
21 User bit (A 105)
22 Audio output channels (A 162)

Ð PLAY Playback

Ý PAUSE Playback pause
10 sec × Advance 10 seconds
Ø 10 sec Go back 10 seconds

Ô/Ó Frame reverse/Frame advance
F FWD x5 Fast forward (speed: x5)
F FWD x15 Fast forward (speed: x15)

F FWD x60 Fast forward (speed: x60)
F REV x5 Rewind (speed: x5)
F REV x15 Rewind (speed: x15)

F REV x60 Rewind (speed: x60)
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Audio (WAV) playback screen
See Onscreen Displays During Clip Playback (A 148) for the description of onscreen displays that are common on all 
playback screens.

Clip Playback Controls
The following playback types are available using the joystick and the touchs screen.
You can also change the position in the video using the progress bar.

1 You may notice some anomalies (blocky video artifacts, banding, etc.) in the playback picture.
2 The speed indicated on the screen is approximate.

NOTES

• There is no audio during any of the playback types listed in the previous table.
• You can press the Ò button during fast playback to return to playback at normal speed.

Playback type Operation

Fast playback1 During playback, push the joystick up or down.
Repeat to increase the playback speed to approximately 5x  15x  60x the normal speed2.

Advance 10 seconds During playback, touch the right side of the screen twice. During playback pause, touch  on the right side of the screen.

Go back 10 seconds During playback, touch the left side of the screen twice. During playback pause, touch  on the left side of the screen.

Frame advance/reverse During playback pause, push the joystick up or down, or touch Ô / Ó

Skip to the beginning of the next clip During playback, push the joystick right, or flick the screen to the left.

Skip to the beginning of the current clip During playback, push the joystick left.

Skip to the previous clip During playback, push the joystick left twice, or flick the screen to the right.

Change the playback/playback pause position 
in the video

During playback/playback pause, touch or slide the progress bar.

1
2

3

1 Audio file name
2 Sampling frequency and bit depth

3 Audio level meter
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Adjusting the Volume
You can use headphones or the built-in speaker to listen to the audio during normal 
playback. When you connect headphones to the × (headphone) terminal, the 
speaker will be muted. The audio signal will also be output from the HDMI OUT 
terminal. 

1 Select  > [¡ Audio Setup] > [Headphone Volume] or [Speaker 
Volume].

2 Select the desired level.

NOTES

• For details on changing the audio channel, refer to Audio Output (A 162).
• If you set an assignable button to [Headphones +] or [Headphones –] (A 131), you can press the button to adjust the 

headphone volume without using the menu.

× (headphone) terminal
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File Operations
You can perform various operations on the file selected in the index screen using the file menu. Available options will 
depend on the type of recording selected. 

File Menu Operations
1 Select the desired recording. 

2 Press SET.
• The file menu will be displayed. Available functions will differ depending on the recording.
• You can also touch the screen for approximately 1 second to display the file menu.

3 Select a menu item.

File menu options

1 Excluding proxy clips.
2 If the clip already contains an $ or %mark, the option to delete the mark will appear in the menu.
3 Only card slot 2 proxy clips and audio recordings (second card recording functions).
4 Excluding chunk recording clips.

Menu item Description
Index screen

[RAW] [XF-AVC]
[XF-HEVC S / 

XF-AVC S]
[Photos] [WAV]

[Cancel] Closes the menu. Ü Ü Ü Ü Ü

[Play] Starts playback. Ü Ü Ü4 Ü Ü

[Display Clip Info] Displays the information screen (A 152). Ü Ü Ü – –

[Add $ Mark] or 
[Delete $ Mark]1,2

Adds or deletes an $ mark (A 152, 153).
– Ü – – –

[Add % Mark] or 
[Delete % Mark]1,2

Adds or deletes a % mark (A 152, 153).
– Ü – – –

[Del. All Shot Marks]1 Deletes all the shot marks (A 153). – Ü – – –

[Recover] Recovers a recording. Ü Ü Ü4 – Ü

[Delete] Deletes a recording (A 154). Ü Ü Ü Ü Ü

[Delete User Memo] Deletes the user memo and GPS information of a clip (A 154). – Ü Ü – –

[Frame.io Upload] Adds clip to the Frame.io upload queue. –  Ü3  Ü3 –  Ü3

[Stop] Ends photo playback. – – – Ü –

[Select] Displays the file selection screen on the index screen. 
Alternatively, selects a file on the file selection screen.

Ü Ü Ü – –

[Deselect] Clears selection for a file. Ü Ü Ü – –

[Deselect All] Clears selection for all files and returns to the index screen. Ü Ü Ü – –

[Refine] Displays the Refine screen. Ü Ü Ü – –

[Reselect] Returns from the Refine screen to the selection screen. Ü Ü Ü – –

[End Refining] Returns from the Refine screen to the index screen. Ü Ü Ü – –
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Displaying Clip Information
1 Select the desired clip in the clip index screen.

2 On the file menu, select [Display Clip Info].
• The [Clip Info] screen will appear. 
• Push the joystick left/right or touch /  on the screen to move to the previous/next clip. Press the CANCEL button to 

return to the index screen.

 

1 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

Displaying Additional Information (User Memo/News Metadata)

From the [Clip Info] screen, you can push the joystick up or down, or touch [ ]/[ ] on the screen to display user memo 
or News Metadata details. To return to the [Clip Info] screen, push the joystick in the direction displayed to the left of [Clip 
Info] at the bottom of the screen ([ ]/[ ]) or touch [Clip Info] at the top of the screen.

Displaying Custom Picture Settings

If a custom picture file was embedded with the clip, you can push the joystick up or down, or touch [ ]/[ ] on the 
screen to display the custom picture settings used. To return to the [Clip Info] screen, push the joystick in the direction 
displayed to the left of [Clip Info] at the bottom of the screen ([ ]/[ ]) or touch [Clip Info] at the top of the screen.

Adding $ Marks or % Marks
You can add an OK mark ($) or check mark (%) to XF-AVC clips to help you identify particular clips. Since clips with an 
$ mark cannot be deleted with the camera, you can use this mark also to protect important clips.

6

1

3

2

5

7

12
11
10

13
14
15
16

8
9

4

1 Thumbnail of the selected clip
2 Clip geotagged with GPS information
3 Thumbnail of the previous clip
4 Thumbnail of the next clip
5 Recording date and time
6 Clip file name (A 46)
7 Compression, bit rate and resolution (A 63)
8 Special recording mode (A 124)  / frame rate1 

(A 66)
9 Shot mark (A 153) and $ mark / % mark (A 152)

10 Custom picture file embedded (A 138)
11 Proxy clip , chunk recording  (A 69, 73)
12 Color sampling and bit depth (A 66)

• For RAW clips, RAW mode (HQ/ST/LT) and bit depth 
are displayed.

13 Lens model name
14 Clip’s start time code
15 Clip’s end time code
16 Clip duration
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Adding an $ Mark or % Mark During Playback

You can add an $ mark or % mark to a clip during playback or playback pause.

1 Set an assignable button to [Add $ Mark] or [Add % Mark] (A 131).

2 During playback/playback pause of an XF-AVC clip, press the assignable button to add the clip mark.
• [$Mark] or [%Mark] will appear briefly and the selected clip mark will be added to the clip.
• Playback will be paused.

Adding an $ Mark or % Mark from the Index Screen

1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Add $ Mark] or [Add % Mark] > [OK].
• The selected clip mark is added to the clip.

NOTES

• A clip cannot have both an $ mark and % mark at the same time. When you add a % mark to a clip with an $ 
mark, the $ mark will be deleted. Similarly, when you add an $ mark to a clip with a % mark, the % mark will be 
deleted.

Deleting $ Marks or % Marks
You can delete an $ mark or % mark added to an XF-AVC clip.

1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Delete $ Mark] or [Delete % Mark] > [OK].
• The selected mark is deleted.

Adding/Deleting Shot Marks
During the playback of a clip recorded in XF-AVC format, you can add shot marks (!) to particular frames in the clip that 
you want to single out. You can also delete all shot marks at once.

Adding Shot Marks during Playback

1 Set an assignable button to [Add Shot Mark] (A 131).

2 During playback/playback pause of an XF-AVC clip, press the assignable button at the point in the clip where you want 
to add the shot mark.
• [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.
• Playback will be paused.

Deleting All the Shot Marks from a Clip
1 Select the desired XF-AVC clip in the index screen.

2 Press SET (file menu) and select [Del. All Shot Marks] > [OK].
• All shot marks in the selected clip are deleted.
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Deleting Recordings
You can delete clips, photos and audio files (WAV). To delete clips with an $ mark, you need to delete the $ mark 
beforehand (A 153). 

1 Select the desired file in the index screen.
• Photos are selectable on the playback screen.

2 Press SET (file menu) and select [Delete] > [OK].
• The file is deleted.
• The operation cannot be canceled.

IMPORTANT

• Be careful when deleting recordings. Once deleted, they cannot be recovered.

Deleting the User Memo and GPS Information from a Clip
1 Select the desired clip in the index screen.

2 Press SET (file menu) and select [Delete User Memo] > [OK].
• The user memo and GPS information that were recorded in the selected clip’s metadata are deleted.
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Video Output Configuration
The video signal output from the HDMI OUT terminal, depends on the clip’s video configuration and on various menu 
settings. 

Video Output Configuration (Recording/Playback)

Video configuration  > [B System Setup] HDMI OUT terminal

Recording 
format

Main resolution Frame rate [HDMI Output Signal] Output format1 Output  frame rate

RAW

6960x4640 29.97P, 25.00P, 24.00P, 
23.98P

4096x2160P / 3840x2160P 3840x2160
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 60.00P, 59.94P

6960x3672
5036x2656

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P

4096x2160P / 3840x2160P 4096x2160
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 59.94P, 50.00P, 60.00P, 59.94P

2524x1332 59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P

1920x1080P 1920x1080 Same as shooting frame rate

1920x1080i 1920x1080 59.94i, 50.00i, 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 59.94P, 50.00P, 60.00P, 59.94P

XF-AVC
XF-HEVC S
XF-AVC S

4096x2160 
3840x2160

59.94P, 50.00P

4096x2160P / 3840x2160P 4096x2160 / 
3840x2160 Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i

1280x720P 1280x720 Same as shooting frame rate

2048x1080 
1920x1080

1920x1080P2 1920x1080 Same as shooting frame rate

1920x1080i 1920x1080 59.94i, 50.00i

1280x720P2 1280x720 Same as shooting frame rate
1280x720

4096x2160

29.97P, 25.00P, 24.00P, 
23.98P

4096x2160P / 3840x2160P 4096x2160
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 60.00P, 59.94P

6912x46083 
3840x2160

4096x2160P / 3840x2160P 3840x2160
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 60.00P, 59.94P

2048x1080 
1920x1080

1920x1080P2 1920x1080 Same as shooting frame rate

1920x1080i 1920x1080 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 60.00P, 59.94P
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1 Color sampling will be YCC422 10 bit. The video signal’s effective bit depth will be output.
2 During playback (MEDIA mode), [4096x2160P/3840x2160P], [1920x1080P] and [1920x1080i] can also be selected. Available options 

depend on the setting values.
3 Only XF-HEVC S.

XF-AVC
XF-HEVC S
XF-AVC S

1920x1080 59.94i, 50.00i
1920x1080i2 1920x1080 Same as shooting frame rate

1280x720P 1280x720 59.94P, 50.00P

1920x1280
1080x1080

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P

4096x2160P / 3840x2160P 1920x1080
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 59.94P, 50.00P, 60.00P, 59.94P

1080x2048 

4096x2160P / 3840x2160P 4096x2160
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 59.94P, 50.00P, 60.00P, 59.94P

1080x1920

4096x2160P / 3840x2160P 3840x2160
Same as shooting frame rate

1920x1080P 1920x1080

1920x1080i 1920x1080 59.94i, 50.00i, 59.94i, 50.00i, 60.00i, 59.94i

1280x720P 1280x720 59.94P, 50.00P, 59.94P, 50.00P, 60.00P, 59.94P

Video configuration  > [B System Setup] HDMI OUT terminal

Recording 
format

Main resolution Frame rate [HDMI Output Signal] Output format1 Output  frame rate
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Connecting to an External Monitor or Recorder
When you connect the camera to an external device, be it a monitor (to monitor the recording or for playback) or an 
external video recorder (for recording), adjust the required settings in the menu. For details about output signals, refer to 
Video Output Configuration (A 155).

Connection diagram

NOTESNOTES
• Powering the camera from a power outlet using a DC coupler and a USB power adapter/AC adapter, or a USB power 

adapter is recommended.
• If you set  > [Æ  Recording/Media Setup] > [Rec Command(EXT REC)] to [On] and connect the camera to 

another device using the HDMI OUT terminal, you can control the recording operation on the other device in 
conjunction with the camera’s recording operation (REC button). However, this function cannot be used during slow & 
fast motion recording, frame recording, interval recording or continuous recording.
When connecting to the HDMI OUT terminal, select [HDMI Time Code] > [On].

Using the HDMI OUT Terminal
The digital signal that is output from the HDMI OUT terminal includes the video signal and audio signal. You can output 
also the time code signal, recording command and various assistance displays (onscreen displays, markers, etc.) in order 
to check them also on an external monitor.

1 Connect the HDMI cable to the HDMI OUT terminal.

2 Select  > [B System Setup] > [HDMI Output Signal] > Desired option.

3 To output the time code signal, select  > [Æ Recording/Media Setup] > [HDMI Time Code] > [On].

NOTESNOTES

• You can set  > [B System Setup] > [Linked to HDMI Monitor] to [On] to automatically change the HDMI OUT 
terminal’s output resolution according to the capabilities of the connected monitor. When this setting is set to [Off ], 
the output resolution is set according to the menu settings and if the connected monitor is not compatible with the 
signal output from the camera, HDMI output will stop.

• When  > [B System Setup] > [HDMI Output] is set to [Off ], no signal will be output from the HDMI OUT 
terminal.

• The HDMI OUT terminal is for output only. Do not connect the camera to another device’s output terminal using the 
HDMI OUT terminal as this will cause a malfunction.

HDMI OUT terminal

HDMI inputs

HDMI cable (commercially available)
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• Correct operation cannot be guaranteed when connecting the camera to DVI monitors.
• In MEDIA mode, the time code is not superimposed on the HDMI OUT terminal.

Selecting the Output Range
You can select the output range of video signals (when using log gamma or PQ/HLG HDR) output from the HDMI OUT 
terminal to determine how the image levels are mapped to code values. Moreover, you can select the setting 
independently for Canon Log output and for HDR output.

Applied output range settings

1 Select  > [¢ Monitoring Setup] > [Range: HDMI].

2 Select [During Canon Log Output] or [During HDR Output] > Desired option.

Options
[Full Range Priority]:

The signal output will use full range coding whenever possible but will change the range automatically 
according to the capabilities of the connected monitor.

[Narrow Range]:
The signal output will use narrow range (video range) coding.

NOTESNOTES
• During playback, the applied range is determined according to the gamma used at the time of recording.
• When [View Assist:] (A 161) are set to [On], output range settings are disabled.

Custom picture file Applied range settings

[Gamma] [Look File]
[Gamma/Color Space] 

after the Look File is applied
 > [¢ Monitoring Setup] > [Range: HDMI]

[Canon Log 2]
[Canon Log 3]

[Off] –
[During Canon Log Output]

[On] [Conform to Custom Picture]

[PQ]
[HLG]

[Off] –
[During HDR Output]

[On] [Conform to Custom Picture]

[BT.709 Wide DR]
[BT.709 Standard]

[Canon 709]

[Off] –

[On] [Conform to Custom Picture] –
(Fixed narrow range)

– [On]

[SDR BT.709]

[SDR BT.2020]

[HDR PQ(BT.2100)]
[During HDR Output]

[HDR HLG(BT.2100)]
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Superimposing Onscreen Displays on Video Outputs
You can output the camera's onscreen displays along with the video output from the HDMI OUT terminal to check the 
onscreen displays on an external monitor. You can also adjust the opacity level of superimposed onscreen displays. This 
setting will not affect your recordings.

Select  > [¢ Monitoring Setup] > [OSD Output: HDMI] > [On].
• T appears on the right of the screen (In CAMERA mode, only if  > [¢ Monitoring Setup] > [Custom 

Display 2] > [OSD Output] is set to [On]).

NOTESNOTES

• Assistance functions will not be superimposed when the [OSD Output: HDMI] is set to [Off ], with the following 
exceptions. 
- Magnification
- Range display when [Custom Picture] > [Skin Detail] or [Color Correction] is set

• When only peaking/zebra pattern/false color is superimposed, set [OSD Output: HDMI] to [On] and set the onscreen 
display level to [DISP Level 3].

• If you set an assignable button to [OSD Output: HDMI], you can press the button to turn the camera’s onscreen displays 
on and off.

Changing the Opacity Level of Onscreen Displays
You can make onscreen displays more visible or less conspicuous by changing their opacity level. You can select to which 
screens to apply the opacity levels. This function allows you to reduce screen glare when recording in dark places.

1 To change the visibility of onscreen displays on individual video outputs, select  > [¢ Monitoring 
Setup] > Desired [OSD Opacity:] setting > [On].

2 Select  > [¢ Monitoring Setup] > [OSD Opacity Level] > Desired option.
• The smaller the percentage the more transparent the onscreen displays.

3 Select  > [¢ Monitoring Setup] > [OSD Opacity: Appl. Screens] > [All] or [Only Rec/Playback 
Screens].
• You can apply the selected opacity level to all onscreen displays (including menus, etc.) or only to onscreen displays 

on the shooting and playback screens.

NOTESNOTES

• If you set an assignable button to one of the [OSD Opacity:] settings, you can press the button to change the opacity 
level of onscreen displays on the corresponding video outputs.
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Applying the View Assistance Function to the LCD Screen
When a special gamma curve/color space is selected in the custom picture file, you can easily convert the image output 
by enabling the View Assistance function, resulting in a gamma curve/color space optimal for viewing on BT.709 
compliant monitors. 

List of view assistance

1 Only  > [¢ Monitoring Setup] > [View Assist: LCD] can be selected.

Available view assistance options

Availability and whether or not the View Assistance function can be applied depend on the [Gamma/Color Space] and 
[Look File] settings in the custom picture file (A 135). If these settings are changed, View Assistance will be turned off.

Available view assistance options (A)

View assistance Gamma curve Color space Description

[CMT 709] CMT 709 BT.709
Converts the gamma curve/color space of the image output, resulting in a standard gamma curve/
color space. It produces a look suitable for a cinema production, keeping a wide dynamic range 
without clipping when log recording.

[Canon 709] Canon 709 BT.709
These settings produce a look appropriate also for use without post processing, featuring high 
contrast while ensuring a wide dynamic range optimized for playback on BT.709 compliant 
monitors.

[HDR Assist. (400%)]1
Original gamma 

curve BT.709
LUT for viewing HDR (high dynamic range) images. The view assistance follows the ITU-R BT.2100 
transfer function to convert a brightness range of 1600% or 400% respectively into a linear 
brightness scale.[HDR Assist. (1600%)]1

Custom picture file Available View Assistance options

[Look File]
[Gamma/Color Space] 

after the Look File is applied
[CMT 709] [Canon 709] [HDR Assist. (400%)] [HDR Assist. (1600%)]

[Off] –
See the following table (A).

[On]

[Conform to Custom Picture]

[SDR BT.709] – – – –

[SDR BT.2020] – – – –

[HDR PQ(BT.2100)] Ü Ü Ü Ü

[HDR HLG(BT.2100)] Ü Ü Ü –

Custom picture file Available View Assistance options

[Gamma/Color Space] [CMT 709] [Canon 709] [HDR Assist. (400%)] [HDR Assist. (1600%)]

[Canon Log 2 / C.Gamut] Ü Ü Ü Ü

[Canon Log 3 / C.Gamut] Ü Ü Ü Ü

[Canon Log 3 / BT.2020] Ü Ü Ü Ü

[Canon Log 3 / BT.709] Ü Ü – –

[PQ / BT.2020] Ü Ü Ü Ü

[HLG / BT.2020] Ü Ü Ü –

[Canon 709 / BT.709]
[BT.709 Wide DR / BT.709]
[BT.709 Standard / BT.709]

– – – –
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Applying the View Assistance Function

1 Select  > [¢ Monitoring Setup] > desired [View Assist:] setting > [On].
• The view assistance function is applied and the gamma curve and color space of the displayed image will change.
• The signal output will use narrow range (video range) coding.

2 Select  > [¢ Monitoring Setup] > desired [Select View Assist:] option > desired setting.

NOTESNOTES

• The colors modified by using this function are an approximation.
• If you enable  > [A Assistance Functions] > one of the [False Color:] settings, the effect of the view assistance 

is temporarily removed.
• When [LCD Luminance Boost] is set to [On], the display will include the luminance-boost effect.

Adjusting the Gain Difference When Converting HDR to SDR
You can adjust the SDR gain difference relative to HDR within a range of ± 7.5 dB (in 0.5 dB increments) in the following 
cases:
• When the main clip is set to HDR* and a view assistance function that changes the color space to CMT 709 / Canon 709 

is applied to the output.
• When the main clip is set to HDR* and [Proxy Rec Color Conversion] is set to [BT.709 (Canon 709)] / [BT.709 (CMT 709)].

* When the [Gamma/Color Space] setting in the custom picture file is set to [PQ / BT.2020] or [HLG / BT.2020], or when the [Gamma/Color 
space] setting after applying a Look File is set to [HDR PQ (BT.2100)] or [HDR HLG (BT.2100)].

Select  > [¢ Monitoring Setup] > [Gain for HDRSDR Conv.] > Desired option.
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Audio Output Channels
The camera can output audio from the HDMI OUT terminal, × (headphone) terminal or speaker. When recording or 
playing back clips recorded with 4-channel audio, you can select which audio channels are output from the HDMI OUT 
terminal and headphones.

Audio output configuration

To select the audio channels for headphone output

Select  > [¡ Audio Setup] > [Monitor Channels] > Desired audio output option (L/R).
• Options like [CH1+2] indicate that two audio channels (CH1 and CH2 in this example) are mixed and output from the 

same side.

To select the audio channels for HDMI output

Select  > [¡ Audio Setup] > [HDMI OUT Channels] > [CH1/CH2] or [CH3/CH4].

Recorded audio configuration Audio output during recording/playback

Audio format Audio bit depth HDMI OUT terminal × (headphone) terminal

4-channel 
linear PCM

24 bit 2-channel 
linear PCM 

16 bit
2 channels

2-channel AAC 16 bit
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Importing Files to a Computer/Smartphone
Canon offers software applications as free downloads that allow you to save on a computer/smartphone clips recorded 
with the camera, develop RAW clips, and more.

Saving Files
Use Canon XF Utility to save and organize XF-AVC clips and other recorded files on a computer. You can use the Canon XF 
plugins to easily use XF-AVC clips directly from Avid non-linear editing (NLE) software. The software and plugins are 
available as free downloads from your local Canon website. Check the download page for the system requirements and 
latest information. 
You will find detailed instructions about installing and uninstalling the software in the "Read This First" file (Install-XF 
Utility.pdf ) included in the compressed file you will download from the website. For details about using the software, 
refer to the instruction manual (PDF file) that is installed with the software.

Canon XF Utility (for Windows/macOS): Software application that allows you to save clips on a computer, check, play back 
and organize clips and grab still frames from clips.

Canon XF Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import clips from a card or a local 
folder in the computer to the compatible version of Avid Media Composer (an NLE application compatible with Avid 
Media Access), directly from within the application.

Joining Clips Split by the Camera

Use MP4 Join Tool to join XF-HEVC S/XF-AVC S clips split by the camera in the following cases.
• When the camera switches to the other card while recording video due to the relay recording function (A 43).
• The video (stream) file in the clip will be split approximately every 4 GB.
• During chunk recording.

MP4 Join Tool is available as a free download (for Windows or macOS) from your local Canon website. Check the download 
page for the system requirements and latest information.
You will find detailed instructions about installing and uninstalling the software in the "Read This First" file (Install-MP4 
Join Tool.pdf ) included in the compressed file you download. For details about using the software, refer to the instruction 
manual (PDF file) that is installed with the software.

Saving Audio Files (WAV)
Audio files in WAV format can be saved to a computer in the same way as XF-HEVC S / XF-AVC S files. Copy the desired 
audio files (located in the “/PRIVATE/AUDIO” folder of the SD card) to the computer.

Developing RAW Clips

Use Cinema RAW Development to develop RAW clips shot/recorded with the camera. After you develop the clips and 
export them to a full-quality standard file type such as DPX, they will be ready for color grading. Alternatively, you can use 
the Canon RAW Plugin to easily use RAW clips unaltered (in RAW format) directly from major non-linear editing (NLE) 
applications. The software and plugin are available as free downloads from your local Canon website. Check the 
download page for the system requirements and the latest information.
You will find detailed instructions about installing and uninstalling the software in the “Read This First” file (Install-Cinema 
RAW Development.pdf ) included in the compressed file you will download from the website. For details about using the 
software, refer to the instruction manual (PDF file) that is installed with the software.

Cinema RAW Development (for Windows/macOS): Software application that allows you to develop, play back and export RAW 
clips.
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Canon RAW Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import RAW clips to the 
compatible version of Avid Media Composer (an NLE application compatible with Avid Media Access), directly from 
within the application.

Canon RAW Plugin for Final Cut Pro (macOS): Plugin that allows you to easily import RAW clips to Apple’s Final Cut Pro, directly 
from the application.

Saving Recordings to a Smartphone

You can save XF-HEVC S / XF-AVC S clips recorded with the camera, as well as WAV audio, photos and News Metadata files 
to a smartphone. Content Transfer Professional is needed for this operation. You can connect a smartphone to the 
camera using a compatible USB cable* or the network functions (A 187).
* For details on compatible USB cables, visit your local Canon website.

1 Select  > [ Network/USB Settings] > [USB Mode] > Desired option.
For iOS devices: select [Canon App(s) for iPhone].
For Android devices: select [Canon App(s) for Android].

2 Connect the smartphone to the camera using a compatible USB cable.

3 Open the application on the smartphone.

4 Use the application to save the files.

5 When the connection ends, disconnect the USB cable from the camera.

NOTESNOTES

• Chunk recording clips cannot be saved to a smartphone.

Automatically Transferring Recording Data to an FTP Server
You can use Content Transfer Professional to automatically transfer XF-HEVC S clips, XF-AVC S clips, WAV audio, photos 
and News Metadata to an FTP server. Install Content Transfer Professional on your smartphone in advance (A 187).

1 Connect the smartphone to the camera.
When using a USB cable, perform steps 1 to 3 of Saving Recordings to a Smartphone (A 164). 
When using network functions, perform steps 2 to 6 of Transferring Recordings to a Smartphone (A 187).

2 Smartphone: specify the destination FTP server on Content Transfer Professional, and start the [Transfer by 
Camera Operation] function. 

Connection port

Smartphone

Compatible USB cable
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3 Press REC to start recording.
• Recorded clips are automatically transferred.

4 End the connection.



Importing Files to a Computer/Smartphone

166



7
167

Network Functions

Network functions and connection types
To be able to use the following network functions you will need to connect to a Wi-Fi network, or use an optional 
Ethernet adapter connected to the camera's USB terminal to connect to a wired (Ethernet) network. For more details on 
compatible Ethernet adapters, refer to the Canon website.

Network functions and connection types

1 Connection to a Wi-Fi network via an external access point (wireless router, etc.)
2 Direct connection to one Wi-Fi-enabled device where the camera serves as the Wi-Fi access point.
3 IPv4 only.
4 Cannot be used outside the service area of Frame.io.

Security
When connecting the camera to a network, make sure to use a secure network environment. It is recommended to use 
the camera with the default settings.
When connecting the camera to a network, there is a risk of unauthorized access from unintended third parties or cyber-
attacks. If access from an external network is not required, physically and/or virtually block access so that only specified 
devices can access the network. Additionally, Wi-Fi (wireless LAN) may be intercepted by malicious third parties, posing a 
risk of eavesdropping on communication content.
If access to an external network is required, it is important to implement a secure method of communication, such as 
using a VPN (Virtual Private Network) that can block access from the outside. Use Wi-Fi in a secure environment. AES 
encryption is recommended.
In particular, the following functions do not support protocol encryption for communication with the camera; therefore, 
use these functions in a secure network environment.

- Canon App (Content Transfer Professional)
- CV Protocol

IMPORTANT

• Canon shall not be liable for any direct or indirect damages caused by network security issues.
• The camera cannot be directly connected to the communication lines (including public wireless LAN) of 

telecommunications carriers (mobile communications companies, fixed-line communications companies, Internet 
providers, etc.). When connecting the camera to the Internet, be sure to connect via a router or similar device.

Network function Description
Wired network 

(Ethernet)

Wi-Fi
A

Infrastructure1 Camera Access 
Point2

IP Streaming
Stream the camera’s live video and audio over IP to a 
compatible IP video decoder connected to the network.

Ü Ü – 183

Canon App
(Content Transfer Professional)

Transfer clips/audio recorded with the camera to a 
smartphone, or apply News Metadata created/edited 
with Content Transfer Professional to the camera.

– Ü – 187

XC Protocol
Control the camera remotely using a controller or 
application compatible with the XC Protocol via an IP 
connection.

Ü Ü Ü 185

CV Protocol
Output metadata information (from the Ethernet 
terminal) necessary for virtual production in real time 
on a PC application.

Ü3 – – 174

Frame.io4 Upload recording data from the camera using Abobe's 
Frame.io Camera to Cloud function.

Ü Ü – 188
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Before using the network functions
• The instructions in this chapter assume you already have a correctly configured and working network and correctly 

configured network device(s). If necessary, refer to the documentation provided with the network devices you plan to 
use.

• Configuring the network settings requires adequate knowledge about configuring and using wired (Ethernet) and/or 
wireless (Wi-Fi) networks. Canon cannot provide support regarding network configurations.

IMPORTANT

• In case it is necessary to set a password for network connections or function settings, make sure to set a secure 
password that is long enough to be hard to guess, including a combination of characters and symbols. Use caution not 
to lose the password.

NOTES

• Do not open the card compartment cover while using network functions.
• Do not place cables connected to the camera’s HDMI OUT terminal, INPUT 

terminals, MIC terminal or USB terminal near the built-in wireless antenna. Doing 
so may negatively affect the wireless communication or the audio recorded.

• Connecting devices to the camera's USB terminal:
- When connecting or disconnecting an Ethernet adapter (or a terminal 

converter/adapter cable), make sure to turn off the camera beforehand.

Using a Wi-Fi Network

Wi-Fi Connection Types

You can connect the camera in Infrastructure mode, using an access point (wireless router etc.), or in Camera Access Point 
mode, directly to a network device. The type of connection you can use, depends on the network function you wish to 
use (A 167).
For an Infrastructure connection, the camera offers 4 ways to configure an access point and the method you use will 
depend on the type and specifications of the access point and network you plan to use. 

Camera Access Point: When shooting in a location where there are no access points available, the camera can serve as a 
wireless access point*. Wi-Fi enabled devices will be able to connect to the camera directly.
* Limited only to the connection between the camera and supported Wi-Fi enabled devices. The functionality is not the same as that of 

commercially available access points. 

Infrastructure connection: 
WPS (button): If your wireless router supports Wi-Fi Protected Setup (WPS), setup will be easy and 
require minimal configuring and no passwords. To check if your wireless router has a WPS button 
and for details about how to activate the Wi-Fi protected setup, refer to the instruction manual of 
your wireless router.

WPS (PIN code): Even if your wireless router does not have a dedicated WPS button, it may support WPS using a PIN code 
instead. For setup using a PIN code, you will need to know in advance how to activate the wireless router’s WPS function. 
For details refer to the instruction manual of your wireless router.

Searching for Access Points: If your access point does not support the WPS function or you cannot activate it, you can 
have the camera search for access points in the area.

Entering the SSID and authentication method: Manually enter the SSID and other information about the access point.

Built-in wireless antenna
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IMPORTANT

• Depending on the country/region of use, some restrictions on outdoor use or Camera Access Point connections may 
apply when using the IEEE 802.11b/g/a/n/ac wireless standard. Check in advance the applicable areas of use and 
restrictions.

Using a Wired (Ethernet) Network
Connect a commercially available Ethernet adapter to the camera’s USB terminal to use a wired network with an Ethernet 
cable. Use Category 5e, shielded twisted pair (STP) Ethernet cables compatible with Gigabit Ethernet (1000BASE-T) and 
with good shielding capability. For more details about the Ethernet adapter and Ethernet cables, refer to the 
manufacturer’s instruction manual.

Connecting

1 Turn off the camera.

2 Insert the Ethernet adapter into the camera’s USB terminal.
• If necessary, use a Type-C (male) to Type-A (female) adapter/cable.

3 Connect an Ethernet cable to the Ethernet adapter and the desired network device.

4 Turn on the camera.

5 Select  > [ Network/USB Settings] > [USB Mode] > [Ethernet Adapter].

NOTES
• When using an Ethernet adapter, operation is only possible using the DR-E6P DC Coupler and the PD-E2 USB Power 

Adapter in combination.

USB terminal

Ethernet cable 
(commercially available)

Ethernet port on a 
network device

Ethernet adapter 
(commercially available)



Configuring Connection Settings

170

Configuring Connection Settings
To connect to a network you will need to define in advance a connection setting (SET), which is a combination of one or 
two communication settings (networks, NW) and one network function setting (MODE). You can save in the camera up 
to 25 individual communication settings and function settings, and up to 20 combinations of connection settings (SET1 
to SET20).
To configure a connection setting for the first time, you will follow the setup wizard (A 171). Using the wizard, you can 
set up only one network and one function per connection setting. After having configured multiple connection settings, 
you can change them (for example to add a secondary network) and you can create new ones combining existing 
communication and function settings (A 179).

Activating a Network Connection
Activate the desired network connection to use network functions or to configure the connection setting online.

1 Select  > [  Network/USB Settings] > [Network] > [Enable].

2 When using connection settings that you saved previously, select  > [  Network/USB Settings] > 
[Connect] > Desired connection setting ([SET1] to [SET20]) > [OK].
• To end the network connection, set [Connect] to [Disconnect] instead.

Configure the necessary connection settings for the networks and network functions you wish 
to use.

Select a connection setting appropriate for the network function you wish to use and start 
using the function.

IP streaming (A 183) 
Canon App (A 173) 
XC Protocol (A 173)
CV Protocol (A 174)
Frame.io (A 174)

Step 1

Step 2

Connection setting (SET)

Communication 
Setting 1* (NW)

Communication 
Setting 2

Function 
Setting 1* (MODE)

Wi-Fi

* Configured using the wizard.

Ethernet

Camera Access Point
Infrastructure

WPS (push button)
WPS (PIN code)
Detected access points
SSID/authentication mode input

IP streaming
Canon App
XC Protocol
CV Protocol
Frame.io
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Adding a New Connection Setting Using the Wizard
You can use the wizard to set up a new connection setting. This section uses a connection to a Wi-Fi network using the 
WPS push button method as an example. Refer to the instruction manual of the access point for details about the 
location and operation of the WPS button.

1 Enable the network functions (A 170).

2 Select  > [  Network/USB Settings] > [New Conn. Setting (Wizard)] > Desired network function > 
[OK].

3 Select [Create New Comm. Setting].
• Once you have added multiple communication settings, you can select [Select Existing Setting] to reuse the settings 

for a network that you saved previously.

4 Select [Wi-Fi ].
• To configure a wired (Ethernet) network (A 175).

5 Select [Connect with WPS] > [WPS (Push Button)].
• To use a different configuration method, complete the corresponding procedure.

Camera Access Point (A 175)
WPS using a PIN code (A 176) 
Detected access points (A 176) 
SSID/authentication mode input (A 176) 
Manual setup without connecting to the network (A 177) 

6 Press and hold the WPS button on the wireless router and then, on the camera, select [OK].

7 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] > 
[Disable].
• To configure IPv4 settings manually (A 177).
• To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6 settings as 

necessary (A 180).

8 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings.

IP streaming (A 171), Canon App (A 173), XC Protocol (A 173), CV Protocol (A 174), Frame.io (A 174)

NOTES
• The [WPS (Push Button)] method may not work correctly depending on the devices used or the surrounding 

conditions. In such case try using [WPS (PIN Code)] (A 176) or selecting one of the detected networks (A 176).

Function Settings

IP Streaming

This section continues the connection settings wizard (A 171). In the function settings you will configure the streaming 
video bit rate and resolution, the protocol used and the receiver’s settings. For details refer to the instruction manual of 
the decoder device or software you will use.

1 Select [Create New Func. Setting].
• Once you have added multiple function settings, you can select [Select Existing Setting] to reuse IP streaming 

settings that you saved previously.

2 Select the desired protocol.
• Depending on the selected protocol, perform steps 3 to 6 if necessary and then continue to step 7.
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[UDP] / [RTP] streaming

3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].
• Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry screen (A 30).
• Using the default port number is recommended.

[RTP+FEC] streaming

3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].
• Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry screen (A 30).
• Using the default port number is recommended.

4 Configure the settings used to send FEC packets. Select [FEC Port No.] and [FEC Interval] > [OK].
• Enter the port number using the data entry screen (A 30).
• Using the default settings is recommended.
• Proceed to step 7.

[RTSP+RTP] streaming

3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].
• Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry screen 

(A 30).
• Using the default port number is recommended.

4 Enter the user name and password of the RTSP client. Select [RTSP: User Name] and [RTSP: Password] > [OK].
• Enter the desired user name and password using the keyboard screen (A 30).
• Proceed to step 7.

SRT

3 Select the connection mode.
Caller:Connect to a decoder or a computer from the camera.
Listener:Listens for connections from the decoder or computer.

4 When [Caller] is selected, enter [Destination Server], [Dest. Port No.] and [Stream ID], then select [OK].
• Using the default port number is recommended. 

5 When [Listener] is selected, enter [Listening Port No.] then select [OK].
• Enter the port number of the decoder or computer.

6 Select [Encryption Settings], enter [Passphrase] and [Latency], and then select [OK].

All streaming protocols

7 Select the video streaming configuration.

8 Select the audio channels.

9 Depending on the resolution and frame rate, a screen may prompt you to change other settings. Change the settings 
as necessary.

10 Select [OK].
• The function settings are saved to a [MODE] file.

11 Select the connection setting (SET1 to SET20) where to save the settings.

12 Select [OK].
• The camera will connect to the network and will be ready to start streaming.

13 Connect the decoder to the network and complete any necessary configurations on the receiving side so the decoder 
is ready to receive video over IP.

• To start streaming, refer to IP Streaming (A 183).
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Options for [Protocol]
[UDP]: This protocol prioritizes transfer speeds but does not guarantee the reliability/integrity of the data. Lost or 

delayed IP packets are ignored.

[RTP]: Standard protocol for video/audio broadcasts over the Internet. Lost or delayed IP packets are ignored.

[RTP+FEC]: This setting uses the RTP protocol and adds a layer of FEC error correction so the receiving side* can recover 
lost or delayed IP packets.

[RTSP+RTP]: This setting uses the RTSP (real time streaming) protocol to control the streaming server (camera) in real time 
and the RTP protocol for the broadcast over IP. With the RTSP protocol, the receiver can control when to start 
and stop the broadcast.

[SRT]: A protocol for high-speed transmission that suppresses the occurrence of lost/delayed packets. Transmitted 
data can be encrypted.

* A decoder compatible with FEC error correction is required.

Canon App (Connecting to a Smartphone)

This section details the necessary settings to connect the camera to a smartphone through a network. Be sure to connect 
both the smartphone and the camera to the same network in advance.
A Content Transfer Professional is necessary to connect the camera to a smartphone. For details on downloading the 
necessary Content Transfer Professional, refer to Transferring Recordings to a Smartphone (A 187). For more details, refer 
to the smartphone’s instruction manual.

1 Select [Create New Func. Setting].
• Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Canon App 

settings that you saved previously.

2 Select [OK].

3 As indicated on the screen, open the application on the smartphone.

4 Select the camera using the Content Transfer Professional.
• If the camera and the smartphone are connected to the same network, the camera will be detected automatically.

5 Select [OK].
• The connection will be completed.
• The function settings are saved to a [MODE] file.

6 Select the connection setting (SET1 to SET20) where to save the settings.

7 Select [OK].
• The connection will be completed and the camera will be ready to operate with the connected smartphone 

(A 187).

XC Protocol

Set a user name and password to connect to an XC Protocol compatible device connected to a network.

1 Select [Create New Func. Setting].

2 Set the authentication method used by the XC Protocol (HTTP/HTTPS) server.
• After selecting [Basic Authentication] or [Digest Authentication], set the user name and password.

User name: 5 to 15 alphanumeric characters or symbols. 

Password: 8 to 32 alphanumeric characters or symbols (use at least 2 types from each).

3 Select [OK].
• The function settings are saved to a [MODE] file.

4 Select the connection setting (SET1 to SET20) where to save the settings.

5  When the confirmation message appears, press SET.
• The camera will connect to the network and will be ready to accept commands from the remote controller/

application (A 185).
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CV Protocol

Configure the camera to output metadata information necessary for virtual production in real time on a PC application. 
Ethernet IPv4 only.

1 Select [Create New Func. Setting].

2 Enter [Destination Server] and [Dest. Port No.] as the destination settings and select [OK].
• Enter the address of the communication method (unicast/multicast*/broadcast) to be used for the destination 

server.
* Communication is only possible within the same network segment.

• Using the default port number is recommended.

3 Select the connection setting (SET1 to SET20) where to save the settings.

4 When the confirmation message appears, press SET.
• Use the Canon Live Link Plugin for Unreal Engine to send metadata information to applications used for virtual 

production. For details about using and downloading Live Link Plugin for Unreal Engine refer to the Canon website.

NOTES

• When the set slow & fast motion shooting frame rate exceeds 60P, [CV Protocol] cannot be used at the same time.
• CV protocol metadata is not output if video signal is not being output from the HDMI OUT terminal.
• Performing the following operations during CV protocol connection may cause the connection to be interrupted:

- Switching the recording mode, second card recording function, or sensor mode.
- Changing the main recording format, main resolution, or frame rate.
- Switching digital image stabilization [On]/[Off ].
- Switching focus breathing correction [On]/[Off ].

Frame.io

Set up a connection between the camera and Frame.io.

1 Select [Create New Func. Setting].
• If there is a previously registered function setting related to Frame.io, you can select it from [Select Existing Setting].

2 Select the pairing destination.
[Keep Current Pairing]: Maintains the pairing status with the camera.

[Create New Pairing]: Creates a new pairing with Frame.io. If you want to re-pair when the camera is already paired, select 
[OK].

3 Select [OK].
• The pairing code is displayed.
• If [Keep Current Pairing] is selected, proceed to step 6.

4 From Frame.io: Access Frame.io and enter the pairing code.
• The camera is paired with Frame.io.

5 Select [OK].

6 Select [Auto Upload File Formats].
 [XF-AVC Proxy]: Proxy clips in XF-AVC format.

 [XF-HEVC S/XF-AVC S Proxy]: Proxy clips in XF-HEVC S/XF-AVC S format.

 [Audio Proxy]: Audio recording files (second card recording functions). 

7 Select [OK].
• The function settings are saved to a [MODE] file.

8 Select the connection setting (SET1 to SET20) where to save the settings, then select [OK].
• The connection is completed. Refer to Uploading Recording Data to Frame.io (A 188) for operation details.



175

Configuring Connection Settings

Other Connection Methods
This section explains how to configure communication settings using methods other than the WPS push button.

Ethernet Settings

1 In the [Network Type] screen, select [Ethernet ].

2 Make sure the Ethernet cable is correctly connected (A 169) and select [Setup with Network Connection].
• Select [Setup without Network Connection] to only configure the settings, without connecting to the network.

3 Set the IP address (A 177).

4 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings (A 171).

Camera Access Point

Connect a network device with the camera’s access point. Two configuration methods are available: easy connection and 
manual connection.

1 In the [Select a network] screen, select [Camera Access Point Mode].

2 Select the configuration method.
• Depending on the selected method, perform either step 3 or steps 3-7 and then continue to step 8.

[Easy Connection]

3 The camera will assign the network name (SSID) and password automatically. Review the settings for the camera’s Wi-Fi 
access point and select [OK].
• These settings are necessary to connect a network device to the camera.

[Manual Connection]

3 Enter the SSID (network name) for the Camera Access Point and then select [OK].
• Enter the desired network name using the keyboard screen (A 30).

4 Select the Wi-Fi channel.
• Select [Automatic Setting] to have the camera select the channel automatically, or select [Manual Setting] > Desired 

channel.

5 Select the encryption settings.
• Select [AES] to use AES encryption, or [Disable] to use no encryption. 
• If you selected [Disable], skip to step 7.

6 Enter the password for the Camera Access Point and then select [OK].
• Enter the desired password using the keyboard screen (A 30).

7 Set the IP address (A 177).

Both configuration methods

8 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings (A 171).

9 Before you can save the connection setting, connect the network device to the camera.
• Activate the device’s Wi-Fi function, select the camera’s SSID (network name) from the list and enter the password to 

connect to the camera.
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WPS using a PIN Code

Connect to an access point using a PIN code. For most wireless routers, you must use a Web browser to access the setup 
screen. For details on how to set up the access point, refer to the access point’s user manual.

1 In the [Select a network] screen, select [Connect with WPS] > [WPS (PIN Code)].
• The camera will generate and display an 8-digit PIN code.

2 Enter the PIN code into the wireless router’s WPS (PIN code) setup screen and then, on the camera, select [OK].

3 Set the IP address (A 177).

4 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings (A 171).

Detected Access Points

The camera will automatically detect access points in the vicinity. After you select the desired access point, you only need 
to enter the selected network’s password to connect the camera. Be sure to activate tethering in advance when using a 
smartphone as an access point. For details about the access point’s network name (SSID) and password refer to the 
wireless router’s instruction manual or consult the network administrator in charge of the access point.

1 In the [Select a network] screen, scroll through the list of detected networks and select the desired network.
• If the access point is encrypted, enter the password of the access point using the keyboard screen (A 30).
• If multiple SSIDs with the same name are detected, the access point channel will be displayed as blank. When 

selecting an SSID with a blank channel, the camera will connect to the access point with the strongest signal 
strength.

2 Set the IP address (A 177).

3 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings (A 171).

SSID/Authentication Mode Input

You can connect to a specific access point by manually entering its details. For details about the access point’s network 
name (SSID) and password refer to the wireless router’s instruction manual or consult the network administrator in charge 
of the access point. 

1 In the [Select a network] screen, select [Enter SSID/Authentication Method].

2 Enter the SSID (network name) of the desired network and then select [OK].
• Enter the desired network name using the keyboard screen (A 30).

3 Select the network’s authentication method.
• If you select [Open System], proceed to step 5.
• If you select [WPA/WPA2/WPA3-Personal], proceed to step 4.
• If you select [WPA/WPA2/WPA3-Enterprise], proceed to step 5.

4 Enter the password of the desired network and then select [OK].
• Enter the desired password using the keyboard screen (A 30).

5 Set the IP address (A 177).

6 Select [OK] to continue to configure the function settings.
• The communication settings are saved to an [NW] file.
• Continue with one the following procedures to configure the selected function’s settings (A 171).
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Offline Configuration without Connecting to a Network

1 In the [Select a network] screen, select [Configure Offline].

2 Select the network type.
• If you select [Infrastructure], continue with the procedure to enter the SSID and authentication mode, from step 2 

(A 176).
If you select [Camera Access Point Mode], continue from that procedure, from step 2 (A 175).

Configuring the Camera’s IP Address

This section explains how to configure the IP address. Available settings will change depending on the network function 
selected.

1 Select the method used to configure IPv4 settings, [Automatic Setting] or [Manual Setting].
• When using the wizard to add a new connection setting, make the selection in the [IP Address Settings (IPv4)] 

screen.
• If you select [Automatic Setting], skip to step 4.

[Manual Setting]

2 Select [IP Address] and [Subnet Mask] and enter the desired addresses using the data entry screen (A 30).
• To use a default gateway, select [Use Gateway] > [Enable] and then select [Gateway] and enter the address.
• To use a DNS address, select [Use DNS Address] > [Manual Setting] and enter the address.

3 Select [OK].

Both methods

4 Select whether to use TCP/IPv6 settings or not.
• To use IPv4 settings, select [Disable].
• To configure IPv6 settings (A 180).

Other Network Settings

802.1X Authentication

Only available when connected via Wi-Fi. The camera is compatible with the following protocols.
EAP-TLS: X.509 supported
EAP-TTLS, PEAP: MS-CHAP v.2 supported

Select  > [  Network/USB Settings] > [Advanced Settings] > [802.1X Authentication] > [Setup 
Wizard].
• Follow the wizard to complete the authentication settings.

When you select the [EAP-TLS] protocol, the root certificate, client certificate and private key (8021X_C.KEY) will be read 
from the card. 
When you select the [EAP-TTLS] or [PEAP] protocol, select [User Name] and [Password] and enter the information using 
the keyboard screen. Then, read the root certificate from the card. Each must be saved directly in the card’s root 
directory.

• After reading the authentication files, select [Check Settings] to check their content. Select [Delete Settings] to delete 
the authentication files in the camera.

NOTES

• Only one root certificate, with one of the following file names, can be read by the camera: "8021X_R.CER", 
"8021X_R.CRT" and "8021X_R.PEM".
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• Only one client certificate, with one of the following file names, can be read by the camera: "8021X_C.CER", 
"8021X_C.CRT" and "8021X_C.PEM".

Reading/Deleting a Root Certificate for Frame.io Upload

This section describes how to read a root certificate onto the camera when using Frame.io.

1 Save the desired root certificate file onto the root directory of a card and insert it into card slot 2.

2 Select  > [  Network/USB Settings] > [Frame.io] > [Root Certificate].

3 Select [Read Root certificate], then select [OK].
• The root certificate file is read from the card.
• After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer and 

expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera.

NOTES

• Only one root certificate, with one of the following file names, can be read by the camera: "FRAMEIO.CER", 
"FRAMEIO.CRT" and "FRAMEIO.PEM".

Giving a Nickname to the Camera

You can give the camera a nickname that is used on network connections and network devices to make it easier to 
identify.

Select  > [  Network/USB Settings] > [Nickname].
• Enter the desired nickname using the keyboard screen (A 30).

Checking and Changing Connection Settings (SET)
You can check and, if necessary, change the settings of connection settings (SET) registered in the camera. In addition to 
deleting and renaming connection settings, you can also add to a connection setting a secondary network.

Checking the Content of a Connection Setting

Select  > [  Network/USB Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) > 
[Check Settings].
• The detailed content of the connection setting is displayed.
• Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to return to 

the menu.

Changing Settings using the Wizard

1 Select  > [ Network/USB Settings] > [Network] > [Enable].

2 Select  > [ Network/USB Settings] > [Connect] > [Disconnect].

3 Select  > [ Network/USB Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Change with Wizard].

4 Select the desired network function and then follow the wizard as described in the previous procedure (from step 3, 
A 171) and make any changes as necessary.
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Changing Connection Settings using Existing Settings

You can use previously registered communication settings ([NW] files) or function settings ([MODE] files) to easily replace 
the content of a connection setting or to add a second network in addition to those registered using the wizard.

1 Select  > [ Network/USB Settings] > [Network] > [Enable].

2 Select  > [ Network/USB Settings] > [Connect] > [Disconnect].

3 Select  > [  Network/USB Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Select Existing Setting].

To add/replace a communication or function setting

4 Select the setting you want to change > [Select Existing Setting] > Desired NW or MODE file.
• In the list of communication settings and function settings registered in the camera, only those that can be selected 

will be displayed in white and others will be grayed out. 

5 Select [Set].
• If necessary, select [Check Comm. Settings] or [Check Function Settings] to check the content of the selected file 

before making the change.

To delete a communication or function setting

4 Select the setting you want to remove > [Clear Selected] > [OK].

NOTES
• If both communication settings are deleted, the connection setting itself will be reset and will appear as [Unspecified].

Renaming Connection Settings

You can rename connection setting (SET) files to make them easier to identify from the list.

1 Select  > [ Network/USB Settings] > [Network] > [Enable].

2 Select  > [ Network/USB Settings] > [Connect] > [Disconnect].

3 Select  > [  Network/USB Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Settings Name].

• Enter the desired name (up to 12 characters) using the keyboard screen.

Deleting Connection Settings

1 Select  > [ Network/USB Settings] > [Network] > [Enable].

2 Select  > [ Network/USB Settings] > [Connect] > [Disconnect].

3 Select  > [  Network/USB Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20]) 
> [Delete Settings] > [OK].

• The connection setting will be deleted.

NOTES

• Even if you delete a connection setting, the individual communication/function settings stored in it are not deleted. 
You can reuse these settings to configure other connection settings.

Checking and Changing Communication Settings (NW)/Function Settings (MODE)
You can check the content of communication settings ([NW] files) and function settings ([MODE] files) saved in the 
camera and change or delete them as necessary.
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Checking the Content of a Communication Setting/Function Setting

1 Select  > [ Network/USB Settings] > [Network] > [Enable].

2 Select  > [ Network/USB Settings] > [Connect] > [Disconnect].

3 Select  > [  Network/USB Settings] > [Advanced Settings] > [Communication Settings] or [Function 
Settings].

4 Select the desired communication setting ([NW1] to [NW25]) or function setting ([MODE1] to [MODE25]).

5 Select [Check Settings].
• The detailed content of the selected setting is displayed.
• Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to return to 

the menu.

Changing/Deleting Communication Settings/Function Settings

1 Select  > [ Network/USB Settings] > [Network] > [Enable].

2 Select  > [ Network/USB Settings] > [Connect] > [Disconnect].

3 Select  > [  Network/USB Settings] > [Advanced Settings] > [Communication Settings] or [Function 
Settings].

4 Select the desired communication setting ([NW1] to [NW25]) or function setting ([MODE1] to [MODE25]).

5 Select [Change Settings] and change the various settings as necessary.
• If in step 4 you selected an [Unspecified] settings file, the only option available is [Create New with Wizard] (A 171).
• Select [Delete Settings] > [OK] to delete the communication setting/function setting.

Configuring TCP/IPv6 Settings
If in the wizard you selected [Enable] to use IPv6 settings, change the settings as necessary after completing the wizard.

1 After step 3 in the previous procedure, select [TCP/IPv6] > [TCP/IPv6 Settings] > [Enable].
• This step is not necessary if you selected [Enable] when you used the wizard to add a new connection setting.
• Continue the procedure to change the default IPv6 settings.

2 To configure the IPv6 settings manually, select [Manual Setting] > [Enable].
• [DNS Server] changes to [Manual Setting].

3 Select [DNS Server] > Desired option.
• If you selected [Disable] in step 2, you can set [DNS Server] to [Auto Assign].
• When not using a DNS server, select [Disable].

4 If you set [DNS Server] to [Manual Setting] in step 3, configure the [DNS Address].
• Enter the IP address using the data entry screen (A 30).

When [Manual Setting] is set to [Enable]

5 Select [Manual Address] (manually entered IPv6 address), [Prefix Length] (bits available for the network address) and 
[Gateway] (gateway’s IP address) and enter the necessary information.
• Enter the IP addresses and prefix length using the data entry screen (A 30).

Individual settings available for manual change (communication settings)

Menu item Setting options and additional information

[Wi-Fi]

[SSID] –

[Advanced Settings] [Authentication Method], [Password]

[TCP/IPv4]
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Individual settings available for manual change (function settings)

* Change these settings as explained in the wizard (A 171).

To change XC Protocol settings

1 Select  > [  Network/USB Settings] > [Advanced Settings] > [XC Protocol Settings].

2 Change the various settings as necessary.
• You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each connection. Using 

the default port numbers (HTTP: 80, HTTPS: 443) is recommended.
• To use an HTTPS connection, select [HTTPS] > [Enable].

To use a secure HTTPS connection, select [Save HTTPS Self-signed Cert] to save the self-signed certificate on the SD 
card. After you import the saved self-signed certificate into an XC Protocol-compatible device, you will be able to use 
a secure HTTPS connection.

[IP Address Settings]* [Automatic Setting], [Manual Setting]

[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address]*, [IP Address]*, 
[Subnet Mask]*, [Gateway]*

[TCP/IPv6]

[TCP/IPv6 Settings]* [Disable], [Enable]

[Manual Setting] [Disable], [Enable]

[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address], 
[Manual Address], 
[Prefix Length], [Gateway]

Enter the desired address using the data entry screen (A 30).

Menu item Setting options and additional information

[IP Streaming]

[Protocol]* [UDP], [RTP], [RTP+FEC], [RTSP+RTP], [SRT]

[Destination Server]*, 
[Dest. Port No.]*,
[FEC Port No.]*

[FEC Interval]

[RTSP: User Name]*, 
[RTSP: Password]*

[SRT: Connection Mode] [Caller], [Listener]

[SRT: Stream ID]

[SRT: Listening Port No.]

[SRT: Encryption Settings] [Disable], [AES-128], [AES-192], [AES-256]

[SRT: Passphrase]

[SRT: Latency]

[Video Output Conf.]* [9Mbps/1920x1080 59.94P], [4Mbps/1920x1080 59.94P], [9Mbps/1920x1080 50.00P], 
[4Mbps/1920x1080 50.00P], [9Mbps/1920x1080 59.94i], [4Mbps/1920x1080 59.94i], 
[9Mbps/1920x1080 50.00i], [4Mbps/1920x1080 50.00i]

[Audio Out Channels]* [CH1/CH2], [CH3/CH4]

[CV Protocol]

[Destination Server]

[Dest. Port No.]

Menu item Setting options and additional information
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Checking the Network’s Status
Unless you selected to configure a connection setting offline (without connecting to the network), immediately after 
configuring a new connection setting, the camera will connect to the network automatically and the selected function 
settings will be activated. The icons displayed on the screen will indicate the type of network selected and the 
connection status. When you disable the network functions or disconnect from the network, the icons will disappear.

Network connection icons
 Wi-Fi (Infrastructure): 

In yellow – the camera is connecting to or disconnecting from the network. In white – the network function 
can be used.

 Wi-Fi (Camera Access Point): 
In yellow – starting the camera’s access point. In white – the camera’s access point is ready. Connect the Wi-Fi 
enabled device to the camera.

 Ethernet: In yellow – the camera is connecting to or disconnecting from the network. In white – the network function 
can be used.

Network function icons
: IP streaming (A 183)

: CV protocol (A 174)

: Frame.io (A 188)

Frame.io upload status icons
 00: Uploading

 00: Upload paused

: Upload requests are full.

Others
: Ethernet adapter recognition status

Displayed in white during recognition of the Ethernet adapter. It is displayed in red in the following cases (A 222):
• When power is not supplied from the DR-E6P DC Coupler. [USB Mode] > [Ethernet Adapter] cannot be used.
• When a malfunction in the Ethernet adapter is detected. [USB Mode] cannot be used.
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IP Streaming
In CAMERA mode, you can stream the camera’s live video and audio over IP to a compatible IP video decoder* connected 
to the network. You can use IP streaming for live broadcasts or to send video reports from a location with poor network 
connectivity.
* This can be a dedicated video transfer device or decoder software on a computer. For details about compatible decoders, please visit your 

local Canon website.

Configuration of video streamed over IP

* When the audio of the primary clip uses 4 channels, you can select which channels to stream over IP.

1 On the receiver’s side: Connect the decoder to the network and complete any necessary configurations so it 
is ready to receive video over IP.
• For details refer to the instruction manual of the decoder device or software you will use.

2 On the camera: Connect the camera to the desired network and activate the network functions (A 170).
• Select a connection setting with the [IP Streaming] function setting.

3 Select  > [  Network/USB Settings] > [Activate IP Streaming] > [Enable].
• The camera will start streaming video over the selected network.
• You can press the REC button to simultaneously record the same image in the camera.

4 On the receiver’s side: Connect to the camera. 
When the streaming protocol is [RTSP+RTP], access the following URL and log in using the RTSP user name and 
password (A 171). 

When the streaming protocol is [SRT] and the connection mode is [Listener], access the following URL.

• If the data to be transmitted is encrypted, enter the SRT passphrase.

5 On the camera: To end the streaming, select  > [  Network/USB Settings] > [Activate IP Streaming] 
> [Disable].

IMPORTANT
• Streamed data is not encrypted (except when encrypted using the SRT protocol).

NOTES

• Except when the streaming protocol is RTSP or SRT, once IP streaming is activated, the camera will continue to 
broadcast video and audio data over the network, regardless of the status of the receiver. Be careful to set up the 
correct IP address and test in advance that the receiving decoder can indeed receive the signals.

• Depending on the network used and the connection conditions, you may experience lost or delayed IP packets.

Main recording video configuration Streamed video configuration

Video format Main resolution Frame rate
Video Audio

Bit rate Resolution Frame rate Audio format Bit rate

XF-AVC,
XF-AVC S

3840x2160,
1920x1080

59.94P

4 Mbps,
9 Mbps 1920x1080

59.94P, 59.94i

MPEG-2 AAC
2 channels* 256 Kbps

59.94i 59.94i

50.00P 50.00P, 50.00i

50.00i 50.00i

rtsp://xxx.xxx.xxx.xxx/stream

Camera’s IP address

srt://xxx.xxx.xxx.xxx/xxx...

Camera’s IP address Listener port number
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• After streaming continuously for 24 hours, the camera will stop the IP streaming momentarily and then restart it 
automatically.

• Opening the card compartment cover and removing a card while IP streaming is activated may cause brief stops in the 
streamed video and audio.

• IP streaming cannot be used in the following cases:
- When the main recording format is set to one of the [XF-HEVC S] or [RAW] options.
- When using a recording mode other than [Normal Recording].
- When [2nd Card Rec Functions] is set to an option other than [Off ].
- When using the camera as a web camera.
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Recording Remotely Using an XC Protocol Compatible Controller/
Application
Set the IP address of the camera on the optional XC Protocol compatible RC-IP100/RC-IP1000 Remote Camera Controller 
or Remote Camera Control Application1 to control the camera remotely. You can also control the camera remotely using 
Multi-Camera Control2 on a smartphone connected to the same network as the camera.
1 Available from your local Canon website.
2 Available from the App Store.

1 In CAMERA mode, activate the network functions (A 170)
• Select a connection setting with the [XC Protocol] function setting. 

Recording remotely using the RC-IP100/RC-IP1000 Remote Camera Controller
You can remotely control camera settings like the aperture and shutter speed, or change picture related settings like the 
knee and sharpness. For more details on the connection, settings and the RC-IP100/RC-IP1000 refer to the RC-IP100/RC-
IP1000 instruction manual.

NOTES
• The zoom can only be operated when a compatible lens (A 246) is attached to the camera.
• [PRESET] focus and zoom settings can only be operated when a compatible lens is attached to the camera (A 246).
• Even if the camera’s controls are locked (key lock), you can use the RC-IP100/RC-IP1000 to operate the camera (A 31).

NOTES
• About changing custom picture related settings

- If a protected custom picture file is selected on the camera, custom picture related settings cannot be changed 
using the remote camera controller or Remote Camera Control Application.

- Adjusting custom picture related settings using the remote camera controller or Remote Camera Control 
Application will change the settings registered under the currently selected custom picture file. If you want to keep 
an important custom picture file, backup it or select in advance a custom picture file you do not mind changing.

Recording remotely using the Remote Camera Control Application
During recording, you can check the angle of view using Live View and adjust various picture related settings. For details 
about connection/setup and the Remote Camera Control Application, refer to the Remote Camera Control Application 
manual.

NOTES

• Even when camera operation is disabled by key lock, operation is possible using the Remote Camera Control 
Application (A 31).

• When adjusting custom picture related settings, refer to About changing custom picture related settings (A 185).
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Recording remotely using Multi-Camera Control
You can use a smartphone connected to the same network as the camera to remotely operate the camera and record 
video. During recording, you can check the angle of view using Live View and adjust various picture related settings.

1 Install Multi-Camera Control on your smartphone.
• Download and install Multi-Camera Control from the App Store.
• There is no need to repeat this step after the first time.

2 Connect the smartphone to the same network (access point) as the camera.
• For details, refer to the smartphone's instruction manual.

3 Activate the desired network connection (A 170).
• Select a connection setting with the [XC Protocol] function setting.

4 Open Multi-Camera Control on the smartphone.

5 Operate the smartphone to connect to the camera.

6 Operate Multi-Camera Control on the smartphone to record remotely.

7 When you finish the procedure, set  > [  Network/USB Settings] > [Network] to [Disable].
• You can also set  > [  Network/USB Settings] > [Connect] to [Disconnect].

NOTES

• Even when camera operation is disabled by key lock, operation is possible using the Multi-Camera Control (A 31).

When connecting multiple cameras

When connecting multiple cameras, it is recommended to use the 5 GHz band or to connect the camera and the 
network device (wireless LAN router) via Ethernet.

USB terminal

Ethernet cable
(commercially available)

Ethernet port on a network device

Ethernet adapter 
(commercially available)

Smartphone/
Tablet

DR-E6P and PD-E2

DR-E6P and PD-E2
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Transferring Recordings to a Smartphone
You can transfer and save clips (XF-HEVC S, XF-AVC S), audio (WAV), photos (JPEG) and News Metadata files to a 
smartphone (connected to the same network as the camera) (A 164).

1 Install Content Transfer Professional on your smartphone.
• Download and install the Content Transfer Professional from the App Store or Google Play.
• There is no need to repeat this step after the first time.

2 Connect the smartphone to the same network (access point) as the camera.
• Be sure to activate tethering in advance when using a smartphone as an access point.
• For details, refer to the smartphone’s instruction manual.

3 Activate the desired network connection (A 170).
• Select a connection setting with the [Canon App] function setting. However, since the Canon application settings 

are saved for each smartphone, reconfiguration is required when using a different smartphone.

4 As indicated on the screen, open the application on the smartphone.

5 Operate the smartphone to connect to the camera.

6 Select [OK].

7 Using the Content Transfer Professional, transfer recordings from the camera.

8 When you finish the procedure, set  > [  Network/USB Settings] > [Network] to [Disable].
• You can also set  > [  Network/USB Settings] > [Connect] to [Disconnect].
• When you end the connection from the smartphone,  > [  Network/USB Settings] > [Network] will be set 

to [Disable].

NOTES
• Use a supported USB cable or the network functions to connect the camera to a smartphone. When connecting using 

a USB cable, refer to Saving Recordings to a Smartphone (A 164).
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Uploading Recording Data to Frame.io
Once paired with the camera, you can use Adobe's Frame.io Camera to Cloud function to upload proxy clips (XF-AVC, XF-
HEVC S, XF-AVC S) and WAV audio (second card recording functions) recorded on the card in slot 2.

Automatic upload

1 Activate the network functions (A 170).
• Select a connection setting with the [Frame.io] function setting.

2 Select  > [  Network/USB Settings] > [Frame.io] > [Auto Upload On Recording] > [On], then start recording.
• The data is added to the upload queue and uploaded to Frame.io sequentially.

Manual upload

1 Switch to MEDIA mode.

2 Activate the network functions (A 170).
• Select a connection setting with the [Frame.io] function setting.

3 Select the recording data to be uploaded from the slot 2 [XF-AVC], [XF-HEVC S/XF-AVC S] or [WAV] index screen.

4 Select the clip menu > [Frame.io Upload] > [OK].
• You can also add the recording data to the upload queue by pressing an assignable button set to [Frame.io Upload].
• The data is added to the upload queue and uploaded to Frame.io sequentially.

NOTES
• You can check the upload status from  > [  Network/USB Settings] > [Frame.io] > [Upload Status/Del. 

Request]. If you want to delete a request, select the clip and select SET > [OK].
• Select  > [  Network/USB Settings] > [Frame.io] > [Delete All Requests] > [OK] to clear all upload requests.
• Select  > [  Network/USB Settings] > [Frame.io] > [Pause Uploading] > [Enable] to pause the upload.
• During recording, uploads to Frame.io are paused.
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Automatic Firmware Update
If the latest firmware is available on the server when the camera is connected to a network using a function setting other 
than the CV Protocol, an asterisk will be shown on B on the menu. In such case, you can update the camera's firmware 
with the following procedure.

1 Insert an SD card into the camera’s card slot 2 (A 39).

2 Select  > [B System Setup] > [Firmware] > [Download Latest Firmware] > [OK].

3 Carefully read and accept the license agreement.
• The latest firmware is downloaded to the SD card.

4 After downloading is complete, select [OK] twice.
• The firmware update starts and it cannot be aborted.

5 When the update is complete, select [OK].
• All settings are reset and the PIN code setting screen appears.

IMPORTANT
• Make sure that you observe the following during firmware update:

- Do not turn off the power. Do not remove the battery or power supply.
- Do not perform any other button operations.
- Do not open the memory card cover and remove the SD card.

NOTES

• Connect the DC coupler and the USB power adapter/AC adapter, USB power adapter, or a fully charged battery to the 
camera.

• When step 2 is performed,  > [  Network/USB Settings] > [Connect] will switch to [Disconnect].
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Additional Information

Menu Options
For details about how to select an item, refer to Using the Menus (A 28). For details about each function, see the 
reference page or the explanation accompanying the menu entry. Setting options in boldface indicate default values.
Depending on the camera’s operating mode and the settings, some menu items may not be available. Such menu items 
do not appear or appear grayed out in menu screens.

To skip directly to the page of a specific menu:

[v Camera Setup] menu (CAMERA mode only)

[v Camera Setup] menu A 191
[/ Custom Picture] menu A 193
[Æ Recording/Media Setup] menu A 193
[¡ Audio Setup] menu A 195
[¢ Monitoring Setup] menu A 196

[A Assistance Functions] menu A 198
[  Network/USB Settings] menu A 200
[  Assignable Buttons] menu A 201
[B System Setup] menu A 201
[¥ My Menu] customized menu A 203

Menu item Setting options and additional information

[Iris Mode] [Automatic], [Manual] (A 82)

This setting is available only when a compatible lens (A 246) is attached to the camera.

[Iris Increment] [1/2 stop], [1/3 stop] (A 82)

[Fine Increment] [On], [Off]

[Zoom-Iris Correction] [On], [Off]

If you are using a compatible lens, when this setting is set to [On], the camera will adjust as needed to keep the selected aperture 
value while zooming. Because of this adjustment, the brightness of the image might flicker slightly or you may hear the 
operation sound. When the setting is set to [Off], there will be no flickering or operation sounds but the aperture value will 
gradually increase (the picture will get darker) as you zoom.

[Shutter Mode] [Automatic], [Manual] (A 75)

[Shutter Manual] [Speed], [Angle], [Clear Scan], [Slow], [Off] (A 75)

[Shutter Increment] [1/3 stop], [1/4 stop]

[Auto Clear Scan Setting] – (A 76)

[Flicker Reduction] [Automatic], [Off] (A 76)

[Base ISO] Available settings differ depending on the [Gamma/Color Space] component in the custom picture file and the 
recording format settings. 

(A 78)

[ISO/Gain] [ISO], [Gain] (A 78)

[ISO/Gain Mode] [Automatic], [Manual] (A 80)

[ISO/Gain Extended Range] [On], [Off] (A 78)

[ISO/Gain Increment] [ISO]: [1 stop], [1/3 stop]
[Gain]: [Normal], [Fine]

(A 78)

[Limit for Auto Mode] Available values differ depending on the main recording format, gamma curve in the custom picture file, ISO/
gain extended range and base ISO settings.

(A 80)

[Light Metering] [Backlight], [Standard], [Spotlight] (A 85)

[AE Shift] –2.0 to +2.0 in 0.25 point intervals (±0) (A 84)

[AE Response] [High], [Normal], [Low] (A 83)

Determines how quickly the exposure (aperture, shutter speed and gain) changes when using the automatic adjustment mode. 
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[Shockless WB] [On], [Off] (A 86)

[AWB Response] [High], [Normal], [Low] (A 88)

[C. Temp. Increment] [Mired], [Kelvin] (A 86)

[Continuous AF] [Disable], [Enable] (A 89)

[Lens action if cannot AF] [Continue focus search], [Stop] (A 92)

[Track after Focusing] [On (tracking frame)], [On (no tracking frame)], [Disable] (A 92)

[AF Area] [Small Zone], [Flexible Zone 1], [Flexible Zone 2], [Flexible Zone 3], [Whole Area] (A 93)

[AF Speed] 1 to 10 (7) (A 92)

[Subj. Switching Sensitivity] 1 to 5 (3)

[Focus Mode] [AF], [MF] (A 89)

[AF Frame Thickness] [Thick], [Slightly Thick], [Normal] (A 93)

[Subject to Detect] [People], [Animals], [None] (A 94)

[Subj. Detect. AF] [Detect. Priority], [Detect. Only] (A 94)

[Eye Detection] [Disable], [Auto], [Right Eye Priority], [Left Eye Priority] (A 94)

[Face Detection AE] [On], [Off] (A 132)

[Tracking by Touch Priority] [Enable], [Disable] (A 95)

[Optical Zoom Speed] (A 98)

[Zoom Speed] [Fast], [Slow]

[Speed Level (Camera) ] [Off], 1 to 16 (8)

[Speed Level (Camera) ] [Off], 1 to 16 (16)

[Speed Level (Lens) ] 1 to 15 (8)

[Speed Level (Lens) ] 1 to 15 (15)

[Speed Level (Handle)]  [Off], 1 to 16 (8)

[Digital Magnification Func.] [Tele-converter 3.0x], [Tele-converter 2.5x], [Tele-converter 2.0x], [Tele-converter 1.5x], 
[Digital Zoom], [Off]

(A 99)

[Digital Zoom Speed]  (A 99)

[Speed Level (Camera) ] [Off], 1 to 16 (8)

[Speed Level (Camera) ] [Off], 1 to 16 (16)

[Speed Level (Handle)] [Off], 1 to 16 (8)

[ABB] – (A 49)

[Color Bars] [On], [Off] (A 117)

[Color Bar Type] [SMPTE], [EBU]*, [ARIB]

[Periph. Illum. Corr.], [Chromatic Aberr. 
Corr.],
[Diffraction Correction], [Distortion Aberr. 
Corr.], 
[Focus Breathing Correction]

[On], [Off] (A 35)

[Lens Optical IS] [On], [Off] (A 97)

When an RF-S lens is attached, set this setting to [On] to compensate for camera shake using optical image stabilization.

[Digital IS] [On], [Off] (A 97)

[Digital IS Mode] [High], [Standard] (A 97)

[Motion Vector For Digital IS] [Enable], [Disable] (A 97)

[Lens Focal Length] 1 to 1000 (50) (A 97)

[Anamorphic Corr.] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.5], [x1.33], [Off]

Menu item Setting options and additional information
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* The default value depends on the country/region of purchase.

[/ Custom Picture] menu (CAMERA mode only)

[Æ Recording/Media Setup] menu

[RF-S/EF-S Lens] [On], [Off] (A 32)

If peripheral brightness fall-off or vignetting occurs when using an EF-S lens, you can set [RF-S/EF-S Lens] to [On] to slightly crop 
the imaging area. The image is enlarged digitally by a factor of about 1.09x (when the resolution is 4096x2160 or 2048x1080), or 
1.04x (when the resolution is 3840x2160 or 1920x1080), affecting image quality. Available only when the main recording 
format is set to an option other than RAW, the sensor mode is set to an option other than [Full Frame 3:2]/[Full Frame], and 
[Digital Magnification Func.] is set to [Off]. In most cases, leaving the [Off] option is recommended.

Menu item Setting options and additional information

[Select / File] [C1:Canon 709], [C2:Canon Log 2], [C3:Canon Log 3], [C4:BT.709 Wide DR], [C5:BT.709 Standard], [C6:PQ], 
[C7: HLG], [C8:EOS Standard], [C9:EOS Neutral], [C10: User10] to [C20: User20]

(A 135)

[Edit / File]

[Rename] – (A 136)

[Protect] [Unprotect], [Protect]

[Reset] [Canon 709], [Canon Log 2], [Canon Log 3], [BT.709 Wide DR], [BT.709 Standard], [PQ], [HLG], [EOS Standard], 
[EOS Neutral], [User (Canon 709)]

Detailed custom picture settings Refer to the tables in the Available Custom Picture Settings section. (A 139)

[Save / File] (A 138)

[Save to SD Card], [Load from SD Card] –
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[Initialize Media] [CFexpress], [SD Card] (A 40)

[Sensor Mode] [Full Frame 3:2], [Full Frame], [Super 35mm (Cropped)], [Super 16mm (Cropped)] (A 66)

[System Frequency] [59.94 Hz], [50.00 Hz]1, [24.00 Hz] (A 66)

[Main Rec Format] [RAW HQ], [RAW ST], [RAW LT], [XF-AVC YCC422 10 bit], [XF-HEVC S YCC422 10 bit], 
[XF-HEVC S YCC420 10 bit], [XF-AVC S YCC422 10 bit], [XF-AVC S YCC420 8 bit]

(A 66)

Available options vary depending on the sensor mode. 

[Main Recording Destination] [CFexpress], [SD Card] (A 66)

[Main Resolution] [RAW]:
[6960x4640], [6960x3672], [5036x2656], [2524x1332]

[XF-AVC]: 
[4096x2160 Intra-frame], [4096x2160 Long GOP], [3840x2160 Intra-frame], [3840x2160 Long GOP], 
[2048x1080 Intra-frame], [2048x1080 Long GOP],[1920x1080 Intra-frame], [1920x1080 Long GOP]

[XF-HEVC S]:
[6912x4608 Intra-frame], [6912x4608 Long GOP], [4096x2160 Long GOP], [3840x2160 Long GOP], 
[2048x1080 Long GOP], [1920x1080 Long GOP]

[XF-AVC S]:
   [XF-AVC S YCC422 10 bit]:

[4096x2160 Intra-frame], [4096x2160 Long GOP], [3840x2160 Intra-frame], 
[3840x2160 Long GOP], [2048x1080 Intra-frame], [2048x1080 Long GOP], 
[1920x1080 Intra-frame], [1920x1080 Long GOP]

   [XF-AVC S YCC420 8 bit]:
[4096x2160 Long GOP], [3840x2160 Long GOP], [2048x1080 Long GOP], [1920x1080 Long GOP]

(A 66)

Available options vary depending on the sensor mode, main recording destination and frame rate. 
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[Frame Rate] When [System Frequency] is set to [59.94 Hz]:
[59.94i]*, [59.94P]1, [29.97P], [23.98P]

When [System Frequency] is set to [50.00 Hz]:
[50.00i]*, [50.00P]1, [25.00P]

When [System Frequency] is set to [24.00 Hz]:
[24.00P]

* XF-AVC clips only. Not available when slow & fast motion recording, frame recording 
or interval recording is activated.

(A 66)

Available options vary depending on the sensor mode and main recording format/main resolution.

[Bit Rate] (A 67)

Available options vary depending on the main recording format, main resolution and frame rate.

[  /  Main Audio] [AAC 16 bit 2CH], [LPCM 24 bit 4CH] (A 109)

[Recording Mode] [Normal Recording], [Slow & Fast Motion], [S&F Clip / Audio (WAV)], [Pre-Recording], 
[  Main /  Continuous Rec], [Frame Recording], [Interval Recording]

(A 43, 124)

[Slow & Fast Frame Rate] (A 124)

Available options and default value vary depending on other settings. See the tables on the reference page.

[Continuous Recording] [REC], [STBY] (A 126)

[Frame Rec: Frame Rate] [1], [3], [6], [9] (A 126)

[Interval Rec: Time Interval] [1 sec], [2 sec], [3 sec], [5 sec], [10 sec], [15 sec], [30 sec], [1 min], [2 min], [3 min], [5 min], [10 min] (A 127)

[Interval Rec: Frame Rate] [1], [3], [6], [9]

[2nd Card Rec Functions] [Off], [  Main /  Proxy Rec], [  Main /  Sub Rec], [  Main /  Crop Rec], 
[  Main /  Audio Rec], [  Main /  Chunk Rec], [Double Slot Recording], [Relay Recording]

(A 43)

[  Rec Format] [XF-AVC YCC422 10 bit], [XF-AVC YCC420 8 bit], [XF-HEVC S YCC422 10 bit], 
[XF-HEVC S YCC420 10 bit], [XF-AVC S YCC422 10 bit], [XF-AVC S YCC420 8 bit]

(A 68, 69)

Available options vary depending on the main recording format.

[  Resolution] Available options vary depending on the main recording’s settings. (A 68)

[  Frame Rate] [Same as Main Recording], [59.94i], [59.94P], [50.00i], [50.00P] (A 68)

[  Bit Rate] Available options vary depending on the [  Resolution] and [  Frame Rate] settings. (A 68)

[   /  Audio] [AAC 16 bit 2CH], [LPCM 24 bit 4CH] (A 109)

[Proxy Rec Color Conversion] [Conform to Custom Picture], [BT.709 (Canon 709)], [BT.709 (CMT 709)] (A 69)

[Crop Setting] (A 71)

[Position] –

[Frame Display: LCD] [On], [Off]

[Frame Display: HDMI] [On], [Off]

[Chunk Rec: Time Setting] [30 sec], [1 min], [2 min] (A 73)
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1 The default value depends on the country/region of purchase.

[¡ Audio Setup] menu

[Metadata]

[Camera Index] [A_] to [ZZ] (A 46)

[Reel Number] [0001] to [9999]

[Clip Number] [001] to [999]

[User Defined] User defined string up to 5 characters ([CANON]) (A 47)

[Scene], [Take] Scene description up to 16 characters / Take description up to 8 characters (A 123)

[Lens Squeeze] [x2.0], [x1.8], [x1.5], [x1.33], [Off] (A 128)

[Add XML File] [On], [Off] (A 121)

[XML File Format] [News Metadata], [User Memo] (A 122)

[News Metadata] [Off], list of available News Metadata files (A 122)

[News Metadata Reset All] – (A 123)

[User Memo] [Off], list of available user memo files (A 121)

[Country Code], [Organization], [User 
Code]

Identifiers up to 4 characters ([00__] default for [Organization] only)

[Country Code]: This identifier is the country code defined by ISO-3166-1 and is to be entered starting from the left.
[Organization]: This identifier represents the organization that owns or operates the camera and can be obtained by registering 

with the SMPTE Registration Authority. If the organization is not registered, enter [0000].
[User Code]: This identifier designates the user. Leave this blank if [Organization] is set to [0000].

[Add / File] [On], [Off] (A 138)

[Clip Numbering] [Reset], [Continuous] (A 46)

[Rec Command(EXT REC)] [On], [Off] (A 157)

[HDMI Time Code] [On], [Off] (A 157)

[Photo Numbering] [Reset], [Continuous] (A 47)

[Volume Label] [Canon], [Canon + Metadata] (A 41)
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[Audio Status] – (A 108)

[CH2 Input] [INPUT 2], [INPUT 1], [MIC Terminal], [Built-in Mic] (A 111)

[CH1/CH2 ALC Link], 
[CH3/CH4 ALC Link]

[Linked], [Separated] (A 113)

[Audio Rec Level] [A] (Automatic), [M] (Manual)
0 to 100 (50)

(A 112)

[Audio Limiter] [On], [Off] (A 113)

[Audio Compressor] [High], [Low], [Off] (A 113)

[INPUT Terminals (Handle)] (A 114)

[INPUT 1 Mic Trimming], 
[INPUT 2 Mic Trimming]

[+12 dB], [+6 dB], [0 dB], [-6 dB], [-12 dB]

[INPUT 1 Mic Att.], 
[INPUT 2 Mic Att.]

[On], [Off]

[INPUT 1 Mic Low Cut], 
[INPUT 2 Mic Low Cut] 

[Off], [LC1], [LC2]

[INPUT Reference Level] [-18dB], [-20 dB]
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[¢ Monitoring Setup] menu

[MIC Terminal] (A 111)

[Attenuator] [On], [Off]

[Low Cut] [Off], [LC1], [LC2]

[MIC Input] [MIC (with Power Supply)], [LINE]

[Built-in Mic] (A 111)

[Mic Mode] [Normal], [Voice Memo], [Off]

[Mic Sensitivity] [Normal], [High]

[Attenuator] [On], [Off]

[Frequency Characteristic] [Normal], [Low-Freq. Enhancement], [Low-Freq. Cut], [Mid-Freq. Enhancement], [Low-High-Freq. Enhanc.]

[Directivity] [Monaural], [Normal], [Wide]

[Shoe Mic] (A 108)

[Attenuator] [On], [Off]

[Low Cut] [On], [Off]

[Directivity] [Shotgun (Monoaural)], [90°(Stereo)], [120°(Stereo)]

[1 kHz Tone] [–12 dB], [–18 dB], [–20 dB], [Off] (A 117)

[Headphone Volume] [Off], 1 to 15 (8) (A 150)

[Speaker Volume] [Off], 1 to 15 (8)

[Monitor Channels] [CH1/CH2], [CH1/CH1], [CH2/CH2], [CH1+2/CH1+2], [CH3/CH4], [CH3/CH3], [CH4/CH4], [CH3+4/CH3+4],
 [CH1/CH3], [CH2/CH4], [CH1+3/CH2+4]

(A 162)

[HDMI OUT Channels] [CH1/CH2], [CH3/CH4]

[Assign CH2 Switch & Dial] [CH2], [CH3] (A 113)

[Level Meter Display Color] [Color], [White]

Menu item Setting options and additional information

[LCD Brightness], [LCD Contrast] –50 to 50 (±0) (A 25)

[LCD Color] –20 to 20 (±0)

[LCD Sharpness] 1 to 4 (2)

[LCD Luminance] [–2], [–1], [Normal], [+1], [+2]

[LCD Luminance Boost] [On], [Off]

[LCD Mirror Image] [On], [Off]

[Anamorphic: LCD], [Anamorphic: HDMI] [On], [Off] (A 128)

[Anamorphic Desqueeze] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.5], [x1.33]

[B&W Image: LCD], [B&W Image: HDMI] [On], [Off] (A 25)

[OSD Output: HDMI] [On], [Off] (A 159)

[Tally OSD: LCD], [Tally OSD: HDMI] [On], [Off] (A 57)

[Tally OSD Settings] [REC/Tally In (PGM/PVW)], [REC], [Tally In (PGM/PVW)]

[Tally OSD Position] [Frame], [Top], [Bottom]

[DISP Level 1] [All Displays], [All Displays (Periph. Border)] (A 56)

[DISP Level 2] [Main Recording Displays], [Only FUNC/MENU]

[DISP Level 3] [Only REC/STBY], [No Displays]

[Apply Peripheral Border] [DISP Level 1/2/3], [DISP Level 1/2], [DISP Level 1], [DISP Level 2], [DISP Level 3], [Off] (A 57)
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[Custom Display 1] (A 53)

[Light Metering], [Custom Picture], 
[Tele-converter], [Focal Length], 
[Focus Mode], [Focus Frame], 
[Subject Detection], 
[Tracking by Touch Priority], 
[White Balance], [AE Shift], [Iris], 
[ISO/Gain], [Shutter], 
[Flicker Detection], [Base ISO], 
[Peaking], [Digital IS], 
[Magnification], [View Assist], [Lens]

[On], [Off]

[Zoom Position] [Always On], [Normal], [Off]

[Digital Zoom Magn.] [Always On], [Normal], [Off]

[Object Distance (Numeric)], 
[Object Distance (Bar)]

[Always On], [Only in MF Mode], [Off]

[Level] [Tilt+Roll], [Roll], [Tilt], [Off]

[Exposure Bar] [On], [Disable During AE], [Off]

[Custom Display 2] (A 53)

[Remaining Battery], 
[Remaining Rec Time]

[Only Warnings], [Normal], [Off]

[Recording Mode], 
[Interval Counter], [Time Code], 
[Reel/Clip Number]

[On], [Off]

[Photo] [Only Warnings], [Normal], [Off]

[Temperature/Fan], [Sensor Mode],
[Resolution/Color Sampling], 
[Frame Rate], [Output Terminals 
Status], 
[OSD Output]*, 
[Rec Command(EXT REC)], 
[User Bit]*, [Monitor Channels]*, 
[Audio Level Indicator], 
[Multi-Function Shoe]

[On], [Off]

[On], [Normal]: Show the icon/onscreen display always or whenever the necessary conditions are triggered.
[Only Warnings]: Show the icon/onscreen display only when a critical level is reached.
• The default setting for items marked with an asterisk (*) is [Off].

[LCD Luminance Boost], 
[Network Functions], [Audio (UAC)], 
[GPS]

[On], [Off]

[Date/Time] [Date/Time], [Time], [Date], [Off]

[Key Lock] [On], [Off]

[Custom Display] (A 148)

These settings are available only in MEDIA mode and determine whether the following onscreen displays will appear on the 
playback image.

[Audio Level Indicator] [On], [Off]

[Date/Time], [Camera Data] [On], [Off]

[Audio Level Indicator]: The audio level meter (clips only).
[Date/Time]: The date and time when the clip/photo was recorded.
[Camera Data]: The aperture value, shutter speed and ISO speed/gain value used to record the clip (clips only).

[Displayed Units] [Meters], [Feet]1

Changes the distance units used in camera displays between meters and feet.
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1 The default value depends on the country/region of purchase.

[A Assistance Functions] menu

[OSD Opacity: LCD], 
[OSD Opacity: HDMI]

[On], [Off] (A 159)

[OSD Opacity Level] [75%], [62.5%], [50%], [37.5%], [25%]

[OSD Opacity: Appl. Screens] [All], [Only Rec/Playback Screens]

[OSD Orientation: LCD] [0 Degrees], [  90 Degrees Left], [  90 Degrees Right] (A 58)

[OSD Orientation: HDMI] [Linked to LCD], [  90 Degrees Left], [  90 Degrees Right]

[View Assist: LCD] [On], [Off] (A 160)

[Select View Assist: LCD] [CMT 709], [Canon 709], [HDR Assist. (1600%)], [HDR Assist. (400%)]

[View Assist: HDMI] [On], [Off] (A 161)

[Select View Assist: HDMI] [CMT 709], [Canon 709] (A 160)

[Gain for HDRSDR Conv.] –7.5 dB to +7.5 dB in 0.5 dB intervals (–3.0 dB) (A 161)

[Range: HDMI] (A 158)

[During Canon Log Output] [Full Range Priority], [Narrow Range]

[During HDR Output] [Full Range Priority], [Narrow Range]
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[Focus Guide] [On], [Off] (A 90)

[Peaking: LCD], [Peaking: HDMI] [On], [Off] (A 91)

[Peaking] [Peaking 1], [Peaking 2]

[Peaking 1]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [Off], 1 to 15 (8)

[Frequency] 1 to 4 (2)

[Peaking 2]

[Color] [White], [Red], [Yellow], [Blue]

[Gain] [Off], 1 to 15 (15)

[Frequency] 1 to 4 (1)

[Magnification] [On], [Off] (A 91)

[Magn. Output] [LCD], [HDMI]

[B&W during Magn.] [On], [Off] (A 91)

[False Color: LCD], 
[False Color: HDMI]

[On], [Off] (A 102)

[False Color Index] –

[Zebra: LCD], [Zebra: HDMI] [On], [Off] (A 102)

[Zebra] [Zebra 1], [Zebra 2], [Zebra 1+2]

[Zebra 1 Level] [5 ±5%] to [95 ±5%] in 5 percentage point intervals ([70 ±5%])

[Zebra 2 Level] 0% to 100% in 5 percentage point intervals (100%)

[WFM: LCD], [WFM: HDMI] [On], [Off] (A 118)

[WFM Opacity Level] [Linked to OSD Opacity], [100%], [80%], [60%], [40%], [20%]

Select the WFM opacity level. If set to [Linked to OSD Opacity], it will be linked to the [OSD Opacity Level] setting.

[WFM Function] [Waveform Monitor], [Vectorscope]
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[Waveform Settings] (A 118)

[Size: LCD] [Normal], [2x]

Changes the size of the waveform displayed on the screen.

[Position] [Right], [Left]

[Type] [Line], [Line+Spot], [Select Line], [RGB], [YPbPr]

[Vertical Scale for HDR] [IRE], [PQ/HLG]

[Select Line] 2160 or higher: 0 to maximum value –2 lines (2-line increments)
  Example: 0 to 2158 (for 2160) (1080)
Below 2160: 0 to maximum value –1 line (1-line increments)
  Example: 0 to 1079 (for 1080) (540)

Available options depend on the resolution and operating mode (CAMERA/MEDIA mode).

[Vectorscope Settings] (A 119)

[Position] [Right], [Left]

[Type] [Normal], [Spot]

[Gain] [1x], [2x]

[Markers: LCD], [Markers: HDMI] [On], [Off] (A 100)

[Playback Marker Display] [Enable], [Disable] (A 100)

[Center Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (A 100)

[Center Marker Type] [Cross 1], [Cross 2], [Dot 1], [Dot 2]

[Horizontal Marker], [Vertical Marker], 
[Grid Marker]

[Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]

[Aspect Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%], [Mask 75%], [Mask 50%], [Mask 25%], 
[Off]

(A 101)

[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1], [9:16], [4:5], [2:1], 
[1:1], [Custom]

[Marker Custom Asp. Ratio] 0.01:0.01 to 9.99:9.99 (1.00:1:00)

[Safe Area Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%], [Mask 75%], [Mask 50%], [Mask 25%], 
[Off]

(A 101)

[Basis for Marker Safe Area] [Whole Picture], [Selected Aspect Marker]

[Marker Safe Area %] [80% (Side Length)], [88% (Side Length)], [90% (Side Length)], [93% (Side Length)], [95% (Side Length)]

[User Marker 1], [User Marker 2], 
[User Marker 3]

[Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (A 101)
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[ Network/USB Settings] menu

[User Marker 1 Settings], 
[User Marker 2 Settings], 
[User Marker 3 Settings]

(A 101)

[Size]

[Specification Method] [Pixel], [Ref. Area & Aspect Ratio], [Ref. Area & Magn. Ratio]

[Pixel] [Width]: 2 to 2048 (only even numbers) (1000)
[Height]: 2 to 1280 (only even numbers) (1000)

[Reference Area] [Whole Picture], [User Marker 1], [User Marker 2], [Crop]

Available options differ depending on the settings for [User Marker 1 Settings] to [User Marker 3 Settings].

[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1], [9:16], [4:5], [2:1], 
[1:1], [Custom]

[Marker Custom Asp. Ratio] [Available Range]: 0.01:0.01 to 9.99:9.99 (1.00:1.00)

[Magnification Ratio] [Available Range]: 50 to 150% (95%)

[Position]

[Specification Method] [Center Coordinates], [Upper-left Coordinates], [Centering (User Marker 1)], 
[Centering (User Marker 2)], [Centering (Crop)]

Available options differ depending on the settings for [User Marker 1 Settings] to [User Marker 3 Settings].

[Center Coordinates] [Horizontal]: –1024 to 1024 (0)
[Vertical]: –640 to 640 (0)

[Upper-left Coordinates] [Horizontal]: 0 to 2048 (0)
[Vertical]: 0 to 1280 (0)
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[Network] [Enable], [Disable] (A 170)

[Connect] [Disconnect], [SET1] to [SET20]

[Connection Setting] [SET1] to [SET20] (A 178)

[Create New with Wizard] –

[Create with Existing Setting] –

[Check Settings] –

[Change with Wizard] –

[Select Existing Setting] –

[Settings Name] File name up to 12 characters 

[Delete Settings] –

[New Conn. Setting (Wizard)] [IP Streaming], [Canon App], [XC Protocol], [CV Protocol], [Frame.io] (A 171)

[IPv4 address name] Displays the current IPv4 address information.

[View Error Info] Displays the latest network related error message.

[USB Mode] [Ethernet Adapter], [Video Output (UVC)], [Canon App(s) for iPhone], [Canon App(s) for Android] (A 129)

[Activate IP Streaming] [Enable], [Disable] (A 183)
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[  Assignable Buttons] menu

Following are the default settings for each assignable button. For a complete list of the functions that can be assigned, 
refer to the detailed table (A 132).

[B System Setup] menu

[Frame.io] (A 188)

[Pair] –

[Unpair] –

[Pairing Information] –

[Upload Status/Del. Request] –

[Delete All Requests] –

[Pause Uploading] [Disable], [Enable]

[Auto Upload On Recording] [On], [Off]

[Auto Upload File Formats] [XF-AVC Proxy], [XF-HEVC S / XF-AVC S Proxy], [Audio Proxy]

[Root Certificate] [Read Root Certificate], [Root Certificate Details], [Delete Root Certificate]

[UVC Setting] (A 129)

[Frame Rate] [60P], [50P], [30P], [25P]

[Audio (UAC)] [Enable], [Disable]

[Advanced Settings] (A 179)

[Communication Settings] [NW1] to [NW25]

[Function Settings] [MODE1] to [MODE25]

[XC Protocol Settings] [Authentication Method], [User Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], [HTTPS], 
[Save HTTPS Self-signed Cert]

(A 173)

[802.1X Authentication] [Setup Wizard], [Check Settings], [Delete Settings] (A 177)

[Nickname] User defined string up to 16 characters ([C50]) (A 178)

Menu item Setting options and additional information

[Camera] 1: [One-Shot AF], 2: [Magnification], 3: [MENU], 4: [DISP], 5: [Push Auto Iris], 
6: [Assignable Button Setting], 7: [REC], 8: [Key Lock], 9: [Peaking: All], 10: [WFM: All], 
11: [FUNC], 12: [AF Lock], 13: [REC], 14: [Set White Balance]

[XC Protocol]

[Link to Camera] [Enable], [Disable]

1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]

Menu item Setting options and additional information

[Power Source Navigation] – (A 36)

[Reset] [All Settings], [Assignable Buttons], [Level]

These settings reset the following camera settings to default values/settings.
[All Settings]: All the camera’s settings except for the hour meter.
[Assignable Buttons]: Only the assignable buttons.

[Transfer Menu//] (A 143)

[Save] [To Camera], [To SD Card]

[Load] [From Camera], [From SD Card]
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[Time Zone] List of world time zones. 
[UTC-05:00 New York] or [UTC+01:00 Central Europe]1

(A 27)

[Date/Time] –

[Date Format] [YMD], [YMD/24H], [MDY], [MDY/24H], [DMY], [DMY/24H]1

[Language H] [Deutsch], [English], [Español], [Français], [Italiano], [Polski], [Português], [Русский], 
[Українська], [ ], [ ], [ ]

(A 27)

[HDMI Output] [On], [Off] (A 157)

[HDMI Output Signal] [4096x2160P/3840x2160P], [1920x1080P], [1920x1080i], [1280x720P]

[Linked to HDMI Monitor] [On], [Off]

[Time Code Mode] [Preset], [Regen.] (A 104)

[Time Code Run] [Rec Run], [Free Run]

[Time Code DF/NDF] [DF], [NDF] (A 105)

[Set Time Code] 59.94 Hz: [00:00:00.00] to [23:59:59.29]
50.00 Hz: [23:59:59:24]
24.00 Hz: [23:59:59:23]

(A 104)

[TC In/Out] [In], [Out] (A 106, 107)

[User Bit Recording Mode] [Internal], [External] (A 106)

[User Bit Type] [Setting], [Time], [Date] (A 105)

[Grip Control Dial], [Top Control Dial], 
[Control Ring], [SELECT Dial]

[Iris], [Shutter], [Clear Scan (Steps)], [ISO/Gain], [White Balance Mode], [White Balance 
(K)], [White Balance (CC)], [Select Subject], [Off]*

(A 79, 
82,

 87, 94)

Determines the function assigned to the respective control dial/control ring/SELECT dial. The [Select Subject] setting allows you 
to switch the main subject/eye used for subject detection/eye detection.
• The default function for the top control dial/control ring/SELECT dial is [Off].
* [Off (Default] for the SELECT dial.

[Grip Ctrl Dial Dir.], [Top Ctrl Dial Dir.], 
[Control Ring Dir.], [SELECT Dial Dir.]

[Reverse], [Normal]

Changes the direction of the adjustment when operating the control dials, the control ring on the lens/adapter or the SELECT 
dial, respectively.

[Ctrl Dial in Menus] [Disable], [Enable] (A 28)

Enables or disables the use of the control dials to navigate the setup menus, direct touch control, direct setting mode and status 
screens.

[Focus Ring Operation] [Enable During AF], [Disable During AF]

[Focus Ring Direction] [Reverse], [Normal]

Changes the direction of the adjustment when operating the focus ring on an RF lens.

[Focus Ring Response] [Varies with Rotation Speed], [Linked to Rotation Degree]

[Focus/Control Ring] [Focus Ring], [Control Ring]

Selects the function assigned to the RF-S lens focus/control ring. When set to [Control Ring], focus is set to AF*.
*  When the focus is in the Center Focus Macro range (using a lens equipped with the Center Focus Macro function), focus is not 

set to AF even if set to [Control Ring] and focus operations from other devices will not be possible. To leave the Center Focus 
Macro range, select [Focus Ring] and operate the ring to focus at infinity focus.

[Keep Key Lock at Shutdown] [On], [Off] (A 31)

[Key Lock] [All Buttons], [All Except REC Button] (A 31)

[REC Button] [Disable], [Enable] (A 51)

Enables or disables the use of the REC buttons. 

[Onscreen REC/STBY Button] [On], [Off] (A 51)

When this setting is set to [On], the recording operation indicator (REC/STBY) on the CAMERA mode screen becomes an onscreen 
button you can touch to start/stop recording.

[Touch Screen Response] [Normal], [Low] (A 25)

Menu item Setting options and additional information
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Menu Options

1 The default value depends on the country/region of purchase.
2 Only when the GP-E2 GPS Receiver is connected to the camera.

[¥ My Menu] menu (CAMERA mode only)

[Review Recording] [Entire Clip], [Last 4 sec] (A 58)

[Tally Lamp (Front)], [Tally Lamp (Rear)],
[Tally Lamp (Handle)]

[On], [Off]

When this setting is set to [On], the tally lamp illuminates/flashes according to the camera and tally input status.

[Tally Lamp Settings] [Power/Media/Tally In (PGM)], [REC/Tally In (PGM)], [REC], [Tally In (PGM)] (A 52)

When this setting is set to [Power/Media/Tally In (PGM)], the tally lamp illuminates/flashes according to battery and recording 
warnings and the card recording status.

[Card Access LED] [On], [Off] (A 39)

When this setting is set to [On], the card access indicator illuminates when the camera is accessing the card. 

[Fan Mode] [Automatic], [Always On] (A 48)

[Fan Speed (STBY)] [Maximum], [High], [Middle], [Low]

[Fan Speed (REC)], [Fan Speed (Always)], 
[Fan Speed]

[High], [Middle], [Low]

[GPS Auto Time]2 [On], [Off]

When this setting is set to [On], the camera automatically adjust its date and time settings according to the information received 
from the GPS signal.
While the automatic date/time adjustment is activated, the  > [B System Setup] > [Date/Time] setting will not be 
available.
The time will not be updated while recording video.

[Retract Lens] [On], [Off]

When a compatible lens (A 247) is attached to the camera and the focus mode switch on the lens is set to AF, if this setting is 
set to [On], the lens will retract fully when the camera is turned off. 
If set to [On], turning off the camera will cause the focus position to shift. Set it to [Off] if you want to maintain the focus position 
to some extent before powering off. However, this does not guarantee the focus position, so check the focus status when turning 
the power back on.

[Sensor Cleaning] [At Power ON/OFF], [At Power OFF], [Off]

Selects when to perform sensor cleaning.

[Reset Hour Meter] The camera has two “hour meters” – the first keeps track of total operation time and the second keeps track of operation time 
since the last time the second hour meter was reset with this function. 

[Certification Information] This displays select certification information that apply to this camera.

[Firmware]

[Camera], [Lens], [Mount Adapter], 
[Power Zoom Adapter], [Accessory]

Check/update the firmware version of the camera, lens (A 34), mount adapter, power zoom adapter or accessory.

[Download Latest Firmware] Downloads the latest firmware for the camera and performs the update. (A 189)

[PIN Code Management] (A 26)

[PIN Code Request] [Enable], [Disable]

[PIN Code Change] –

[Access Log Display] – (A 234)

Menu item Setting options and additional information

[CAMERA-1: Edit] to 
[CAMERA-5: Edit]

[Register], [Move], [Delete], [Reset All], [Rename] (A 29)

Menu item Setting options and additional information
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Displaying the Status Screens
You can use the status screens to check the camera’s various settings. You can also output the status screens to an 
external monitor. Portions of the status screens will be displayed in English regardless of the language selected.

1 Set an assignable button to [Status] (A 131).

2 Press the assignable button to open the status screens.
• The status screen most recently displayed will appear unless you turned off the camera or changed the operating 

mode.
• You can also press an assignable button set to [Audio Status] open directly only the [¡ Audio Setup] status screen.

3 Scroll through the status screens to check the desired settings.
• Bring the cursor to a page number and push the joystick left/right to move between the status screens.
• You can also use grip/top control dials and the SELECT dial to navigate the status screens in the same way as the 

setup menus.

4 Press the assignable button again or select [X CLOSE] to close the status screens.
• You can also press the MENU button to close the status screens and open the menu instead.
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Using a Battery Grip

Using a Battery Grip
Equipped with buttons and dials for vertical shooting, the BG-R20 Battery Grip 
is an optional camera accessory that can power the camera with two 
batteries. For details on how to attach the battery grip to the camera, refer to 
the Advanced User Guide (PHOTO Edition).

Button and Dial Operations

To use the buttons and dials, turn the vertical-grip on/off switch to ON.

When the power switch is set to VIDEO, the buttons and dials are used the same way as corresponding buttons and dials 
on the camera in VIDEO mode.

NOTES
• Battery information is also displayed when using the battery grip.
• Available recording conditions are the same when using a battery pack or the battery grip.

PHOTO Mode VIDEO Mode

1 Shutter button REC (start/stop recording) button

2 < > Multi-function button FUNC button/Assignable button Camera 11

3 < > Main dial Grip control dial

4 Vertical-grip On/Off switch Vertical-grip On/Off switch

5 < > Magnify/Reduce button MAGN. (magnification) button/Assignable button Camera 2

6 < > Multi-controller Joystick

7 < > AE lock/FE lock button AUTO IRIS button/Assignable button Camera 5

8 < > AF point selection button (Disabled)

9 < > AF start button AF-ON button/Assignable button Camera 1

10 < > Quick control dial 2 Top control dial

4

1

2

65 7 8 9 10

3
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Recording / Output Signal and Detailed Settings
Sub Recording Clips
Main clip: RAW
Sub recording clip: XF-AVC, XF-HEVC S

Primary clip Sub recording clip configuration1

Main 
recording 

format

Main 
resolution

Frame rate Bit rate
Sub recording format and resolution/bit rate

XF-AVC YCC422 10 bit XF-HEVC S YCC422 10 bit XF-HEVC S YCC420 10 bit

RAW ST

6960x3672, 
5036x2656

59.94P

2860 Mbps, 
1500 Mbps

4096x2160 / 600 Mbps Intra-frame
4096x2160 / 250 Mbps Long GOP

2048x1080 / 300 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 225 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 150 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

RAW LT 1860 Mbps, 
972 Mbps

RAW ST
50.00P

2380 Mbps, 
1250 Mbps

4096x2160 / 500 Mbps Intra-frame
4096x2160 / 250 Mbps Long GOP

2048x1080 / 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 225 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 150 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

RAW LT 1550 Mbps, 
811 Mbps

RAW HQ

29.97P

2900 Mbps, 
1520 Mbps

4096x2160 / 600 Mbps Intra-frame
4096x2160 / 450 Mbps Intra-frame
4096x2160 / 300 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 150 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 135 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOPRAW ST 1430 Mbps, 

748 Mbps

RAW LT 927 Mbps, 
486 Mbps

RAW HQ

25.00P

2420 Mbps, 
1270 Mbps

4096x2160 / 500 Mbps Intra-frame
4096x2160 / 375 Mbps Intra-frame
4096x2160 / 250 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 125 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 135 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOPRAW ST 1190 Mbps, 

624 Mbps

RAW LT 773 Mbps, 
406 Mbps

RAW HQ

24.00P

2320 Mbps, 
1220 Mbps

4096x2160 / 480 Mbps Intra-frame
4096x2160 / 360 Mbps Intra-frame
4096x2160 / 240 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 135 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOPRAW ST 1150 Mbps, 

599 Mbps

RAW LT 742 Mbps, 
390 Mbps

RAW HQ

23.98P

2320 Mbps, 
1220 Mbps

4096x2160 / 480 Mbps Intra-frame
4096x2160 / 360 Mbps Intra-frame
4096x2160 / 240 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 135 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOPRAW ST 1150 Mbps, 

599 Mbps

RAW LT 742 Mbps, 
389 Mbps

 (A 68)
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1 In most cases, the frame rate is the same as in the primary clip.

RAW HQ

2524x1332

59.94P

769 Mbps
2048x1080 / 300 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 379 Mbps

RAW LT 246 Mbps

RAW HQ

50.00P

642 Mbps
2048x1080 / 250 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 316 Mbps

RAW LT 206 Mbps

RAW HQ

29.97P

385 Mbps
2048x1080 / 150 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 190 Mbps

RAW LT 123 Mbps

RAW HQ

25.00P

321 Mbps
2048x1080 / 125 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 158 Mbps

RAW LT 103 Mbps

RAW HQ

24.00P, 23.98P

308 Mbps
2048x1080 / 120 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 152 Mbps

RAW LT 99 Mbps

Primary clip Sub recording clip configuration1

Main 
recording 

format

Main 
resolution

Frame rate Bit rate
Sub recording format and resolution/bit rate

XF-AVC YCC422 10 bit XF-HEVC S YCC422 10 bit XF-HEVC S YCC420 10 bit
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Sub recording clip: XF-AVC S

1 In most cases, the frame rate is the same as in the primary clip.

Primary clip Sub recording clip configuration1

Main 
recording 

format

Main 
resolution

Frame rate Bit rate
Sub recording format and resolution/bit rate

XF-AVC S YCC422 10 bit XF-AVC S YCC420 8 bit

RAW ST

6960x3672, 
5036x2656

59.94P

2860 Mbps, 1500 Mbps 4096x2160 / 600 Mbps Intra-frame
4096x2160 / 250 Mbps Long GOP

2048x1080 / 300 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 150 Mbps Long GOP
2048x1080 / 35 Mbps Long GOPRAW LT 1860 Mbps, 972 Mbps

RAW ST

50.00P

2380 Mbps, 1250 Mbps 4096x2160 / 500 Mbps Intra-frame
4096x2160 / 250 Mbps Long GOP

2048x1080 / 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 150 Mbps Long GOP
2048x1080 / 35 Mbps Long GOPRAW LT 1550 Mbps, 811 Mbps

RAW HQ

29.97P

2900 Mbps, 1520 Mbps 4096x2160 / 600 Mbps Intra-frame
4096x2160 / 450 Mbps Intra-frame
4096x2160 / 300 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 150 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

RAW ST 1430 Mbps, 748 Mbps

RAW LT 927 Mbps, 486 Mbps

RAW HQ

25.00P

2420 Mbps, 1270 Mbps 4096x2160 / 500 Mbps Intra-frame
4096x2160 / 375 Mbps Intra-frame
4096x2160 / 250 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 125 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

RAW ST 1190 Mbps, 624 Mbps

RAW LT 773 Mbps, 406 Mbps

RAW HQ

24.00P

2320 Mbps, 1220 Mbps 4096x2160 / 480 Mbps Intra-frame
4096x2160 / 360 Mbps Intra-frame
4096x2160 / 240 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

RAW ST 1150 Mbps, 599 Mbps

RAW LT 742 Mbps, 390 Mbps

RAW HQ

23.98P

2320 Mbps, 1220 Mbps 4096x2160 / 480 Mbps Intra-frame
4096x2160 / 360 Mbps Intra-frame
4096x2160 / 240 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

RAW ST 1150 Mbps, 599 Mbps

RAW LT 742 Mbps, 389 Mbps

RAW HQ

2524x1332

59.94P

769 Mbps
2048x1080 / 300 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 379 Mbps

RAW LT 246 Mbps

RAW HQ

50.00P

642 Mbps
2048x1080 / 250 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 316 Mbps

RAW LT 206 Mbps

RAW HQ

29.97P

385 Mbps
2048x1080 / 150 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 190 Mbps

RAW LT 123 Mbps

RAW HQ

25.00P

321 Mbps
2048x1080 / 125 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 158 Mbps

RAW LT 103 Mbps

RAW HQ
24.00P, 
23.98P

308 Mbps
2048x1080 / 120 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOPRAW ST 152 Mbps

RAW LT 99 Mbps
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Main clip: XF-AVC

Primary clip Sub recording clip configuration1

Main 
recording 

format
Main resolution Frame rate Bit rate

Sub recording format and resolution/bit rate

XF-AVC YCC422 10 bit XF-AVC S YCC422 10bit XF-AVC S YCC420 8bit

XF-AVC 
YCC422 
10 bit

4096x
2160

Intra-frame

59.94P
1200 Mbps, 
900 Mbps, 
600 Mbps

2048x1080 / 300 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

2048x1080 / 300 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

50.00P
1000 Mbps, 
750 Mbps, 
500 Mbps

2048x1080 / 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

2048x1080 / 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Long GOP 59.94P, 
50.00P 250 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Intra-frame

29.97P

600 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 150 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP

4096x2160 / 600 Mbps Intra-frame

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

600 Mbps, 
450 Mbps 4096x2160 / 450 Mbps Intra-frame

600 Mbps, 
450 Mbps, 
300 Mbps

4096x2160 / 300 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 150 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

25.00P

500 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 125 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP

4096x2160 / 500 Mbps Intra-frame

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

500 Mbps, 
375 Mbps 4096x2160 / 375 Mbps Intra-frame

500 Mbps, 
375 Mbps, 
250 Mbps

4096x2160 / 250 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 125 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

24.00P, 
23.98P

480 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 120 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP

4096x2160 / 480 Mbps Intra-frame

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

480 Mbps, 
360 Mbps 4096x2160 / 360 Mbps Intra-frame

480 Mbps, 
360 Mbps, 
240 Mbps

4096x2160 / 240 Mbps Intra-frame
4096x2160 / 150 Mbps Long GOP

2048x1080 / 120 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

Long GOP

29.97P, 
25.00P, 
24.00P, 
23.98P

150 Mbps 2048x1080 / 50 Mbps Long GOP 4096x2160 / 150 Mbps Long GOP
2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP
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XF-AVC 
YCC422 
10 bit

3840x
2160

Intra-frame

59.94P
1200 Mbps, 
900 Mbps, 
600 Mbps

1920x1080 / 300 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

The following are 59.94i
1920x1080 / 150 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP
1920x1080 / 25 Mbps Long GOP

1920x1080 / 300 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

50.00P
1000 Mbps, 
750 Mbps, 
500 Mbps

1920x1080 / 250 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

The following are 50.00i
1920x1080 / 125 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP
1920x1080 / 25 Mbps Long GOP

1920x1080 / 250 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Long GOP 59.94P, 
50.00P 250 Mbps

1920x1080 / 50 Mbps Long GOP
The following are 59.94i / 50.00i
1920x1080 / 50 Mbps Long GOP
1920x1080 / 25 Mbps Long GOP

1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Intra-frame

29.97P

600 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 150 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP

3840x2160 / 600 Mbps Intra-frame

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

600 Mbps, 
450 Mbps 3840x2160 / 450 Mbps Intra-frame

600 Mbps, 
450 Mbps, 
300 Mbps

3840x2160 / 300 Mbps Intra-frame
3840x2160 / 150 Mbps Long GOP

1920x1080 / 150 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

25.00P

500 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 125 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP

3840x2160 / 500 Mbps Intra-frame

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

500 Mbps, 
375 Mbps 3840x2160 / 375 Mbps Intra-frame

500 Mbps, 
375 Mbps, 
250 Mbps

3840x2160 / 250 Mbps Intra-frame
3840x2160 / 150 Mbps Long GOP

1920x1080 / 125 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

24.00P, 
23.98P

480 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 120 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP

3840x2160 / 480 Mbps Intra-frame

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

480 Mbps, 
360 Mbps 3840x2160 / 360 Mbps Intra-frame

480 Mbps, 
360 Mbps, 
240 Mbps

3840x2160 / 240 Mbps Intra-frame
3840x2160 / 150 Mbps Long GOP

1920x1080 / 120 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP

Long GOP

29.97P, 
25.00P, 
24.00P, 
23.98P

150 Mbps 1920x1080 / 50 Mbps Long GOP 3840x2160 / 150 Mbps Long GOP
1920x1080 / 50 Mbps Long GOP

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

Primary clip Sub recording clip configuration1

Main 
recording 

format
Main resolution Frame rate Bit rate

Sub recording format and resolution/bit rate

XF-AVC YCC422 10 bit XF-AVC S YCC422 10bit XF-AVC S YCC420 8bit
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1 In most cases, the frame rate is the same as in the primary clip.

XF-AVC 
YCC422 
10 bit

2048x
1080

Intra-frame
59.94P 300 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 300 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

50.00P 250 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Long GOP 59.94P, 
50.00P 50 Mbps – 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Intra-frame

29.97P 150 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 150 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

25.00P 125 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 125 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

24.00P, 
23.98P 120 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 120 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Long GOP

29.97P, 
25.00P, 
24.00P, 
23.98P

50 Mbps – 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

1920x
1080

Intra-frame
59.94P 300 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 300 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

50.00P 250 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 250 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Long GOP 59.94P, 
50.00P 50 Mbps – 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Intra-frame

29.97P 150 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 150 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

25.00P 125 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 125 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

24.00P, 
23.98P 120 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 120 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Long GOP

29.97P, 
25.00P, 
24.00P, 
23.98P

50 Mbps – 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Intra-frame
59.94i 150 Mbps 1920x1080 / 50 Mbps Long GOP

1920x1080 / 25 Mbps Long GOP – –
50.00i 125 Mbps

Long GOP 59.94i, 
50.00i

50 Mbps, 
25 Mbps – – –

Primary clip Sub recording clip configuration1

Main 
recording 

format
Main resolution Frame rate Bit rate

Sub recording format and resolution/bit rate

XF-AVC YCC422 10 bit XF-AVC S YCC422 10bit XF-AVC S YCC420 8bit
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Main clip: XF-HEVC S

1 In most cases, the frame rate is the same as in the primary clip.

Primary clip Sub recording clip configuration1

Main recording 
format

Main resolution Frame rate Bit rate
Sub recording format and resolution/bit rate

XF-HEVC S YCC422 10 bit XF-HEVC S YCC420 10 bit

XF-HEVC S 
YCC422 10 bit

4096x2160
Long GOP 59.94P, 50.00P 225 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 135 Mbps 2048x1080 / 50 Mbps Long GOP 4096x2160 / 100 Mbps Long GOP

2048x1080 / 35 Mbps Long GOP

3840x2160
Long GOP 59.94P, 50.00P 225 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 135 Mbps 1920x1080 / 50 Mbps Long GOP 3840x2160 / 100 Mbps Long GOP

1920x1080 / 35 Mbps Long GOP

2048x1080
Long GOP 59.94P, 50.00P 50 Mbps – 2048x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 50 Mbps – 2048x1080 / 35 Mbps Long GOP

1920x1080
Long GOP 59.94P, 50.00P 50 Mbps – 1920x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 50 Mbps – 1920x1080 / 35 Mbps Long GOP

XF-HEVC S 
YCC420 10 bit

4096x2160
Long GOP 59.94P, 50.00P 150 Mbps – 2048x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 100 Mbps – 2048x1080 / 35 Mbps Long GOP

3840x2160
Long GOP 59.94P, 50.00P 150 Mbps – 1920x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 100 Mbps – 1920x1080 / 35 Mbps Long GOP

2048x1080
Long GOP 59.94P, 50.00P 35 Mbps – –

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 35 Mbps – –

1920x1080
Long GOP 59.94P, 50.00P 35 Mbps – –

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 35 Mbps – –
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Main clip: XF-AVC S

Primary clip Sub recording clip configuration1

Main recording 
format

Main resolution Frame rate Bit rate
Sub recording format and resolution/bit rate

XF-AVC S YCC422 10 bit XF-AVC S YCC420 8 bit

XF-AVC S 
YCC422 10 bit

4096x2160

Intra-frame

59.94P
1200 Mbps, 
900 Mbps, 
600 Mbps

2048x1080 / 300 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

50.00P
1000 Mbps, 
750 Mbps, 
500 Mbps

2048x1080 / 250 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Long GOP 59.94P, 50.00P 250 Mbps 2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP

Intra-frame

29.97P
600 Mbps, 
450 Mbps, 
300 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 150 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

25.00P
500 Mbps, 
375 Mbps, 
250 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 125 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

24.00P, 23.98P
480 Mbps, 
360 Mbps, 
240 Mbps

4096x2160 / 150 Mbps Long GOP
2048x1080 / 120 Mbps Intra-frame

2048x1080 / 50 Mbps Long GOP

4096x2160 / 100 Mbps Long GOP
2048x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 150 Mbps 2048x1080 / 50 Mbps Long GOP 4096x2160 / 100 Mbps Long GOP

2048x1080 / 35 Mbps Long GOP

3840x2160

Intra-frame

59.94P
1200 Mbps, 
900 Mbps, 
600 Mbps

1920x1080 / 300 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

50.00P
1000 Mbps, 
750 Mbps, 
500 Mbps

1920x1080 / 250 Mbps Intra-frame
1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Long GOP 59.94P, 50.00P 250 Mbps 1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP

Intra-frame

29.97P
600 Mbps, 
450 Mbps, 
300 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 150 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

25.00P
500 Mbps, 
375 Mbps, 
250 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 125 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

24.00P, 23.98P
480 Mbps, 
360 Mbps, 
240 Mbps

3840x2160 / 150 Mbps Long GOP
1920x1080 / 120 Mbps Intra-frame

1920x1080 / 50 Mbps Long GOP

3840x2160 / 100 Mbps Long GOP
1920x1080 / 35 Mbps Long GOP

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 150 Mbps 1920x1080 / 50 Mbps Long GOP 3840x2160 / 100 Mbps Long GOP

1920x1080 / 35 Mbps Long GOP

2048x1080

Intra-frame
59.94P 300 Mbps

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP
50.00P 250 Mbps

Long GOP 59.94P, 50.00P 50 Mbps – 2048x1080 / 35 Mbps Long GOP

Intra-frame

29.97P 150 Mbps

2048x1080 / 50 Mbps Long GOP 2048x1080 / 35 Mbps Long GOP25.00P 125 Mbps

24.00P, 23.98P 120 Mbps

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 50 Mbps – 2048x1080 / 35 Mbps Long GOP
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1 In most cases, the frame rate is the same as in the primary clip.

Slow & Fast Motion Recording
Available shooting frame rates

* The shooting frame rate upper limit varies depending on the sensor mode.
[Full Frame 3:2]: up to 30P
[Full Frame]: up to 180P
[Super 35mm (Cropped)]: up to 60P
[Super 16mm (Cropped)]: up to 150P

** Only when [Sensor Mode] is set to [Super 16mm (Cropped)].

XF-AVC S 
YCC422 10 bit 1920x1080

Intra-frame
59.94P 300 Mbps

1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP
50.00P 250 Mbps

Long GOP 59.94P, 50.00P 50 Mbps – 1920x1080 / 35 Mbps Long GOP

Intra-frame

29.97P 150 Mbps

1920x1080 / 50 Mbps Long GOP 1920x1080 / 35 Mbps Long GOP25.00P 125 Mbps

24.00P, 23.98P 120 Mbps

Long GOP 29.97P, 25.00P, 
24.00P, 23.98P 50 Mbps – 1920x1080 / 35 Mbps Long GOP

XF-AVC S 
YCC420 8 bit

4096x2160

Long GOP

59.94P, 50.00P 150 Mbps
– 2048x1080 / 35 Mbps Long GOP29.97P, 25.00P, 

24.00P, 23.98P 100 Mbps

3840x2160
59.94P, 50.00P 150 Mbps

– 1920x1080 / 35 Mbps Long GOP29.97P, 25.00P, 
24.00P, 23.98P 100 Mbps

2048x1080, 
1920x1080

59.94P, 50.00P, 
29.97P, 25.00P, 
24.00P, 23.98P

35 Mbps – –

Frame rate Available shooting frame rate (fps) during slow & fast motion recording*

59.94P 1, 2, 3, 6, 15, 30, 44, 48, 52, 56, 60, 90, 120, 150, 180

29.97P 1, 2, 3, 6, 15, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60, 90, 120, 150, 180

50.00P 1, 5, 15, 25, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120, 125, 150, 175, 180

25.00P 1, 5, 15, 17, 19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 50, 54, 58, 60, 75, 100, 120, 125, 150, 175, 180

23.98P, 24.00P 1, 2, 3, 6, 12, 16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60, 72, 96, 120, 144, 150**, 168, 180

Primary clip Sub recording clip configuration1

Main recording 
format

Main resolution Frame rate Bit rate
Sub recording format and resolution/bit rate

XF-AVC S YCC422 10 bit XF-AVC S YCC420 8 bit

 (A 124)



215

Recording / Output Signal and Detailed Settings

Available shooting frame rates during slow & fast motion recording (RAW)
Recording media: CFexpress card

Recording media: SD card

Main recording format Main resolution
Slow & fast motion shooting frame rate range

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

RAW ST
6960x4640

– 1 to 30 1 to 30 – 1 to 30 1 to 30

RAW LT – 1 to 30 1 to 30 – 1 to 30 1 to 30

RAW HQ
6960x3672
5036x2656

– 1 to 30 1 to 30 – 1 to 30 1 to 30

RAW ST 1 to 60 1 to 60 1 to 60 1 to 60 1 to 60 1 to 60

RAW LT 1 to 60 1 to 60 1 to 60 1 to 60 1 to 60 1 to 60

RAW HQ

2524x1332

1 to 150 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150

RAW ST 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150

RAW LT 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150

Main recording format Main resolution
Slow & fast motion shooting frame rate range

59.94P 29.97P 23.98P 50.00P 25.00P 24.00P

RAW ST
5036x2656

– – 1 to 24 – – 1 to 24

RAW LT – 1 to 30 1 to 30 – 1 to 30 1 to 30

RAW HQ

2524x1332

– 1 to 30 1 to 30 – 1 to 30 1 to 30

RAW ST 1 to 60 1 to 60 1 to 60 1 to 60 1 to 60 1 to 60

RAW LT 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150 1 to 150
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Available shooting frame rates during slow & fast motion recording (XF-AVC)
Recording media: CFexpress card

1 Up to 60P when [Sensor Mode] is set to [Super 35mm (Cropped)].
2 Up to 150P when [Sensor Mode] is set to [Super 16mm (Cropped)].

Main recording format Main resolution Frame rate Bit rate
Shooting frame rate during slow & fast motion 

recording1, 2

XF-AVC YCC422 10 bit

4096x2160 Intra-frame
3840x2160 Intra-frame

59.94P
1200 Mbps 1 to 60

900 Mbps, 600 Mbps 1 to 120

50.00P
1000 Mbps 1 to 60

750 Mbps, 500 Mbps 1 to 120

29.97P
600 Mbps 1 to 60

450 Mbps, 300 Mbps 1 to 120

25.00P
500 Mbps 1 to 60

375 Mbps, 250 Mbps 1 to 120

24.00P, 23.98P
480 Mbps 1 to 60

360 Mbps, 240 Mbps 1 to 120

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 250 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 150 Mbps 1 to 120

2048x1080 Intra-frame
1920x1080 Intra-frame

59.94P 300 Mbps 1 to 180

50.00P 250 Mbps 1 to 180

29.97P 150 Mbps 1 to 180

25.00P 125 Mbps 1 to 180

24.00P, 23.98P 120 Mbps 1 to 180

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 50 Mbps 1 to 180
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Recording media: SD card

1 Up to 60P when [Sensor Mode] is set to [Super 35mm (Cropped)].
2 Up to 150P when [Sensor Mode] is set to [Super 16mm (Cropped)].

During proxy clip recording

1 In most cases, the frame rate is the same as in the primary clip.

Main recording format Main resolution Frame rate Bit rate
Shooting frame rate during slow & fast motion 

recording1, 2

XF-AVC YCC422 10 bit

4096x2160 Intra-frame
3840x2160 Intra-frame

59.94P 600 Mbps 1 to 60

50.00P 500 Mbps 1 to 60

29.97P
600 Mbps, 450 Mbps 1 to 30

300 Mbps 1 to 60

25.00P
500 Mbps, 375 Mbps 1 to 30

250 Mbps 1 to 60

24.00P, 23.98P
480 Mbps, 360 Mbps 1 to 30

240 Mbps 1 to 60

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 250 Mbps 1 to 120

29.97P 150 Mbps 1 to 120

25.00P, 24.00P, 23.98P 150 Mbps 1 to 100

25.00P 135 Mbps 120

24.00P, 23.98P 130 Mbps 120

2048x1080 Intra-frame
1920x1080 Intra-frame

59.94P 300 Mbps 1 to 120

50.00P 250 Mbps 1 to 120

29.97P 150 Mbps 1 to 120

25.00P 125 Mbps 1 to 120

24.00P, 23.98P 120 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 50 Mbps 1 to 180

Recording format Resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1

XF-AVC YCC420 8 bit 2048x1080 Long GOP 59.94P, 50.00P, 29.97P, 25.00P, 
24.00P, 23.98P 35 Mbps 1 to 60
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Available shooting frame rates during slow & fast motion recording (XF-HEVC S)
Recording media: CFexpress card

1 Up to 60P when [Sensor Mode] is set to [Super 35mm (Cropped)].
2 Up to 150P when [Sensor Mode] is set to [Super 16mm (Cropped)].

Recording media: SD card

1 Up to 60P when [Sensor Mode] is set to [Super 35mm (Cropped)].
2 Up to 150P when [Sensor Mode] is set to [Super 16mm (Cropped)].

Main recording format Main resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1, 2

XF-HEVC S YCC422 10 bit

6912x4608 Intra-frame

29.97P 1620 Mbps, 1080 Mbps 1 to 30

25.00P 1350 Mbps, 900 Mbps 1 to 30

24.00P, 23.98P
1730 Mbps 1 to 24

1300 Mbps, 864 Mbps 1 to 30

6912x4608 Long GOP 29.97P, 25.00P, 24.00P, 
23.98P 486 Mbps 1 to 30

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 225 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 135 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 50 Mbps 1 to 180

XF-HEVC S YCC420 10 bit

6912x4608 Long GOP 29.97P, 25.00P, 24.00P, 
23.98P 360 Mbps 1 to 30

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 150 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 100 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 35 Mbps 1 to 180

Main recording format Main resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1, 2

XF-HEVC S YCC422 10 bit

6912x4608 Long GOP 29.97P, 25.00P, 24.00P, 
23.98P 486 Mbps 1 to 30

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 225 Mbps 1 to 120

29.97P, 25.00P 135 Mbps 1 to 120

24.00P, 23.98P
135 Mbps 1 to 100

130 Mbps 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 50 Mbps 1 to 180

XF-HEVC S YCC420 10 bit

6912x4608 Long GOP 29.97P, 25.00P, 24.00P, 
23.98P 360 Mbps 1 to 30

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 150 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 100 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 35 Mbps 1 to 180
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During proxy clip recording

1 In most cases, the frame rate is the same as in the primary clip.

Available shooting frame rates during slow & fast motion recording (XF-AVC S)
Recording media: CFexpress card

1 Up to 60P when [Sensor Mode] is set to [Super 35mm (Cropped)].
2 Up to 150P when [Sensor Mode] is set to [Super 16mm (Cropped)].

Recording format Resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1

XF-HEVC S YCC420 10 bit
2048x1080 Long GOP 59.94P, 50.00P, 29.97P, 

25.00P, 24.00P, 23.98P
16 Mbps, 9 Mbps

1 to 60

1920x1280 Long GOP 29.97P, 25.00P, 24.00P, 
23.98P 1 to 30

Main recording format Main resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1, 2

XF-AVC S YCC422 10 bit

4096x2160 Intra-frame
3840x2160 Intra-frame

59.94P
1200 Mbps 1 to 60

900 Mbps, 600 Mbps 1 to 120

50.00P
1000 Mbps 1 to 60

750 Mbps, 500 Mbps 1 to 120

29.97P
600 Mbps 1 to 60

450 Mbps, 300 Mbps 1 to 120

25.00P
500 Mbps 1 to 60

375 Mbps, 250 Mbps 1 to 120

24.00P, 23.98P
480 Mbps 1 to 60

360 Mbps, 240 Mbps 1 to 120

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 250 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 150 Mbps 1 to 120

2048x1080 Intra-frame
1920x1080 Intra-frame

59.94P 300 Mbps 1 to 180

50.00P 250 Mbps 1 to 180

29.97P 150 Mbps 1 to 180

25.00P 125 Mbps 1 to 180

24.00P, 23.98P 120 Mbps 1 to 180

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 50 Mbps 1 to 180

XF-AVC S YCC420 8 bit

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 150 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 100 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 35 Mbps 1 to 180
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Recording media: SD card

1 Up to 60P when [Sensor Mode] is set to [Super 35mm (Cropped)].
2 Up to 150P when [Sensor Mode] is set to [Super 16mm (Cropped)].

During proxy clip recording

1 In most cases, the frame rate is the same as in the primary clip.

Main recording format Main resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1, 2

XF-AVC S YCC422 10 bit

4096x2160 Intra-frame
3840x2160 Intra-frame

59.94P 600 Mbps 1 to 60

50.00P 500 Mbps 1 to 60

29.97P
600 Mbps, 450 Mbps 1 to 30

300 Mbps 1 to 60

25.00P
500 Mbps, 375 Mbps 1 to 30

250 Mbps 1 to 60

24.00P, 23.98P
480 Mbps, 360 Mbps 1 to 30

240 Mbps 1 to 60

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 250 Mbps 1 to 120

29.97P 150 Mbps 1 to 120

25.00P, 24.00P, 23.98P 150 Mbps 1 to 100

25.00P 135 Mbps 120

24.00P, 23.98P 130 Mbps 120

2048x1080 Intra-frame
1920x1080 Intra-frame

59.94P 300 Mbps 1 to 120

50.00P 250 Mbps 1 to 120

29.97P 150 Mbps 1 to 120

25.00P 125 Mbps 1 to 120

24.00P, 23.98P 120 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 50 Mbps 1 to 180

XF-AVC S YCC420 8 bit

4096x2160 Long GOP
3840x2160 Long GOP

59.94P, 50.00P 150 Mbps 1 to 120

29.97P, 25.00P, 24.00P, 
23.98P 100 Mbps 1 to 120

2048x1080 Long GOP
1920x1080 Long GOP

59.94P, 50.00P, 29.97P, 
25.00P, 24.00P, 23.98P 35 Mbps 1 to 180

Recording format Resolution Frame rate Bit rate Shooting frame rate during slow & fast motion recording1

XF-AVC S YCC420 8 bit
2048x1080 Long GOP 59.94P, 50.00P, 29.97P, 25.00P, 

24.00P, 23.98P 16 Mbps, 9 Mbps
1 to 60

1920x1280 Long GOP 29.97P, 25.00P, 24.00P, 23.98P 1 to 30
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Troubleshooting
If you have a problem with your camera, refer to this section. Consult your dealer or a Canon Service Center if the 
problem persists.

Power source
Refer also to the Power-related problems section of the Troubleshooting Guide in the Advanced User Guide (PHOTO 
edition).

The camera will not turn on or it turns off by itself.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Shortly after turning it on, the camera turns off on its own.
- You are using a battery pack that is not compatible for use with this camera. Use a recommended battery pack (A 238).

Cannot charge the battery pack.
- The temperature of the battery pack is outside the charging range. If the battery pack’s temperature is below 5 °C (41 °F), warm 

it before charging it; if it is above 40 °C (104 °F), let the battery pack cool down before charging it.
- Charge the battery pack in temperatures between 5 °C and 40 °C (41 °F and 104 °F).
- The battery pack is faulty. Replace the battery pack.

The battery pack is depleted extremely quickly even at normal temperatures.
- Check the [B System Setup] status screen (A 204) to check if the battery pack has reached the end of its battery life. If so, buy 

a new battery pack.

Recording
The camera’s controls are not responsive/disabled.

- When key lock is activated, all buttons (or all buttons with the exception of some REC buttons) are locked and cannot be 
operated. Press the LOCK button to disable key lock. You can change which controls are locked with the  > [B System 
Setup] > [Key Lock] setting.

Performing a recording operation (pressing a button/touching the onscreen button) will not start recording.
- The card is full or it already contains the maximum number of clips (999 clips). Delete some clips (A 154) or save your 

recordings and initialize the card (A 40) to free some space. Alternatively, replace the card.
- The REC button was pressed while all the camera's controls were locked (key lock, A 31). Unlock the controls or set  > 

[B System Setup] > [Key Lock] to [All Except REC Button].
- Power supply to the camera has reached the level set for the power level warning. Check the power source.
- The camera cannot record while the [Color Correction] settings in the custom picture file (A 142) are being adjusted (except 

for the [Revision Level]/[Revision Phase] settings).
- Video recording is not possible when  > [  Network/USB Settings] > [UVC Setting] > [Audio (UAC)] is set to [Enable].

The point when the recording operation was performed does not match the beginning/end of the recording.
- There may be a slight interval between pressing the REC button (or touching the onscreen button) and the actual start/end of 

recording. This is not a malfunction.

The lens will not function.
- Turn off the camera and correctly attach the lens again (A 33).
- A lens that cannot be used with the camera is attached (A 246).
- Check the content of the error message when it appears on the screen and proceed as suggested (A 226).
- Use the  > [B System Setup] > [Power Source Navigation] function to check the availability of lenses, and power sources 

depending on the configuration of the camera.

The camera will not focus.
- The camera may not be able to focus on certain subjects using autofocus. Focus manually (A 89).
- When [Continuous AF] is enabled and [Lens action if cannot AF] is set to [Stop], start focusing manually until the AF frame 

changes from yellow to white.
- The lens is dirty. Clean the lens with a soft lens-cleaning cloth.
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When a subject flits across in front of the lens, the image appears slightly bent.
- This is a phenomenon typical of CMOS image sensors. When a subject crosses very quickly in front of the camera, the image 

may seem slightly warped. This is not a malfunction.

Bright red, green, blue, white or black dots appear on the screen.
- Try lowering the ISO speed/gain value or adjusting the black balance (A 49). The camera’s CMOS sensor is a delicate piece of 

precision engineering. Direct exposure of the sensor to ion rays or other types of cosmic radiation may affect it and this may 
rarely appear as bright colored dots on the screen. This is the nature of CMOS image sensors and does not represent a 
malfunction.

- The effects of the damage may be more noticeable when the camera is used in places subject to high temperatures, when a 
high ISO speed or gain level is used and when slow shutter speeds are used.

Abnormal images appear on the screen and the camera cannot record properly.
- While recording with a depleted battery attached and a USB power adapter connected, the USB power adapter was unplugged 

or the power supply was suddenly interrupted. Reconnect the USB power adapter and turn the camera off and then on again or 
replace the battery pack with a fully charged one.

Changing between recording (ÜREC) and record standby (STBY) takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings and 

initialize the card (A 40). Alternatively, replace the card.

Clips or photos cannot be recorded properly.
- This may occur as clips and photos are recorded/deleted over time. Save your recordings and initialize the card (A 40).

After using the camera for a long time, it becomes hot.
- The camera may become hot after using it continuously for long periods of time; this is not a malfunction. If the camera 

becomes unusually hot or it becomes hot after using it only for a short while, it may indicate a problem with the camera. 
Consult a Canon Service Center.

Playback
Cannot delete clips/photos

- XF-AVC clips with an $ mark cannot be deleted with the camera. Remove the $ mark (A 153).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- Photos that were protected using other devices cannot be deleted with this camera.

Deleting clips takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings and 

initialize the card (A 40).

Indicators and Onscreen Displays
 appears in red on the screen.

- Battery pack is depleted. Replace or charge the battery pack.

í appears on the screen.
- The camera cannot communicate with the battery pack attached so the remaining battery time cannot be displayed.

 appears in red on the screen.
- The Ethernet function is disabled because a power source other than the DR-E6P DC Coupler is being used. Turn off the camera 

and use the DR-E6P DC Coupler.
- The USB function is disabled due to a malfunction in the Ethernet adapter. Remove the Ethernet adapter and restart the camera 

to restore functionality for the USB terminal.

The power indicator/tally lamp does not illuminate.
- Set  > [B System Setup] > Desired [Tally Lamp] setting to [On].

The power indicator/tally lamp flashes quickly.  (4 flashes per second)
- The battery pack is depleted. Replace or charge the battery pack.
- There is not enough available space on the cards. Delete recordings (A 154) to free some space or replace the card.
- A system error has occurred. Turn the camera off and then on again. If this does not solve the problem, consult a Canon Service 

Center.
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The power indicator/tally lamp flashes slowly.  (1 flash per second)
- The combined available space on the cards is low. Delete recordings (A 154) to free some space or replace the card.

 or  appears in red on the screen.
- A card error occurred. Remove and reinsert the card. If the display does not change back to normal, save your recordings and 

initialize the card (A 40).

 /  appears in red on the screen followed by [END].
- The indicated card is full. Delete recordings (A 154) to free some space or replace the card.

Even after stopping recording, the access indicator stays illuminated in red.
- The clip is being recorded on the card. This is not a malfunction.

b appears in yellow on the screen.
- The camera’s internal temperature has reached a predetermined level. You can continue using the camera.

b appears in red on the screen.
- The camera’s internal temperature has risen further while b appeared in yellow on the screen. Turn off the camera and wait 

until the temperature has decreased.

` appears in red on the screen.
- The cooling fan may not be working properly. The camera will automatically turn off after a few minutes. Consult a Canon 

Service Center.

i  appears on the screen.
- The camera and lens cannot communicate normally. Clean the lens’s contacts and reattach the lens.

The aperture value (T or F value) appears in gray on the screen.
- When using a compatible EF Cinema lens (A 246), the aperture value will appear in gray when the camera detects that the 

aperture may be close to fully closed. As you continue to close down the aperture further, the display will change to [closed].

Picture and Sound
There is no picture from an external monitor.

- Make sure the cable connecting the camera to the monitor is correctly connected on both sides.
- Check that the correct video input is selected on the external monitor.

There is no picture or sound from an external monitor/recorder connected to the HDMI OUT terminal
- Disconnect the HDMI cable and then restore the connection or turn the camera off and then on again.
- Check that the settings of the external monitor/recorder match the configuration of the output signal selected on the camera 

(A 155).
- Replace the HDMI cable.
- Set  > [B System Setup] > [HDMI Output] to [On].

An assistance display (peaking/zebra pattern/video scope/onscreen markers/false color/magnification/B&W image/tally OSD/
anamorphic desqueeze/view assistance) does not appear or is not applied on the screen.

- These assistance displays have separate settings that allow you to turn the display on/off on individual monitoring devices/
video outputs. Check the settings to see that the desired function is enabled on the desired monitor/video output.

- Onscreen displays output has not been enabled. Activate the output of the camera’s onscreen displays (A 159).

Screen displays turn on and off repeatedly.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Abnormal characters appear on the screen and the camera does not operate properly.
- Remove all the cards and disconnect the power source. After a moment, reconnect the power and reinsert the cards. If the 

problem still persists, use the  > [B System Setup] > [Reset] > [All Settings] function. This resets all the camera’s settings 
to default values, except for the hour meter.

Video noise appears on screen.
- Keep a distance between the camera and devices that emit strong electromagnetic fields such as near powerful magnets and 

motors, MRI machines or high-voltage power lines. 
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Horizontal bands appear on the screen.
- This is a phenomenon typical of CMOS image sensors when recording under some types of lighting. This is not a malfunction. 

You may be able to reduce the symptoms by setting the shutter speed mode to [Speed] and the shutter speed to a value 
matching the frequency of the local electrical system: 1/50* or 1/100 for 50 Hz systems, 1/60 or 1/120 for 60 Hz systems.
* May not be available depending on the frame rate.

Audio is not recorded.
- The audio input source is not correctly selected (A 111) or a microphone is not connected to the selected terminal.
- When using the INPUT 1/INPUT 2 terminals, make sure you are using an XLR connector. When using the MIC terminal, make 

sure you are using a condenser microphone with a ∅ 3.5 mm stereo mini plug.
- The external microphone is not turned on or its battery is depleted.
- The external microphone connected to the INPUT 1/INPUT 2 terminal requires phantom power. Set the corresponding INPUT 1/

INPUT 2 sensitivity switch to MIC+48V (A 111).
- The external microphone connected to the MIC terminal requires plug-in power but  > [¡ Audio Setup] > [MIC 

Terminal] > [MIC Input] is set to an option other than [MIC (with Power Supply)].
- To record audio for slow & fast motion clips, set the recording mode to [S&F Clip / Audio (WAV)] (A 43).

Sound is distorted or is recorded at lower levels.
- This may happen when the appropriate audio level is not set correctly. Adjust the audio recording level manually (A 113). You 

can also activate the microphone attenuator (A 114) to reduce the audio level.
- The audio source selected for the INPUT terminal or MIC terminal is incorrect. When using an external microphone, set the 

INPUT switch to MIC or set  > [¡ Audio Setup] > [MIC Input] to [MIC (with Power Supply)]. When using an analog 
audio device set the INPUT switch or the [MIC Input] setting to [LINE].

- The audio level is adjusted manually and the recording level is set too low. Check the audio level meter on the screen and adjust 
the audio level correctly (A 112).

Cards and Accessories
Cannot insert the card.

- The card you are trying to insert is not facing the correct direction. Turn it over and insert it.

Cannot record on the SD card.
- A compatible card must be used (A 38).
- Initialize the card (A 40) when you use it with the camera for the first time.
- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings (A 154) to free some space or 

replace the card.
- The clip number has reached its maximum value. Save your recordings and initialize the card (A 40) or delete all the clips 

(A 154).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- The folder and file numbers for photos have reached their maximum value. Set  > [Æ Recording/Media Setup] > [Photo 

Numbering] to [Reset] and insert a new card.

Recording to and playing back from a card is slow.
- This may occur as recordings are made and deleted repeatedly over time. Save your recordings and initialize the card (A 40).

Connections with External Devices
Video noise appears on a nearby TV screen.

- When using the camera in a room where a TV is located, keep a distance between the USB power adapter or AC adapter and the 
power or antenna cables of the TV.
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Network Functions

Check This First

Cannot connect with an access point.
- Check that the settings on the network device the camera is trying to connect with are correct.
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal. Refer to 

Precautions Regarding Wi-Fi Networks (A 226).

Cannot establish a Camera Access Point connection with a network device.
- When you reset all the camera settings, all network settings are lost as well. Configure the network settings again (A 175).
- The wireless signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal. Refer to 

Precautions Regarding Wi-Fi Networks (A 226).
- If you cannot connect to the camera from a mobile device, change the [Network] setting to [Disable] and then change it back to 

[Enable].

Cannot connect with a wired (Ethernet) network.
- Visit your local Canon website and check that the model of Ethernet adapter used (commercially available) was tested for use 

with this camera.
- Turn off the camera, remove the Ethernet adapter and correctly attach it again.
- Use a category 5e or better shielded twisted pair (STP) Ethernet cable.
- Try replacing the Ethernet cable.
- When you reset all the camera settings, all network settings are lost as well.
- Check that the network device to which the camera is connected is on and functioning properly. Use a network device that 

supports the Ethernet adapter standard. For example, to use 1000BASE-T connection speeds, make sure to use network devices 
compatible with Gigabit Ethernet (1000BASE-T).

Cannot start IP streaming.
- Make sure IP streaming was activated on the camera (A 183).
- If the IP streaming protocol is set to an option other than [RTSP+RTP], make sure the [Destination Server] is set correctly 

(A 171).
- IP streaming cannot be used in the following cases. Check the settings.

• When the main recording format is set to RAW/XF-HEVC S.
• When the system frequency is set to 24.00 Hz.
• When the recording mode is set to an option other than normal recording.
• When [2nd Card Rec Functions] is set to an option other than [Off ].

Cannot connect the optional XC Protocol compatible RC-IP100/RC-IP1000 Remote Camera Controller, Remote Camera Control 
Application or Multi-Camera Control.

- Make sure to use a connection setting with the [XC Protocol] function setting.
- Check that the settings on the optional RC-IP100/RC-IP1000, Remote Camera Control Application or Multi-Camera Control that 

the camera is trying to connect with are correct.
- When connecting multiple cameras, use the 5 GHz band or change the network connection method (A 186).

Cannot connect to a smartphone.
- Connect the camera and the smartphone to the same network if they are connected to different networks.
- When using a smartphone as an access point, enable the tethering (sharing a mobile connection) function on the smartphone 

if it is disabled.

• Are the camera, computer or other network devices all turned on?
• Is the network working and correctly configured?
• Are all network devices correctly connected to the same network as the camera?
• When using a Wi-Fi network, are there any obstructions between the camera and the access point or between the 

network device used and the access point?
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Precautions Regarding Wi-Fi Networks
When using a Wi-Fi network, try the following corrective actions if the transmission rate drops, the connection is lost, or 
other problems occur.

Positioning a network device (access point, mobile device, etc.)
- When using a Wi-Fi network indoors, place the network device in the same room as the camera.
- Place the network device in an open, unobstructed location, where people or objects do not come between it and the camera.
- Place the network device as close as possible to the camera. Change the position, height or facing of the network device, as 

necessary.

About camera installation and setup when using the 2.4 GHz band.
The following operations may improve the communication status.

- Do not install the handle unit so as not to block the signal.
- Connect the camera and the controlling device via a network device (access point).

Nearby electronic devices
- If the transmission rate over a Wi-Fi network drops because of interference from the following electronic devices, switching to 

the 5 GHz band or to a different channel may solve the problem.
- Wi-Fi networks using the IEEE 802.11b/g/n protocol operate in the 2.4 GHz band. For this reason, the transmission rate may 

drop if there are nearby microwave ovens, cordless telephones, wireless microphones and Bluetooth or similar devices 
operating on the same frequency band.

Using multiple cameras/Wi-Fi adapters/access points 
- Check that there are no IP address conflicts among the devices connected to the same network.
- If multiple cameras are connected to a single access point, connection speeds may be reduced.
- To reduce radio wave interference when there are multiple access points using IEEE 802.11b/g or IEEE 802.11n (in the 2.4 GHz 

band), leave a gap of four channels between each wireless access point. For example, use channels 1, 6, and 11, channels 2, 7, 
and 12, or channels 3, 8, and 13. 
If you can use IEEE 802.11a/n/ac (in the 5 GHz band), switch to IEEE 802.11a/n/ac and specify a different channel, leaving an 
appropriate gap between channels according to the wireless standard and frequency band used. For example, when using IEEE 
802.11ac (VHT80), leave a gap of 8 channels between access points.

List of Messages
Refer to this section if a message appears on the screen. Note that for some messages, an indication of the card involved 
may appear above the message itself:
• [CFexpress], [ ]: CFexpress card (card 1, slot 1)
• [SD Card], [ ]: SD card (card 2, slot 2)

The following settings were changed.
- The settings displayed on the screen were changed automatically due to a change in one of the [Æ Recording/Media Setup] 

settings. Check the settings before you continue recording.

An error has occurred
Turn the camera off, then on again 

- An error has occurred. Turn the camera off and then back on. If the error persists, when the error message appears, turn off the 
camera while you press and hold the MENU button. All the camera’s settings will be reset except for the hour meter. Turn on the 
camera again.

REC disabled when UAC is enabled.
- REC operation is disabled when  > [  Network/USB Setting] > [UVC Setting] > [Audio (UAC)] is set to [Enable]. Disable 

[Audio (UAC)].

No photos
- There are no photos on the SD card.

No clips
- There are no clips of the selected video format on the selected card.
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With the current [Gamma/Color Space] settings, setting the main recording format to one of the 10 bit options is 
recommended.

- The main recording format is set to one of the options using 8 bit depth but the color space component of the [Gamma/Color 
Space] setting in the custom picture file is set to [C.Gamut] or [BT.2020]. Using a 10 bit depth is recommended to fully realize the 
characteristics of the selected color space.

If you change this setting, you will not be able to use the current Look File.
- The Look File’s adjustments to the image quality cannot be applied because the [Gamma/Color Space], [HLG Color], [White 

Level 100%], [Over 100%] settings in the custom picture file are different from those registered with the Look File. Change these 
settings or register a different Look File.

This photo cannot be displayed
- You may not be able to display photos taken with other devices or image files created or edited on a computer.

Cannot play back
- The XF-AVC clip’s file control information is corrupted or there was a decoder error. Turn the camera off and then on again. If this 

does not solve the problem, consult a Canon Service Center.
* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information cannot be read by the 

software (Canon XF Utility or plugins for NLE applications).
- Playback was stopped because the card's read speed was too slow. Use a recommended card for recording/playback (A 38).
- Played back a clip recorded with AAC audio format from approximately 1 to 2 frames before the final frame. Play back using 

frame reverse/frame advance.

Magnification cannot be used when [Sensor Mode] is XF-HEVC S recording in [Full Frame 3:2], and [HDMI Output Signal] is 
3840x2160 or higher.  

- Magnification cannot be used at the same time. Check the settings.

Invalid operation
- An invalid operation (such as the ones listed below) was performed.

• In MEDIA mode, during playback, trying to add a shot mark to a frame that has one already.
• Trying to add an $ mark and a % mark to the same clip.
• Pressing the REC button when no cards are inserted in the camera.

Fan error
- The cooling fan may not be working properly. The camera will turn off automatically after a few minutes. Consult a Canon 

Service Center.

[2nd Card Rec Functions] is not working
Check the memory card

- Cannot record to CFexpress or SD card. Check the card.

[Gamma/Color Space] ([HLG Color], [Over 100%] or [White Level 100%])
Look File not available because these settings are different from those registered with the Look File. 

- A Look File is disabled if the [Gamma/Color Space], [HLG Color], [Over 100%] or [White Level 100%] settings are changed after 
registering it. Restore the setting or register the Look file again.

Noise levels will rise on the image of the sub recording and on video outputs not in RAW.
- The main recording format is set to RAW and the gamma curve component of the [Gamma/Color Space] setting in the custom 

picture file is set to an option other than [Canon Log 2]/[Canon Log 3]. Under such conditions, there may be more noise on the 
recorded proxy clips (SD card) and on video output from the various terminals.

Number of Shot Marks at maximum
- The shot mark could not be added because the clip already contains 100 shot marks.

When [Slow & Fast Frame Rate] is set higher than 60 (fps), the Magnification function cannot be used.
- You attempted to use the magnification function with slow & fast motion recording activated with a shooting frame rate higher 

than 60. Change the sensor mode or set a shooting frame rate of 60 or lower.

[Slow & Fast Motion/Audio (WAV)] 
Audio (WAV) recording not working 
Check the memory card 

- Cannot record audio (WAV) to the SD card. Check the card.
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Power Supply
Low Power Warning   Check the power supply.

- The input power supplied to the camera (DC coupler) or the remaining recording/playback time for the battery has reached the 
level set for the power level warning. Check the power source.

- The message appears every time you press the REC button when the power supply is too low (as described above).

Battery communication error.  Does this battery display the Canon logo?
- You attached a battery pack that is not recommended by Canon for use with this camera.
- If you are using a battery pack recommended by Canon for use with this camera, there may be a problem with the battery pack 

or camera. Consult a Canon Service Center.

Attach a battery pack or DC Coupler.
- Usage of the USB power adapter has reached a determined period of time. Attach a battery pack or DC coupler to the camera.

Battery internal temperature is rising. Power supply from the battery may stop. 
- The battery receiving power supply reached a high temperature. Turn off the camera, replace the battery or attach a DC 

coupler.

Shutting down the camera. This accessory is not supported with this camera.
- The attached accessory is not supported. Use a supported power source instead.

This camera does not support power supply during operation with the attached USB power adapter. 
- A USB power adapter that is not supported for power supply to the camera is attached. Use a supported power source instead.

The DC coupler is supplying power. The USB power adapter does not work.
- Both the DC coupler and USB power adapter are attached. Supply power using only the DC coupler.

[USB Mode] is set to Ethernet adapter
Power cannot be supplied by the USB power adapter. 
(Use DC coupler DR-E6P.)

- [USB Mode] is set to [Ethernet Adapter]. When using Ethernet, use the DR-E6P DC Coupler to supply power.

Memory Cards
Media full

- The card is full. Replace the card or delete recordings (A 154) to free some space on the card.
- Recording will not start because the card is full. Switch to the card in the other card slot to record.

Media is almost full
- Available space on one or both cards is insufficient as described below. Replace the relevant card(s) or delete recordings 

(A 154) to free some space on the card.

Accessing <...>   Do not remove
- You opened the card compartment cover while the camera was recording on the card. Be sure to stop the recording before 

removing the card.

Memory card is write-protected
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.

Check the memory card
- Cannot access the card. If the card is correctly inserted, remove it. Check it has no defects or other problems and then reinsert it.
- A card error occurred and recording/playback is not possible. Try removing and reinserting the card or replace it.
- You inserted a MultiMedia Card (MMC) into the camera. Use a recommended SD card (A 38).
- If after the message disappears,  or  appears in red, perform the following: Turn off the camera and remove and reinsert 

the card. If  or  turns back to green you can resume recording/playback. If the problem persists, save your recordings and 
initialize the card (A 40).

The management file's version is different.
Recommend full backup and initializing.

- Cannot record/playback because the management file's version is different. Back up the content in the card, then initialize the 
card (A 40).

Cover is open
- The card compartment cover is open. Insert a card and close the card compartment cover.

Management file error
- Cannot record because the camera cannot write to the file control information. This may occur if the files on the card were 

accessed using another device. Save your recordings and initialize the card (A 40).



229

Troubleshooting

Recording was stopped.
- The file control information is corrupted or there was an encoder error. Turn the camera off and then on again. Then, remove 

the card being used and reinsert it. Alternatively, replace the card. If this does not solve the problem, consult a Canon Service 
Center.
* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information cannot be read by the 

software (Canon XF Utility or plugins for NLE applications).

Number of clips already at maximum
- The card selected for recording already contains the maximum number of clips (999 clips). Replace the card or use the card in 

the other card slot.
- Because both cards reached the maximum number of clips, double slot recording is not available.

The memory card is not compatible with the current recording settings.
- One of the following recording settings was used with a card with a video speed class lower than V90. Change to a V90 card.

• Slow & fast motion recording mode is activated and the frame rate selected is for slow recording.
• The recording format was set to [XF-AVC YCC422 10 bit] / [XF-AVC S YCC422 10 bit] and the resolution to [4096x2160 Intra-

frame] / [3840x2160 Intra-frame].
- One of the following recording settings was used with a card with a video speed class lower than V60. Change to a V60 or V90 

card.
• The recording format was set to [XF-AVC YCC422 10 bit] / [XF-AVC S YCC422 10 bit] with an [Intra-frame] resolution.
• The recording format was set to [XF-AVC YCC422 10 bit] / [XF-AVC S YCC422 10 bit] with a resolution of [4096x2160 Long 

GOP] / [3840x2160 Long GOP].
• The recording format was set to [XF-HEVC S YCC422 10 bit] with a resolution of [4096x2160] / [3840x2160].

Cannot record at current bit rate.
- Check the main recording format, main resolution and the recording mode.

May not be possible to record clips on this media
- The card used does not meet the camera's requirements. Use a recommended card (A 38).

Some clips require data recovery
- The power may have been suddenly turned off or the card may have been removed while the camera was recording. As a result, 

one or more clips contain corrupted data. You can try to recover the clips (A 42).

Some audio files require data recovery.
- The power may have been suddenly turned off or the card may have been removed while the camera was recording. As a result, 

one or more audio files contain corrupted data. You can try to recover the files (A 42).

Cannot switch card slots
- The SLOT SELECT button was pressed while the camera is recording. Wait until recording is finished to change the selected card 

slot. 

Recommend checking the data and initializing
- The card cannot be used for any of the following reasons. Save your recordings and initialize the card (A 40).

• A problem has occurred with the card.
• The camera cannot read the data on the card.
• The card was initialized using a computer.
• The card is partitioned. 

Unable to recover data
- Could not recover the selected recording (clip or audio file). Back up your recordings and delete the recordings that could not 

be recovered (A 154).
- The camera may not be able to recover files when there is not enough space on the card. Delete recordings (A 154) to free 

some space.

Buffer overflow. Recording was stopped.
- Recording was stopped because the card's write speed was too slow. Use a recommended card (A 38).
- Save your recordings and initialize the card (A 40).

File name error
- Clip/photo numbers have reached their maximum value. Save your recordings and initialize the card (A 40) or delete all the 

recordings (A 154).

Recorded at 24.00 Hz/50.00 Hz/59.94 Hz   Recommend checking the data and initializing
- The card contains clips that were recorded using a system frequency different from the one currently used by the camera. To 

record on this card, save your recordings and initialize the card with the camera (A 40). To play back the XF-AVC clips recorded 
on the card, change the camera's system frequency (A 66) to match the recordings on the card.
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60 minutes have elapsed.    Audio (WAV) recording will stop.
- Recording of the audio file will stop after 60 minutes but video recording will continue unaffected.

CFexpress SD Card /  SD Card CFexpress Switched
- This message appears when you switch the card slot in use or recording continued from one card to the other.

CFexpress SD Card /  SD Card CFexpress Will switch in a moment
- The card is almost full so recording will continue on the other card in approximately 1 minute.

Lenses / Accessories
Currently, the accessory cannot be used

- A communication error occurred between the camera and an accessory attached to the multi-function shoe. Turn the camera 
off and then back on again.

Currently, the accessory cannot be used 
Please check the accessory power status

- Battery level is low on the accessory attached to the multi-function shoe. Replace the battery.

When using an Ethernet adapter, GP-E2 may not be able to receive GPS signals
- When using an Ethernet adapter, the GP-E2 may not be able to position correctly. Use only one of them.

Camera b Lens communication error.   Clean the lens’s contacts and reattach the lens.
- The camera cannot correctly communicate with the lens due to dirty lens contacts. After the message disappears, the i 

icon appears on the screen. Clean the lens contacts with a soft cloth and reattach the lens.

The following functions are not compatible with the current lens. 
[Focus Breathing Correction]

- The attached lens is not compatible with focus breathing correction. Correction is not applied even if  > [v Camera 
Setup] > [Focus Breathing Correction] is set to [On].

The lens does not work with the current conditions and attached power source. Check [Power Source Navigation] for more 
details.

- Use the  > [B System Setup] > [Power Source Navigation] function to check the available power source and settings 
(A 36).

Recommended settings for attached lens:
Sensor Mode: Full Frame
Digital IS: Off
Main Resolution: 3840x2160 or higher

- Adjust the menu settings as indicated in the message.

Attached lens accessory not supported by the camera. It may not work properly.
- The attached lens accessory is not supported. Some functions may not work correctly.

Attached lens’s firmware must be updated for the lens to work properly with this camera.
- For details about available firmware updates for the lens used, visit your local Canon website.

With the current combination of lens and mount adapter, some functions' performance may not be precise. Visit your local 
Canon web site for details.

- With the current combination of lens and mount adapter used, the focal length and aperture value displayed by the camera 
may not be accurate and should be considered only as a reference. Additionally, some functions may not work as precisely.

Attached lens not supported by the camera. It may not work properly.
- The attached lens is not supported. Some functions may not work correctly.

Attached lens not supported by the camera. It will not function.
- The attached lens is not supported.

Using a fast shutter (approx. equivalent to 1/250 shutter speed) is recommended for handheld shooting.
- A telephoto lens without optical IS was attached. When shooting handheld, subject blur (where the subject appears 

momentarily out of focus) may become noticeable. It is recommended to use a faster shutter speed.

Insufficient power. The lens does not work.
- The attached power source cannot be used with the attached lens. Use the  > [B System Setup] > [Power Source 

Navigation] function to check the available power source for the lens in use (A 36).

Power Zoom Adapter   Temperature too high. Cannot perform task.
- The power zoom adapter cannot be operated because its temperature is too high. Stop using the power zoom adapter and let 

it cool down before using it again.

Power Zoom Adapter   Check the power supply.
- The power zoom adapter’s remaining battery charge is low. Replace the power zoom adapter’s batteries.



231

Troubleshooting

Network Functions

Along with this list, refer also to the instruction manuals of the access point or other external devices you are using.

Lens error   Turn the camera off, then on again.
- There was a communication error between the camera and the lens. Turn the camera off and then on again.

Set with switch on lens side
- If you select  > [v Camera Setup] > [Focus Mode], attach a lens with a focus mode switch to switch AF/MF.
- If you select  > [v Camera Setup] > [Lens Optical IS], attach a lens with an optical IS on/off switch to switch it.

Set the lens to the shooting position.
- The collapsible lens attached to the camera is not set to the shooting position (with the barrel extended and locked). Set the 

lens to the shooting position.

Lens firmware update   Firmware update failed. Try updating again.
- The lens’s firmware could not be correctly updated. Try updating the firmware again.

Mount Adapter firmware update     Firmware update failed. Try updating again.
- The mount adapter’s firmware could not be correctly updated. Try updating the firmware again.

Power zoom adapter firmware update   Firmware update failed. Try updating again.
- The power zoom adapter’s firmware could not be correctly updated. Try updating the firmware again.

No response from access point.
- Check that the access point is working properly.
- Refer to Precautions Regarding Wi-Fi Networks (A 226) and check if there are applicable steps you can take.

Unable to connect to access point.
- The camera’s encryption method is different from that of the access point. Change the settings on the camera to match the 

access point.

Unable to connect to access point.   Retry from the beginning.
- To configure a new network connection using the WPS function (push button method), refer to the access point’s instruction 

manual and check how to activate the WPS function on the wireless router.

Ethernet connection lost.
- Check that any network hubs, routers and servers are turned on and working properly.

The camera’s temperature is too high. Network connection terminated.
- The network connection has been terminated because the camera’s internal temperature is too high. Turn off the camera and 

wait until the temperature has decreased.

No Wi-Fi network found with the selected SSID.
- Check the access point’s SSID (network name) and make sure the same name is used in the camera’s settings.
- Check that the access point is working properly and try again.

Security of server connection cannot be verified.   To always trust this server and connect, set [Trust Destination Server] to 
[Enable].

- Check that the necessary certificate is correctly configured.
- To trust and use this server even without the proper certificate, set [Trust Destination Server] to [Enable].

Failed to add to upload queue
- Upload request to Frame.io failed. Check the network connection or any problems with Frame.io.

Another device with the same IP address already connected to the network.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting device or 

the camera.
- When using a network with a DHCP server, if the camera’s IP address assignment is set to [Manual Setting], change it to 

[Automatic Setting] (A 177).

Multiple access points detected. Unable to connect.   Retry from the beginning.
- Other Wi-Fi devices are using the WPS function (push button method) to connect. Try the operation again or use other 

methods to configure the network (A 175).

Another device has set the same IP address.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting device or 

the camera.
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A streaming error occurred.
- CV protocol data could not be sent to the receiver. Check the receiver’s [Destination Server] and [Dest. Port No.] settings on the 

camera.
- In SRT Protocol Caller mode, the connection to the destination was lost while connected to the decoder or computer. Set the 

decoder or computer to receiving standby mode, then set [Activate IP Streaming] to [Enable] again (A 183).

Firmware download failed. File is write-protected.
- There is a write-protected file with the same name on the SD card. Delete the corresponding file.

Invalid root certificate.
- Check the date and time settings on the camera.
- The root certificate has expired. Load a root certificate from  > [  Network/USB Settings] > [Frame.io] > [Root 

Certificate] > [Read Root Certificate].

No address assigned by the DHCP server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DHCP server, change the camera’s 

IP address assignment to [Manual Setting] and configure the IP address (A 177).
- Check the DNS server.

• Check that the DHCP server is turned on and working properly.
• Make sure the DHCP server has enough IP addresses to assign.

- Check the network.
• Check if a router with an active gateway function is not being used on the network you are trying to connect to.
• Set the correct gateway address on the camera and on all the devices connected to the same network.
• Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the camera’s network 

settings.

No response from DNS server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DNS server, change the camera’s 

DNS address to [Disable] and configure the IP address (A 177).
- Enter the same IP address of the DNS server used in the camera’s network settings.
- Check the DNS server.

• Check that the DNS server is turned on and working properly.
• On the DNS server, set the correct IP address and the name corresponding to the same address.

- Check the network.
• Check if a router with an active gateway function is not being used on the network you are trying to connect to.
• Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the camera’s network 

settings.
• Set the correct gateway address on the camera and on all the devices connected to the same network.

Pairing with Frame.io is disabled. Re-pair.
- The pairing has expired or was canceled from the menu settings. Select  > [  Network/USB Settings] > [Frame.io] > 

[Pair] to re-pair.

Communication with Frame.io failed.
- Check if there are any issues with the network connection or Frame.io.

File access error occurred during Frame.io upload.
- Check the SD card:

• The memory card cover may be open.
• A compatible card must be used (A 38).
• Initialize the card (A 40) when you use it with the camera for the first time.
• The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
• The card is full. Replace the card or delete recordings (A 154) to free some space on the card.

Wi-Fi error.    Incorrect encryption method.
- Make sure the camera and access point are using the same authentication/encryption method.

Wi-Fi connection lost.
- The camera could not connect to the access point or network device.
- The wireless signal may be affected by nearby cordless telephones, microwave ovens, refrigerators or other devices. Operate 

the camera in a place more distant from such interference.
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Wi-Fi authentication unsuccessful
- The camera’s authentication mode and/or encryption key are different from those of the access point. Change the settings on 

the camera to match the access point.

Incorrect Wi-Fi password.
- Set the correct encryption key on the camera and the access point.
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Access Log
When security-related settings are changed or when device authentication/user authentication fails consecutively, the 
information is saved as an access log in the camera. From a security perspective, it is recommended to regularly check the 
access logs (A 203).

Access Log List

NOTES
• The access log is cleared when you reset the camera's settings.
• When the number of access logs exceeds 100, the oldest ones will be deleted.

Access Log Description

Change PIN code The PIN code was changed.

Update PIN code request setting The PIN code request setting was enabled/disabled.

Update Function settings The RTSP user name/password was changed.

Update XC Protocol settings The XC Protocol authentication method/port number/user name/password was changed, or HTTP/HTTPS were switched.

Update Communication settings The Camera Access Point password or Wi-Fi connection parameters were changed.

Update Connection settings The network connection settings (SET) were changed.

Update 802.1X authentication The root certificate for 802.1X authentication was changed or deleted.

Update Frame.io root certificate The root certificate for Frame.io upload was changed or deleted.

Save Camera settings on camera Menu/Custom Picture settings were saved to the camera.

Save Camera settings on card Menu/Custom Picture settings were saved to the SD card.

Load Camera settings from camera Menu/Custom Picture settings were loaded from the camera.

Load Camera settings from card Menu/Custom Picture settings were loaded from the SD card.

Reset all settings The camera’s settings were reset.

Maximum PIN code attempts exceeded An incorrect PIN code was entered consecutively.

IP Streaming Login Fail Failed to log in consecutively with IP Streaming.

XC Protocol Login Fail Failed to log in consecutively with XC Protocol.
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Handling Precautions 

Camera
Be sure to observe the following precautions to ensure maximum performance. 
• Do not use or store the camera in dusty or sandy places. The camera is not waterproof – avoid also water, mud or salt. If 

any of the above should get into the camera it may damage the camera and/or the lens. Consult a Canon Service 
Center as soon as possible.

• Be careful to avoid dust and dirt particles accumulating on the lens or entering the camera. When you finish using the 
camera, make sure to attach the body cap to the lens mount and the lens cap and dust cap to the lens.

• Do not use the camera near strong electromagnetic fields such as near powerful magnets and motors, MRI machines 
or high-voltage power lines. Using the camera in such places may cause anomalies in the video, or audio/video noise.

• Do not point the camera toward an intense light source, such as the sun on a sunny day or an intense artificial light 
source. Doing so may damage the image sensor or the camera’s internal components. Be especially careful when using 
a tripod or shoulder strap. When you are not using the camera, make sure to attach the lens cap to the lens.

• Do not touch the lens contacts on the lens mount. Dirty contacts may cause a poor contact 
between the camera and the lens resulting in incorrect operation of the camera. After 
removing the lens, make sure to attach the body cap to the lens mount and the lens cap and 
dust cap to the lens.

• Do not carry the camera by the LCD monitor or store the camera in a forced position, without 
returning the LCD monitor to its correct position. This may damage to the monitor’s joints.

• Do not apply excessive force when touching the screen. This may cause irregularities in the display quality or damage 
to the monitor’s joints.

• Do not apply protective film to the touch screen. The camera features a capacitive touch screen that may stop working 
correctly with a protective overlay.

Long-term storage 
If you do not intend to use the camera for a long time, store it in a place free of dust, in low humidity, and at temperatures 
not higher than 30 °C (86 °F).

Battery Pack

• Dirty terminals may cause a poor contact between the battery pack and the camera. Wipe the terminals with a soft dry 
cloth.

DANGER!

Treat the battery pack with care.
• Keep it away from fire (or it might explode).
• Do not expose the battery pack to temperature higher than 60 °C (140 °F). Do not leave it near a heater or inside a 

car in hot weather.
• Do not try to disassemble or modify it.
• Do not drop it or subject it to shocks.
• Do not get it wet.
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• Be sure to attach the terminal cover (Figure 1) to transport or store the battery pack. 
Do not allow any metal objects to touch the terminals (Figure 2), as this can cause a 
short circuit and damage the battery pack.

• The correct remaining battery time may not be displayed if a fully charged battery 
pack is used continuously in high temperatures or is left unused for long periods of 
time. Also, the correct remaining time may not be displayed, depending on the 
battery life. Use the time shown on the screen as an approximation.

• The battery terminal cover has a [ð]-shaped hole. This is useful when you wish 
to differentiate between charged and uncharged battery packs.

• You can use the battery charger, an optional DC coupler and USB power adapter/AC adapter, or a USB power adapter 
in any country/region with power supply between 100 and 240 V AC, 50/60 Hz. Consult a Canon Service Center for 
information on plug adapters for overseas use.

Long-term storage 
• Store battery packs in a dry place at temperatures no higher than 30 °C (86 °F). 
• Before storing battery packs, charge them until two lamps (on the indicator on top of the battery) illuminate (A 21).
• When charging the battery, aim to charge it to approx. 50% instead of fully charging it.
• At room temperature (23 °C) (73 °F), it takes approx. 60 min. to charge a depleted battery to about approx. 50%. Battery 

charging time varies greatly depending on ambient temperature.
• Charge all your battery packs fully at least once a year.

Recording Media
• Periodically backing up recordings from the cards used to a computer is recommended. Data may be corrupted or lost 

due to defects or exposure to static electricity. Canon shall not be liable for lost or corrupted data.
• Do not touch or expose the terminals to dust or dirt.
• Do not use cards in places subject to strong magnetic fields.
• Do not leave cards in places subject to high humidity and high temperature.
• Do not attach any labels or stickers on the cards.
• Do not disassemble, bend, drop, or subject cards to shocks and do not expose them to water.

Disposal
When you delete data on a card, only the file allocation table is altered and stored data is not physically erased. Take the 
necessary precautions when you dispose of the card, for example by physically damaging it to prevent the leakage of 
private data.
If giving the card to another person, initialize it. Fill it up with unimportant recordings, and then initialize it again. This 
makes recovering the original recordings very difficult.

Built-in Backup Battery
The camera has a built-in rechargeable lithium battery to keep the date/time and other settings. The built-in backup 
battery is recharged while you use the camera; however, it will be depleted completely if you do not use the camera for 
about 3 months.
To recharge the built-in backup battery: Turn off the camera and attach a power source (sufficiently charged battery, an optional 
DC coupler and USB power adapter/AC adapter, or a USB power adapter). The built-in backup battery will be fully 
charged in approx. 24 hours.

Figure 1 Figure 2
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Maintenance/Others
Condensation
Moving the camera rapidly between hot and cold temperatures may cause condensation (water droplets) to form on its 
internal surfaces. Stop using the camera if condensation is detected. Continued use may damage the camera. 
Condensation may form in the following cases:
• When the camera is moved quickly from cold to warm places
• When the camera is left in a humid room
• When a cold room is heated rapidly

When condensation is detected 
Disconnect the power source (battery, DC coupler and USB power adapter/AC adapter, USB power adapter, etc.). The 
precise time required for water droplets to evaporate will vary depending on the location and weather conditions. As a 
general rule, wait for 2 hours before resuming use of the camera.

To avoid condensation 
Remove the battery pack and any cards. Then, place the camera in an airtight plastic bag and let it adjust gradually to 
temperature changes before removing it from the bag.

Cleaning

Camera body
• Use a soft dry cloth to clean the camera’s body. Never use chemically treated cloths or volatile solvents such as paint 

thinner.

Lens
• Remove any dust or dirt particles using a non-aerosol type blower.
• Use a clean, soft lens-cleaning cloth to gently wipe the lens. Never use tissue paper.

LCD screen
• Clean the LCD screen using a clean, soft lens-cleaning cloth and commercially available cleaning fluid for eyeglasses.
• Condensation may form on the surface of the screen when the temperature changes suddenly. Wipe it with a soft dry 

cloth.
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List of Accessories
The following optional accessories are compatible with this camera. The availability differs from area to area.
For details on using the optional accessories and on their specifications, refer also to the Cinema EOS System Expansion User 
Guide (PDF file), available from your local Canon website.

1 The optional PD-E2 USB Power Adapter is required to connect to the camera.
2 The optional CA-946 AC Adapter is required to connect to the camera.
3 In VIDEO mode, power supply is not supported.
4 The transmission rate when IFC-100U is used is equivalent to SuperSpeed USB (USB 3.1 Gen 1).
5 The transmission rate when IFC-400U is used is equivalent to Hi-Speed USB (USB 2.0).
6 This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to 

take adequate measures.
7 The optional RA-E3 Remote Controller Adapter is required to connect to the camera.

For our customers in the USA: Call or visit your local retailer/dealer for genuine Canon video accessories. You can also obtain 
genuine accessories for your Canon camera by calling: 1-800-828-4040, Canon U.S.A. Information Center.

Optional Accessories

Batteries and Chargers

LP-E6P Battery Pack

LP-E6NH Battery Pack

LC-E6/LC-E6E Battery Charger

Power Supply and Cables

DR-E6P DC Coupler1

DR-E6C DC Coupler2

PD-E2 USB Power Adapter

PD-E1 USB Power Adapter3

IFC-100U Interface Cable4

IFC-400U Interface Cable5

Added Functionality and Lens Compatibility

RC-IP100 Remote Camera Controller6

RC-IP1000 Remote Camera Controller6

PL-RF Mount Adapter

EF-EOS R 0.71x Mount Adapter

EF-EOS R Mount Adapter

EF-EOS R Control Ring Mount Adapter

EF-EOS R Drop-in Filter Mount Adapter with Drop-in Variable ND Filter A

EF-EOS R Drop-in Filter Mount Adapter with Drop-In Circular Polarizing Filter A

DM-E1D Multi-Function Shoe Directional Stereo Microphone

DM-E1 Directional Stereo Microphone

Shooting Styles and Configuration

BG-R20 Battery Grip

RS-80E3 Remote Switch

RS-60E3 Remote Switch

RS-80N3 Remote Switch7

OC-E4A Off-Camera Shoe Cord
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IMPORTANT

• Use of genuine Canon accessories is recommended.
The message [Battery communication error] is displayed if you use a non-genuine Canon battery pack, and user 
response is required. Note that Canon shall not be liable for any damages resulting from accidents, such as malfunction 
or fire, that occur due to use of non-genuine Canon battery packs.

• Charging/power supply via the USB terminal.
Charging and power supply through the USB terminal are only supported with the PD-E2/PD-E1* USB Power Adapter. 
Proper operation is not guaranteed when using USB chargers or power supplies that are not genuine Canon products.
* In VIDEO mode, power supply is not supported.

This mark identifies genuine Canon video accessories. When you use Canon video equipment, we 
recommend Canon-brand accessories or products bearing the same mark.



Specifications

240

Specifications
C50
System

• Recording System
Clips:

RAW
Video format: Cinema RAW Light
Audio format: Linear PCM, 24 bit, 48 kHz, 4 channels
File format: CRM (Canon RAW Movie; Canon proprietary file format)

XF-AVC
Video compression: MPEG-4 AVC / H.264
Audio format: Linear PCM, 24 bit, 48 kHz, 4 channels
File format: MXF

XF-HEVC S / XF-AVC S
Video compression: XF- HEVC S HEVC / H.265, XF-AVC S MPEG-4 AVC / H.264
Audio format: Linear PCM, 24 bit, 48 kHz, 4 channels

MPEG-2 AAC-LC, 16 bit, 48 kHz, 2 channels
File format: MP4

WAV
Audio format: Audio files for slow & fast motion recording:

Linear PCM, 24 bit, 48 kHz, 4 channels
Audio files for the second card recording function:

Linear PCM, 16 bit, 8 kHz, 1 channel
File format: BWF

Photos: DCF (Design rule for Camera File system), compatible with Exif Ver. 2.31, JPEG compression

• Video Configuration (recording/playback)
Primary clips:

RAW
Bit rate: 2900 Mbps, 2860 Mbps, 2420 Mbps, 2380 Mbps, 2320 Mbps, 1860 Mbps, 1800 Mbps, 

1550 Mbps, 1520 Mbps, 1510 Mbps, 1500 Mbps, 1450 Mbps, 1440 Mbps, 1430 Mbps, 
1270 Mbps, 1250 Mbps, 1220 Mbps, 1190 Mbps, 1170 Mbps, 1150 Mbps, 976 Mbps, 
972 Mbps, 937 Mbps, 936 Mbps, 927 Mbps, 811 Mbps, 773 Mbps, 769 Mbps, 748 Mbps, 
742 Mbps, 642 Mbps, 624 Mbps, 599 Mbps, 486 Mbps, 406 Mbps, 390 Mbps, 389 Mbps, 
385 Mbps, 379 Mbps, 321 Mbps, 316 Mbps, 308 Mbps, 246 Mbps, 206 Mbps, 190 Mbps, 
158 Mbps, 152 Mbps, 123 Mbps, 103 Mbps, 99 Mbps

Resolution: 6960x4640, 6960x3672, 5036x2656, 2524x1332
Color bit depth: 12 bit
Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

XF-AVC
Bit rate: 1200 Mbps, 1000 Mbps, 900 Mbps, 750 Mbps, 600 Mbps, 500 Mbps, 480 Mbps, 

450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps, 250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 
120 Mbps / Intra-frame
250 Mbps, 150 Mbps, 50 Mbps, 25 Mbps / Long GOP

Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080
Color sampling: YCbCr 4:2:2, 10 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P
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XF-HEVC S / XF-AVC S
Bit rate: XF-HEVC S:

1730 Mbps, 1620 Mbps, 1350 Mbps, 1300 Mbps, 1080 Mbps, 900 Mbps, 
864 Mbps / Intra-frame
486 Mbps, 360 Mbps, 225 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 
35 Mbps / Long GOP

XF-AVC S:
1200 Mbps, 1000 Mbps, 900 Mbps, 750 Mbps, 600 Mbps, 500 Mbps, 480 Mbps, 
450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps, 250 Mbps, 240 Mbps, 150 Mbps, 125 
Mbps, 120 Mbps / Intra-frame
250 Mbps, 150 Mbps, 100 Mbps, 50 Mbps, 35 Mbps / Long GOP

Resolution: XF-HEVC S:
6912x4608, 4096x2160, 3840x2160, 2048x1080, 1920x1080

XF-AVC S:
4096x2160, 3840x2160, 2048x1080, 1920x1080

Color sampling: XF-HEVC S:
4:2:2 10 bit, 4:2:0 10 bit

XF-AVC S:
4:2:2 10 bit, 4:2:0 8 bit

Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

Sub recording clips:
XF-AVC

Bit rate: 600 Mbps, 500 Mbps, 480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 300 Mbps, 
250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps / Intra-frame
250 Mbps, 150 Mbps, 50 Mbps, 25 Mbps / Long GOP

Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080
Color sampling: YCbCr 4:2:2, 10 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

XF-HEVC S / XF-AVC S
Bit rate: XF-HEVC S:

225 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 35 Mbps / 
Long GOP

XF-AVC S:
600 Mbps, 500 Mbps, 480 Mbps, 450 Mbps, 375 Mbps, 360 Mbps, 
300 Mbps, 250 Mbps, 240 Mbps, 150 Mbps, 125 Mbps, 120 Mbps / 
Intra-frame
250 Mbps, 150 Mbps, 100 Mbps, 50 Mbps, 35 Mbps / Long GOP

Resolution: 4096x2160, 3840x2160, 2048x1080, 1920x1080
Color sampling: XF-HEVC S:

4:2:2 10 bit, 4:2:0 10 bit
XF-AVC S:

4:2:2 10 bit, 4:2:0 8 bit
Frame rate: 59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

Proxy clips:
XF-AVC

Bit rate: 35 Mbps / Long GOP
Resolution: 2048x1080, 1920x1080
Color sampling: YCbCr 4:2:0, 8 bit
Frame rate: 59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P
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XF-HEVC S / XF-AVC S
Bit rate: 16 Mbps, 9 Mbps, 6 Mbps / Long GOP
Resolution: 2048x1080, 1920x1280, 1920x1080, 1280x720
Color sampling: XF-HEVC S:

4:2:0 10 bit, 4:2:0 8 bit
XF-AVC S:

4:2:0 8 bit
 Frame rate: 59.94P, 50.00P, 29.97P, 23.98P, 25.00P, 24.00P

Crop recording:
XF-HEVC S

Bit rate: 50 Mbps, 35 Mbps, 27 Mbps, 19 Mbps / Long GOP
Resolution: 1080x2048, 1080x1920, 1080x1080
Color sampling: 4:2:2 10 bit, 4:2:0 10 bit
Frame rate: 59.94P, 50.00P, 29.97P, 23.98P, 25.00P, 24.00P

XF-AVC S
Bit rate: 300 Mbps, 250 Mbps, 159 Mbps, 150 Mbps, 133 Mbps, 125 Mbps, 120 Mbps, 80 Mbps, 

67 Mbps, 64 Mbps / Intra-frame
50 Mbps, 35 Mbps, 27 Mbps, 19 Mbps / Long GOP

Resolution: 1080x2048, 1080x1920, 1080x1080
Color sampling: 4:2:2 10 bit, 4:2:0 8 bit
Frame rate: 59.94P, 50.00P, 29.97P, 23.98P, 25.00P, 24.00P

Chunk recording:
XF-HEVC S / XF-AVC S

Bit rate: 16 Mbps, 9 Mbps, 6 Mbps / Long GOP
Resolution: 2048x1080, 1920x1280, 1920x1080, 1280x720
Color sampling: XF-HEVC S

4:2:0 10 bit, 4:2:0 8 bit
XF-AVC S

4:2:0 8 bit
Frame rate: 59.94P, 50.00P, 29.97P, 23.98P, 25.00P, 24.00P

• Recording Media (not included)
CFexpress cards compliant with CFexpress 2.0 Type B specifications, SD, SDHC (SD High Capacity) or SDXC (SD 
eXtended Capacity) cards

• Image Sensor
Full frame CMOS sensor
Total number of pixels1 (approximate): 34,200,000 pixels
Effective camera pixels1 (approximate): 32,400,000 pixels (in VIDEO mode)
1 Rounded to the nearest 10,000.

• LCD Touch Screen
7.62 cm (3.0 in.) color LCD, approx. 1,620,000 dots, 100% coverage, capacitive touch screen operation
- View assistance functions can be applied (Gamma: CMT 709 equivalent, Canon 709 equivalent, original / Color space: 

BT.709 equivalent) and assistance displays can be output (onscreen displays, peaking, zebra pattern, magnification, 
B&W image, video scope, false color, anamorphic desqueeze).

• Lens Mount
Canon RF lens mount compatible with Canon RF/EF/PL lenses1
1 RF lenses include RF-S lenses and RF Cinema lenses. One of the available Canon EF-EOS R Mount Adapters is required for using EF lenses 

(including EF-S and EF Cinema lenses). PL lenses can be used when a PL-RF Mount Adapter is attached.
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• Approximate lens multiplication factor (for 35mm equivalent focal length)
[Full Frame 3:2] sensor mode:

Actual focal length1 x 1.002 (when the horizontal resolution is 6960)
[Full Frame] sensor mode:

Actual focal length1 x 1.062 (when the horizontal resolution is 6960/4096/2048)
Actual focal length1 x 1.122 (when the horizontal resolution is 3840/1920)

[Super 35mm (Cropped)] sensor mode:
Actual focal length1 x 1.472 (when the horizontal resolution is 5036/4096/2048)
Actual focal length1 x 1.542 (when the horizontal resolution is 3840/1920)

[Super 16mm (Cropped)] sensor mode:
    Actual focal length1 x 2.922 (when the horizontal resolution is 2524/2048)
    Actual focal length1 x 3.082 (when the horizontal resolution is 1920)
1 Lens focal length
2 Conversion factor

• Lens Correction 
Peripheral illumination/chromatic aberration/diffraction distortion aberration/focus breathing correction is available 
for Canon RF, EF and RF/EF Cinema lenses2

Distortion aberration/focus breathing correction is available only for Canon RF and RF Cinema lenses
2 Some lenses are not compatible with in-camera correction.

• Shutter Speed 
Automatic
Manual: Speed (1/3-stop increments, 1/4-stop increments), angle, clear scan, slow, off

• Iris
Manual (1/2-stop increments, 1/3-stop increments, fine adjustment available), push auto iris, automatic aperture

• ISO Speed/Gain
Manual, automatic adjustment
ISO speed ([1 stop] and [1/3 stop] settings): ISO 100 to ISO 102400
Gain ([Normal] and [Fine] settings): –6 dB to 54 dB

• Exposure
AE shift, light metering modes (standard, spotlight, backlight)

• White Balance
Custom white balance (two sets, A and B); two preset settings (daylight, 5,600 K4 and tungsten lamp, 3,200 K4); color 
temperature setting (2,000 K to 15,000 K); automatic white balance (AWB)
Color temperature and color compensation (CC) adjustment available for all settings except custom white balance and 
AWB.
4 Color temperatures are approximate and given only as a reference.

• Focus
Manual focus, autofocus (one-shot AF, continuous AF, subject detection AF); subject tracking available
AF type: Dual Pixel CMOS AF

• Sensor Sensitivity (ISO 800, 2000 lux, 89.9% reflection)
59.94 Hz: F10 (at 59.94P), F14 (at 29.97P)
50.00 Hz: F11 (at 50.00P), F16 (at 25.00P)

• Wi-Fi
Wireless standard: IEEE 802.11b/g/n (2.4 GHz band), IEEE 802.11a/n/ac (5 GHz band)
Connection methods: Infrastructure (Wi-Fi Protected Setup (WPS), search for access points, manual), Camera 

Access Point
Authentication methods: Open, WPA/WPA2/WPA3-Personal, WPA/WPA2/WPA3-Enterprise
Encryption methods: TKIP, AES

• Microphone
Built-in microphone (stereo)
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• Size of Photos
[Full Frame 3:2] sensor mode:

When the main recording format is RAW: 3240x2160
When the main recording format is XF-HEVC S: 6912x4608

[Full Frame], [Super 35mm (Cropped)] sensor mode:
When the main recording format is RAW or the main resolution is 4096x2160/2048x1080: 4096x2160
When the main resolution is 3840x2160/1920x1080: 3840x2160

[Super 16mm (Cropped)] sensor mode:
When the main recording format is RAW or the main resolution is 2048x1080: 2048x1080
When the main resolution is 1920x1080: 1920x1080

Terminals

• HDMI OUT Terminal
HDMI connector (TYPE-A), output only
The time code signal can be output (proprietary standard)

Video/audio output: Conforming to HDMI specifications.

• INPUT Terminals (INPUT 1 and INPUT 2 (handle unit))
XLR 3-pin jack (pin1: shield, pin2: hot, pin3: cold), 2 sets, balanced
Sensitivity:

MIC setting: –60 dBu (volume center, full scale –18 dB) / microphone attenuator: 20 dB
LINE setting: 4 dBu (volume center, full scale –18 dB) 

• MIC Terminal
∅ 3.5 mm stereo mini-jack
Sensitivity:

[MIC (with Power Supply)] setting:
–72 dBV (volume center, full scale –18 dB) / microphone attenuator: 20 dB
Plug-in power supply: 2.0 V DC 

[LINE] setting: –12 dBV (volume center, full scale –18 dB) 

• × (Headphone) Terminal
∅ 3.5 mm stereo mini-jack, –17 dBV (32 Ω load, Max volume) 

• TIME CODE Terminal
DIN 1.0/2.3 jack, input/output
Input setting: 0.5 Vp-p to 4.5 Vp-p / 100 kΩ; Output setting: 1.3 Vp-p / 50 Ω 

• USB Terminal
USB Type-C jack
Equivalent to SuperSpeed USB (USB 3.2 Gen 1) when using an Ethernet adapter.
Otherwise, equivalent to SuperSpeed Plus USB (USB 3.2 Gen 2).

• Remote control Terminal
E3-type
∅ 2.5 mm stereo sub-mini jack

• Multi-Function Shoe Terminal
Proprietary Canon connector

Power/Others

• Power Supply (rated)
7.2 V DC (battery pack)

• Operating Temperature
0 – 40 °C (32 – 104 °F)
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• Dimensions (W x H x D)5

Camera body only: 142 x 88 x 95 mm (5.6 x 3.5 x 3.7 in.)
Camera with handle unit, microphone holder: 222 x 239 x 186 mm (8.7 x 9.4 x 7.3 in.)

• Weight5 
Camera body: 670 g (1.5 lb.)
Camera with LP-E6P battery, a CFexpress card and an SD card: 765 g (1.7 lb.)
Camera with handle unit, microphone holder, LP-E6P battery, a CFexpress card and an SD card: 1,120 g (2.5 lb.)

Accessories
LC-E6/LC-E6E Battery Charger

• Rated Input: 100-240 V  AC (50/60 Hz)

• Rated Output: 8.4 V DC, 1.0 A

• Operating Temperature: 5 – 40 °C (41 – 104 °F)

• Dimensions5 (W x H x D): 69 x 33 x 93 mm (2.7 x 1.3 x 3.7 in.)

• Weight5

LC-E6: 110 g (3.9 oz.)
LC-E6E: 100 g (3.5 oz.) (excluding power cord)

LP-E6P Battery Pack

• Battery Type: Rechargeable lithium ion battery

• Rated Voltage: 7.2 V DC

• Battery Capacity: 2,130 mAh

• Operating Temperature: 0 – 40 °C (32 – 104 °F)

• Dimensions5 (W x H x D): 38.4 x 21.0 x 56.8 mm (1.51 x 0.83 x 2.24 in.)

• Weight5: 82 g (2.89 oz.) (excluding protective cover)
5 All dimensions and weights are approximate.

Errors and omissions excepted.
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Compatible Lenses and Functions
Following is a list of lenses compatible with this camera and the various functions that can be used depending on the 
lens. Depending on the lens’s purchase date, you may need to update the lens’s firmware to use these functions. For 
details, visit your local Canon website or consult a Canon Service Center.
PL mount lenses can only be used after attaching the optional PL-RF Mount Adapter. In addition, connection to an 
external power source is required for lenses equipped with a drive unit.

1 A mount adapter is required.
2 Except for the RF600mm F11 IS STM, RF800mm F11 IS STM.
3 Only lenses with the PZ-E1 Power Zoom Adapter attached.
4 The AE response setting (A 191) is not supported (not applicable).
5 Only lenses with the PZ-E2/PZ-E2B Power Zoom Adapter attached or RF-S14-30mm F4-6.3 IS STM PZ.
6 Excluding RF75-300mm F4.5-5.6.

• EF lenses compatible with auto iris:

Lens
Iris control from the camera Zoom control from 

the cameraManual Push auto iris Automatic

RF lenses Ü2 Ü2 Ü2, 6 Ü5

EF lenses1 Ü Ü – Ü3

EF lenses compatible with auto iris Ü Ü Ü –

RF / EF1 Cinema lenses / PL1 lenses

CN7x17 KAS S/E14

CN10x25 IAS S/E14

CN20x50 IAS H/E14

CN8x15 IAS S/E14

Ü Ü Ü Ü

CN-E18-80mm T4.4 L IS KAS S
CN-E70-200mm T4.4 L IS KAS S
CN7x17 KAS T/R1
CN5x11 IAS T/R1

Ü Ü Ü Ü

CN7x17 KAS S/P14

CN20x50 IAS H/P14

CN10x25 IAS S/P14

CN8x15 IAS S/P14

CN7x17 KAS T/P14

CN5x11 IAS T/P14

– – – –

Manual focus lenses compatible with focus guide

– – – –
CN-E15.5-47mm T2.8 L S
CN-E15.5-47mm T2.8 L SP
CN-E30-105mm T2.8 L S
CN-E30-105mm T2.8 L SP

EF85mm F1.4L IS USM EF70-200mm F4L IS II USM
EF400mm F2.8L IS III USM EF600mm F4L IS III USM
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Compatible Lenses and Functions

1 A mount adapter is required.
2 Except for the RF5.2mm F2.8 L Dual Fisheye lens.
3 Disabled while operating the zoom from the camera (excluding digital zoom).

• Manual focus lenses compatible with focus guide:

 

• Lenses compatible with automatic retraction when the camera is turned off (A 203):

• Lenses that support preset focus/zoom operations from XC Protocol-compatible controllers:

1 Zoom operation is possible only when the PZ-E2/PZ-E2B Power Zoom Adapter is attached.
2 Focus operation only.

Lens
Focus control from the camera

Focus guide
Manual One-shot AF Continuous AF

Subject 
detection AF

Tracking

RF / EF1 lenses Ü2 Ü2 Ü2 Ü2 Ü2 Ü

RF / EF1 Cinema lenses, PL1 lenses

CN5x11 IAS T/R1
CN7x17 KAS S/E1
CN7x17 KAS T/R1
CN8x15 IAS S/E1
CN10x25 IAS S/E1

Ü Ü Ü Ü Ü Ü

CN20x50 IAS H/E1 Ü – – – – –

CN5x11 IAS T/P1
CN7x17 KAS S/P1
CN20x50 IAS H/P1
CN10x25 IAS S/P1
CN8x15 IAS S/P1
CN7x17 KAS T/P1

– – – – – –

CN-E18-80mm T4.4 L IS KAS S,
CN-E70-200mm T4.4 L IS KAS S

Ü Ü3 Ü3 Ü3 Ü Ü

Manual focus lenses compatible with focus guide – – – – – Ü

CN-E14mm T3.1 L F CN-E50mm T1.3 L F
CN-E20mm T1.5 L F CN-E85mm T1.3 L F
CN-E24mm T1.5 L F CN-E135mm T2.2 L F
CN-E35mm T1.5 L F CN-E20-50mm T2.4 L F
CN-E14-35mm T1.7 L S CN-E45-135mm T2.4 L F
CN-E31.5-95mm T1.7 L S CN-R24mm T1.5 L F
CN-R35mm T1.5 L F CN-R50mm T1.3 L F
CN-R85mm T1.3 L F CN-R14mm T3.1 L F
CN-R20mm T1.5 L F CN-R135mm T2.2 L F

RF35mm F1.8 MACRO IS STM EF50mm F1.8 STM
EF40mm F2.8 STM EF-S24mm F2.8 STM
RF85mm F2 MACRO IS STM RF50mm F1.8 STM
RF24mm F1.8 MACRO IS STM RF16mm F2.8 STM

CN-E18-80mm T4.4 L IS KAS S CN-E70-200mm T4.4 L IS KAS S
CN7×17 KAS T/R1 CN5x11 IAS T/R1
RF 24-105 F2.8 L IS USM Z1 RF35mm F1.4 L VCM2

RF28-70mm F2.8 IS STM2 RF70-200mm F2.8 L IS USM Z1

RF16-28mm F2.8 IS STM2 RF-S14-30mm F4-6.3 IS STM PZ
RF50mm F1.4 L VCM2 RF24mm F1.4 L VCM2

RF20mm F1.4 L VCM2 RF85mm F1.4 L VCM2
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Reference Tables
Approximate Recording Time on a Card
Approximate times, for reference only, based on a single recording that continues until the card is full.

Recording 
format 

Bit rate
CFexpress card SD card Recording 

format 
Bit rate

CFexpress card SD card

512 GB 512 GB 128 GB 512 GB 512 GB 128 GB

RAW

2900 Mbps 22 min. – –

XF-AVC

1200 Mbps 53 min. – –

2860 Mbps 22 min. – – 900 Mbps 70 min. – –

2320 Mbps 27 min. – – 600 Mbps 104 min. 105 min. 26 min.

1860 Mbps 34 min. – – 480 Mbps 131 min. 131 min. 32 min.

1800 Mbps 35 min. – – 450 Mbps 140 min. 140 min. 35 min.

1520 Mbps 41 min. – – 360 Mbps 174 min. 174 min. 43 min.

1500 Mbps 42 min. – – 300 Mbps 206 min. 206 min. 51 min.

1440 Mbps 44 min. – – 250 Mbps 245 min. 245 min. 61 min.

1430 Mbps 44 min. – – 240 Mbps 259 min. 259 min. 64 min.

1220 Mbps 52 min. – – 150 Mbps 406 min. 406 min. 101 min.

1170 Mbps 54 min. – – 120 Mbps 502 min. 502 min. 125 min.

1150 Mbps 55 min. – – 50 Mbps 1044 min. 1044 min. 261 min.

972 Mbps 65 min. – – 25 Mbps 1943 min. 1943 min. 485 min.

936 Mbps 67 min. – –

XF-HEVC S

1730 Mbps 37 min. – –

927 Mbps 68 min. – – 1620 Mbps 39 min. – –

769 Mbps 81 min. – – 486 Mbps 131 min. 131 min. 32 min.

748 Mbps 84 min. – – 360 Mbps 177 min. 177 min. 44 min.

742 Mbps 85 min. – – 225 Mbps 282 min. 282 min. 70 min.

599 Mbps 105 min. 105 min. 26 min. 150 Mbps 422 min. 422 min. 105 min.

486 Mbps 129 min. 129 min. 32 min. 135 Mbps 471 min. 471 min. 117 min.

389 Mbps 161 min. 161 min. 40 min. 100 Mbps 635 min. 635 min. 158 min.

385 Mbps 162 min. 166 min. 41 min. 50 Mbps 1237 min. 1237 min. 309 min.

379 Mbps 163 min. 169 min. 42 min. 35 Mbps 1740 min. 1740 min. 435 min.

308 Mbps 202 min. 208 min. 52 min.

XF-AVC S

1200 Mbps 53 min. – –

246 Mbps 246 min. 261 min. 65 min. 900 Mbps 71 min. – –

190 Mbps 322 min. 337 min. 84 min. 600 Mbps 106 min. 106 min. 26 min.

152 Mbps 400 min. 422 min. 105 min. 480 Mbps 133 min. 133 min. 33 min.

123 Mbps 485 min. 521 min. 130 min. 450 Mbps 142 min. 142 min. 35 min.

99 Mbps 597 min. 648 min. 162 min. 360 Mbps 177 min. 177 min. 44 min.

300 Mbps 212 min. 212 min. 53 min.

250 Mbps 254 min. 254 min. 63 min.

240 Mbps 266 min. 266 min. 66 min.

150 Mbps 422 min. 422 min. 105 min.

120 Mbps 530 min. 531 min. 132 min.

100 Mbps 635 min. 635 min. 158 min.

50 Mbps 1237 min. 1237 min. 309 min.

35 Mbps 1740 min. 1740 min. 435 min.
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Approximate Continuous Video Recording Times
Refer to the following table for the approximate continuous recording times when using the supplied LP-E6P Battery Pack  
or the optional LP-E6NH Battery Pack (fully charged).
The values were measured while recording to a CFexpress card (second card recording functions turned off ), with an RF 
50mm F1.8 L USM lens attached, with all settings other than those listed in the table set to default, and with no terminals 
connected.

Video configuration
Power 

consumption

Approximate continuous 
recording time

(LP-E6P)

Approximate continuous 
recording times

(LP-E6NH)Sensor mode Main recording format Resolution Frame rate Bit rate

RAW

Full frame 3:2 RAW ST 6960x4640
29.97P 1800 Mbps 9.7 90 65

25.00P 1510 Mbps 8.8 100 70

Full frame

RAW ST 6960x3672
59.94P 2860 Mbps 13.8 60 40

50.00P 2380 Mbps 12.2 70 45

RAW HQ 6960x3672
29.97P 2900 Mbps 10.3 85 60

25.00P 2420 Mbps 9.3 95 70

Super 35mm
(Cropped) RAW ST 5036x2656

59.94P 1500 Mbps 12.2 70 45

50.00P 1250 Mbps 10.8 80 60

Super 16mm
(Cropped) RAW HQ 2524x1332

59.94P 769 Mbps 9.9 90 65

50.00P 642 Mbps 8.8 100 70

XF-AVC

Full frame XF-AVC YCC422 10 bit

4096x2160 
Intra-frame

59.94P 1200 Mbps 13.6 60 40

50.00P 1000 Mbps 12.1 70 45

3840x2160 
Long GOP

59.94P 250 Mbps 13.3 65 40

50.00P 250 Mbps 12.0 70 45

Super 35mm
(Cropped) XF-AVC YCC422 10 bit 4096x2160 

Intra-frame
59.94P 1200 Mbps 12.4 65 45

50.00P 1000 Mbps 11.0 80 55

Super 16mm
(Cropped) XF-AVC YCC422 10 bit 2048x1080 

Intra-frame
59.94P 300 Mbps 9.8 90 65

50.00P 250 Mbps 8.7 100 70

XF-HEVC S

Full frame 3:2 XF-HEVC S YCC422 10 bit 6912x4608 
Intra-frame

29.97P 1620 Mbps 12.0 70 45

25.00P 1350 Mbps 10.7 80 60

Full frame XF-HEVC S YCC422 10 bit 4096x2160 
Long GOP

59.94P 225 Mbps 13.5 60 40

50.00P 225 Mbps 11.9 70 45

Super 35mm
(Cropped) XF-HEVC S YCC422 10 bit 4096x2160 

Long GOP
59.94P 225 Mbps 12.1 70 45

50.00P 225 Mbps 10.8 80 60

Super 16mm
(Cropped) XF-HEVC S YCC422 10 bit 2048x1080 

Long GOP
59.94P 50 Mbps 9.6 90 65

50.00P 50 Mbps 8.6 100 75

XF-AVC S

Full frame XF-AVC S YCC422 10 bit 4096x2160 
Intra-frame

59.94P 1200 Mbps 13.7 60 40

50.00P 1000 Mbps 12.1 70 45

Super 35mm
(Cropped) XF-AVC S YCC422 10 bit 4096x2160 

Intra-frame
59.94P 1200 Mbps 12.4 65 45

50.00P 1000 Mbps 11.0 80 55

Super 16mm
(Cropped) XF-AVC S YCC422 10 bit 2048x1080 

Intra-frame
59.94P 300 Mbps 9.7 90 65

50.00P 250 Mbps 8.7 100 75
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Charging Times
Charging times are approximate and vary according to charging conditions, ambient temperature and initial charge of 
the battery pack.

Battery pack LP-E6P

Charging time using the supplied 
LC-E6/LC-E6E Battery Charger

180 min.
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Appendix: Camera Dimensions

Appendix: Camera Dimensions
Unless indicated with the " (inch) mark, all units are in mm.  represents the depth of a hole or socket.

Top

Bottom

Front

Rear

Left

Right

142.0

88.0 54.0
94.5

70.524.0

17.7

1/4"  8.8
 (x 2)

1/4"  5.5 ∅ 5.4   4.5 

Lens 
attachment 
plane

29
.0

16.2

87
.8

43
.5

18.2

42.2

1/4"  9.6

29
.0

16.7

Lens attachment 
plane

1/4"  9.1

26
.640

.0

44
.3

26
.7
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Camera with handle unit and microphone holder

Handle unit

133.2 102.7

23
8.

4

19
4.

2

23
.0

85.6

221.2

58
.4

 

185.9

120.1

83
.593

.7

49
.1

185.9

19.8

73.5

75.2

29
.0

1/4" SCREW 

37.0

1/4"  7.5 

1/4"  7.5 

98
.4

29
.0

26.2
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× (headphones) terminal  . . . . . . . . . . . . . . . . . . . . 116, 150
802.1X Authentication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

A
ABB (automatic black balance) . . . . . . . . . . . . . . . . . . . . . . 49
Abroad, using the camera  . . . . . . . . . . . . . . . . . . . . . . . . . 236
Access log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 234
Access point . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 167, 168
Accessories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11, 238
AE shift . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
AF area . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
Air vents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13, 14, 48
Anamorphic lenses and desqueeze . . . . . . . . . . . . . . . . 128
Aperture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

Auto iris  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Automatic aperture (auto iris) . . . . . . . . . . . . . . . 84

Assignable buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
Audio

Audio level  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112
Bit depth  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108
Format  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Output channels  . . . . . . . . . . . . . . . . . . . . . . . . . . 162
Peak limiter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

Audio files (for slow & fast motion clips) . . . . . . . . . . . . 124
Audio reference signal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Authentication  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176, 177
AWB (auto white balance)  . . . . . . . . . . . . . . . . . . . . . . . . . . 88
AWB lock . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

B
Base ISO . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
Bit rate  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Built-in backup battery  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236
Button connection mode (WPS)  . . . . . . . . . . . . . . 168, 171

C
Camera Access Point  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
Camera dimensions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 251
CAMERA mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Camera nickname  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
Canon App . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173, 187
Canon Log 2, Canon Log 3 

(gamma curves)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Canon XF Utility (download) . . . . . . . . . . . . . . . . . . . . . . . 163
Card volume label  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

CFexpress card  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Check marks (%) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120, 152
Chunk recording  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
Cinema EOS System Expansion 

User Guide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
Cinema RAW Development . . . . . . . . . . . . . . . . . . . . . . . . 163
Clips

Adding $ marks/% marks  . . . . . . . . . . 120, 152
Adding shot marks  . . . . . . . . . . . . . . . . . . . 120, 153
Clip information . . . . . . . . . . . . . . . . . . . . . . . . . . . 152
Clip name format . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Clip numbering . . . . . . . . . . . . . . . . . . . . . . . . . .46, 47
Deleting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
Playback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
Proxy clips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Recovering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Color bars  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
Color bit depth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Color compensation (CC) value . . . . . . . . . . . . . . . . . . . . . 86
Color sampling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
Color space . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139, 160
Computer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Condensation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
Connection to external devices . . . . . . . . . . . . . . . . . . . . 157
Content Transfer Professional . . . . . . . . . . . . . . . . . 164, 187
Continuous recording  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Control dials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78, 82
Control ring (RF lens)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
Crop Recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Custom displays . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53, 197
Custom picture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Detailed custom picture settings  . . . . . . . . . . 139
Look File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137
Preset settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

CV Protocol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

D
Data entry / keyboard screen  . . . . . . . . . . . . . . . . . . . . . . . 30
Date and time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Deleting recordings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
Desqueeze  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Detection of access points . . . . . . . . . . . . . . . . . . . . . . . . . 176
Digital IS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Digital tele-converter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98
Direct setting mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Index
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Direct touch control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Double slot recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Drop frame (time code) . . . . . . . . . . . . . . . . . . . . . . . . . . . .105

E
EF Cinema lenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32, 246
Encryption . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175, 176
Exposure bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Exposure compensation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

F
False color . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .102
Fan . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
FEC error correction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .171
File menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .151
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• The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade dress and the HDMI Logos are trademarks or 
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Licensing Information
• This device incorporates exFAT technology licensed from Microsoft.
• This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding MPEG-4 

compliant video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal and 
noncommercial purpose or (2) by a video provider licensed under the AT&T patents to provide MPEG-4 compliant 
video. No license is granted or implied for any other use for MPEG-4 standard.

• THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER 
OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE 
AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A 
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO 
LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED 
FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM

Third Party Software
For details regarding third party software, refer to Software Used in This Product (PDF) available on the download page of 
the Instruction Manual.
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CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN THE UNITED STATES
The limited warranty set forth below is given by Canon U.S.A., Inc. (‘Canon USA’) with respect to (a) the Canon Cinema EOS 
Product, and (b) the accessories for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively 
the “Products”)* and purchased in the United States. This limited warranty is only effective upon presentation of your Bill of 
Sale or other proof of purchase. The Products are warranted to the original end-user purchaser, when delivered in new 
condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At Canon 
USA’s option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the 
date of original purchase.  Labor: For a period of ONE YEAR from the date of original purchase, labor will be provided free of 
charge by Canon USA’s factory service centers or designated service facilities located in the United States. When returning 
Products under this warranty, you must pre-pay the shipping charges, and you must enclose a copy of the Bill of Sale or 
other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, repairs will be 
made and the Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be 
given an estimate of the cost of repair and an opportunity to approve or disapprove of the repair expense before it is 
incurred. If you approve, repairs will be made and the Products will be returned to you at your risk and expense. If you 
disapprove, we will return-ship the Products to you at no charge to you to an address within the United States.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as to which items Canon USA will have 
no responsibility. Canon USA shall have no responsibility under this limited warranty for use of the Products in conjunction with incompatible peripheral equipment and/or 
incompatible software. Non-Canon brand peripheral equipment and software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty 
of any kind by Canon USA, including any implied warranty regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such non-Canon brand 
items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the 
Products or contact the CANON INFORMATION CENTER AT 855-CINE-EOS (855-246-3367) or on the internet at pro.usa.canon.com/
support. You will be directed to the nearest service facility for your Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following 
cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon 
accessories or failure to follow operating, maintenance or environmental instructions prescribed in Canon USA’s user’s 
manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;
C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon USA) that cause 

damage to the Products or that cause abnormally frequent service calls or service problems;
D. If defects or damages are caused by  service other than  Canon USA’s factory service centers or authorized service 

facilities;
E. Any internal modification to product hardware or firmware;
F. Any applicable fee for Maintenance of the Products;
G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside the United States. This Limited Warranty does not 
apply to accessories or consumables not originally packaged with the Product. Please retain this warranty card and your Bill 
of Sale as a permanent record of your purchase. This card ensures that you are contacted promptly should there be a safety 
inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE PRODUCTS AFTER THE APPLICABLE PERIOD OF EXPRESS 
WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, FIRM OR CORPORATION WITH RESPECT TO THE PRODUCTS SHALL BIND CANON USA (SOME 
STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON USA SHALL NOT BE 
LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING WITHOUT 
LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, 
MISUSE OR INABILITY TO USE THE PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON USA BE GREATER THAN THE PURCHASE PRICE OF THE PRODUCTS SOLD BY CANON USA AND 
CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO 
OTHERS AND THEIR PROPERTY ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF CANON USA (SOME STATES DO NOT 

USA

http://pro.usa.canon.com/support
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ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).THIS LIMITED WARRANTY SHALL NOT 
EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

CANON U.S.A., INC
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CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN CANADA
The limited warranty set forth below is given by Canon Canada Inc. (‘Canon Canada’) with respect to (a)  the Canon Cinema 
EOS product, and (b)  the accessories for the  Canon Cinema EOS Product (if any),  packaged with this limited warranty 
(collectively the “Products”)* and purchased in Canada. This limited warranty is only effective upon presentation of your Bill 
of Sale or other proof of purchase. The Products  are warranted to the original end-user purchaser, when delivered in new 
condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At Canon 
Canada’s option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from 
the date of original purchase.  Labor: For a period of ONE YEAR from the date of original purchase, labor will be provided free 
of charge by Canon Canada’s factory service center or designated service facilities located in Canada. When returning 
Products under this warranty, you must pre-pay the shipping charges, and you must enclose a copy of the Bill of Sale or 
other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, repairs will be 
made and the Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be 
given an estimate of the cost of repair and an opportunity to approve or disapprove of the repair expense before it is 
incurred. If you approve, repairs will be made and the Products will be returned to you at your risk and expense. If you 
disapprove, we will return-ship the Products to you at no charge to you to an address within Canada.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as to which items Canon Canada will 
have no responsibility. Canon Canada shall have no responsibility under this limited warranty for use of the Products in conjunction with incompatible peripheral equipment and/
or incompatible software. Non-Canon brand peripheral equipment and software which may be distributed with, or factory loaded on, the  Products, are sold ‘AS IS’ without 
warranty of any kind by Canon Canada, including any implied warranty or condition regarding merchantability or fitness for a particular purpose. The sole warranty with respect 
to such non-Canon brand items is given by the manufacturer or producer thereof. 

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the  
Products or contact the CANON PROFESSIONAL SERVICE CENTRE 1-800-667-2666 or on the internet at www.canon.ca/pro.  You 
will be directed to the nearest service facility for your Products. 

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following 
cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon 
accessories or failure to follow operating, maintenance or environmental instructions prescribed in Canon Canada’s 
user’s manual;

B. If the Products  are defective as a result of leaking batteries, sand, dirt or water damage;
C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon Canada) that cause 

damage to the Products or that cause abnormally frequent service calls or service problems;
D. If defects or damages are caused by  service other than  Canon Canada’s factory service centers or authorized service 

facilities;
E. Any internal modification to product hardware or firmware;
F. Any applicable fee for Maintenance of the Products;
G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside Canada. This Limited Warranty does not apply to 
accessories or consumables not originally packaged with the Product. Please retain this warranty card and your Bill of Sale as 
a permanent record of your purchase. This card ensures that you are contacted promptly should there be a safety 
inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY OR CONDITION, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE PRODUCTS AFTER THE APPLICABLE PERIOD OF 
EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, FIRM OR CORPORATION WITH RESPECT TO THE PRODUCTS SHALL BIND CANON 
CANADA (SOME PROVINCES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY 
TO YOU). CANON CANADA SHALL NOT BE LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE  PRODUCTS OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION 
OF DATA, INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE  PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON CANADA 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON CANADA BE GREATER THAN THE PURCHASE PRICE OF THE 
PRODUCTS SOLD BY CANON CANADA AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR 
INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE 
NEGLIGENCE OF CANON CANADA (SOME PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY 

CANADA

http://www.canon.ca/pro
http://www.canon.ca/pro


261

NOT APPLY TO YOU). THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR WHOM IT WAS 
PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from province to province. 

CANON CANADA INC.
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